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Alkusanat

Käyttöohjeen 
tarkoitus

Tämä käyttöohje kuvaa yleisesti SIPROTEC laitteiden hallintaa, konfigurointia, 
parametrointia, käyttöä, asennusta ja käyttöönottoa. 

Yksittäisten laitteiden tarkemmat tekniset tiedot kuten laitteen toiminnat, yksittäiset 
parametrit ja laitteen liitynnät suojattavaan järjestelmään, on esitetty erillisissä 
laitekohtaisissa käyttöohjeissa. 

Kohderyhmä Järjestelmäsuunnittelijat, suojaus- ja käyttöönottoasiantuntijat, henkilöt jotka 
suorittavat suojaus- ja ohjausjärjestelmien asettelut, kausikoestukset ja 
huoltotoimenpiteet ja henkilöt jotka työskentelevät sähköasemilla ja voimalaitoksilla. 

Edellytykset Windows-käyttöjärjestelmän hallinta on edellytyksenä toimintojen käytölle.

Käyttöohjeen 
voimassaolo

Tämä käyttöohje on pätevä ja voimassa SIPROTEC® laitteille lähtien versiosta 4.0 ja 
DIGSI versiosta V4.3. Tässä kuvataan myös SIPROTEC® V2 / V3 laitteiden hallinta 
projektissa. 

Hotline Puhelin  ++ 49 (0) 18 05 24 70 00
Telefax  ++ 49 (0) 18 05 24 70 00
Sähköposti  ptd.support@siemens.com

Kurssit Tarjolla olevat kurssit on esitetty erillisessä koulutuskatalogissa tai niistä saa tietoa 
kysymällä suoraan koulutuskeskuksesta Nürnbergistä tai paikalliselta Siemens-
yhteyshenkilöltä sekä internetistä osoitteesta

www.ptd-training.de

Yhdenmukaisuus 

Tämä tuote on yhdenmukainen Euroopan unionin jäsenvaltioiden laitteiden 
sähkömagneettisille ominaisuuksille ja pienjännitteelle rajoitetuille kojeille 
määriteltyjen direktiivien kanssa (EMC Neuvosto Direktiivi 89/336/EEC ja 73/23/EEC). 

Yhdenmukaisuus, joka on toteutettu neuvostodirektiivin 10 artikkelin mukaisesti, on 
koestettu Siemens AG:n toimesta ja pohjautuu yleisiin EMC standardeihin EN 50081 
ja EN 50082 ja kansainväliseen standardiin 60255-6. 

Tuote on kehitetty kansainvälisten IEC 255 ja Saksan DIN 57 435 osa 303 (vastaa 
normia VDE 0435 osa 303) standardien mukaisesti. 
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Alkusanat
Ohjeet ja 
varoitukset

Tämän käyttöohjeen ohjeita ja varoituksia tulee noudattaa oman turvallisuutenne 
vuoksi ja jotta laite saavuttaisi sille mitoitetun eliniän. Olkaa hyvä ja ottakaa ne 
huomioon! 

Käyttöohjeessa käytetään seuraavia varoitustunnuksia ja vakiomääritteitä: 

VAARA
Tarkoittaa, mikäli varoituksen ohjeita ei noudateta voi seurauksena olla joko vakava 
loukkaantuminen tai huomattavat materiaaliset vahingot. 

Varoitus
Tarkoittaa, mikäli varoituksen ohjeita ei noudateta voi seurauksena olla joko kuolema, 
vakava loukkaantuminen tai huomattavat materiaaliset vahingot. 

Huomio
Tarkoittaa, mikäli huomautuksen ohjeita ei noudateta voi seurauksena olla joko 
loukkaantuminen tai materiaaliset vahingot. Materiaalisilla vaurioilla tarkoitetaan 
lähinnä laitteen itsensä vaurioitumista. 

Ohje
Ohjeen avulla kuvataan tuotteen tai tämän käyttöohjeen kohtaa, joka tulee erikoisesti 
ottaa huomioon. 

KOULUTETTU HENKILÖKUNTA 

Laitteen moitteeton toiminta edellyttää, että kuljetus, varastointi, asennus ja 
käyttöönotto on suoritettu asianmukaisesti ja tämän käyttöohjeen ohjeita ja varoituksia 
noudattaen.

On koulutettu ja valtuutettu suorittamaan kytkentätoimenpiteitä kuten kiinni- ja 
aukikytkennät, maadoitukset ja niiden merkitseminen. 

On perehdytetty voimassa oleviin turvallisuusohjeisiin ja määräyksiin. 

Ensiapukoulutus. 

Varoitus! 
Otettaessa sähköisiä laitteita käyttöön, on osa laitteen liittimistä vaarallisten 
jännitteiden alaisina.  Jos laitteita ei käytetä asian mukaisesti, voi seurauksena olla 
henkilö- tai materiaalivahingot. 

Tuotetta saa käsitellä vain koulutettu henkilöstö. Henkilökunnan tulee olla perehtynyt 
huolellisesti tämän käyttöohjeen varoituksiin ja turvallisuusohjeisiin, sekä muihin 
voimassa oleviin turvaohjeisiin ja -määräyksiin. 

Laitteen häiriötön ja turvallinen käyttö edellyttää että kuljetus, varastointi ja asennus 
on suoritettu asianmukaisesti ja tämän käyttöohjeen ohjeita ja varoituksia noudattaen. 

Erikoisesti tulee noudattaa voimassa olevia määräyksiä sähköisten kojeistojen 
käsittelyssä (esimerkiksi ANSI, IEC, EN, DIN tai muut kansalliset ja kansainväliset 
normit). Jos turvallisuusohjeita ei noudateta, voi seurauksena olla vakavaan 
loukkaantumiseen johtava työtapaturma tai merkittävät materiaaliset vahingot. 
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Alkusanat
Kaaviokuvissa käytetään seuraavia symboleja: 

Yleisesti symbolit noudattavat IEC 60617-12 ja IEC 60617-13 normeja tai ne voidaan 
johtaa normien määrittelemistä symboleista.

mahdolliset asettelut On ja Off

UL1-L2

Ground laitteen sisäinen looginen tulosignaali

Ground laitteen sisäinen looginen ulostulosignaali

sisääntuleva sisäinen analoginen signaali

> Enable
funktionumerolla (FNo) varustettu ulkoinen binäärinen tulosignaali

Dev. off funktionumerolla (FNo) varustettu ulkoinen binäärinen lähtösignaali

On

Off

1234 FUNCTION

Parametriosoite
Parametrin nimi

Asetteluparametrit

esimerkki FUNCTION toimintaparametrin käytöstä, jonka numero on 12

(binäärinen tulo, tulomerkinanto)

(laitteen jälleenantama merkinanto)

F#

F#

Sisääntuleva sisäinen analoginen signaali

≥1

&

Tuloarvojen TAI-piiri

Tuloarvojen JA-piiri

Signaalin negaatio
iiiSIPROTEC Järjestelmäkäyttöohje
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Alkusanat
Iph>

2610 Iph>>

0 T

S

R

Q

≥1 Dynaamiset tulosignaalit

Analogisen lähtösignaalin muodostus
useammasta analogiatulosignaalista

Aikaelementti (palautumisviive)

Rajaporras varustettuna parametriosoitteella ja
nimellä

T
Reunakäynnisteinen aikalelementti toiminta-ajalla T

Staattinen muistipiiri (RS–flipflop), jossa

=1 XOR-piiri: lähtö on aktiivisena jos 
vain toinen tuloista on aktiivinen 

= Vertailu: Lähtö on aktiivisena jos molemmilla tuloilla
on sama arvo

0T

2611 T Iph>> 

Aikaelementti (havahtumisaikaviive) varustettuna
parametriosoitteella ja nimellä

asetustulo (S), palautustulo (R), ulostulo (Q)
ja käänteinen ulostulo (Q)

Q
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Järjestelmän kuvaus 1
Tässä kappaleessa on kuvattu SIPROTEC® 4 laitteiden yleiset 
ominaisuudet ja niiden liittäminen ohjausjärjestelmään. Tässä on myös 
kuvattu teoreettinen menettelytapa laitteen parametrien asetteluille ja 
yleisten toimintojen käytölle. 

Sisältö 1.1  Yleisiä  2

1.2  Kommunikaatio  3

1.3  Käyttöliittymä  7

1.4  Asetteluparametrit  9

1.5  Ohjaustoiminnat  13
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Järjestelmän kuvaus
1.1 Yleisiä 

SIPROTEC® 4 on innovatiivinen numeeristen suojaus- ja 
ohjauslaitteiden tuoteperhe, joissa on avoimet kommunikaatioväylät 
kaukokäyttöä ja kaukoasettelua varten, sekä käyttäjäystävällinen 
käyttöliittymä ja erittäin joustavat toiminnat. 

Laite toimii numeerisella mittausperiaatteella. Täysin numeerinen 
signaalien käsittely takaa korkean mittaustarkkuuden ja pitkäaikaisen 
muuttumattoman toiminnallisuuden, sekä yliaaltojen ja transienttien 
luotettavan käsittelyn. Mitattujen suureiden numeeriset 
suodatusmenetelmät ja dynaaminen vakavointi takaa suojaustoimintojen 
korkean luotettavuuden. Laitehäiriöt tunnistetaan ja ilmaistaan 
välittömästi sisäisin itsevalvontamenetelmin. Suojan häiriö verkkovian 
aikana on täten lähes täysin pois suljettu. 

Käyttöön voidaan valita laitteet erikseen suojaus- ja ohjaustoimintoja 
varten tai valita kenttätason laite, jossa molemmat toiminnat on integroitu 
samaan laitteeseen. 

Käytettävissä ovat seuraavat vaihtoehdot: 

suojaus- ja ohjaustoiminnat erillisissä laitteissa,

suojauslaitteet jotka mahdollistavat lähdön kytkinlaitteiden ohjaukset 
kommunikaatioväylän kautta,

suojauslaitteet jotka mahdollistavat myös kentän kytkinlaitteiden 
paikallisohjaukset ja muut tarvittavat kentän toiminnat. 
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Kommunikaatio
1.2 Kommunikaatio 

SIPROTEC® 4 laitteet täyttävät täysin nykyaikaisen 
kommunikaatioteknologian vaatimukset. Käytettävissä on 
liikennöintiväylät suojan liittämiseksi ylemmän tason 
ohjausjärjestelmään, toimintojen käyttäjäystävälliseen 
etäparametrointiin ja käyttöön tietokoneella joko asemalla tai etäisesti 
modeemin välityksellä. 

SIPROTEC® 4 laitteet mahdollistavat kansainvälisesti hyväksytyt 
avoimet kommunikaatiostandardit:

PROFIBUS FMS

PROFIBUS DP

IEC 60870-5-103

DNP 3.00 taso 2

MODBUS ASCII/RTU

Ethernet liityntä IEC 61850 mukaisesti

Ohje:

Lisätietoja yksittäisten laitteiden kommunikaatio-ominaisuuksista on 
esitetty kunkin SIPROTEC® laitteen käyttöohjeessa.
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Järjestelmän kuvaus

istus
F, GPS
Kuva 1-1 Kenttäyksiköiden liittäminen aseman ohjausjärjestelmään - esimerkki

Yllä esitetyssä kaaviossa tiedot kenttäyksiköiltä siirretään 
valvontasuunnassa aseman ohjausjärjestelmään SICAM® SC, 
esitetään paikallisohjauspisteellä SICAM® WinCC ja välitetään edelleen 
ylemmän tason kaukokäyttöjärjestelmiin. 

Ohjaussuunnassa vastaavasti ohjaukset voidaan vastaanottaa 
kaukokäyttöjärjestelmiltä sekä aseman paikallisohjauspisteeltä. 

Paikallisohjauspiste
   SICAM WinCC

DIGSI 4

SICAM SC

Kaukokäyttöjärjestelmät
IEC 60870-5-101

IEC 60870-5-103

PROFIBUS FMS

Ajantahd
DC

Kenttäyksiköt

Profibus DP, DNP 3.00

Ohje:

Kaikki SIPROTEC® 4 laitteet voidaan liittää tähtijakajaan. Sen avulla 
voidaan yksinkertaisesti muodostaa etäyhteys toimistoon tai esimerkiksi 
huoltoautoon.
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Kommunikaatio
PROFIBUS DP protokollan avulla  SIPROTEC®  laitteet voidaan liittää 
suoraan PLC-pohjaisiin prosessiohjausjärjestelmiin (esim. SIMATIC S5/
S7). DNP 3.00 ja MODBUS ASCII/RTU protokollilla voidaan laitteet 
myös liittää usean valmistajan eri järjestelmiin. 

1.2.1 Ajantahdistus

SIPROTEC®  4 laitteiden sisäiset kellot voidaan tahdistaa seuraavasti:

DCF77 radiovastaanottimella (PTB Braunschweig aikasignaali), 

IRIG–B radiovastaanottimella (GPS satelliittijärjestelmän 
aikasignaali),

Telegrammina järjestelmäväylää pitkin (esimerkiksi kaukokäytöltä),

Radiokellon avulla kojeistokohtaisesta tahdistusjärjestelmästä,

Binääriseen sisääntuloon tuodun minuuttipulssin avulla.

Ajantahdistusmahdollisuudet järjestelmäväylää pitkin riippuvat 
käytetystä liikennöintiprotokollasta, jotka on esitetty yksityiskohtaisesti 
Protokollasta riippuvat toiminnat taulukossa tämän käyttöohjeen 
liitteessä.

Parametrien asettelu tietokoneella on mahdollista vain DIGSI® 4 
ohjelmistolla. 
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Järjestelmän kuvaus
1.2.2 Sarjaliikenneväylät

Ajantahdistusväylän lisäksi SIPROTEC® 4 laitteet voidaan varustaa 
lisäliikennöintiväylin. 

Laite liitetään ylemmän tason ohjausjärjestelmään 
järjestelmäväylällä. Seuraavat liikennöintiprotokollat ovat 
käytettävissä laitteen tyypistä ja rakenteesta riippuen:

− IEC 60870-5-103

− PROFIBUS FMS

− PROFIBUS DP

− DNP 3.00 taso 2

− MODBUS ASCII/RTU

− Ethernet liityntä IEC 61850 mukaisesti

Radiokello liitetään ajantahdistusväylään (katso kappale 1.2.1). 

Etähallintakäyttöä varten DIGSI® 4 ohjelmistolla laitteeseen on 
mahdollista lisätä huoltoväylä modeemia ja/tai tähtijakajaa varten. 
Kaikki DIGSI® 4 toiminnat ovat mahdollisia tämän väylän kautta. 

Laitteen etupaneelissa oleva käyttösarjaliikenneväylä on tarkoitettu 
asemalla työskenneltäessä tietokoneen liittämiseksi suojaan 
DIGSI® 4 ohjelmistoa varten. Tämän väylän kautta laite voidaan 
parametroida ja käyttää kaikkia DIGSI® 4 ohjelman ominaisuuksia, 
kuten esimerkiksi häiriötallenteiden tai käyttömerkinantojen luku 
laitteelta. 

Laitteen tyypistä riippuen käytettävissä voi olla myös muita 
liikennöintiväyliä, kuten esimerkiksi johtoerovirtasuojan 
kommunikaatioyhteys tai kenttien välinen kommunikaatio 
kenttätasolla.

DIGSI® 4 asetteluohjelmiston valintaikkunassa voidaan määritellä 
väylien tarvittavat asettelut kuten esimerkiksi

liikennöintiprotokolla ja

liikennöintinopeus. 

Ohje:

Laitteen järjestelmäväyläksi voidaan valita jokin seuraavista 
liikennöintitavoista: valokuituyhteys,  RS485 tai RS232 väylä.
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Käyttöliittymä
1.3 Käyttöliittymä

SIPROTEC® laitteen kanssa voidaan toimia, joko

laitteen käyttöpaneelin tai 

tietokoneen ja DIGSI® 4 ohjelmiston kanssa, joka voi olla joko 
liitettynä suoraan suojan käyttösarjaliikenneväylään tai huoltoväylän 
ja modeemin liikennöintiä hyväksi käyttäen. 

1.3.1 Ohjauspaneeli

SIPROTEC® 4 laitteiden käyttöpaneeli on rakenteeltaan 
käyttäjäystävällinen ja helppokäyttöinen ja se mahdollistaa ohjausten 
toteutuksen asemalla, yksittäisten asetteluosoitteiden määrittelyn sekä 
kaikkien ohjauksessa ja käytössä tarvittavien tapahtumien esittämisen 
näytöllä. 

Laitteiden käyttöpaneeli voi olla rakenteeltaan joko graafinen tai 
neljärivinen näyttö laitteen tyypistä riippuen. 

Kuva 1-2 SIPROTEC® 4 laitteiden käyttöpaneelit, esimerkki
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Järjestelmän kuvaus
1.3.2 DIGSI 4 

DIGSI® 4 ohjelmistolla voidaan asetella SIPROTEC® laitteet tietokonetta 
hyväksi käyttäen.   

Käyttöliittymä DIGSI® 4 ohjelmistossa käytetään Window käyttöjärjestelmän tyypillisiä 
toimintoja. Tästä johtuen ohjelmiston käytön omaksuminen on helppoa. 

Konfigurointia ja käyttöä helpottaa se että käyttäjälle esitetään vain ne 
asetteluparametrit ja ominaisuudet jotka laitteessa on käytössä. 

SIPROTEC® laitteiden asettelu on käyttäjäystävällistä ja havainnollista 
useiden aputoimintojen, kuten tilannevalikkojen, alasvetoluetteloiden 
ohjaamine valintamahdollisuuksineen, sekä numeeristen 
asetteluarvorajojen ja ohjeiden esitys vietäessä hiiri kohteen päälle. 

Määrittelymatriisi Matriisilla linkitetään informaatiot erityyppisiin tuloihin ja lähtöihin 
suojattavan kohteen vaatimusten mukaisesti, hyödyntäen 
käyttäjäystävällisiä näytön asetteluita ja suodatustoimintoja. Käyttäjä voi 
aktivoida matriisissa haluamansa informaatiosarakkeet näkyville näytön 
säilyessä havainnollisena suurista informaatio- ja 
määrittelymahdollisuuksista huolimatta. 

Salasanat Salasanoin suojataan erityyppiset toiminnat, kuten asettelumuutokset, 
ohjausten toteutus tai testaus- ja diagnoositoiminnat, luvatonta käyttöä 
vastaan. 

Käyttöönoton 
aputoiminnat

DIGSI® 4 ohjelmistossa on käyttöönoton aputoiminnat, kuten 
kytkinlaitteen ohjaukset, tulojen ja lähtöjen aktivoinnit sekä 
mittausarvojen simuloinnit. 

Apua-toiminnat Apua-toiminnat kuvaavat yksittäisten toimintojen parametrien 
merkitykset. 
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Asetteluparametrit
1.4 Asetteluparametrit

SIPROTEC® 4 laite toimitetaan tehdasaseteltuna ja täten 
perustoiminnoiltaan toimintavalmiina. 

DIGSI® 4 ohjelmisto tarjoaa käyttäjäystävällisen käyttöliittymän ja 
loogisen toimintajärjestyksen laitteen asetteluparametrien ja 
konfigurointien toteuttamiseksi. 

DIGSI® 4 asennetaan normaaliin henkilökohtaiseen tietokoneeseen ja 
esimerkiksi liitetään se laitteeseen edessä olevan 
käyttösarjaliikenneväylän kautta. 

Asetteluparametrointi voidaan suorittaa offline tilassa. Suoritetut 
määrittelyt ladataan paikallisesti SIPROTEC® 4 laitteelle 
käyttösarjaliikenneväylän kautta tai etäisesti modeemiyhteyttä 
hyödyntäen huoltoväylää pitkin. 

Online-tilassa asetteluparametrit on suojattu salasanalla.

SIPROTEC® 4 laitteen asetteluparametreihin kuuluvat: 

Yleismääritykset ja ohjaustoiminnat 

Toiminnallisuuden määrittely,

Informaatioiden konfigurointi,

Käyttäjän määrittelemien loogisten toimintojen toteutus (CFC). 

Toimintojen asettelut 

Yleisasettelut,

Suojaustoimintojen asettelut,

Kentän ohjaustoimintojen asettelut. 

Yksittäisten toimintojen parametrit voidaan muuttaa käytön aikana 
joko käyttösarjaliikenneväylään liitetyllä tietokoneella ja DIGSI® 4 
ohjelmistolla tai suoraan laitteen ohjauspaneelista. 

Laitteen ohjauspeneelilta voidaan lukea myös muiden 
asetteluparametrien määrittelyt, kuten konfiguroinnit, toiminnallisuus tai 
liikennöintiväylien ominaisuudet, mutta niitä ei voi muuttaa. 

Yksittäisten asetteluparametrien muuttaminen online-tilassa on suojattu 
salasanalla.
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Järjestelmän kuvaus
1.4.1 Toiminnallisuus

Yksittäiset SIPROTEC® 4 laitteet on varustettu yksilöllisin toiminnoin. 
Laitetta tilattaessa suoritetaan toimintojen esivalinnat, joista voidaan 
aktivoida halutut käyttöön DIGSI® 4 ohjelmistolla. 

Toiminnat Jotkin suojaustoiminnat löytyvät useampaan kertaan laitteelta. Näiden 
asettelu helposti ja joustavasti on mahdollista hiirellä valitsemalla 
(lisätietoja toiminnasta DIGSI® 4 ohjelmiston Online - Apua ikkunoista).

Asetteluryhmät Katso kappale 5.4.

1.4.2 Konfigurointi 

Konfiguroinnilla  tarkoitetaan määrittelymatriisissa suoritettavia 
informaatioiden määrittelyitä tuloihin ja lähtöihin. 

Konfigurointi suoritetaan DIGSI® 4 ohjelmistolla. 

1.4.3 Ohjelmoitava logiikka - CFC 

DIGSI® 4 CFC ohjelmalla voidaan muodostaa graafisesti loogisia 
toimintoja, kuten lukitusehtoja tai mittausarvojen valvontarajoja. 

Laitekohtaiset CFC funktiot on määritelty tehdasasetteluissa. 

Loogisilla piireillä (AND, OR, NAND, jne.) ja analogisilla piireillä 
(esimerkiksi UPPER_SETPOINT, LOWER_SETPOINT, jne.) voidaan 
toteuttaa käyttökohteen vaatimia loogisia toimintoja. 

Yksittäiset piirit liitetään toisiinsa CFC ohjelmassa, jolloin voidaan 
toteuttaa esim.:

Kentän edellyttämiä tarkastustoimintoja,

Muodostaa merkinanto kun mittausarvo saavuttaa valvontarajan tai

Muodostaa ryhmähälytyksiä yksittäisistä hälytyksistä kaukokäyttöön 
välitettäväksi. 
10 SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Asetteluparametrit
1.4.4 Kojeiston tiedot (Power System Data)

Kojeiston määrätyt tiedot syötetään asettelutoimintojen yhteydessä. 
Kojeiston tietoihin kuuluu

Verkon tiedot kuten taajuus, jännite, jne.,

Tiedot virta- ja jännitemuuntajista,

Tiedot lähdön katkaisijasta. 

Kaikissa SIPROTEC® 4 laitteissa ei ole näitä kaikkia tietoja, esim. 
6MD66 laitteessa on vain nimellistaajuus.

Määrätyt kojeiston tiedot ovat osa asetteluryhmiä, jotka voidaan 
aktivoida käytön aikana käyttöön valitulla asetteluryhmän 
ohjausmenetelmällä. Näitä tietoja ovat esimerkiksi:

Ensiön nimelliskäyttöjännite

Ensiön nimelliskäyttövirta

Suojattavan kohteen ominaisuuksia kuvaavat asettelut

1.4.5 Asetteluryhmät

SIPROTEC® 4 laitteilla voi olla neljät eri määrittelyt, jotka on tallennettu 
asetteluryhmiin A ... D. Asetteluryhmien avulla voidaan sovittaa suojan 
toiminnat vastaamaan esimerkiksi muuttunutta verkon 
kytkentätilannetta. 

Asetteluryhmien parametrit tallennetaan ja asetteluryhmät voidaan 
aktivoida käytön aikana DIGSI® 4 ohjelmistolla, laitteen etupaneelista, 
binäärisellä tulolla tai ohjauksena järjestelmäväylästä. 

Joillakin SIPROTEC 4 laitteilla (esim. 6MD63, 6MD66 ja 6MD665) ei ole 
asetteluryhmiä.

Ohje:

Asettelyryhmän suojattavaa kojeistoa kuvaavat parametrit on tallennettu 
Power System Data 2 lohkoon. 
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Järjestelmän kuvaus
1.4.6 Salasanat 

SIPROTEC® laitteen toiminnat ja asettelumuutokset voidaan suojata 
salasanoin tahatonta käyttöä vastaan. 

Seuraavat salasanamäärittelyt on suoritettu tehdasasetteluna: 

Ohjaukset/merkinantojen asetukset/päivitykset (salasana No. 1)

Lukitusehtojen ohitus (salasana No. 2)

Testaus ja diagnoositoiminnat (salasana No. 4)

Hardware-testivalikot (salasana No. 6)

Yksittäisten parametrien muuttaminen (salasana No. 5)

Parametriryhmien vaihto (salasana No. 7)

Web Monitor Käyttöoikeudet "Kaikki oikeudet" (vain SIPROTEC B&B)

Käyttöoikeudet "Muutosoikeudet" (vain SIPROTEC B&B)

Käyttöoikeudet "Vain lukutoiminta" (vain SIPROTEC B&B)

Salasanan syöttöpyyntö ilmestyy automaattisesti toiminnan edetessä 
määrättyyn pisteeseen käytettäessä suojaa DIGSI® 4 ohjelmistolla tai 
suoraan SIPROTEC® suojan ohjauspaneelista. 

Salasanasuojaus on voimassa vain online käyttötilassa. 
Asettelumuutoksilta suojaava salasana aktivoituu vasta kun asettelut on 
ladattu laitteelle. Salasanat eivät ole käytössä DIGSI® 4 ohjelmiston 
ollessa offline-tilassa. 

Salasanojen oikea syöttäminen edellyttää että salasanat tiedetään! 

Ohje:

• Salasanana käytetään numeroita aina 8 numeroon saakka. 

Toimitettaessa kaikki salasanat on aseteltu tehdasasetteluna 
000000. Web Monitor toiminnan salasanat poikkeavat edellisestä: 
Esiasetteluna on 000002 "Kaikki oikeudet", 000001 "Muutosoikeudet" 
ja 000000 "Vain lukutoiminta" käyttöoikeuksille.

• Web Monitor toiminnalla on seuraavat määrittelyt : 
Käyttöväylä Vain luku 
Huoltoväylä Vain luku  
Järjestelmäväylä Ei sallittu
Nämä asettelut tulee tarvittaessa muuttaa jotta SIPROTEC laitetta 
voidaan käsitellä halutulla tavalla.
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Ohjaustoiminnat
1.5 Ohjaustoiminnat

SIPROTEC® 4 laitteella on mahdollista esittää kentän voimassa olevat 
kytkinlaitteiden asentotiedot sekä suorittaa tarvittavat ohjaukset. 
Ohjaukset voidaan aktivoida

kaukokäytöltä (kauko)

ohjauspaneelista (paikallis)

DIGSI® 4 ohjelmistolla (kauko tai paikallis)

Kaukokäyttö Jos laite on liitetty numeeriseen ohjausjärjestelmään, voidaan 
informaatiot siirtää SIPROTEC® 4 laitteen järjestelmäväylällä 
ohjausjärjestelmään. Saman väylän kautta voidaan myös vastaanottaa 
ohjauksia kaukokäytöltä. 

SIPROTEC® 4 laitteet voivat olla liitettyinä

ylemmän tason ohjausjärjestelmään tai

aseman ohjausjärjestelmään, esimerkiksi SICAM SC. 

Käyttöpaneeli Paikallisesti SIPROTEC® 4 laitteen tapahtumat voidaan lukea tai 
ohjaukset suorittaa laitteen etupaneelista. 

DIGSI® 4 Jos tapahtumat halutaan lukea DIGSI® 4 ohjelmistolla, tulee

tietokone liittää paikallisesti edessä olevaan 
käyttösarjaliikenneväylään tai 

kommunikoida SIPROTEC® 4 laitteen kanssa etäisesti 
modeemiväylän ollessa liitettynä huoltoväylään. 

Ohje:

Jos asetteluparametrien vaihtosalasana on unohtunut, voi hotline-
palvelusta pyytää väliaikaisen salasanan. Sen avulla voidaan toiminnalle 
määritellä uusi salasana. 
Hotline-tukipalvelu tarvitsee DIGSI® 4 ohjelmiston 
rekisteröintinumeron ohjelmiston asennuspakkauksesta! 
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Järjestelmän kuvaus
1.5.1 Merkinannot

SIPROTEC® 4 laitteella on erityyppisiä päiväkirjoja. 

Merkinannot saadaan näkyviin DIGSI® 4 ohjelmistolla tai laitteen 
etupaneelin näyttöön.  DIGSI® 4 ohjelmistossa merkinannot on jaettu 
seuraaviin ryhmiin:

Event Log (käyttöpäiväkirja),
Verkkohäiriöistä riippumattomat tapahtumat, esimerkiksi 
kytkinlaitteiden ohjaukset tai valvontatoimintojen havahtumat

Trip Log (häiriömerkinannot),
esimerkiksi merkinannot oikosulusta, jne.

Sensitive Ground Fault Log, (maasulkupäiväkirja)
(suojilla jotka on varustettu herkällä maasulkutoiminnalla)

General interrogation,
Voimassa olevien tilojen esitykset

Spontaneous Annunciation,
Laitteen tapahtumien jatkuva esitys spontaanisti, esimerkiksi häiriön 
tai kytkentätoimenpiteen merkinannot, jne.

Laitteen näytöllä merkinannot on esitetty seuraavissa ryhmissä

Event Log

Trip Log

Sensitive Ground Fault Log

Spontaanit merkinannot,
joka esittää automaattisesti häiriötapahtumat laitteen 
yleishavahtuman jälkeen

1.5.2 Mittausarvot

Mittausarvot on jaettu seuraaviin ryhmiin ja ne voidaan lukea DIGSI® 4 
ohjelmistolla tai suoraan laitteesta operator control panel 
käyttöpaneelin näytöstä. Mittausarvoryhmiä ovat esimerkiksi: 

Ensiöarvot, jotka lasketaan mitatuista toisioarvoista ottaen huomioon 
asetellut muuntosuhteet ja nimellisarvot

Toisioarvot, mitatut suureet

Prosenttiarvot, suhteessa aseteltuihin nimellisarvoihin

Muut arvot jotka on laskettu laitteen toimesta

Laskuriarvot, kuten esimerkiksi katkaisijan toimintakertalaskuri
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Ohjaustoiminnat
1.5.3 Häiriön tallennus

SIPROTEC® 4 laite tallentaa määrätyn määrän mittausarvoja ja 
merkinantoja häiriötilanteissa. 

Nämä häiriötiedot voidaan lukea laitteen muistista DIGSI® 4 ohjelmistolla 
ja tallentaa häiriötallenteena COMTRADE häiriöntallennusformaatissa. 

SIGRA 4 ohjelmalla voidaan tallenne analysoida havainnollisesti ja 
graafisesti. 

SIGRA 4 laskee lisäksi muita arvoja tallennetuista suureista, esimerkiksi 
impedanssit ja ohjelma esittää mitatut ja lasketut arvot

signaaliaikakaavioissa,

vektorikaavioissa,

ympyrädiagrammeissa ja

harmoonisina yliaaltoina. 

digra009.gif

Kuva 1-3 SIGRA 4 häiriön tallennuksen analysointi, esimerkki
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Järjestelmän kuvaus
1.5.4 Ohjaukset

Ohjaukset SIPROTEC® 4 laitteiden monipuolisiin toimintoihin kuuluvat myös 
kattavat ohjaustoiminnat. 

Laitteen etupaneelista tai järjestelmäväylän kautta vastaanotetun kauko-
ohjauksen lisäksi voidaan määritellä DIGSI® 4 CFC graafisella 
määrittelyohjelmalla loogisia funktioita, jotka voivat suorittaa ohjauksen 
logiikan ohjaamana. Nämä loogisten toimintojen aktivoimat ohjaukset 
liitetään laitteen ulostuloille ja käsitellään niitä aseteltujen 
ominaisuuksien  mukaisesti. 

Ohjauksiin voidaan määritellä lukitusehtoja, jotka muodostetaan myös 
DIGSI® 4 CFC ohjelmalla. Vakiolukitukset kuten kennon lukitukset tai 
lähdön maadoitus, on määritelty esimerkkinä laitteen tehdasasetuksissa. 

Ohjauksen kestoaika, takaisinvalvonta-aika, jne. määritellään 
ohjaustoiminnan asetteluparametrein. 

Kaikki ohjaustoiminnat kirjautuvat käyttöpäiväkirjaan päivämäärällä ja 
kellonajalla leimattuna. 

Ohjaukset saa suorittaa vain ohjausoikeudet omaava henkilökunta ja 
ohjaustoiminnat on tästä syystä suojattu salasanoin! 

Käsin merkkaus Jos kytkinlaitteen asentotiedon välittyminen laitteelle on estynyt, voidaan 
kytkinlaitteen asento määritellä käsin laitteen etupaneelista Update 
toiminnolla. Tämä käsin aseteltu tila otetaan huomioon lukitusehtoja 
tarkastettaessa ja automaattisesti käynnistyviä ohjauksia 
määriteltäessä. 

Tilan asetus Käyttöönoton yhteydessä voi olla tarpeen estää tiedon kulku 
kytkinlaitteen ja laitteen välillä väliaikaisesti ilman että piiriä avattaisiin 
fyysisesti. Tämä voidaan suorittaa laitteen etupaneelista Set status 
toiminnalla. 
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Ohjaustoiminnat
1.5.5 Sisäisten merkinantojen asetus

Kytkinlaitoksen epänormaalien käyttötilojen määrittely voidaan suorittaa 
taggings toiminnalla. 

Tarkoitusta varten voidaan matriisiin lisätä sisäinen yksinapainen 
merkinanto joka kuvaa kojeiston tilaa, esimerkiksi maadoitettu. Tämä 
sisäinen yksinapainen merkinanto voidaan ottaa huomioon esimerkiksi 
lukitusehtoja tarkastettaessa CFC logiikalla. 
Merkinantojen tiloja voidaan ohjata myös logiikan määräämänä. 

 

Ohje:

Yksittäisten laitteiden tarkemmat tekniset tiedot kuten laitteen toiminnat, 
yksittäiset parametrit ja laitteen liitynnät suojattavaan järjestelmään, on 
esitetty erillisissä laitekohtaisissa käyttöohjeissa. 
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SIPROTEC® laitteet 2
Tässä kappaleessa kuvataan SIPROTEC® 4 laitteiden käyttöpaneelin 
elementit, kotelon rakennevaihtoehdot ja käytetyt liitintyypit. Lisäksi on 
annettu tietoja suositeltavista ja sallituista johdotustarvikkeista, sekä 
soveltuvista varusteista ja työkaluista. 

Sisältö 2.1  Laitteiden käyttöelementit  20

2.2  Laitteet uppo- ja pinta-asennuskoteloissa  24

2.3  Laitteet pinta-asennuskotelossa  28

2.4  Erillisellä käyttöpaneelilla varustetut laitteet  33

2.6  Liitynnät ruuviliittimille - uppoasennuskotelo  37

2.7  Liitynnät ruuviliittimille - pinta-asennuskotelo  43

2.8  Pistokeliittimet  44

2.9  Valokuituliitynnät - uppoasennuskotelo  48

2.10  Valokuituliitynnät - pinta-asennuskotelo  49

2.11  Sähköisten sarjaliikenneväylien liitynnät  52

2.12  Analogialähtöliitynnät  54

2.13  Piensignaalimuuntimien liitynnät  56
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SIPROTEC® laitteet
2.1 Laitteiden käyttöelementit

Riippuen SIPROTEC® laitteiden versioista, voi ohjauspaneeli olla 
rakenteeltaan

4-rivinen tekstinäyttö tai

graafinen näyttö. 

Laitteen tyypistä riippuen näyttö ja käyttöelementit poikkeavat toisistaan. 
Esimerkiksi graafisella näytöllä varustetussa laitteessa kytkinlaitteita 
voidaan ohjata suoraan laitteen näytöltä. Laitteilla on myös poikkeava 
määrä ilmaisinledejä, joihin halutut tapahtumat ovat liitettävissä. 

2.1.1 Käyttöpaneeli 4-rivisellä näytöllä

Kuva 2-1  Esimerkkinä laite edestä kuvattuna, kotelon koko 1/3

Ilmaisin- ja ohjauselementtien merkitykset on kuvattu seuraavissa 
kappaleissa.

SIEMENS SIPROTEC

1 2

6

3

+/-0

54

7 8 9

 

 
 

 
 

 

 

  7SA610RUN ERROR

  MENU 

ESCLED ENTER

F4

F1

F2

F3

 Event Log 

 Meas. values 

MAIN MENU            01/04

Annunciation             1
Measured values      2

2)

3)

4)

5)

6)9)

12)

11)

10)

1)

13) 13)
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 Indication
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Laitteiden käyttöelementit
2.1.2 Käyttöpaneeli varustettuna graafisella näytöllä

Kuva 2-2  Esimerkkinä laite edestä kuvattuna, kotelon koko 1/2

Ilmaisinelementit LCD näyttö (2)
Kojeiston ja laitteen tapahtumien esitykseen joko graafisella näytöllä 
tai 4-rivisellä tekstinäytöllä. 
Yleisesti esitettäviä tietoja ovat kytkinlaitteiden ja muiden kojeiston 
elementtien asennot, mittausarvot, energiamittausarvot, kentän ja 
laitteen tilat, suojaustiedot ja hälytykset. 

Ledit (11)
Vapaasti määriteltävät ledit kojeiston tai laitteen tilojen esitykseen. 
Käyttöpaneelissa on tasku johon voidaan pujottaa tekstiliuska, jossa 
ledien merkitykset on kuvattu.

Laitteen käyttötilan ilmaisut (12) "RUN" ja "ERROR"

Avainkytkimet Avainkytkimet (8)
Avainkytkimillä voidaan vaihtaa kauko- ja paikallisohjaukset ja 
lukitut ja lukitsemattomat ohjaukset tilojen välillä nopeasti ja 
luotettavasti. 

SIEMENS SIPROTEC
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  7SA631RUN ERROR

  MENU 

ESCLED CTRL ENTER

F4

F1

F2

F3

 Event Log 

 Meas. values 

 Fault Record
Indication

Remote

Normal

Local

Interlocking OFF

Schlossplatz

Earth feeder with F4

21 kV 1000 A 

1)
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SIPROTEC® laitteet
Käyttösarja-
liikenneväylä

9-napainen D-sub naarasliitin (9)
Sarjaliikenneväylä on tarkoitettu tietokoneen liittämistä varten 
SIPROTEC® laitteeseen, joka mahdollistaa DIGSI® 4 ohjelmiston 
liikennöinnin paikallisesti laitteen kanssa.

Käyttöpaneelin
kiinnitys

Suojakansien alla sijaitsevat käyttöpaneelin kiinnitysruuvit (13).

2.1.3 Käyttöpaneelien painikkeet

Riippuen SIPROTEC® laitteen versiosta, on käytettävissä seuraavat 
painikkeet tai osa niistä:

Taul. 2-1 SIPROTEC® laitteen käyttöpaneelin painikkeet

Painike Toiminta/merkitys

MENU painikkeella voidaan avata valikkopuu (1)

Nuolipainikkeella voidaan siirtyä alaspäin menu-valikoissa tai 
ohjausnäytössä (3)

Nuolipainikkeella voidaan siirtyä ylöspäin menu-valikoissa tai 
ohjausnäytössä (3)

Nuolipainikkeella voidaan siirtyä vasemmalle menu-valikoissa 
tai ohjausnäytössä (3)

Nuolipainikkeella voidaan siirtyä oikealle menu-valikoissa tai 
ohjausnäytössä (3)

Nuolipainikkeella voidaan siirtyä alaspäin menu-valikoissa tai 
ohjausnäytössä (3)

Nuolipainikkeella voidaan siirtyä ylöspäin menu-valikoissa tai 
ohjausnäytössä (3)

Vahvistetaan syötetty muutos (4)

MENU

ENTER
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Laitteiden käyttöelementit
Hylkäys valinta, siirtyminen takaisin (4)

Numeeriset painikket 0 ... 9, piste ja etumerkki numeeristen 
arvojen syöttämistä varten (5)

Funktiopainikkeet F1 ... F4 (6)
Funktiopainikkeilla voidaan aktivoida nopeasti ja 
käyttäjäystävällisesti usein käytettyjä toimintoja. 
Funktiopainikkeet ovat vapaasti ohjelmoitavissa. 
Käyttöpaneelissa on tasku johon voidaan pujottaa tekstiliuska, 
jossa funktiopainikkeiden merkitykset on kuvattu. Tyypillisiä 
käyttötapoja funktiopainikkeille on suorat siirtymiset haluttuun  
kohtaan valikkopuussa. 
Kolmella ensimmäisellä funktiopainikkeella on seuraavat 
toiminnat määriteltynä tehdasasetteluissa:
F1 Käyttöpäiväkirja
F2 Käyttömittaukset ensiöarvoina
F3 Häiriöpäiväkirjat

Ohjausnäytön aktivointi (7) 

Ledien testaus ja
muistaviksi määriteltyjen ledien ja koskettimien palautus (10)

KIINNI-painike kytkinlaitteiden ohjaukseen (4)

AUKI-painike kytkinlaitteiden ohjaukseen (4)

Taul. 2-1 SIPROTEC® laitteen käyttöpaneelin painikkeet

Painike Toiminta/merkitys

ESC

0

F1

CTRL

LED

Ohje:

Käyttöpaneelin toiminta on kuvattu tarkemmin kappale 3.3 ja kappale 6.
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SIPROTEC® laitteet
2.2 Laitteet uppo- ja pinta-asennuskoteloissa

SIPROTEC® laitteilla käytetään 7XP20 koteloita uppo- ja pinta-
asennukseen. Koteloita on kolmea eri kokoa: 

1/3 x 19 " varustettuna 4-rivisellä tekstinäytöllä
1/2 x 19 " varustettuna 4-rivisellä teksti- tai graafisella näytöllä
1/1 x 19 " varustettuna 4-rivisellä teksti- tai graafisella näytöllä

Käytetty liitinteknologia valitaan laitteen tilauksen yhteydessä.

2.2.1 Kotelo 

Kotelo muodostuu kehikosta, takalevystä ja käyttöpaneelista. Kehikon 
ylä- ja alareunaan sisäpuolelle on sijoitettu ohjauskiskot. Laitteen modulit 
on sijoitettu näihin kiskoihin. Jokainen kisko on varustettu 
paikkatunnuksella 1 ... 42, jotka kuvaavat modulien sijoituspaikkaa. 
Modulit on liitetty toisiinsa ja käyttöpaneeliin lattakaapelein. Kehikkoon 
ruuvein kiinnitetyllä takapaneelilla sijaitsevat laitteen liitinmodulit, joihin 
kojeiston johdotus on liitettävissä. 

Käyttöpaneeli voidaan irroittaa kotelosta. 

• Poistetaan kotelon kulmista neljä suojakantta ja avataan niiden alla 
olevat neljä kiinnitysruuvia. 

• 1/1 kotelossa on lisäksi kaksi ylimääräistä suojakantta ja 
kiinnitysruuvia. Nämä sijaitsevat kotelon ylä- ja alareunassa keskellä 
käyttöpaneelia. Käyttöpaneelin irroitus edellyttää siis niiden 
avaamisen. 

Käyttöpaneelissa on kalvopainikkeisto ja muut käyttö- ja näyttöelementit, 
joita laitteen käytössä tarvitaan. Käyttö- ja näyttöelementtien johdotukset 
on koottu yhteen ja tuotu yhdellä kaapelilla prosessorimodulille (CPU). 

Koteloon on liimattuna kilpitarra, jossa on esitetty tärkeät tiedot, kuten 
apujännite, koestusjännite ja tilausnumero (MLFB) ja nämä tiedot 
löytyvät kotelon ulkopinnan lisäksi myös käyttöpaneelin sisäpuolelta. 

SIPROTEC® 4 laitteiden mittakuvat on esitetty laitekohtaisissa 
käyttöohjeissa. 
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Laitteet uppo- ja pinta-asennuskoteloissa
2.2.2 Laiteversiot edestä ja takaa kuvattuina

Käyttö- ja ohjauselementit on kuvattu erillisessä kappaleessa (kappale 
2.1). 

Laite on kuvattu takaa yksinkertaistettuna, jossa on myös esitetty 
esimerkinomaisena käytettävissä olevat liittimet. 

Kuva 2-3  4-rivinen näyttö, kotelon koko 1/3, esimerkki uppoasennuskotelosta

Kuva 2-4  4-rivinen näyttö, kotelon koko 1/2, esimerkki uppoasennuskotelosta
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SIPROTEC® laitteet
Kuva 2-5  4-rivinen näyttö, kotelon koko 1/1, esimerkki uppoasennuskotelosta

Kuva 2-6  Uppoasennuskotelo takaa kuvattuna, kotelon koko 1/1
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Laitteet uppo- ja pinta-asennuskoteloissa
Kuva 2-7  Graafinen näyttö, kotelon koko 1/2, esimerkki uppoasennuskotelosta

Kuva 2-8  Graafinen näyttö, kotelon koko 1/1, esimerkki uppoasennuskotelosta
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SIPROTEC® laitteet
2.3 Laitteet pinta-asennuskotelossa 

SIPROTEC®  4 laitteilla käytetään 7XP20 koteloa pinta-asennukseen. 
Koteloita on kolmea eri kokoa: 

1/3 x 19 " varustettuna 4-rivisellä tekstinäytöllä
1/2 x 19 " varustettuna 4-rivisellä teksti- tai graafisella näytöllä
1/1 x 19 " varustettuna 4-rivisellä teksti- tai graafisella näytöllä

Suoja on asennettu valmiiksi pinta-asennuskoteloon tehtaalla tilatusta 
versiosta riippuen. 

2.3.1 Kotelo 

SIPROTEC 4 laitteet pinta-asennuskotelossa poikkeavat 
uppoasennuskotelon laitteista kaksirivisten liittimiensä sijainnin 
mukaisesti. Pinta-asennuskotelossa olevalla laitteella liittimet on 
käsiteltävissä edestä päin (katso kuva 2-9 ... kuva 2-13). 

Pinta-asennuskotelossa on laitteen takaliittimiltä toteutettu johdotukset 
ulkopuolella oleville riviliittimille laitetyyppikohtaisesti. 

Käyttöpaneeli voidaan irroittaa kotelosta. 

• Poistetaan kotelon kulmista neljä suojakantta ja avataan niiden alla 
olevat neljä kiinnitysruuvia. 

• 1/1 kotelossa on lisäksi kaksi ylimääräistä suojakantta ja 
kiinnitysruuvia. Nämä sijaitsevat kotelon ylä- ja alareunassa keskellä 
käyttöpaneelia. Käyttöpaneelin irroitus edellyttää siis niiden 
avaamisen.

Käyttöpaneelissa on kalvopainikkeisto ja muut käyttö- ja näyttöelementit, 
joita laitteen käytössä tarvitaan. Käyttö- ja näyttöelementtien johdotukset 
on koottu yhteen ja tuotu yhdellä kaapelilla prosessorimodulille (CPU). 

Koteloon on liimattuna kilpitarra, jossa on esitetty tärkeät tiedot, kuten 
apujännite, koestusjännite ja tilausnumero (MLFB). Nämä tiedot löytyvät 
kotelon ulkopinnan lisäksi myös käyttöpaneelin sisäpuolelta. 

SIPROTEC® 4 laitteiden mittakuvat on esitetty laitekohtaisissa 
käyttöohjeissa. 
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Laitteet pinta-asennuskotelossa
2.3.2 Laiteversiot edestä kuvattuna

Käyttö- ja ohjauselementit on kuvattu tarkemmin erillisessä kappaleessa 
(kappale 2.1).

Kuva 2-9  4-rivinen näyttö, kotelon koko 1/3, esimerkki pinta-asennuskotelosta, jossa ei ole 
valokuituliittimiä
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SIPROTEC® laitteet
Kuva 2-10  4-rivinen näyttö, kotelon koko 1/2, esimerkki pinta-asennuskotelosta, jossa ei ole 
valokuituliittimiä

Kuva 2-11  4-rivinen näyttö, kotelon koko 1/1, esimerkki pinta-asennuskotelosta, jossa ei ole 
valokuituliittimiä
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Laitteet pinta-asennuskotelossa
Kuva 2-12  Graafinen näyttö, kotelon koko 1/2, esimerkki pinta-asennuskotelosta, jossa ei ole 
valokuituliittimiä
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SIPROTEC® laitteet
Kuva 2-13  Graafinen näyttö, kotelon koko 1/1, esimerkki pinta-asennuskotelosta, jossa ei ole 
valokuituliittimiä
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Erillisellä käyttöpaneelilla varustetut laitteet
2.4 Erillisellä käyttöpaneelilla varustetut laitteet 

SIPROTEC® laitteet varustettuna erillisellä käyttöpaneelilla on tarkoitettu 
asennettaviksi kohteisiin, joissa laitetta ei kokonaisuudessaan voi 
sijoittaa käyttäjäystävälliseen paikkaan. Laite muodostuu 7XP20 
koteloon sijoitetusta 1/2 tai 1/1 koon laitteesta pinta-asenteisena, sekä 
uppoasenteisesta käyttöpaneelista. 

Käyttöpaneeli ja kotelo liitetään toisiinsa kaapelilla, joka on kiinteästi 
asennettu käyttöpaneeliin (katso kuvat 2-14 ja 2-15). 

Käytetty liitinteknologia valitaan laitteen tilauksen yhteydessä. 

2.4.1 Kotelo ja käyttöpaneeli

Kotelo Kotelo muodostuu kehikosta, taka- ja etulevystä, jossa ei ole näyttö- tai 
käyttöelementtejä. Kehikon ylä- ja alareunaan sisäpuolelle on sijoitettu 
ohjauskiskot. Laitteen modulit on sijoitettu näihin kiskoihin. Jokainen 
kisko on varustettu paikkatunnuksella 1 ... 42, jotka kuvaavat modulien 
sijoituspaikkaa. Modulit on liitetty toisiinsa ja käyttöpaneeliin 
lattakaapelein. Kehikkoon ruuvein kiinnitetyllä takapaneelilla sijaitsevat 
laitteen liitinmodulit, joihin kojeiston johdotus on liitettävissä. 

Koteloon on liimattuna kilpitarra, jossa on esitetty tärkeät tiedot, kuten 
apujännite, koestusjännite ja tilausnumero (MLFB). Nämä tiedot löytyvät 
kotelon ulkopinnan lisäksi myös käyttöpaneelin sisäpuolelta. 

Kotelo kiinnitetään asennusalustaan ylä- ja alareunassa olevista 
kiskoista, joissa on kolme kiinnitysreikää kotelon koon ollessa 1/2 ja viisi 
reikää 1/1 kotelossa. 

Käyttöpaneeli Käyttöpaneeli muodostuu etulevystä ja kotelosta. Käyttöpaneelissa on 
kalvopainikkeisto ja muut käyttö- ja näyttöelementit, joita laitteen 
käytössä tarvitaan. Liityntäkaapeli laitteen modulikoteloon on kiinnitetty 
kiinteästi käyttöpaneeliin. 

Ennen käyttöpaneelin asennusta asennusaukkoon, tulee ensin irroittaa 
kolmesta neljä suojakantta. Kotelo voidaan kiinnittää asennusaukkoon 
suojakansien alla olevien reikien kautta. 

Käyttö- ja ohjauselementit on kuvattu erillisessä kappaleessa (kappale 
2.1).
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SIPROTEC® laitteet
2.4.2 Kuvat käyttöpaneelista ja laitteista

Seuraavissa kuvissa on kaaviollisesti esitetty SIPROTEC 4 laitteet, 
joissa on erillinen käyttöpaneeli, sekä laitekotelot varustettuna pistoke- 
tai ruuviliittimin, sekä yksiköt yhdistävä liityntäkaapeli 1/2 ja 1/1 koteloilla. 

Kuva 2-14  SIPROTEC 4 laite varustettuna erillisellä käyttöpaneelilla, kotelon koko 1/2, esimerkki

Kuva 2-15  SIPROTEC 4 laite varustettuna erillisellä käyttöpaneelilla, kotelon koko 1/1, esimerkki
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Pinta-asenteiset laitteet ilman käyttöpaneelia
2.5 Pinta-asenteiset laitteet ilman käyttöpaneelia

SIPROTEC 4 laitteet, joilla ei ole käyttöpaneelia lainkaan, voidaan 
asentaa esimerkiksi toisiokojekaappiin. Laite muodostuu 7XP20 
koteloon sijoitetuista moduleista kotelon koon ollessa 1/2 tai 1/1 
varustettuna liityntäkaapelilla. 

Käytetty liitinteknologia valitaan laitteen tilauksen yhteydessä. 

2.5.1 Pinta-asennuskotelo ja liityntäkaapeli

Kotelo Kotelo muodostuu kehikosta, taka- ja etulevystä, jossa ei ole näyttö- tai 
käyttöelementtejä. Kehikon ylä- ja alareunaan sisäpuolelle on sijoitettu 
ohjauskiskot. Laitteen modulit on sijoitettu näihin kiskoihin. Jokainen 
kisko on varustettu paikkatunnuksella 1 ... 42, jotka kuvaavat modulien 
sijoituspaikkaa. Modulit on liitetty toisiinsa ja käyttöpaneeliin 
lattakaapelein. Kehikkoon ruuvein kiinnitetyllä takapaneelilla sijaitsevat 
laitteen liitinmodulit, joihin kojeiston johdotus on liitettävissä.

Koteloon on liimattuna kilpitarra, jossa on esitetty tärkeät tiedot, kuten 
apujännite, koestusjännite ja tilausnumero (MLFB). 

Kotelo kiinnitetään asennusalustaan ylä- ja alareunassa olevista 
kiskoista, joissa on kolme kiinnitysreikää kotelon koon ollessa 1/2 ja viisi 
reikää 1/1 kotelossa. 

Liityntäkaapeli 2.5 metriä pitkä liityntäkaapeli korvaa erillisen käyttöpaneelin. Edessä 
oleva käyttösarjaliikenneväylä on tuotu ulos kotelosta 68-napaisella 
liittimellä ja toinen pää on varustettu 9-napaisella D-sub naarasliittimellä 
(katso kuva 2-16  ja 2-17). Laite voidaan initialisoida ja käyttää tämän 
väylän kautta.

9-napaisen D-sub naarasliittimen ja sen kiinnitystarvikkeiden asennus 
asennuslevyyn tai kaapin oveen on esitetty laitekohtaisessa 
käyttöohjeessa kappaleessa Asennus ja käyttöönotto. 
Lisätietoja laitteen mitoista tai asennustavoista on esitetty 
laitekohtaisissa käyttöohjeissa Tekniset tiedot kappaleessa. 
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SIPROTEC® laitteet
Kuva 2-16  SIPROTEC 4 laite, kotelon koko 1/2 varustettuna liityntäkaapelilla, esimerkki

Kuva 2-17  SIPROTEC 4 laite, kotelon koko 1/1 varustettuna liityntäkaapelilla, esimerkki
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Liitynnät ruuviliittimille - uppoasennuskotelo
2.6 Liitynnät ruuviliittimille - uppoasennuskotelo

Ruuviliittimet ovat käytettävissä seuraavilla kotelotyypeillä

uppoasennuskotelossa ja

laitteilla jotka on varustettu erillisellä käyttöpaneelilla

Ruuviliittimiä käytetään seuraavien piirien liittämiseen: 

Liityntämodulit jänniteliitynnöille ja

liityntämodulit virtaliitynnöille. 

Ruuviliittimien kiristyksessä ja avauksessa käytetään 
lattaruuvimeisseliä. Liittimiä käsiteltäessä tulee käyttää 6 x 1 kokoista 
lattaruuvimeisseliä. 

2.6.1 Liityntämodulit jänniteliitynnöille

Käytössä on kaksi eri versiota jänniteliityntöjen liitinmoduleille: 

Kuva 2-18  Liitinmodulit ruuviliittimin jänniteliitynnöille, takaa kuvattuna
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SIPROTEC® laitteet
Seuraavassa kuvassa on esitetty yksittäisten liitinten sijainti ja numerointi 
liitinmodulissa. 

Kuva 2-19  Liitinten sijainti ja numerointi modulissa, esimerkki

Liitynnässä voidaan käyttää joko rengaskaapeli- tai suoraa johdinholkkia. 
Jotta johdotusten eristyskyky ei vaarantuisi, tulee käyttää ainoastaan 
eristettyjä johdinholkkeja. Muussa tapauksessa paljaana oleva 
puristusholkin osa tulee eristää käyttötarkoituksen mukaisesti (esim. 
kutistesukalla). 

Johdotuksessa tulee noudattaa seuraavia ohjeita: 

Kaapelikengät Kengän ruuvin aukko 4 mm;
Suurin ulkohalkaisija 10 mm; 
Sallittu johdin poikkipinta-ala 1.0 mm2 ... 2.6 mm2, vastaa johdin kokoja 
AWG 16 ... 14.
Liitynnöissä saa käyttää vain kupariliittimiä! 

Suosittelemme käytettäväksi PIDG sarjan kaapelikenkiä; valmistaja Tyco 
Electronics AMP Co. 
Esimerkiksi:
Kaapelikenkäliitin: PIDG PN 320565-0 
Suora johdinhylsy: PIDG PN 321233-0 

Johtimien 
liittäminen suoraan

Johdinlanka suoraan tai monisäikeinen varustettuna johdinhylsyllä.
Sallittu johdin poikkipinta-ala 0.5 mm2 ... 2.6 mm2, vastaa johdin kokoja 
AWG 20 ... 14.
Johdin tulee liittää liittimeen siten, että liitinruuvi pääsee kiristymään 
vapaasti eikä johdin jää kantamaan. 
Liitynnöissä saa käyttää vain kupariliittimiä!

Kuorintapituus Lankajohtimilla 9 mm ... 10 mm. 

Kiristys-
momentti

Enintään 1.8 Nm. 

1
2 Liitin

Liitin 2 1
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Liitynnät ruuviliittimille - uppoasennuskotelo
2.6.2 Liityntämodulit virtaliitynnöille

Käytössä on kaksi eri versiota virtaliityntöjen liitinmoduleille: 

Kuva 2-20  Liitinmodulit ruuviliittimin virtaliitynnöille, takaa kuvattuna

Liittimet virtaliitynnöille on sijoitettu samalla periaatteella kuin kuvassa 
2-19 on esitetty. 

Käytettävissä olevien liitinten lukumäärä on muodostunut 2-liittimisistä 
pareista. Pari muodostetaan aina suoraan peräkkäin olevista liittimistä. 
Täten 8-napaisessa virtaliitinmodulissa on neljä virtapiiriparia. 

Laitteen modulikortin ja liitinmodulin oikosulkutoiminnan kanssa on 
muodostettu automaattisesti oikosulkeutuvat piirit kun laitemoduli 
vedetään ulos kotelosta. Tämä takaa että laitemodulia ulos vedettäessä 
toisiovirtapiiri ei jää auki ja muodosta täten laitteen eristyksille ja 
henkilöille vaarallista ylijännitettä. 

Kun laitemoduli työnnetään takaisin koteloon, aukeavat virtapiiriparit 
modulilla automaattisesti ja kulkevat täten laitemodulin mittauspiirien 
kautta. 

Liitinmodulien virtapiirien oikosulut avautuvat automaattisesti kun 
liitinmoduli työnnetään takaisin. Oikosulku ei avaudu ennen kuin 
laitemoduli on työnnetty luotettavasti takaisin paikoilleen taaten täten 
kunnollisen galvaanisen kosketuksen piireille. Tästä automaattisesta 
toiminnasta riippumatta tulee toisiovirtapiirien käsittelyssä noudattaa 
erittäin suurta varovaisuutta. 

Virtapiirien oikosulkusilta sijaitsee liitinmodulissa kotelon puolella ja 
oikosulkusiltaa ohjaava nasta sijaitsee laitemodulissa. 
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SIPROTEC® laitteet
Liitynnässä voidaan käyttää joko rengaskaapeli- tai suoraa johdinholkkia. 
Jotta johdotusten eristyskyky ei vaarantuisi, tulee käyttää ainoastaan 
eristettyjä johdinholkkeja. Muussa tapauksessa paljaana oleva 
puristusholkin osa tulee eristää käyttötarkoituksen mukaisesti (esim. 
kutistesukalla). 

Johdotuksessa tulee noudattaa seuraavia ohjeita: 

Kaapelikengät Kengän ruuvin aukko 5 mm;
Suurin ulkohalkaisija 12 mm; 
Sallittu johdin poikkipinta-ala 2.6 mm2 ... 6.6 mm2, vastaa johdin kokoja 
AWG 14 ... 10.
Liitynnöissä saa käyttää vain kupariliittimiä! 

Suosittelemme käytettäväksi PIDG sarjan kaapelikenkiä; valmistaja Tyco 
Electronics AMP Co. 
Esimerkiksi:
Kaapelikenkäliitin: PIDG PN 130171-0 
Suora johdinhylsy: PIDG PN 326865-0 

Johtimien 
liittäminen suoraan

Johdinlanka suoraan tai monisäikeinen varustettuna johdinhylsyllä.
Sallittu johdin poikkipinta-ala 2.6 mm2 ... 3.3 mm2, vastaa johdin kokoja 
AWG 14 ... 12.
Johdin tulee liittää liittimeen siten, että liitinruuvi pääsee kiristymään 
vapaasti eikä johdin jää kantamaan.
Liitynnöissä saa käyttää vain kupariliittimiä!

Kuorintapituus Lankajohtimilla 10 mm ... 11 mm. 

Kiristys-
momentti

Enintään 2.7 Nm. 
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Liitynnät ruuviliittimille - uppoasennuskotelo
2.6.3 Kytkentäsillat ja suojakannet

Kytkentä-
sillat

Liitinmoduleissa voidaan määrätyt liittimet ryhmitellä yhteen. Tämä 
voidaan tehdä esimerkiksi liityntäsilloin. 

Liityntäsillat voivat liittää samalla puolella modulia sijaitsevat kaksi 
vierekkäistä liitintä. Liityntäsiltaa voidaan jatkaa seuraaviin liittimiin 
toisella liityntäsillalla. Kaksi siltaa saadaan saman liittimen alle 
kääntämällä ne vastakkaisiin asentoihin. Kuhunkin liittimeen voidaan 
liittää kaksi liityntäsiltaa, yksi silta ja johdin tai yksi suora johdinlanka. 

Liityntäsillat täyttävät määräysten mukaiset 
kosketussuojausvaatimukset. 

Jännite- ja virtaliittimille on omat siltansa (kuva 2-21). 

Kuva 2-21  Liityntäsillat jännite- ja virtaliitynnöille

Liityntäsiltojen tilausnumerot on esitetty laitekohtaisessa käyttöohjeessa 
Liite kappaleessa kohdassa Lisävarusteet. 

Liityntäsilta
jänniteliittimille

Liityntäsilta
virtaliittimille
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SIPROTEC® laitteet
Suojakannet Ruuviliitinmodulien päälle voidaan sijoittaa suojakannet lisäämään 
henkilösuojausta sähköiskuja vastaan, jolloin suojausluokka nousee 
IP1x luokasta IP2x luokkaan. 

Suojakansin saadaan suojattua kaikki jännitteiset osat luotettavasti. 
Suojakannet kiinnitetään paikoilleen helposti napsauttamalla 
liitinmodulien päälle. Ennen suojakansien paikoilleen asettamista tulee 
varmistua että kaikkien liittimien ruuvit on kiristetty. Suojakannet 
saadaan poistettua helposti esimerkiksi 6x1 mm ruuvitaltalla. 

Suojakansia on kahta tyyppiä (kuva 2-22): 

Kuva 2-22  Liitinmodulien suojakannet

Suojakansien tilausnumerot on esitetty laitekohtaisessa käyttöohjeessa 
Liite kappaleessa kohdassa Lisävarusteet. 
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Liitynnät ruuviliittimille - pinta-asennuskotelo
2.7 Liitynnät ruuviliittimille - pinta-asennuskotelo

Liittimet Kaikki liitynnät on tuotu kaksirivisille riviliittimille, jotka sijaitsevat pinta-
asennuskotelon ylä- ja alareunassa.

Liitinten lukumäärä riippuu kotelon koosta:
1/3 kotelossa on 60 liitintä, 
1/2 kotelossa on 100 liitintä ja
1/1 kotelossa on 200 liitintä.

Virtapiirien liittimet oikosulkeutuvat automaattisesti kun laitteen moduli 
vedetään ulos kotelosta. Tästä toiminnasta riippumatta tulee 
toisiovirtapiirejä käsitellä huolellisesti. 

Johtimien 
liittäminen suoraan

Yksisäikeinen johdin tai monisäikeinen varustettuna johdinhylsyllä; 
johdinpoikkipinnoille  0.5 mm2 ... 5 mm2 (AWG 20 ... 10).
Johdotuksissa saa käyttää ainoastaan kuparijohtimia! 

Kuorintapituus Lankajohtimilla 7 ... 8 mm. 

Kiristys-
momentti

Enintään 1.7 Nm. 
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SIPROTEC® laitteet
2.8 Pistokeliittimet 

Pistokeliittimet ovat käytettävissä seuraavilla kotelotyypeillä

uppoasennuskotelossa ja

laitteilla jotka on varustettu erillisellä käyttöpaneelilla

Versioilla joissa on käytetty pistokeliittimiä käytetään niitä vain 
jännitepiirien liitynnöissä. Versiosta riippumatta virtaliitynnöissä 
käytetään aina ruuviliittimiä. 

Liityntämodulit Liityntämoduleja on kahta eri versiota: 

Kuva 2-23  Liityntämodulit pistokeliittimin

Kuvassa 2-24 on esitetty pistokeliittimien sijainnit ja numeroinnit. 

Kuva 2-24  Esimerkki pistokeliittimien sijainnista ja numeroinnista
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Pistokeliittimet
Kosketinryhmät Jokaisessa pistokeliitinryhmässä on erityyppisiä liityntöjä. Ryhmä 
muodostuu kolmesta eri liittimestä seuraavasti: 

Liitin a: signaalikosketin

Liitin b: ryhmäkosketin

Liitin c: paluupiirikosketin

Signaaliliittimet a ovat ainoita liittimiä jotka on liitetty suoraan 
laitemodulin koskettimelle. Liitinmodulista riippuen käytössä on joko 18 
tai 12 signaaliliitintä. 

Ryhmäliittimet b on liitetty yhteen muiden vastaavien liittimien kanssa 
eikä niistä ole yhteyttä laitemodulin liittimille. Ne on jaettu kahteen 
ryhmään jotka eivät ole liitetty toisiinsa. Ryhmää voidaan käyttää 
esimerkiksi ketjutuksiin. Liitinmodulista riippuen käytössä on joko 18 tai 
12 ryhmäliitintä. 

Ryhmäliittimet on liitetty toisiinsa seuraavasti: 

12-napainen liitinmoduli: Ryhmä 1 Liittimet 1 ... 6 
Ryhmä 2 Liittimet 7 ... 12 

18-napainen liitinmoduli: Ryhmä 1 Liittimet 1 ... 9 
Ryhmä 2 Liittimet 10 ... 18 

Paluukoskettimet c  on liitetty toisiinsa sekä laajapinta-alaisesti kotelon 
takalevyyn. Liitinmodulista riippuen käytössä on joko 18 tai 12 
paluukosketinta. 

Kuva 2-25  Liitinmodulien kaaviollinen kytkentä
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SIPROTEC® laitteet
Liityntöjen toteutus Käytettävissä on kosketinnastoin varustettuja liitinrunkoja johdotusten 
toteuttamiseksi. 

Käytettävissä on kahdenlaisia liitinrunkoja kuten kuvassa 2-26 on 
esitetty. 

Versio 1: 2-napainen
Versio 2: 3-napainen

Kuva 2-26  Liitinrungot, 2- ja 3-napainen

Liitinkoteloiden tilausnumerot on esitetty laitekohtaisissa käyttöohjeissa 
Liite kappaleessa kohdassa Lisävarusteet. 

Liitinkotelot on varustettu ohjausurin, jotka estävät niiden liittämisen 
suojaan väärin päin. Lisäksi on varmistettu että version 1 (2-napainen) 
liittimen saa liitettyä vain koskettimeen a ja b. Liitinrungon rakenteella on 
estetty että johdinkotelon liitintä b ei saa kytkettyä laitteen c 
koskettimeen. 

Johdinkotelo lukittuu liitinmoduliin kun se työnnetään paikoilleen. Se on 
vedettävissä irti modulista ilman työkalua. 

Liitinmodulissa käytetään koskettimia jotka on tarkoitettu sallituille 
johdinpoikkipinnoille. Johdotuksessa saa käyttää ainoastaan 
monisäikeisiä johtimia! 

Liitinrungoissa saa käyttää vain johdinpoikkipintoja 0.5 mm2 ... 2.5 mm2, 
jotka vastaavat johdinkokoja AWG 20 ... 14.
Johdotuksessa saa käyttää ainoastaan monisäikeisiä 
kuparijohtimia!

ab abc
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Pistokeliittimet
Seuraavia pistokeliitin tyyppejä voidaan käyttää: 

Siemens suosittelee yksittäisten liitinrunkojen käyttöä 
nauharungon sijaan.

Kun liitin on puristettu johtimeen, työnnetään se liitinrunkoon niin syvälle 
että se lukittuu sinne.

Johtimet voidaan irroittaa liitinrungosta vapauttamalla lukitus 
irroitustyökalulla tyyppi 725840-1, valmistaja Tyco Electronics AMP. 

Irroitustyökalussa on irrallinen vapautuskärki, joka on kuluva osa. Se 
voidaan tilata erikseen. 
Tyyppi 725841-0, valmistaja Tyco Electronics AMP 

Tinatut liittimet

Johdinpoikkipinnat 0.5 mm2 ... 1.0 mm2: 

Pakkauskoko 4000 kappaletta Tyyppi: 0-827039-1, valm. Tyco Electronics AMP

Yksin kappalein Tyyppi: 0-827396-1, valm. Tyco Electronics AMP

Johdinpoikkipinnat 1.0 mm2 ... 2.5 mm2:  

Pakkauskoko 4000 kappaletta Tyyppi: 0-827040-1, valm. Tyco Electronics AMP

Yksin kappalein Tyyppi: 0-827397-1, valm. Tyco Electronics AMP

Johtimet voidaan puristaa liittimiin seuraavin työkaluin:

Puristuspihdit (esimerkki) Tyyppi: 0-734372-1, valm. Tyco Electronics AMP

Puristinleuat Tyyppi: 1-734387-1, valm. Tyco Electronics AMP

Kullatut liittimet (suositellaan käytettäväksi)

Johdinpoikkipinnat 0.75 mm2 ... 1.5 mm2: 

Pakkauskoko 4000 kappaletta Tyyppi: 0-163083-7, valm. Tyco Electronics AMP

Yksin kappalein Tyyppi: 0-163084-2, valm. Tyco Electronics AMP

Johtimet voidaan puristaa liittimiin seuraavin työkaluin:

Puristuspihdit Tyyppi: 0-539635-1, valm. Tyco Electronics AMP

Puristinleuat Tyyppi: 0-539668-2, valm. Tyco Electronics AMP

Ohje:

Johtimet tulee kiinnittää ryhmänä liitinrunkoon nippusiteellä! 
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SIPROTEC® laitteet
2.9 Valokuituliitynnät - uppoasennuskotelo

Käytössä on kolme erityyppistä ST-liittimin varustettua valokuitumodulia. 
Yksittäiset liittimet on suojattu suojatulpin, jotka voidaan poistaa 
kääntämällä niitä 90° vasemmalle. 

Kuva 2-27  Suojatulpin varustetut valokuituliitynnät

Valokuitupäätteet 
ST-liittimin

Normin EN 60825-1 mukainen luokka 1 täyttyy kun käytetään seuraavia 
valokuitujohdin tyyppejä: G50/125 µm ja G62.5/125 µm. 
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Valokuituliitintyyppi: ST-liitin

Kuidun tyyppi: Monimuotokuitu
G50/125 µm,
G62.5/125 µm,
G100/140 µm

Valoaallon pituus: λ = noin 820 nm

Sallittu taivutussäde: Sisäasennusjohdin: rmin = 5 cm
Ulkoasennuskaapeli: rmin = 20 cm
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Valokuituliitynnät - pinta-asennuskotelo
2.10 Valokuituliitynnät - pinta-asennuskotelo

Liitynnät Käytettävissä on 1- ... 4-kanavaiset versiot valokuituliitynnöille. Liittimet 
on varustettu suojatulpin likaantumista vastaan. Suojatulpat voidaan 
irroittaa kääntämällä niitä 90° vastapäivään. 

Modulikoteloon voidaan liittää enintään 2-kanavainen valokuitumoduli. 
Kun käytössä on useampia valokuitukanavia, sijoitetaan kanavat B ja/tai 
C laitekotelon alapuolelle. Jos käytetään enintään neljää 
valokuitukanavaa, sijoitetaan kanavat  D ja E kotelon yläpuolella olevaan 
modulikehikkoon (katso kuva 2-28). Käyttämättömät modulikehikot on 
suljettu suojakannella. Käyttämättömät valokuituliittimet tulee olla 
suojattuna suojatulpin. 

Kuva 2-28  Valokuituliitynnöin varustettu pinta-asennuskotelo sivulta kuvattuna 
(täysin kalustetut valokuituliitynnät)

Valokuituliityntöjen modulikotelo

Valokuituliityntöjen modulikotelo kanaville B ja C

kanaville D ja E
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SIPROTEC® laitteet
Liitinmodulikotelossa on taulukot jotka ilmaisevat kanavien tunnukset 
(kanavat B ... E). Kuvassa 2-29 on kyseessä kanavat B ja C. 

Kuva 2-29  Valokuituliityntöjen modulikotelo (esimerkki: kanavat B ja C 
käytössä) 

Jos laitteessa on sähköinen RS485 väylä PROFIBUS liikennöintiä 
varten, laitteen pohjassa olevassa kanavassa B ei ole valokuituväylää. 
Sen sijaan siinä on D-sub naarasliitin PROFIBUS väylää varten (katso 
kuva 2-30). 

Kuva 2-30  Liitinmodulikotelo varustettuna valokuituliitynnällä ja D-sub 
naarasliittimellä PROFIBUS väylää varten

Kanava B
Kanava D

Kanava C
Kanava E

Kanava B
Kanava D

Kanava C
Kanava E
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Valokuituliitynnät - pinta-asennuskotelo
Seuraavilla liikennöintiväylä protokollilla käytetään D-sub naarasliitintä 
pinta-asennuslaitteella:

PROFIBUS FMS

PROFIBUS DP

DNP 3.0 taso 2

Modbus ASCII/RTU

Tarvittaessa valokuituliityntä voidaan myös näillä kanavilla toteuttaa 
ulkoisella valokuitumuuntimella.

Valokuitupäätteet 
ST-liittimin

Normin EN 60825-1 mukainen luokka 1 täyttyy kun käytetään seuraavia 
valokuitujohdin tyyppejä: G50/125 µm ja G62.5/125 µm. 

Valokuituliitintyyppi: ST-liitin

Kuidun tyyppi: Monimuotokuitu
G50/125 µm,
G62.5/125 µm,
G100/140 µm

Valoaallon pituus: λ = noin 820 nm

Sallittu taivutussäde: Sisäasennusjohdin: rmin = 5 cm
Ulkoasennuskaapeli: rmin = 20 cm
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SIPROTEC® laitteet
2.11 Sähköisten sarjaliikenneväylien liitynnät 

Uppoasennus-
kotelo

Liitynnöissä käytetään 9-napaisia D-sub naarasliittimiä (kuva 2-31). 
D-sub naarasliittimien kytkentä on esitetty laitekohtaisessa 
käyttöohjeessa. 

Kuva 2-31  9-napaiset D-sub naarasliittimet

Pinta-
asennuskotelo

Liitynnöissä käytetään 9-napaisia D-sub naarasliittimiä, jotka on sijoitettu 
erillisiin liitinkoteloihin (kuva 2-32). D-sub naarasliittimien kytkennät on 
esitetty laitekohtaisessa käyttöohjeessa Asennus ja käyttöönotto 
kappaleessa. 

Kuva 2-32  9-napaiset D-sub naarasliittimet erillisissä liitinkoteloissa

P s
lav

e
AM

E
RS

23
2

RS
23

2-F
O

RS
48

5

1
6

5
9

laitteen takana

5
9

1
6

Käyttösarjaliikenneväylä
laitteen edessä

1
6

5
9

Sarjaliikenneväylä

Ajantahdistusväylä
    laitteen takana

 

Kanava B
Kanava D

Kanava C
Kanava E

Kanava B
Kanava D

Kanava C
Kanava E

Muovisuojatulpat
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Sähköisten sarjaliikenneväylien liitynnät
Liityntöjen toteutus Liitynnän toteutuksessa voidaan käyttää yleisesti saatavilla olevia 
9-napaisia D-sub liittimiä normien MIL-C-24308 ja DIN 41652 
mukaisesti.

Liitynnässä käytetty kaapeli valitaan käyttötarkoituksen mukaisesti: 

RS232: 3- tai 5-napainen, suojattu, esim. liityntäkaapeli 7XV5100-4.

RS485: 3-napainen kierretty ja suojattu parikaapeli. 

Profibus: 2- tai 4-napainen kierretty ja suojattu parikaapeli. 
Kaapelityyppi A normien DIN 19245 osa 2 ja EN 50170 osa 2 
mukaisesti, kierretty ja suojattu,
Häiriöimpedanssi: 135 Ω ... 165 Ω (f > 100 kHz),
Ominaiskapasitanssi: < 30 nF/km, 
Silmukkaimpedanssi: < 110 Ω/km,
Johdinhalkaisija: > 0.64 mm, 
Johdinpoikkipinta: > 0.34 mm2,
esim., SINEC L2 kierretty parikaapeli teollisuuskäyttöön
(katso katalogi IK 10 SIMATIC NET, Teollisuuskommunikaatioverkot)
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SIPROTEC® laitteet
2.12 Analogialähtöliitynnät

2.12.1 Uppoasennuskotelo

Liitynnöissä käytetään 9-napaisia D-sub naarasliittimiä (kuva 2-33). 
D-sub naarasliittimien kytkennät on esitetty laitekohtaisessa 
käyttöohjeessa Asennus ja käyttöönotto kappaleessa.

Kuva 2-33  9-napainen DSUB liitin

Liityntöjen toteutus Liitynnän toteutuksessa voidaan käyttää yleisesti saatavilla olevia 
9-napaisia D-sub naarasliittimiä normien MIL-C-24308 ja DIN 41652 
mukaisesti.

Kaapeli: 2-/4-napainen suojattu

Suurin kuormitus 350 Ω

1
6

5
9

A
N

20
20

 m
A

/
33

2R
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Analogialähtöliitynnät
2.12.2 Pinta-asennuskotelo

Liitynnöissä käytetään 9-napaisia D-sub naarasliittimiä, jotka on sijoitettu 
erillisiin liitinkoteloihin (kuva 2-34). D-sub naarasliittimien kytkennät on 
esitetty laitekohtaisessa käyttöohjeessa Asennus ja käyttöönotto 
kappaleessa.

Kuva 2-34  9-napaiset D-sub naarasliittimet erillisissä liitinkoteloissa

Liityntöjen toteutus Liitynnän toteutuksessa voidaan käyttää yleisesti saatavilla olevia 9-
napaisia D-sub liittimiä normien MIL-C-24308 ja DIN 41652 mukaisesti.

Kaapeli: 2-/4-napainen suojattu

Suurin kuormitus 350 Ω

Kanava B
Kanava D

Kanava C
Kanava E

Muovisuojatulpat
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2.13 Piensignaalimuuntimien liitynnät

Mitatut suureet liitetään laitteelle piensignaaliliittimin. Laitteen takana on 
liityntöjä varten värikoodatut pistokeliittimet. 

Käytettävissä on kolme sinistä pistokeliitintä jännitteelle ja neljä punaista 
pistokeliitintä virroille. 

Kuva 2-35  Laiteliittimet

Liitettäessä pistokeliittimiä laitteelle tulee varmistua että esimerkiksi 
punaiset merkit ovat samalla puolen laitteen liitimessä (katso kuva 2-35), 
sillä liitin voidaan kytkeä ainoastaan tässä asennossa.

Käytettäessä näitä pistokeliittimiä tulee laitteen takana olla vähintään 
120 mm vapaata tilaa. Lisätietoja toiminnasta on esitetty laitekohtaisessa 
käyttöohjeessa Tekniset tiedot kappaleessa.

 

Siniset
liittimet

Punaiset
liittimet

Punaiset pisteet
(jännitepiirit)

(virtapiirit)

(kohdistusmerkit)
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Tutustuminen 3
Tässä kappaleessa on kuvattu ensimmäiset vaiheet jotka tulee ottaa 
huomioon käsiteltäessä SIPROTEC® laitteita. 

Lisäksi on kuvattu perusohjaustoimenpiteet SIPROTEC® laitteelle 
käyttöliittymän kautta sekä DIGSI 4 ohjelmiston asennusvaiheet.

Sisältö 3.1  Laitteen pakkaus  58

3.2  Laitteen vastaanottotarkastus  59

3.3  SIPROTEC® 4 laitteen käyttö käyttöpaneelista  61
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3.5  Varastointi  69
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Tutustuminen
3.1 Laitteen pakkaus 

SIPROTEC® laitteet on pakattu tehtaalla normin IEC 60255-21 
määrittelemällä tavalla. 

• Laite tulee purkaa pakkauksestaan ilman liiallista voiman käyttöä ja 
oikeanlaisia työkaluja käyttäen.

• Välittömästi pakkauksen purkamisen jälkeen tulee tarkastaa, että 
laite ei ole mekaanisesti vaurioitunut. 

• Pakkauksessa ja laitteessa olevia lisäohjeita ja huomautuksia tulee 
noudattaa. 

Ohje:

Kuljetuspakkausta voidaan käyttää edelleen laitteen kuljetuksessa. 
Yksittäisten laitteiden varastopakkaus ei sovellu kuljetukseen. 
Jos kuljetuksessa käytetään muuta pakkausta, tulee sen täyttää 
seuraavat normit IEC 60255-21-1 luokka 2 ja IEC 60255-21-2 luokka 1.

Huomio:

Ennen kuin laitteeseen kytketään apujännite ensimmäistä kertaa, sen 
tulee olla käyttöympäristössään vähintään kahden tunnin ajan, jotta 
lämpötilaerot tasaantuisivat ja mahdollinen höyry tai kosteus poistuisi. 
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Laitteen vastaanottotarkastus
3.2 Laitteen vastaanottotarkastus

3.2.1 Nimellisarvojen tarkastaminen

Tilausnumero • Verrataan että tilausnumeron (MLFB) määrittelemät nimellisarvot ja 
toiminnat vastaavat kyseessä olevaa käyttökohdetta. Laitteen 
tilausnumero kokonaisuudessaan on sijoitettu tyyppikilpitarraan, joka 
sijaitsee asennuskotelon päällä. Tilausnumeron ominaisuudet on 
esitetty laitekohtaisessa käyttöohjeessa Liite kappaleessa.
Varmistetaan että laitteen nimellisarvot vastaavat suojattavan 
kojeiston arvoja. Näitä tietoja ovat ennen kaikkea nimellisapujännite 
ja virtamuuntajien toision nimellisvirta, jotka molemmat on kuvattu 
tyyppikilpitarrassa.

• Tarkastetaan lisävarusteet. 

Ohje:

Toimitettaessa binääristen sisääntulojen havahtumistaso on esiaseteltu 
vastaamaan laiteen nimellisapujännitettä. 
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Tutustuminen
3.2.2 Sähköiset tarkastukset

Laitteen ensimmäiselle sähköiselle tarkastukselle riittää, kun laitteelle on 
liitetty luotettava maadoitus sekä apujännite: Tarkastus suoritetaan 
seuraavasti: 

• Liitetään maadoitusliityntä laitteen kotelon suojamaadoitusliittimeen. 
Maadoitusliittimet sijaitsevat kotelon takaosassa laitteen ollessa 
uppoasennuskotelossa. Pinta-asennuskotelossa maadoitusliitin 
sijaitsee riviliittimillä. 

• Liitetään suoja-automaatilla suojattu oikean suuruinen apujännite 
oikeanapaisesti laitteelle. Laitteen liitynnät on esitetty 
laitekohtaisessa käyttöohjeessa Liite kappaleessa. 

• Ohjataan apujännitepiirin suoja-automaatti kiinni. 

Viimeistään 0.5 sekunnin kuluttua apujännitteen kytkemisestä tulee 
vihreän "RUN" ledin syttyä ja punaisen "ERROR" ledin tulee sammua 
viimeistään 10 sekunnin kuluttua. 

Viimeistään 15 s kuluttua apujännitteen kytkemisestä näyttöön tulee 
ilmestyä laitteen tilausnumero kokonaisuudessaan, käytössä oleva 
firmware-versio ja laitteen valmistusnumero. 

Näyttöön tulee perustilanäyttö ja ledit syttyvät mahdollisesti käyttöön 
määriteltyjen toimintojensa mukaisesti. 

Ohje:

Tulee varmistua että käyttöolosuhteet ovat normien VDE0100 ja 
VDE0105 osan 1 mukaisia.

Huomio:

Ennen kuin laitteeseen kytketään apujännite ensimmäistä kertaa, sen 
tulee olla käyttöympäristössään vähintään kahden tunnin ajan, jotta 
lämpötilaerot tasaantuisivat ja mahdollinen höyry tai kosteus poistuisi. 

Varoitus:

Seuraavat tarkastusvaiheet suoritetaan osittain vaarallisten jännitteiden 
alaisuudessa. Edellä mainitut toimenpiteet saa suorittaa ainoastaan 
tehtävään koulutettu henkilökunta, joka tuntee voimassa olevat 
turvallisuusmääräykset ja joka suorittaa työvaiheet myös niitä 
noudattaen. 
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SIPROTEC® 4 laitteen käyttö käyttöpaneelista
3.3 SIPROTEC® 4 laitteen käyttö käyttöpaneelista 

3.3.1 Käyttäjäliittymä

Seuraavissa kappaleissa on kuvattu yleisesti kuinka perustoiminnoissa 
liikutaan laitteen näytöllä. Esimerkkien kuvissa on kukin valikko 
kokonaisuudessaan. Laitteelta voidaan kuitenkin lukea kerrallaan vain 
rajoitettu määrä tekstirivejä. 

3.3.2 Näytön valikkopuussa liikkuminen

SIPROTEC® 4 laitteen käyttöliittymä on hierarkisesti muodostettu 
valikkopuu, jossa voidaan liikkua nuoli-, MENU, ENTER, CTRL ja ESC 
painikkeilla. 

• Kun laite on käyttökunnossa, painetaan ensin MENU painiketta, 
jolloin siirrytään päävalikkoon MAIN MENU. 

• Tämän jälkeen voidaan valikossa liikkua nuoli alas tai nuoli ylös 
painikkeilla halutun alivalikon kohdalle ja siirtyä alivalikkoon nuoli 
oikealle painikkeella.

• Näin liikutaan eteenpäin valikkopuussa kunnes haluttu kohta on 
saavutettu.

• Nuoli vasemmalle painikkeella voidaan siirtyä takaisin ylemmälle 
tasolle.

• Nuoli ylös painikkeella voidaan siirtyä samalla tasolla aiempaan 
valikon kohtaan.

• Takaisin päävalikkoon MAIN MENU voidaan siirtyä suoraan MENU 
painikkeella tai painamalla ESC painiketta useamman kerran 
peräkkäin.
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Tutustuminen
3.3.3 Laitteen tilausnumeron lukeminen

Seuraavassa on kuvattu kuinka laitteen tilausnumero, käytössä oleva 
firmware-versio ja valmistusnumero voidaan lukea: 

• Haetaan näytölle asetteluvalikko Settings ja siirrytään tähän 
alivalikkoon SETTINGS. 

• Tässä alivalikossa siirrytään edelleen Setup/Extras alivalikkoon.  

Kuva 3-1 SETTINGS asettelualivalikko

• Valitaan edelleen valikko MLFB/Version ja siirrytään sinne MLFB/
VERSION. 

Laitteen tiedot on esitetty nyt näytöllä alakkain. Lisärivejä saadaan 
näytölle siirtymällä eteenpäin nuoli alas painikkeella. 

Kuva 3-2 Laitekohtaisten tietojen esitys — esimerkki

MAIN MENU         04/05
--------------------
Annunciation     –> 1

 Measurement    –> 2
Control             –> 3

>Settings            –> 4
 Test/Diagnosis   –> 5

SETTINGS           10/11
--------------------
 Device Config.                 
–>  01
 Masking (I/O)                  
–>  02
 P. System Data1              
–>  03
 Group A                            
–>  04
 Group B                             
–>  05
 Group C                             
–>  06

MLFB/VERSION    01/03
MLFB: SIPROTEC...
3HH0
BF–No.: 0011049704

SETUP/EXTRAS    05/06
--------------------
  Date/Time                     
–>   1
>Clock Setup                 
–>   2
  Serial Ports                   
–>   3

MLFB/VERSION    02/03
Firmware:   V4.xx.xx
Boot system: V1.xx.xx
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SIPROTEC® 4 laitteen käyttö käyttöpaneelista
3.3.4 Käyttömittausarvojen lukeminen

Seuraavassa on kuvattu kuinka käyttömittausarvot voidaan lukea 
laitteelta: 

• Päävalikosta MAIN MENU siirrytään Measurement alivalikkoon. 

• Sieltä valitaan esimerkiksi valikko Operation. sec 
(toisiokäyttömittausarvot) ja siirrytään sinne OPERATION. SEC. 

• Nuolipainikkeilla voidaan siirtyä käyttömittausarvoissa ylös- ja 
alaspäin. 

Jos laitteelle ei ole kytketty vielä mitattavia suureita, esittävät kaikki 
mittausarvot nollaa. Tällöin mahdollisesti näytössä esitetyillä 
mittausarvoilla ei ole merkitystä. 

3.3.5 Käyttötapahtumien lukeminen

Seuraavassa on kuvattu kuinka laitteelta voidaan lukea 
käyttötapahtumat. 

Toimitaan seuraavasti:

• Päävalikossa MAIN MENU siirrytään kohtaan Annunciation ja 
mennään edelleen tuohon alivalikkoon ANNUNCIATION. 

• Sieltä valitaan esimerkiksi käyttöpäiväkirja Event Log ja siirrytään 
sinne EVENT LOG. 

Näytön oikeassa yläreunassa oleva luku ilmaisee kuinka monta 
tapahtumaa on laitteen muistissa. Kenoviivan vasemmanpuoleinen luku 
ilmaisee kuinka mones merkinanto on paraikaa näytöllä. Siirryttäessä 
tähän alivalikkoon näytössä on viimeisin laitteen vastaanottama 
tapahtuma. Merkinannon yläpuolella on ilmaistu sen päivämäärä ja 
kellonaika. 

Kuva 3-3 Käyttöpäiväkirjan kutsu näytölle - esimerkki

• Nuolipainikkeilla voidaan siirtyä käyttöpäiväkirjassa eteen- ja 
taaksepäin. 

• Painetaan LED-kuittauspainiketta. 
Tällöin kaikki ilmaisinledit syttyvät ja LED acknowledgement 
merkinanto esitetään viimeisimpänä tapahtumana 
käyttöpäiväkirjassa ja tapahtumien lukumäärä kasvaa yhdellä. 

MAIN MENU        01/
05
-------------------

ANNUNCIATION    01/
05
---------------------
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Tutustuminen
3.3.6 Näytön kontrastin asettelu

Laitteen käyttöpaneelin nestekidenäytön tehdasasetteluina määriteltyä 
kontrastia voidaan tarvittaessa muuttaa. Kontrastin ollessa 
voimakkaampi, on näyttö helpommin luettavissa laajemmassa 
katselukulmassa. Näytön kontrastia saa muuttaa vain pienin askelin 
yksi tai kaksi tasoa kerrallaan. Jos kontrasti on liian suuri tai liian heikko, 
ei näyttö välttämättä ole enää lukukelpoinen ja laitteen käyttö ei ole enää 
mahdollista. 

Toimitaan seuraavasti:

• Siirrytään asetteluvalikkoon valitsemalla MAIN MENU →  SETTINGS 
→  SETUP/EXTRAS → Contrast

• Painetaan ENTER painiketta. Tällöin näyttöön tulee voimassa oleva 
asetteluarvo vilkkuvalla kursorilla varustettuna. 

• Syötetään uusi kontrastiarvo numeropainikkeistolta. Syöttämällä 
korkeampi arvo vahvistetaan kontrastia ja samalla näyttö tummuu. 

• Muutos hyväksytään käyttöön painamalla ENTER painiketta. 

Kuva 3-4 Näytön kontrastin asettelu

ENTER SETUP/EX       06/06
--------------------
 MLFB/Ve    n  –>  5
 Contrast     –>  6

22

SETUP/EXTRAS    06/06
--------------------
 Date / Time  –> 1
Clock Setup  –> 2
 Serial Ports  –> 3
 Device ID    –> 4
 MLFB/Version  –> 5
>Contrast      –> 6
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DIGSI 4 ohjelmiston asennus / poistaminen / käynnistys
3.4 DIGSI 4 ohjelmiston asennus / poistaminen / käynnistys

Käyttöjärjestelmä Microsoft Windows 

PC Hardware Prosessori: Pentium ≥ 133 MHz, suositeltu 400 MHz

RAM: 64 Mtavua, suositeltu 128 Mtavua

Kovalevy: 300 Mtavua vapaata tilaa

CD-ROM asema

1 sarjaliikenneväylä

3.4.1 DIGSI 4 ohjelmiston asennus

Asennus suoritetaan seuraavasti:

• Ennen asennuksen aloitusta tulee kaikkien muiden sovellutusten 
olla suljettuina, jotta DIGSI 4 ohjelmiston asennuksessa vaadittavat 
määritteet olisivat kirjautuneina käyttöjärjestelmän kirjastoihin. 

• Sijoitetaan asennus CD tietokoneen CD-asemaan. Asennusikkuna 
aukeaa yleensä automaattisesti näytölle.

• Painetaan DIGSI 4.xx painiketta.

• Noudatetaan asennusohjeita. 

• Valitaan jompi kumpi asennusvaihtoehdoista:

− Full installation jolloin ohjelma asentautuu kokonaisuudessaan

− Partial installation jolloin käyttäjä voi valita haluamansa 
asennettavat kokonaisuudet tai laiteajurit

• Syötetään rekisteröintikortista löytyvä sarjanumero serial number  
kenttään.  

• Asennuksen jälkeen käynnistetään Windows käyttöjärjestelmä 
uudelleen ennen DIGSI 4 ohjelmiston käyttöä.

Ohje:

Käytössä tulee olla Microsoft Windows administraattorioikeudet 
ohjelmistoa asennettaessa. 
On suositeltavaa lukea  README.TXT tiedosto, joka löytyy DIGSI 4 
asennus-CD:ltä, ennen asennuksen suoritusta.

Jos koneessa on jo vanhempi DIGSI 4 ohjelmistoversio asennettuna, 
tulee se ensin poistaa (katso kappale 3.4.2). 
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Tutustuminen
Asennustoiminnan 
käsin käynnistys

Jos asennusikkuna ei aukea automaattisesti, toimitaan seuraavasti:

• Painetaan Windows Start (käynnistä) painiketta ja sieltä edelleen 
Run... (suorita) toimintoa.

• Syötetään x:\Digsi_4\Setup.exe syöttökenttään
(x kirjain korvataan CD-ROM aseman tunnuksella).

• Painetaan OK painiketta.

• Noudatetaan ohjelmiston määräämiä asennusohjeita (katso yllä)

Lisätoiminnat /
laiteajurit

Optiona määriteltävissä olevat lisätoiminnat voidaan asentaa 
tarvittaessa myöhemmin. Tällöin toimitaan seuraavasti:

• Sijoitetaan asennus-CD tietokoneen asemaan ja valitaan osittainen 
asennus Partial installation, josta edelleen valitaan halutut 
asenettavat toiminnat tai laiteajurit.

• Syötetään rekisteröintikortista löytyvä sarjanumero serial number  
kenttään.  

• Asennuksen jälkeen käynnistetään Windows käyttöjärjestelmä 
uudelleen ennen DIGSI 4 ohjelmiston käyttöä.

Ohje:

Jos DIGSI® 4 ohjelmistoa halutaan käyttää SICAM SAS 
parametrointiympäristön kanssa ja SICAM SAS ohjelmisto halutaan 
asentaa, tulee toimia seuraavasti:

• Poistetaan DIGSI 4 ohjelmisto

• Asennetaan SICAM plusTOOLS ohjelmisto

• Asennetaan DIGSI 4 ohjelmisto uudelleen

Jos DIGSI 4 ohjelmistoa ei jostain syystä poistettu, voidaan DIGSI 4 
ohjelmisto asentaa uudestaan kun SICAM plusTOOLS ohjelmisto on 
asennettu. On kuitenkin suositeltavaa noudattaa yllä kuvattua 
suoritusjärjestystä.

Ohje:

DIGSI 4 asennuspaketin mukana tuleviin lisäohjeisiin tulee tutustua.
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DIGSI 4 ohjelmiston asennus / poistaminen / käynnistys
3.4.2 DIGSI 4 ohjelmiston poistaminen tietokoneelta

Ohjelmistot poistetaan tietokoneelta Microsoft Windows 
käyttöjärjestelmän määrittelemällä menetelmällä:

• Siirrytään Start → Settings → Control Panel → Software polkua 
pitkin  Software Properties ikkunaan.

• Valitaan DIGSI 4 ja painetaan remove (poisto) painiketta. 
Toistetaan tämä sama muille DIGSI komponenteille (esim. DIGSI 4 
Devices).

Dynaamisesti muodostetut tiedostot voivat jäädä tietokoneen kovalevylle 
kun ohjelmisto on poistettu. Tämä ilmaistaan yleensä ohjelmistoa 
poistettaessa seuraavalla merkinannolla: Some elements could not be 
removed. You should manually remove items related to the 
application. Dynaamisesti muodostettuja tiedostoja ei välttämättä 
tarvitse poistaa.

3.4.3 DIGSI 4 ohjelmiston käynnistäminen

• Valitaan Start → Programs → DIGSI 4 → DIGSI 4,

jolloin DIGSI® 4 Manager käynnistyy.

Huomio:

Tietokone tulee käynnistää uudelleen ohjelmiston poistamisen jälkeen.

Ohje:

Optiona asennettuja toimintoja ei voi poistaa yksittäin.
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Tutustuminen
3.4.4 DIGSI 4 ohjelmiston käyttö

Seuraavissa kappaleissa on kuvattu DIGSI 4 ohjelmiston käyttö. Käyttö 
muodostuu seuraavista osista

Projektien ja laitteiden hallinta (Kappale 4)

Järjestelmän konfigurointi ja parametrointi (Kappale 5)

Ohjaustoimenpiteet (Kappale 6)

SIPROTEC laitteen kommunikointi DIGSI 4 ohjelmiston tai 
ylemmän tason ohjausjärjestelmän kanssa (Kappale 7)

Ohje:

Käyttöohjeessa SIPROTEC DIGSI 4, Start Up /1/ on kuvattu DIGSI 4 
toiminnat yksityiskohtaisesti. Tässä käyttöohjeessa on kuvattu 
käytännöllisin esimerkein kuinka projekti luodaan, laiteparametrit 
asetellaan, CFC logiikka tehdään, näytöt piirretään, laitteen kanssa 
kommunikoidaan online-tilassa ja häiriötallenteiden käsittely suoritetaan.
68 SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Varastointi
3.5 Varastointi 

Jos laitetta ei oteta käyttöön välittömästi, voidaan se varastoida 
seuraavissa olosuhteissa: 

SIPROTEC®-laitteet ja niiden varusteet voidaan varastoida kuivassa 
ja puhtaassa tilassa, jossa lämpötila on alueella –25 °C ... +55 °C (-
12 °F ... +130 °F).
Lisätietoja toiminnasta on esitetty laitekohtaisessa käyttöohjeessa 
Tekniset tiedot kappaleessa. 

On suositeltavaa, että varastointi suoritetaan ympäristön lämpötilassa 
+10 °C ... +35 °C (+50°F ... +95 F), jolloin apujänniteen syöttöpiireissä 
käytettyjen elektrolyyttikondensaattoreiden vanheneminen on 
vähäistä. 

Suhteellisen kosteuden tulee olla alueella, jossa kondenssiveden ja 
siitä edelleen mahdollisesti aiheutuvaa jään muodostusta ei voi 
esiintyä. 

Ennen kuin laitteeseen kytketään ensimmäistä kertaa apujännite, 
tulee sen olla vähintään kaksi tuntia käyttöympäristössään. Tämä 
siksi, että lämpötilaerot tasaantuisivat ja tästä aiheutuva kosteus ja 
veden kondensoituminen olisi ehtinyt poistua.

Laitteen tulisi olla kytkettynä apujännitteeseen 1 ... 2 päivää ennen 
käyttöönottoa. Vaikeissa ympäristön olosuhteissa (tropiikki) 
saavutetaan tällä myös esilämmitys, jolloin mahdollinen 
kondensoitumisesta aiheutunut kosteus poistuu laitteesta. 

Edellisen lisäksi tulee pitkäaikaisessa varastoinnissa kytkeä laite 
apujännitteeseen kahden vuoden välein 1 ... 2 päivän ajaksi, jotta 
apujännitteen syöttömodulissa olevat elektrolyyttikondensaattorit 
palautuisivat. 
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Projektien ja laitteiden hallinta 4
Tässä kappaleessa on kuvattu kuinka projektien järjestelmätiedot 
voidaan organisoida, laitteet asetella ja laitetietoja hallita. Lisäksi on 
kerrottu kuinka tiedot voidaan suojata salasanoin ja käyttökielet valita 
laitteille ja tietokoneohjelmalle. 

Sisältö 4.1  Yleistä  72

4.2  Projektit  74

4.3  Laitteet  101

4.4  Asetteluarvot  117

4.5  Käyttökieli  124

4.6  Salasanat  128

4.7  Tietojen vienti / tuonti  134

4.8  SIPROTEC 4 laitetyyppien päivittäminen  144
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Projektien ja laitteiden hallinta
4.1 Yleistä 

DIGSI® 4 ohjelmistoa käytetään  SIPROTEC® laitteiden asetteluun ja 
käyttöön. DIGSI® 4 ohjelmistossa toiminnat on jaettu 
ohjelmistokomponentteihin, jotka on kuvattu alla lyhyesti.

DIGSI 4 Manager DIGSI 4 Managerilla hallinnoidaan SIPROTEC laitetiedostoja ja 
kommunikointiominaisuuksia.

Jos käytössä on myös SIMATIC STEP7 automaatio-ohjelmistoympäristö 
tai SIPROTEC laitteita käytetään SICAM ohjausjärjestelmissä, voidaan 
DIGSI 4 ohjelmistoa käyttää osana ohjausjärjestelmäkokonaisuutta. 
Tarvittaessa tietoja voidaan vaihtaa eri järjestelmien kesken sen ollessa 
mahdollista yhtenevien tiedostorakenteiden ansiosta. Tietojen hallinta 
kenttätasolla ja asematasolla on toteutettu käyttäjäystävällisesti.     

DIGSI 4
Device 
Configuration

DIGSI 4 Device Configuration toimintaa käytetään uusien laitteiden 
liittämisessä projektiin, jolloin määritellään laitteen toiminnallisuus, 
informaatioiden määrittely, asetteluarvojen hallinta ja liikennöintiväylien 
määrittely.

Kun DIGSI 4 ohjelmiston ja laitteen välille on muodostettu yhteys, ovat 
laitteelle tallentuneet prosessitiedot kuten merkinannot ja mittausarvot 
esitettävissä tietokoneella, sekä testaustoimintojen käynnistykset ja 
kytkinlaitteiden ohjaukset ovat mahdollisia.

Lisäksi laiteparametrien vertailu, tallennus, vienti ja tulostus on 
mahdollista.

Laitteiden määrittelytoiminnat on kuvattu kappaleessa 5. Laitteen eri 
toimintatilat on kuvattu kappaleessa 6.

DIGSI 4
Display Editor

DIGSI 4 Display Editor työkalulla voidaan piirtää ja hallita graafisella 
näytöllä varustettujen SIPROTEC 4 laitteiden perus- ja ohjausnäyttöjä.

Perusnäytöllä esitetään laitteeseen liitetyn kentän kytkinlaitteen 
asentotiedot, mittausarvot, suojaus- ja yleistietoa kentän tilasta. 
Ohjausnäytöllä voidaan esittää samat tiedot kuin perusnäytölläkin, 
mutta sen lisäksi siinä voidaan ohjata kytkinlaitteita ja esittää lisätietoja, 
jotka ovat mahdollisesti tarpeen ohjauksia suoritettaessa.

Kytkinlaitteet esitetään symboleina, jolloin voidaan käyttää ohjelmiston 
mukana toimitettuja valmiita symboleja tai käyttäjä voi luoda haluamansa 
symbolikirjaston käyttötarpeen mukaisesti.

Valikkoikkunoilla muodostetaan yhteys näytön kytkinlaitesymbolin ja 
DIGSI 4  konfiguraatiomatriisin välille. 
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Yleistä
DIGSI 4 CFC DIGSI 4 CFC ohjelmistossa on käytettävissä erityyppisiä loogisia 
funktiomoduleita, joilla voidaan muodostaa käyttökohteen vaatimia 
toimintoja, kuten

Lisäehtoja ohjaustoiminnoille
(esimerkiksi muiden erottimien kytkinasennot ja "jousi vireessä" tieto)

Käyttäjän määrittelemät ryhmämerkinannot
(esimerkiksi yksittäiset merkinannot voidaan liittää yhteen AND, OR, 
NOT moduleilla)

Uuden dynaamisen symbolin esitys näytöllä (eri tilat määritelty CFC 
logiikalla)

Asetteluryhmien automaattinen vaihto
(esimerkiksi kun kaikki vaihevirrat laskevat valvontarajan alapuolelle)

Vilkkuva hälytysledi jos ohjausoikeus avainkytkin on käännetty 
"PAIKALLIS" asentoon

Sellaisen suojaustoiminnan muodostus, jota ei ole laitteella 
käytettävissä
(esimerkiksi "Takatehosuoja" tai "Hyötysuhdevalvonta")

Kytkentäsekvenssin toteutus funktiopainikkeelta (esimerkiksi lähdön 
maadoittaminen)

Vaiheittain tapahtuva kuormien pudotus
(pudotettavien lähtöjen määritys CFC-logiikalla)

DIGSI 4 Remote DIGSI 4 Remote optiopaketti mahdollistaa kommunikoinnin 
SIPROTEC® laitteiden kanssa modeemiyhteydellä.

SIGRA 4 SIGRA 4 ohjelmistolla on mahdollista analysoida verkkohäiriöistä 
tallennettuja häiriötallenteita. Siinä käsitellään häiriötapahtumaa 
graafisessa muodossa. Mitatuista suureista ohjelmisto laskee 
lisäsuureita, kuten impedanssit tai tehollisarvot, jotka helpottavat 
häiriötallenteen analysointia. Suureet voidaan esittää ajanfunktiona, 
vektorikaavioina, impedanssikaaviona ja harmoonisina yliaaltoina.

Lisäksi häiriötallenteeseen voidaan liittää toisia tallenteita, esimerkiksi 
johdon vastapäästä. 

SIGRA ohjelmistolla voidaan käsitellä myös muiden valmistajien 
laitteiden tallentamia häiriöitä. 

Ohje:

Liitteessä A.1 on esitetty yleisiä tietoja DIGSI 4 ohjelmiston käytöstä. 
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Projektien ja laitteiden hallinta
4.2 Projektit

DIGSI 4 Manager toiminnalla voidaan

Luoda projekti,

Määritellä projektille rakenne (sähköaseman topologia),

Lisätä objekteja projektirakenteeseen ja sijoittaa ne topologiaan 
hierarkisesti,

Editoida projektirakenteita kopioimalla, siirtämällä ja poistamalla 
objekteja,

Arkistoida, uudelleen organisoida tai poistaa projekteja.

4.2.1 Projektin rakenne

Projekti DIGSI® 4 ohjelmistolla voidaan muodostaa projektille hierarkinen 
rakenne. Kukin hierarkinen taso on sijoitettu hakemistoon jossa voi 
edelleen olla alemman tason hakemistoja. 

DIGSIMAN001

Kuva 4-1  Projektin hierarkinen rakenne, esimerkki

Projekti muodostuu hakemistotasoista, laitteista ja lisätiedoista. 

Objekti Projektirakenteen jokainen elementti on objekti. 

DIGSIMAN002

Kuva 4-2  Projektin objekteja, esimerkki

Käytettävissä olevat objektityypit riippuvat määrätyistä ehdoista. 
Esimerkiksi Puhelinluettelo, Modeemit ja Modeemiliitynnät ovat 
käytettävissä vain jos  DIGSI 4 Remote ohjelmisto on asennettu. 
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Projektit
Hakemisto Jos objekti sisältää muita objekteja, kutsutaan sitä hakemistoksi.

4.2.2 Objektit projektirakenteessa

Objekteilla on ominaisuuksia, jotka voidaan sijoittaa 
projektirakenteeseen määrätyin ehdoin ja riippuen objektin tyypistä niillä 
voi olla myös sisältö.

Objektit esitetään ikoneina ja niillä on myös nimi kun DIGSI 4 Manager 
ohjelmistossa näyttötavaksi on määritelty puu- tai luettelonäyttö.

Objektityypit Puuhakemistonäytössä projektissa on automaattisesti neljä objektia kun 
uusi projekti on luotu. 

Projekti
Tämä objektityyppi esittää uuden projektin nimeä. Sitä ei voida liittää 
käsin. Se sijoitetaan automaattisesti hierarkiatason alkuun eikä sitä 
voi siirtää.

Hakemisto
Tällä objektityypillä voidaan projektirakenne jakaa useammalle 
tasolle. Hierarkisesti voidaan liittää enintään yhdeksän hakemistoa 
alakkain.

Puhelinluettelo
Tämä objektityyppi luodaan automaattisesti vain jos DIGSI 4 Remote 
ohjelmisto on asennettu tietokoneelle. Sillä voidaan luoda 
modeemikommunikaatioyhteys SIPROTEC laitteelle ja tallentaa 
käyttäjän modeemiyhteyksien osoitteet ja puhelinnumerot. 

Modeemit
Tämä objektityyppi luodaan automaattisesti vain jos DIGSI 4 Remote 
ohjelmisto on asennettu tietokoneelle. Sen avulla voidaan muodostaa 
modeemikommunikaatioyhteys SIPROTEC 4 laitteelle ja tallentaa 
tarvittavat modeemiasettelut.

Ohje:

Tulee varmistua että alasvetovalikossa ei ole määritelty suodatusta 
käyttöön (<No filter>). Muussa tapauksessa kaikkia objekteja ei 
mahdollisesti esitetä jos ne määritelty piilotettavaksi.
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Seuraavat objektityypit voidaan sijoittaa käsin hakemiston alle:

SIPROTEC device
SIPROTEC device objektityyppi muodostaa todellisen SIPROTEC 
laiteobjektin kaikkine tarvittavine asetteluineen ja prosessitietoineen. 

SIPROTEC variant
Tämä objektityyppi muodostaa kopion todellisesta SIPROTEC 
laitteesta. Tämän objektityypin sisältämät laitetiedot voivat poiketa 
alkuperäisestä. SIPROTEC variant objektityyppiä voidaan käyttää 
esimerkiksi  SIPROTEC laitteiden parametrointiprosessin eri 
vaiheissa.

Modem connection
Modeemiliitynnät objektityyppi voidaan luoda vain jos DIGSI 4 
Remote on asennettu tietokoneelle. Sen avulla voidaan muodostaa 
modeemiyhteys tietokoneen ja SIPROTEC laitteiden välille ja se 
sisältää tiedot niin tietokoneen pään kuin vasta-aseman 
modeemeistakin. 
Modeemiliityntä objektin alle ei voida enää liittää muita objekteja.
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4.2.3 Projektin luonti

Kaikki tarvitut tiedot on tallennettu projektin sisälle ja ne esitetään 
hierarkisena rakenteena.

Projekti luodaan seuraavasti:

• Valitaan File → New, projektin luontia varten.

DIGSIMAN003

Kuva 4-3  Uusi projekti

• Syötetään projektin nimi Name kenttään. 

• Valitaan hakemistopuu uuden projektin tallennusta varten. 
Ohjelma tarjoaa esivalitun hakemistopuun Storage location (path) 
kentässä (katso kappale 4.2.5). 
Jos projektia ei haluta tallentaa tähän hakemistoon, voidaan uusi 
hakemistopolku syöttää kenttään tai valita haluttu vaikka Browse 
painikkeella.

• Valitut määrittelyt hyväksytään OK painikkeella.

Ohje:

Muut toiminnat, kuten esimerkiksi kirjaston luonti (library), on mahdollista 
vain jos STEP 7 ohjelmisto on asennettu kokonaisuudessaan 
tietokoneelle.
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4.2.4 Projektin objektien käsittely

Objektin 
lisääminen

Seuraavaksi on kuvattu kuinka hakemisto Folder, puhelinluettelo Phone 
Book ja modeemi Modems voidaan liittää käsin:

• Valitaan projektista  haluttu hierarkinen taso johon esimerkiksi uusi 
hakemisto-objekti halutaan liittää ja valitaan objekti 
valintaluetteloikkunasta (Folder, Phone Book, Modems tai Modem 
Connection).

• Syötetään uudelle hakemisto-objektille nimi.

SIPROTEC devices eli laitteet voidaan liittää projektirakenteeseen 
Drag&Drop menetelmällä laiteluettelosta device catalog (katso kappale 
4.3.1).

SIPROTEC variant objektityyppi luodaan seuraavasti:

Muodostetaan variantti olemassa olevasta SIPROTEC device 
objektista 

Tuomalla objekti projektiin ulkoisesta tiedostosta

Muodostamalla yhteys SIPROTEC 4 laitteelle "plug-and-play" 
menetelmällä

Objektin 
avaaminen

Objekti voidaan avata seuraavasti:

• Klikataan oikealla hiiripainikkella objektin nimeä ja valitaan toiminta 
Open Object valikosta

tai

• Kun objektin nimi on valittu, aktivoidaan valikosta Edit → Open 
Object.

tai

• Kaksoisklikataan objektin nimeä vasemmalla hiiripainikkeella.

Huomio:

Phone Book ja Modems objektit voidaan liittää suoraan projektin 
ylimmälle tasolle. Jos Phone Book tai Modems objektit ovat jo 
olemassa, poistetaan ne automaattisesti jos projektiin luodaan uusi 
objekti samaa tyyppiä. Kaikki näissä objekteissa olleet tiedot häviävät! 
Joka tapauksessa tapahtumasta esitetään varoitusikkuna ennen uuden 
objektin hyväksyntää.
78 SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/
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Objektin
ominaisuudet

Jokaisella objektilla on ominaisuuksia. Nämä voivat olla yleisiä 
ominaisuuksia, jotka ovat tyypillisiä määrätyille objekteille tai määrättyjä 
ominaisuuksia, esimerkiksi tilausnumero (MLFB).

Objektin ominaisuudet voidaan aktivoida näytölle seuraavasti:

• Valitaan objekti, klikataan oikealla hiiripainikkeella avautuneesta 
valikosta Object Properties toimintaa, jolloin esimerkiksi Properties 
- SIPROTEC Device ikkuna avautuu näytölle.   

DIGSIMAN048

Kuva 4-4  SIPROTEC 4 laitteen ominaisuudet, MLFB ikkuna, esimerkki 

Valkoisella taustalla esitettyjen ikkunoiden arvoja voidaan muuttaa tai 
valita alasvetovalikoista. Harmaalla taustalla esitettyjen laatikoiden 
tietoja ei voi muuttaa suoraan. Esimerkiksi SIPROTEC 4 laitteen MLFB 
numeroa voidaan muuttaa vain offline-tilassa. 

Projektirakenteen 
muuttaminen

Editointikäskyjä kopioi Copy, leikkaa Cut, liitä Paste ja poista Delete 
voidaan käyttää projektin rakenteen muuttamisessa. Niitä käytetään 
kopiointiin, siirtoon tai objektien poistamiseen. 

Toiminta vaikuttaa yleensä kaikkiin objektin alle sijoitettuihin objekteihin. 
Jos esimerkiksi poistetaan hakemisto-objekti Folder, poistuvat myös 
kaikki sen alle sijoitetut objektit. 

Objekteja voidaan kopioida ja siirtää projektien välillä.
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Objektien kopiointi Objekti voidaan kopioida seuraavasti:

• Valitaan objekti, klikataan oikealla hiiripainikkeella ja valitaan 
valikosta Copy, valitaan kohdeobjekti ja klikataan uudelleen oikealla 
hiiripainikkeella ja valitaan Paste. 

tai

• Valitaan objekti ja klikataan vasemmalla hiiripainikkeella työkalurivillä 
Copy ikonia. Valitaan uusi objekti ja klikataan vasemmalla 
hiiripainikkeella työkalurivillä Paste ikonia.

tai

• Valitaan objekti, siirretään sitä Drag & Drop menetelmällä vasen 
hiiripainike alaspainettuna kohdeobjektin päälle ja vapautetaan 
hiiripainike.

Objektien 
siirtäminen

Objekti voidaan siirtää seuraavasti:

• Valitaan objekti, klikataan sitä oikealla hiiripainikkeella ja valitaan 
valikosta Cut, valitaan kohdeobjekti ja klikataan uudelleen oikealla 
hiiripainikkeella ja valitaan Paste toiminta. 

tai

• Valitaan objekti ja klikataan vasemmalla hiiripainikkeella työkalurivillä 
Cut ikonia. Valitaan kohdeobjekti ja klikataan vasemmalla 
hiiripainikkeella työkalurivillä Paste ikonia.

tai

• Valitaan objekti, siirretään sitä Drag & Drop menetelmällä vasen hiiri- 
ja SHIFT-painike alaspainettuna kohdeobjektin päälle ja vapautetaan 
painikkeet. 

Objektien 
poistaminen

Objekti voidaan poistaa seuraavasti:

• Valitaan objekti ja klikataan sitä oikealla hiiripainikkeella ja valitaan 
Delete toiminta ja seuraavaksi vahvistetaan poistaminen 
hyväksymällä se Yes painikkeella. 

Ohje:

Kun SIPROTEC 4 laite on kopioitu tai siirretty 

VD osoite määritellään uudelleen automaattisesti.

IEC osoite poistetaan. Se tulee asetella uudelleen käsin.

Lisätietoja VD ja IEC osoitteista on esitetty kappaleessa 7.
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4.2.5 Projektin tallennushakemistopuun määrittely ja muuttaminen

Kun uusi projekti luodaan, DIGSI® 4 ohjelmisto ehdottaa esivalintana 
tallennushakemistopolun projektille. Se voidaan muuttaa seuraavasti: 

• Valitaan Options → Settings ja avataan Customize toiminta. 
Syötetään uusi polku General sivulla (kaikkien määriteltyjen 
hakemistojen tulee olla olemassa) tai valitaan haluttu 
tallennushakemisto Browse painikkeella.

• Valitut määrittelyt hyväksytään OK painikkeella.

DIGSIMAN026

Kuva 4-5  Oletustietojen määrittely
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4.2.6 Projektin avaaminen ja sulkeminen

Avaaminen 
ohjelmiston 
käynnistyessä

Tulee toimia seuraavasti jos halutaan että kaikki edellisessä istunnossa 
auki olleet projektit avautuvat automaattisesti kun DIGSI® 4 ohjelmisto 
avataan:

• Valitaan Options → Settings ja valitaan toiminta Save window 
arrangement and contents at end of session, Customize 
valikossa, General sivulla. 

• Valitut määrittelyt hyväksytään OK painikkeella.

Viimeksi editoidun 
projektin 
avaaminen

Neljän viimeksi editoidun projektin nimet ja tallennuspolut ovat 
päivittyneinä automaattisesti DIGSI® 4 ohjelmiston File valikkoon. 

• Valitaan projekti joka halutaan avata. 

Muiden projektien 
avaaminen

Tulee toimia seuraavasti jos halutaan valita jokin projekti, joka ei ole 
viimeksi käsiteltyjen projektien luettelossa:

• Valitaan File → Open ja valitaan haluttu projekti Open ikkunassa, 
User projects sivulta. 

• Valitaan kaikkien projektien nimet jotka halutaan avata. Valitut 
määrittelyt hyväksytään OK painikkeella. 

Tämän jälkeen jokainen avattu projekti avautuu omaan ikkunaansa.

DIGSIMAN029

Kuva 4-6  Projektin avaaminen

• Valitaan muu hakemistopolku Browse painikkeella, jos projektia ei 
ole esitetty projektiluettelossa.
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Projektin 
sulkeminen

• Klikataan jotakin kohtaa projekti-ikkunasta, jolloin se aktivoituu ja 
valitaan File → Close. 
Projekti on nyt suljettu.

• Valitaan Window → Close All jos kaikki auki olevat projektit 
halutaan sulkea.

4.2.7 Projekti-ikkunoiden järjestely

Projekti-ikkunassa esitetään kaikki projektin objektit ja niiden 
rakenteelliset riippuvuudet. 

Projekti-ikkuna luodaan automaattisesti projektia avattaessa tai käsin 
menu-valikosta. Yhdessä projektissa auki olevien ikkunoiden määrää 
ei ole rajoitettu DIGSI 4 Manager ohjelmassa.

Ikkunan sijaintia ja kokoa voidaan muuttaa.

Eri projekteja voi olla auki yhtäaikaa useampia ja ne voidaan esittää 
eri ikkunoissa, jotka on järjesteltävissä näytölle usealla eri tavalla.

Projekti-ikkunoiden 
järjestely

Drag-and-drop toimintaa varten on käytännöllistä käsitellä projektia 
kahdessa ikkunassa. 

Sijoitetaan projekti-ikkuna näytölle valitsemalla Arrange → Vertically tai 
Arrange → Horizontally. Tällöin ikkunat järjestyvät näytölle siten että 
ne täyttävät koko kuva-alan.

Ikkunoiden limittäminen on myös mahdollista. Minimoituja ikkunoita ei 
oteta huomioon.

Ikkunajärjestely voidaan tallentaa ja kutsua uudelleen käyttöön. Käsin 
tallennettu järjestely ohitetaan DIGSI® 4 Settings valikon esiasettelulla.

Projekti-ikkunoiden 
pienentäminen

• Kaikki auki olevat projekti-ikkunat voidaan pienentään ikonikokoon 
valitsemalla Window → Minimize All. Yksittäiset ikonit on sijoitettu 
riviin näytön alalaitaan. 
Jos järjestystä on muutettu, voidaan se paluttaa valitsemalla
Window → Arrange Icons.

Ohje:

• Jos projektiin halutaan avata uusi ikkuna, valitaan Window → 
New Window. 
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Projekti-ikkuna
näkymä

View valikosta voidaan määritellä mitä tietoja projekti-ikkunassa 
esitetään. Valittavissa on joko suuri tai pieni ikoni tai luettelonäyttö tai 
näyttö ilman tietoja. Nämä vaihtoehdot valitaan Windows 
käyttöjärjestelmän toimintoja hyödyntäen.

Toimitaan seuraavasti kun näytöllä esitettyjen tietosarakkeiden 
lukumäärää halutaan muuttaa:

• Valitaan Options → Settings josta edelleen avataan
Customize ikkuna. Avataan Columns sivu.

DIGSIMAN095

Kuva 4-7  Tietosarakkeiden valinta

• Object Types ikkunassa valitaan minkä objektin ominaisuuksia 
halutaan muuttaa. Library ikkuna on käytettävissä vain SIMATIC 
Manager ohjelmiston yhteydessä. 

• Visible columns ikkunassa valitaan ne sarakkeet jotka objektin 
yhteydessä halutaan esittää.

• Objektisarakkeiden järjestys projekti-ikkunassa voidaan muuttaa. 
Valittu sarake voidaan siirtää ylös- tai alaspäin nuolipainikkeita 
klikkaamalla Visible columns ikkunan oikealta puolelta.

• Suljetaan Customize määrittelyikkuna OK painikkeella. 
Tehdyt muutokset näkyvät välittömästi projekti-ikkunassa.
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Objektityyppien 
suodatus

Suodattimien avulla voidaan estää määrättyjen objektityyppien 
näkyminen ikkunassa. Suodatukset voidaan määritellä käyttäjän 
toimesta ja ne ovat käytettävissä kaikissa projekteissa.

• Valitaan View → Filter.

Jos suodatus on jo määritelty, aukeaa näyttöön Filter ikkuna. 

DIGSIMAN097

Kuva 4-8  Suodatusikkuna (supistettu näyttö)

• Painetaan Expanded painiketta Filter ikkunan avaamiseksi. Jos 
suodatinta ei ole aiemmin määritelty, avautuu valinta-ikkuna suoraan.

DIGSIMAN096

Kuva 4-9  Suodatusikkuna (laajennettu näyttö)
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Suodattimen 
luominen

• Painetaan New uuden suodattimen luomiseksi. Syötetään uudelle 
suodattimelle nimi Filter name alasvetovalikkokenttään ja valitaan 
suodattimelle voimassaoloalue Area of application ruudussa.   

Kaikkien objektityyppien nimet jotka voivat liittyä "Area of application" 
kentässä valittuun objektiin on esitetty Displayed objects ikkunassa. 

• Tässä ikkunassa valitaan valintaruutu aktivoimalla kaikki objektityypit, 
jotka halutaan esittää. Project ja Folder hakemistoja ei voi piilottaa. 

• Painetaan OK painiketta.

Suodattimen 
muuttaminen tai 
poistaminen

• Olemassa olevaa suodatinta voidaan muuttaa tai se voidaan poistaa 
valitsemalla halutun suodattimen nimi filter name alasvetovalikosta 
ja tämän jälkeen valitsemalla joko Edit tai Delete. 

Suodattimen 
valinta

Projektialueelle Project ja hakemistoalueelle Folder voidaan kullekin 
valita yksi suodatin käyttöön. 

• Valitaan Project jos suodatin halutaan aktivoida projektialueelle. 

• Valitaan Folder jos suodatin halutaan aktivoida hakemistoalueelle.

• Valitaan suodattimen nimi työkalurivin alasvetovalikosta. 

Vain niiden suodattimien nimet ovat valittavissa, jotka on luotu kyseessä 
olevalle toiminta-alueelle. 

• Valitaan <No Filter> jos halutaan esittää kaikki olemassa olevat 
objektit.

Ohje:

Suodattimet eivät ole projektikohtaisia, vaan ne ovat yhteisiä kaikille 
projekteille. Jos jokin suodatin poistetaan, ei se ole käytettävissä enää 
myöskään muissa projekteissa!
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4.2.8 Projektin kopiointi

Projektin konfigurointeja ja parametrointeja voidaan yksinkertaistaa ja 
nopeuttaa luomalla malliprojekteja. DIGSI 4 ohjelmistossa tämä voidaan 
toteuttaa helposti ja käyttäjäystävällisesti.

Tämä suoritetaan valitsemalla malliprojekti ja kopioimalla tiedot 
käyttöön yksinkertaisesti muuttamalla projektin nimi ja tallennuspolku. 

Projekti kopioidaan seuraavasti:

• Valitaan File → Save As ja valitaan uusi tallennuspolku Save 
project as kentässä.

4.2.9 Projektin poistaminen

Projektit voidaan poistaa valintaikkunasta määrittelemällä. 

Projekti poistetaan seuraavasti:

• Valitaan File → Delete, jolloin Delete valintaikkuna aukeaa, josta 
valitaan edelleen User projects ikkuna.

DIGSIMAN031

Kuva 4-10  Projektien poistaminen
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Ikkunassa on esitetty kaikki ne projektit joiden tallennuspolku on 
DIGSI® 4 tiedossa.

• Valitaan poistettavien projektien nimet ja aktivoidaan toimenpide OK 
painikkeella. Valitut projektit on esitetty User projects ikkunassa. 

• Poistotapahtuma yleisesti tulee vielä hyväksyä Yes painikkeella. 
Yksittäisten projektien poistoon tulee vastata myös Yes painikkeella. 

Muiden projektien 
hakeminen

• Klikataan Browse painiketta jos halutaan hakea poistettavaksi myös 
muita projekteja, joita ei luettelossa ole esitetty. 

Ohje:

Aukiolevia projekteja ei voi poistaa.
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4.2.10 Projektin uudelleen organisointi

Objektien toistuva lisääminen ja poistaminen kasvattaa muistialuetta, 
joka ei ole enää käytössä. Uudelleen organisoinnilla voidaan vapauttaa 
tämä muisti käyttöön.

Tämä tapahtuu seuraavasti:

• Valitaan File → Reorganize, jolloin aukeaa Reorganize ikkuna, 
josta valitaan edelleen User projects ikkuna.

DIGSIMAN032

Kuva 4-11  Projektien uudelleen organisointi

Ikkunassa on esitetty kaikki ne projektit joiden tallennuspolku on 
DIGSI® 4 tiedossa.

• Valitaan yksitellen projektien nimet, jotka halutaan uudelleen 
organisoida  ja aktivoidaan toimenpide OK painikkeella. 

Näyttöön tulee ilmoitus kun projektit on uudelleen organisoitu. 

• Klikataan Browse painiketta jos halutaan organisoida uudelleen 
myös muita projekteja, joita ei luettelossa ole esitetty. 

Ohje:

Jos tallennuspolkua muutetaan Save As toiminnalla, on mahdollista 
tallentaa projekti uuteen hakemistopolkuun uudelleen organisoimalla se 
samalla With reorganization (slow). Tallennus tapahtuma kestää tällöin 
hieman kauemmin.
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4.2.11 Projektien hallinta

Jos käsitellään suurta määrää projekteja, voi olla mielekästä 
väliaikaisesti piilottaa projekteja, joita ei sillä hetkellä käsitellä. 

DIGSI® 4 Manager ohjelma mahdollistaa projektien piilottamisen ja 
niiden tuomisen uudelleen näkyviin tarvittaessa. Tällöin projekteja ei 
siirretä tai poisteta. Ainoastaan projektin nimeä ei tällöin esitetä 
projektien valintaikkunassa.

Tämä tapahtuu seuraavasti:

• Valitaan File → Manage, jolloin Manage ikkuna avautuu, josta 
valitaan edelleen User projects sivu.

DIGSIMAN033

Kuva 4-12  Projektien hallinta

Ikkunassa on esitetty kaikki ne projektit joiden tallennuspolku on 
DIGSI® 4 tiedossa.

• Valitaan piilotettavien projektien nimet ja aktivoidaan toimenpide Hide 
painikkeella. 

Valitut projektit on esitetty User projects ikkunassa. 
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Projektien 
näyttäminen

• Valitaan Display toiminta jos projektit halutaan uudelleen näkyviin.

Browse valikkoikkuna aukeaa. 

• Valitaan projektien nimet jotka halutaan uudelleen näkyviin ja 
aktivoidaan toimenpide OK painikkeella.

4.2.12 Projektien arkistointiasetukset

DIGSI® 4 Manager ohjelmassa on käyttäjäystävällinen arkistointitoiminta 
projektien varmuuskopiointiin. Kaikki projektin tiedot tallentuvat 
pakatussa muodossa tiedostoon, joka voidaan myöhemmin avata 
uudelleen käyttöön. 

DIGSI® 4 ohjelmisto tukee ARJ, WINZIP, PKZIP, PKUNZIP ja LHARC 
pakkausohjelmia. Valintaikkunassa valitaan haluttu pakkausohjelma ja 
määritellään sille mahdollisesti tarvittavat asettelut. 

Ohje:

Tulee huomioida että vain ne projektin hakemistot, jotka DIGSI® 4 
ohjelma on luonut, varmuuskopioidaan.  Tällöin tallentuvat myös 
esimerkiksi mahdolliset EXCEL tiedostot, jotka on tallennettu 
projektihakemistoon.
Sähköaseman projektitiedostoja ei yleensä tallenneta DIGSI 
projektihamistoon, jolloin niitä ei myöskään varmuuskopioida. SIEMENS 
suosittelee että projektin muut tiedostot varmuuskopioidaan erikseen.
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Perus-
asetukset

Ennen projektin arkistointia tulee ensimmäisellä kerralla määritellä 
muutama perusasettelu. 

• Valitaan Options → Settings, jolloin avautuu Customize ikkuna ja 
valitaan sieltä edelleen Archiving sivu.

DIGSIMAN034

Kuva 4-13  Varmuuskopioinnin perusasettelut

Arkistoitavan 
projektin valinta

• Tarkastetaan että haluttu arkistointiohjelma on asennettuna. 
Tarvittaessa se tulee asentaa erikseen.

• Valitaan haluttu pakkausohjelma Preferred Archiving Program 
alasvetoikkunasta. Kaikki tuetut ohjelmat tulevat näkyviin luetteloon 
riippumatta siitä, onko ohjelmaa asennettu tietokoneelle vai ei. 

Ohje:

WINZIP pakkausohjelma on mahdollista hankkia suoraan Internetistä 
www.winzip.com sivulta.
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Arkistointi-
ohjelmien 
määrittely

• Klikataan Configuring. Tällöin aukeaa Archiving - Configuring 
ikkuna. 

DIGSIMAN035

Kuva 4-14  Arkistointiohjelman määrittely

Pakkausohjelman 
valinta

• Valitaan pakkausohjelman nimi Archiving Program kentästä. 
Riippuen valitusta ohjelmasta käytettävissä on ohjelmaan liittyviä 
asetteluita. 

• Käyttäjän tulee määritellä käyttöön valitun pakkausohjelman 
asettelut. Kaikki käyttäjän tekemät määrittelyt, eli eri ohjelmille, 
tallentuvat kunkin ohjelman yhteydessä toisistaan riippumattomasti.

Ohjelmistopolun 
määrittely

• Syötetään valitun pakkausohjelman tallennuspolku Program Path 
kenttään. Esivalintana on määritelty ohjelma ilman levy- tai 
polkumäärittelyitä. Tämä määrittely on riittävä edellyttäen että 
pakkausohjelma sijaitsee käyttöjärjestelmän tunnistamassa 
paikassa. Jos näin ei ole, tulee koko ohjelman tallennuspolku 
kirjoittaa kenttään. 

• Browse toiminnalla voidaan hakea haluttu tallennushakemisto 
valintaikkunasta valitsemalla.

Jos pakkausohjelma ei sijaitse määritellyssä polussa, seuraa 
virhemerkinanto Not Found, joka esitetään Archiving Program 
valintaikkunan alapuolella.
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Luodaan 
varmuuskopio 
levykkeille 
tallennettaviksi

Suuren projektin arkistointi levykkeelle saattaa edellyttää sen tallennusta 
useammalle levykkeelle. Seuraavassa on kuvattu toimintavaiheet 
varmuuskopioinnille, joka tallentuu useammalle levykkeelle. 

• Valitaan jokin vaihtoehdoista Archive That Goes across Diskettes 
alasvetovalikosta:

No
Tämä on esiasetus. Luodaan varmuuskopio, jota ei tallenneta 
useammalle levykkeelle, vaan muodostetaan yksi kokonainen 
varmuuskopiotiedosto.

Use Free Space
Jos levykkeellä on jo tiedostoja, niitä ei poisteta. Tiedostot jakautuvat 
varmuuskopioitaessa levykkeiden vapaaseen tilaan täyttäen ne 
optimaalisesti.

1.4 MB, 1.2 MB, 720 KB tai 360 KB
Tällä valinnalla määritellään yhden varmuuskopiotiedoston osan 
suurin koko. Varmuuskopion tiedostot voidaan myös tallentaa 
kovalevylle ja siirtää sieltä myöhemmin levykkeelle. Nämä 
vaihtoehdot ovat mahdollisia vain ARJ pakkausohjelmalla.

Delete Files
Jos levykkeellä on jo tiedostoja, ne poistetaan. Tämä vaihtoehto on 
mahdollinen vain PKZIP pakkausohjelmalla.

Varmuuskopio-
vaihtoehtojen 
määrittely

Incremental Archiving
Jos toiminta on aktivoitu, varmuuskopioidaan vain ne tiedostot joiden 
ARC atribuutti on aktiivisena. ARC atribuutti tai niin sanottu 
arkistointibitti asettuu päälle, kun tiedosto luodaan tai sitä on käsitelty.

Reset archive bit
Jos tämä valinta on aktivoituna, tiedoston aristointibitti palautetaan 
arkistoinnin jälkeen. Tällöin tiedostoa ei varmuuskopioida 
seuraavassa arkistoinnissa, jos sitä ei ole tänä aikana käsitelty. Jos 
tiedostoa käsitellään uudelleen asettuu arkistointibitti automaattisesti, 
jolloin tiedosto kuuluu varmuuskopioitavien tiedostojen joukkoon.

Consistency check
Jos tämä toiminta on aktivoituna, verrataan pakattuja tiedostoja 
alkuperäisiin pakkaustoiminnan jälkeen. Tällä voidaan varmistaa että 
pakattaessa tiedostoihin ei ole tullut virheitä esimerkiksi viallisen 
levykkeen aiheuttamana. Tämä toiminta on mahdollinen vain ARJ 
pakkausohjelmalla.

Asetteluiden 
hyväksyntä

• Vahvistetaan asettelut OK painikkeella. Avoin valintaikkuna 
sulkeutuu ja näyttöön palaa Customize valintaikkuna.

Muiden 
asetteluiden 
suoritus

Seuraavaksi tehdään muut tarvittavat asettelut Archiving ikkunassa. 
Kaikkia asetteluita ei käytetä arkistoinnin tai arkistoinnin palautuksen 
yhteydessä riippuen käytetyn pakkausohjelman ominaisuuksista. 
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Toiminnassa on seuraavat rajoitukset:

Jos käyttöön valitaan WINZIP pakkausohjelma, ei Archiving sivulla 
olevilla muilla asetteluilla ole merkitystä.

Jos käyttöön on valittu LHARC pakkausohjelma, Check Options 
toiminnat eivät ole käytössä.

Arkistointi-
hakemiston 
määrittely

• Määritellään tallennushakemisto arkistoinnille ja lähdehakemisto 
arkiston palautukselle. Määriteltyä hakemistopolkua käytetään 
arkistoinnille tai arkiston palautukselle esiaseteltuna 
tallennuspaikkana.

• Aktivoidaan Use valintaikkuna. Muussa tapauksessa 
tallennuspolkuna käytetään edellisessä arkistoinnissa käytettyä 
asettelua.

Muut asettelut • Otetaan Generate archive path automatically toiminta pois päältä, 
jos halutaan muuttaa esiaseteltua tallennuspolkua ja määritellä 
arkistointitiedoston nimi ennen jokaista arkistointitapahtumaa. 
Jos toiminta on aktiivisena, muodostetaan arkistointitiedoston nimi 
projektin nimestä ja tallennuspolkuna käytetään esiaseteltua polkua 
tai polkua jota on viimeksi käytetty arkistoinnissa.

Toiminta Create new archive name if names conflict on käytettävissä 
vain jos toiminta Generate archive path automatically on valittu 
käyttöön. Jos arkiston nimi muodostetaan projektinimestä, on 
mahdollista että on jo olemassa arkistotiedosto jolla on sama nimi.

• Aktivoidaan Create new archive..., jolloin nimeen lisätään juokseva 
numero jos tiedoston nimi on jo olemassa. Näin voidaan estää jo 
olemassa olevan tiedoston ylikirjautuminen. 
Jos toiminta ei ole käytössä, kirjoitetaan olemassa olevan tiedoston 
päälle, jolla on sama nimi, kun tilanteesta muodostettu varoitus 
kuitataan hyväksytysti. 

• Check target directory on retrieval valitaan käyttöön, jos arkiston 
palautustoiminnassa ei haluta käyttää projektien 
vakiotallennuspaikkaa. Tällöin ohjelma kysyy ennen jokaisen arkiston 
palautusta mistä hakemistopolusta palautus suoritetaan. 

• Check options toiminta määritellään käyttöön, jos käyttäjä haluaa 
muuttaa esiasetteluita välittömästi ennen arkistointia tai arkiston 
palautusta. 

• Hyväksytään määritellyt asettelyt käyttöön OK painikkeella. 
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4.2.13 Projektien arkistointi

Projektin arkistointi eli varmuuskopiointi voidaan suorittaa valikko-
ohjaustoiminnalla tai automaattisesti kun projekti avataan. 

Arkistointi
Menu-käskyllä 

• Valitaan File → Archive, jolloin Archiving ikkuna aukeaa, josta 
valitaan edelleen User projects ikkuna. 

DIGSIMAN036

Kuva 4-15  Arkistointi

Kaikki projektit joiden tallennuspaikka on DIGSI® 4 Manager ohjelmiston 
tiedossa, esitetään näytöllä.

• Valitaan arkistoitavien projektien nimet ja aktivoidaan toimenpide OK 
painikkeella. 

Näyttöön saattaa tulla lisää valintaikkunoita ennen varsinaista 
varmuuskopiointia, riippuen toimintaan määritellyistä asetteluista (katso 
kappale 4.2.12).

• Näyttöön tulee ilmoitus, jos käyttöön valittua pakkausohjelmaa ei ole 
asennettu. Valitaan käyttöön asennettu pakkausohjelma ja 
tarkastetaan sen tallennuspolku.

Ohje:

Avattua projektia ei voi arkistoida.
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Arkiston määrittely • Määritellään Archive - Select Archive ikkunassa arkistointitiedosto, 
johon projekti halutaan varmuuskopioida.

DIGSIMAN040

Kuva 4-16  Arkistotiedoston määrittely

• Määritellään arkistotiedoston nimi File name  kenttään. Nimen 
muodostuksessa tulee ottaa huomioon esimerkiksi mahdolliset DOS 
rajoitukset, määrättyjä pakkausohjelmia kuten ARJ:ta käytettäessä. 
tai

• Valitaan olemassa oleva arkistotiedosto ja painetaan Save painiketta.

• Jos näyttöön ilmestyneeseen ilmoitukseen vastataan Yes 
painikkeella, kirjautuu olemassa oleva tiedosto uudella 
arkistotiedostolla. Aiemmin olemassa ollut tiedosto poistuu 
lopullisesti. 

• Jos esitettyyn kysymykseen vastataan No, uudet tiedot lisätään 
olemassa olevaan pakkaustiedostoon. Tällä menetelmällä voidaan 
tallentaa useita projekteja samaan arkistotiedostoon. 

Arkistointiprosessi on valvottu. Jos arkistoitavaksi on valittu useampia 
projekteja, arkistoidaan ne peräkkäin vastaavalla tavalla.

Arkiston
muodostus 
automaattisesti 
projektia 
avattaessa

• Valitaan Options → Settings, jolloin aukeaa Customize ikkuna. 

• Avataan General sivu ja aktivoidaan Archive Automatically on 
Opening a Project toiminta ja vahvistetaan valinta OK painikkeella. 

Tällöin kaikki projektit varmuuskopioidaan automaattisesti ennen kuin ne 
avautuvat näytölle. 
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4.2.14 Arkistoidun projektin palauttaminen

Arkistoitu projekti palautetaan käyttöön seuraavasti:

• Valitaan File → Retrieve, jolloin Retrieve - Select Archive ikkuna 
aukeaa.

DIGSIMAN043

Kuva 4-17  Arkistoidun projektin valinta

• Valitaan arkistotiedosto, joka sisältää halutun projektin. Tiedosto 
valitaan klikkaamalla tiedostonimeä ja vahvistamalla toiminta OK 
painikkeella. 
Vain yksi arkistoitu tiedosto voidaan avata kerrallaan. 

Seuraavat tapahtumat määräytyvät suoritettujen arkistointiasetusten 
määrääminä.

• Valitaan kohdehakemistopolku palautettavalle projektille ja 
hyväksytään toiminta OK painikkeella.

• Valitaan mahdolliset palautustoimintavaihtoehdot (katso kappale 
4.2.12).

Projektin palautusprosessi kirjautuu tapahtumatiedostoon.
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4.2.15 Työskentely SIMATIC Manager ohjelmassa

Jos tietokoneelle on asennettu täysi STEP 7 ohjelmisto, käytetään 
projektien luonnissa SIMATIC Manager ohjelmaa. 
SIMATIC Manager ohjelmaa on laajennettu DIGSI® 4 ominaisilla 
toiminnoilla DIGSI® 4 ohjelman asennuksen yhteydessä. 

Tulee huomioida seuraavat kohdat käytettäessä DIGSI® 4 ohjelmistoa 
SIMATIC Managerissa:

Näyttövaihtoehdossa "component" sijaitsevat kaikki SIPROTEC 
laitteet Device container hakemistossa, joka on näkyvissä vain  
STEP 7 yhteydessä. Tällä hakemistolla on vain yleiset ominaisuudet 
General properties.

Kaikki DIGSI 4 Manager ohjelman toiminnat ovat käytettävissä 
samoissa valikko-ohjauksissa SIMATIC Manager ympäristössä. 

DIGSI® 4 Device valikko on nimeltään PLC SIMATIC Managerissä. 
Se sisältää kaksi toimintoa Device > DIGSI (plug-and-play) ja 
Initialize device.

DIGSI® 4 esittää aina projektin hierarkisen rakenteen objekteineen. 
SIMATIC Managerissa tämän näyttövaihtoehdon Topological View 
lisäksi on käyttöön valittavissa toinen näyttötapa eli Component View. 
"Component view" näyttövaihtoehto esittää katselmuksen projektissa 
olevista  SIPROTEC laitteista. 

• Valitaan View → Component View menu-valikosta. Riippuen 
projektin esiasetteluista näyttö aukeaa avoimeen ikkunaan tai 
luodaan uusi ikkuna. Esiasetteluita voidaan muuttaa Options → 
Settings ikkunasivulla View tab. 

• Valitaan Device hakemisto puurakenteesta. Näyttöön tulee luettelo 
kaikista projektissa olevista SIPROTEC 4 laitteista.

Object Properties toiminnalla saadaan näkyviin tieto laitteen 
hierarkisesta sijainnista projektissa. 

• Valitaan oikealla hiiripainikkeella valikosta Object Properties ja 
siirrytään System Management sivulle. 
Laitteen sijainti hierarkiarakenteessa on esitetty System Hierarchy 
sivulla.

• Valitaan View → Topological View joilloin palataan takaisin 
projektin hierarkiseen näyttötapaan.
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PROFIBUS SIPROTEC 4 device ikkunassa on lisäksi  PROFIBUS FMS 
Connections sivu.

DIGSIMAN071

Kuva 4-18  SIPROTEC® device ikkuna ja PROFIBUS FMS Connections sivu

Jos tietokoneelle on asennettu täydellinen STEP 7 ohjelmisto, asetellaan 
PROFIBUS FMS osoite PROFIBUS FMS Connections sivulla. Tällöin ei 
voida suorittaa mitään määrittelyitä FMS / IEC setting sivulla, jota 
käytetään DIGSI® 4 ohjelmistossa IEC tai PROFIBUS FMS 
kommunikaatioparametrien määrittelyissä. 

ROFIBUS FMS kommunikaatioyhteyden määrittely on kuvattu 
kappaleessa 7.

Huomio:

Tällä sivulla ei tule suorittaa mitään määrityksiä jos käytetään 
PROFIBUS DP protokollaa.
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4.3 Laitteet

DIGSI® 4 ohjelmistolla voidaan käsitellä SIPROTEC laitteiden V4, V3 ja 
V2 tuoteperheitä. Laitteiden käsittely projektissa ei poikkea versioittain. 
Toiminta on esitetty tässä kappaleessa SIPROTEC 4 laitteella 
esimerkkinä. 

4.3.1 SIPROTEC® laitteen lisääminen projektiin

Seuraavassa on kuvattu vaiheet, joiden avulla saadaan liitettyä uusi 
SIPROTEC® laite projektiin:

• Valitaan projektirakenteesta taso johon laite halutaan sijoittaa, jolloin 
valitaan Insert New Object → SIPROTEC Device tai Device 
Catalog valikosta, jolloin Device Catalog ikkuna aukeaa.

DIGSIMAN007

Kuva 4-19  Laiteluettelo

• Avataan halutun laiteperheen valikko, esimerkiksi 7SJ Overcurrent 
time protection. Valitaan haluttu laite luettelosta, esimerkiksi 
7SJ631 V4.0, tartutaan hiiripainikkeella laitteeseen ja siirretään se 
drag-and-drop menetelmällä kohdehakemistoon projektissa. 

Ohje:

Tulee huomata että laitteet voidaan sijoittaa vain hakemistoihin, eikä 
suoraan ylimmälle tasolle. Tästä syystä projektia luotaessa sinne 
luodaan myös automaattisesti aina Folder hakemisto.
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4.3.2 Laitteen mallin määrittely

Properties - SIPROTEC 4 Device ikkunassa on MLFB sivu joka aukeaa 
näytölle ennen kuin laite sijoitetaan projektirakenteeseen.

• Alasvetovalikoilla määritellään tilausnumeron (MLFB) yksittäiset 
merkit, jotka määrittelevät laitteen ominaisuudet ja tämän jälkeen 
hyväksytään valinnat OK painikkeella.

DIGSIMAN008

Kuva 4-20  SIPROTEC 4 device valikon MLFB sivu

• SIPROTEC laitteen kaikki ominaisuudet saadaan näytölle 
valitsemalla DIGSI 4 Manager ohjelmassa oikealla hiiripainikkeella 
laitesymbolin päällä "object properties" valinta (katso myös 
kappaleessa 5.2). 

Ohje:

SIPROTEC 4 laitteen määrittelyohjeita on esitetty kappaleessa 5. 
Kommunikaatioväylien määrittelyohjeet on esitetty kappaleessa 7. 

SIPROTEC V3 ja V2 määritellään samalla tavalla. Yksityiskohtaisia 
tietoja käyttöliittymästä on esitetty online-apua toiminnoissa.
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4.3.3 Offline / Online toimintatilat

Laitteelle ei ole minkäänlaita yhteyttä Offline käyttötilassa. 

Online tilassa laitteen ja tietokoneen välillä on 
komminikaatioyhteys, joka voidaan toteuttaa useammalla tavalla. 

Käytössä oleva toimintatila on esitetty DIGSI 4 ohjelmiston tilarivillä.

Offline Offline tilassa

Voidaan määritellä SIPROTEC 4 laiteen toiminnallisuus,

Voidaan määritellä yksittäisten toimintojen asettelut,

Voidaan määritellä informaatioiden käsittely,

Voidaan määritellä graafisella näytöllä varustetun laitteen perus- ja 
ohjausnäyttö DIGSI 4 Display Editor ohjelmalla (optio),

Voidaan määritellä liikennöintiasettelut, ajantahdistus ja salasanat,

Voidaan määritellä logiikkatoiminnat DIGSI 4 CFC ohjelmalla (optio),

Voidaan esittää tallennetut mittausarvot ja merkinannot,

Voidaan asetella valvontarajat,

Voidaan käsitellä tallennettuja häiriötallenteita ja analysoida niitä 
SIGRA 4 ohjelmalla (optio),

Voidaan viedä ulos ja tulostaa määrättyjä tietoja,

Voidaan tallentaa kaikki määritellyt muutokset tiedostoon.

Online Online tilassa

Voidaan siirtää tietokoneella suoritetut asettelut SIPROTEC® 
laitteelle,

Voidaan siirtää SIPROTEC® laitteen asettelut tietokoneen 
väliaikaiseen muistiin ja tallentaa ne tarvittaessa edelleen tietokoneen 
pysyvään muistiin (katso kappale 4.4),

Voidaan siirtää merkinannot, mittausarvot ja häiriötallenteet 
SIPROTEC 4 laitteelta tietokoneen väliaikaiseen muistiin ja sieltä 
edelleen pysyvään muistiin (katso kappale 4.4),

Voidaan käynnistää testaustoimintoja,

Voidaan ohjata kytkinlaitteita ja asetella sisäisiä merkinantoja,

Voidaan aktivoida SIPROTEC laitteen uudelleen käynnistys,

Voidaan asetella SIPROTEC laitteen päivämäärä ja kellonaika.

Myös Offline tilassa voidaan käsitellä prosessitietoja. Tietokoneen 
pysyvään muistiin tallennettuja mittausarvoja, tapahtumia ja 
häiriötallenteita voidaan käsitellä vain offline tilassa. 
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4.3.4 SIPROTEC 4 laitteen avaaminen

SIPROTEC® laite avataan seuraavasti:

• DIGSI® 4 projektinäytössä valitaan haluttu laite ja avataan Open 
Device ikkuna Open Object valikosta.

DIGSIGB032

Kuva 4-21  Laitteen avaaminen

Offline • Valitaan Offline käyttötila jos yhteyttä laitteeseen ei haluta 
muodostaa. Tällöin työskennellään tietokoneelle tallennettujen 
tietojen kanssa. 

Direct • Valitaan Direct toimintatapa, PC interface ja Device interface (ja 
channel switch, jos tarpaan), jos halutaan muodostaa yhteys 
tietokoneen ja SIPROTEC® laitteen välille. 

Modem Connection • Valitaan Modem connection toimintatapa, modem connection ja 
device interface (ja channel switch, jos tarpeen), jos yhteys 
halutaan muodostaa modeemiyhteyden kautta.

PROFIBUS FMS • Valitaan PROFIBUS FMS toimintatila, jos halutaan kommunikoida 
PROFIBUS FMS väylän kautta.

Ethernet • Valitaan Ethernet toimintatila, jos halutaan kommunikoida Ethernet 
väylän kautta. 

• Vahvistetaan valinnat OK painikkeella.

Tiedonsiirron edistyminen esitetään liikennöintiä kuvaavalla palkilla.
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Jos yhteyttä ei voi muodostaa, näyttöön tulee Establish Connection 
ikkuna, jossa on esitetty mahdollisia syitä yhteyden epäonnistumiselle.

• Tarkastetaan tietokoneen ja SIPROTEC® laitteen välinen yhteys, 
poistetaan virheet ja painetaan Repeat painiketta. 

• Jos SIPROTEC® laitteella ei ole vielä käytettyä projektia ladattuna, 
valitaan Initialize ja toistetaan yhteydenmuodostusvaiheet.

Asetteluiden 
lataaminen

Kun laite on avautunut, ovat kaikki SIPROTEC® laitteen asetteluarvot 
tallennettuna tietokoneelle. 

Online tilassa ladattuja parametrejä verrataan  SIPROTEC® laitteen 
parametreihin. Ongelmatilanteessa voidaan valita kumpia tietoja 
käytetään. Suoritettu valinta ei vaikuta tallennetuihin tietoihin.

DIGSIGB018

Kuva 4-22  Laitteen ja tietokoneen tiedoissa on ongelmia

• Valitaan Open Device Online valikossa Device Data tai PC Data.

Ohje:

Jos halutaan kommunikoida laitteen kanssa, jonka tietoja ei ole 
tietokoneella tallennettuna, voidaan tiedot lukea laitteelta Plug-and-play 
toiminnalla (katso kappale 7.2).
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4.3.5 DIGSI valikkopuu

Kun kaikki tiedot on luettu, avaa DIGSI® 4 valikkopuun ja laitteen tiedot 
esitetään.

DIGSIGB020

Kuva 4-23  Valikkopuu offline tilassa

Riippuen käytetystä toimintatilasta laitekohtaiset toiminnat on esitetty 
navigointi-ikkunassa. Joillakin SIPROTEC 4 laitteilla (esim. 6MD63, 
6MD66 ja 6MD665) ei ole asetteluryhmiä.

Seuraavia toimintoja voidaan käyttää laitteella:

Parametrointi

Prosessitietojen esitys

Ohjaustoimintojen suoritus

Testaustoimintojen suoritus

Toimitaan seuraavasti halutun toiminnan käynnistämiseksi:

• Valitaan navigointi-ikkunassa (vasemmanpuoleinen ikkuna) 
toiminta,  esimerkiksi Settings.

Tietoikkunassa (oikeanpuoleinen) esitetään valitun toiminnan sisältö, 
esimerkiksi Select function.
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4.3.6 Restart ja Resume toimintojen käynnistys

• Valitaan Device → Restart tai Device → Resume, halutun 
uudelleen käynnistystavan aktivoimiseksi.

Salasanan 
syöttäminen

Restart tai resume toimintojen aktivointi edellyttää salasanan 
syöttämistä testaus- ja diagnoositoiminnoille (testing and diagnostics). 
Jos salasana on aktivoitu käyttöön, kysytään sitä ennen näiden 
ohjausten suoritusta. 

• Syötetään salasana ja vahvistetaan se OK painikkeella. 

Ohje:

Control ja Test objektit ovat käytettävissä vain kun ollaan Online tilassa. 

Toiminnallisuuden määrittelyikkunassa on käytettävissä vain ne 
toiminnat jotka sisältyvät kulloinkin käytössä olevaan SIPROTEC® 
laitteeseen. 

Ohje:

Asetteluparametrien määrittelyistä on annettu ohjeita kappaleessa 5.

Ohjaustoiminnat, kuten merkinantojen-, mittausarvojen- ja 
häiriötallenteiden luku, kytkinlaitteiden ohjaukset, jne. on kuvattu 
kappaleessa 6.

Testaustoimintojen käyttö on esitetty kappaleessa 8.

Huomio:

Jos Restart toiminta aktivoidaan, nollautuvat kaikki laitteen muistit, kuten 
energian mittaus- ja laskuriarvot (spontaanit merkinannot eivät poistu). 
Resume toiminnalla laitteen muistit säilyvät muuttumattomina. On 
suositeltavaa ensin tallentaa asettelut ja puskureiden sisällöt, käyttäen 
DIGSI 4 Device Editor ohjelmaa ennen uudelleen käynnistystä (Restart) 
(katso kappale 6.2.7).
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4.3.7 Kellonajan ja päivämäärän asettelu SIPROTEC laitteelle

DIGSI® 4 ohjelmistolla on mahdollista asetella päivämäärä ja kellonaika 
SIPROTEC laitteelle. Halutut arvot voidaan syöttää tai käyttää 
tietokoneen aikaa ja päivämäärää.

• Valitaan Device → Set Time ja avataan Set clock & date in device 
ikkuna.

DIGISGB002

Kuva 4-24  Päivämäärän ja kellonajan asettelu

• Syötetään päivämäärä ja kellonaika. Varmistetaan että ne 
syötetään oikeassa formaatissa, sillä muussa tapauksessa seuraa 
virheilmoitus.

tai

• Valitaan Use PC time/date  valintaikkuna jos halutaan käyttää 
tietokoneelle tallennettua päivämäärää ja kellonaikaa. 
Tällöin käsinsyöttökentät eivät ole käytettävissä. 

Päivä määräytyy automaattisesti päivämäärän mukaisesti, eikä sitä voi 
muuttaa.

• Hyväksytään määrittelyt OK painikkeella, joka jälkeen tiedot siirtyvät 
SIPROTEC® laitteelle. 

Ohje:

Tätä toimintaa ei tarvitse käyttää jos SIPROTEC® laitteet on liitetty esim. 
SICAM järjestelmään IEC 60870-5-103 protokollalla.
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4.3.8 Toimintatilan muuttaminen

DIGSI® 4 mahdollistaa toimintatilan muuttamisen ilman että tiedostoa 
tarvitsisi sulkea ja käynnistää uudelleen SIPROTEC® laitteelle. 
Edellytyksenä on että laiteikkuna on aktiivisena. 

Tämä tapahtuu seuraavasti:

• Valitaan Device → Switch Online/Offline, jolloin siirrytään Offline 
tilasta Online tilaan ja tarvittaessa tulee tallentamattomat muutokset 
tallentaa.

• Valitaan yhteyden muodostustapa Open Device ikkunassa ja 
hyväksytään valinta OK painikkeella. 

Yhteys laitteelle muodostuu. Kun yhteys on onnistuneesti muodostettu, 
esitetään ONLINE käyttötila tilarivillä. Laiteikkunan sisältö päivittyy. 

Siirtyminen Online tilasta Offline tilaan tapahtuu vastaavalla tavalla. 

4.3.9 Tietojen siivoaminen

Järjestelmäväylään menevien informaatioiden toistuva lisääminen ja 
poistaminen varaa muistialueita, jotka eivät ole enää käytettävissä. 
Siivoustoimenpiteellä voidaan vapauttaa nämä varatut muistialueet 
uudelleen käyttöön.

Tämä tapahtuu seuraavasti:

• Valitaan File → Clean Up ja vahvistetaan toiminta OK painikkeella. 

Huomio:

Kun siivoustoimenpide suoritetaan, numeroidaan informaatiot uudelleen. 
Jos SIPROTEC 4 laite on liitettynä SICAM ohjausjärjestelmään, 
käytetystä liikennöintiprotokollasta riippuen, voi olla tarpeen suoritaa 
tietojen uudelleen tuonti SICAM plusTOOLS ohjelmistoon!

Ohje:

Tietojen siivous hyväksytään vasta lopullisesti kun Save painiketta 
painetaan. Jos siivoustoimenpide on valittu vahingossa, suljetaan DIGSI 
4 Device Configuration tallentamatta ja käynnistetään se uudelleen. 
Tällöin kuitenkin menetetään muut mahdolliset muutokset joita ei vielä 
oltu tallennettu.
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4.3.10 Häiriömuistin lukeminen

Jos SIPROTEC® laitteella on häiriöitä, kuten esimerkiksi 
elektroniikkavaurio tai vaurioitunut parametritiedosto, 
valvontamerkinannot tallentuvat laitteen häiriömuistiin. Tällöin häiriötön 
liikennöinti laitteen kanssa ei välttämättä ole enää mahdollista. 
Häiriötilanteessa pyritään ottamaan yhteys laitteeseen. Yhteyden 
muodostuksen jälkeen SIPROTEC® laitteelle tallentunut häiriömuisti 
voidaan lukea ja tallentaa tapahtumat tekstitiedostoon. Tämä tiedosto 
tulee lähettää DIGSI hotline palveluun.

Jos häiriötön kommunikaatioyhteys SIPROTEC® laitteelle ei ole 
mahdollista, tulee ensin näyttöön häiriöilmoitus: 

DIGSIGB120

Kuva 4-25  Häiriö parametrilohkossa

• Painetaan OK painiketta ja vastataan seuraavaan kysymykseen Yes 
painikkeella, jolloin häiriömuisti luetaan. 

• Syötetään nimi ja määritellään tallennuspolku Save As ikkunassa. 
Tiedostolle määritellään automaattisesti .txt pääte.

• Painetaan OK painiketta. Tekstieditori, joka on määritelty toimimaan 
.txt  tiedostojen kanssa, aukeaa ja häiriötiedot tulevat näytölle.

• Häiriötapahtumatiedosto tulee lähettää DIGSI hotline palveluun.
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DIGSIGB121

Kuva 4-26  Tekstieditorin näyttö häiriötapahtumista, esimerkki

4.3.11 SIPROTEC® laitteen sulkeminen 

Yksittäiset laitteet Jos halutaan sulkea yksittäinen SIPROTEC® laite, toimitaan seuraavasti:

• Valitaan File → Close  ja hyväksytään näyttöön tullut kysymys, jos 
muutetut asettelut halutaan tallentaa.

Tällöin laiteikkuna sulkeutuu. Jos avattuna oli useampia laitteita, 
sulkeutuu vain se laite jonka ikkuna oli valittuna. DIGSI 4 Device 
Configuration ikkuna jää auki.

Kaikki laitteet Jos halutaan sulkea kaikki avoimena olevat laitteet, toimitaan 
seuraavasti:

• Valitaan File → Exit ja vahvistetaan näyttöön tullut kysymys Yes 
painikkeella, jos halutaan tallentaa tehdyt mutta vielä 
tallentamattomat muutokset.

Tällöin sulkeutuu DIGSI 4 Device Configuration ja kaikki auki olleet 
laitteet.
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4.3.12 Laitteiden kopiointi

On mahdollista määritellä esimerkkilaitteita, jos käytetään vakioituja 
konfigurointiparametrejä, esimerkiksi yrityksen määrittelemiä 
vakiotoimintatapoja mikä mahdollistaa yhtenevien parametrien 
käyttöönoton samantyyppisillä laitteilla. Nämä mallilaitteet voidaan 
monistaa tarvittaessa yksinkertaisesti kopioimalla ne. Tällöin luodaan 
aina uusi laite. Tämän jälkeen suoritetaan mahdollisesti tarvittavat 
muutokset laiteparametreihin. 

Tämä tapahtuu seuraavasti:

• Valitaan kopioitava laite DIGSI 4 Manager ikkunassa ja valitaan Copy 
toiminta valikosta. Klikataan haluttua kohdetta johon laite halutaan 
sijoittaa projektin hierarkiassa ja valitaan Paste toiminta valikosta.

Uudessa laitteessa on samat asetteluparametrit kuin alkuperäisessä 
laitteessakin, mutta VD-osoite on muuttunut.  Jotta tiedostot saadaan 
ladattua laitteelle, tulee se tehdä initialisoimalla.

Variaatioiden 
muodostus

Jos uutta laitetta ei haluta luoda kopioimalla, mutta dokumentoida eri 
toteutusvaiheita parametrointiprojektin edistyessä, voidaan DIGSI 4 
Manager ohjelmistossa luoda ja käyttää ns. variaatiota SIPROTEC 
variant. 

Laitevarianttia voidaan käsitellä DIGSI® 4 ohjelmistossa kuten 
alkuperäistä laitettakin.

Laitevariaatio luodaan seuraavasti:

• DIGSI 4 Manager ikkunassa valitaan SIPROTEC® device ja valitaan 
Create Variant valikosta, jolloin alkuperäisestä laitteesta 
muodostetaan variaatio ja tiedosto on varustettu .var päätteellä. Se 
sijaitsee samassa kohtaa projektin hierarkista rakennetta kuin 
alkuperäinen laitekin.

Varianttina luotu laite on malli alkuperäisestä laitteesta, joten VD osoite 
pysyy samana. Variantti kuvaa täten samaa fyysistä SIPROTEC® 4 
laitetta.

Ohje:

SIPROTEC® 4 varianttien käytössä on seuraavat rajoitukset:

SICAM ohjausjärjestelmän ja SIPROTEC® variantin liittäminen 
yhteen SICAM plusTOOLS ohjelmistossa ei ole mahdollista.

SIPROTEC® 4 varianttia ei voida käyttää IRC (releiden välinen 
suorakommunikaatio) käytössä.

Prosessiväylälinkkiä ei voida muodostaa.
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4.3.13 V3/V2 laitteiden käsittely

SIPROTEC 4 ja V2.x tai V3.x laitteiden käsittelyssä ei ole oleellisia eroja 
DIGSI® 4 Manager ohjelmistossa. Laitteita voidaan tuoda, muodostaa 
variantteja, kopioida, jne. yhtenäisin menetelmin.

DIGSI  4 ohjelmistolla niitä voidaan parametroida vastaavin menetelmin 
kuin SIPROTEC 4 laitteitakin. Lisätietoja käyttäjäliittymästä ja 
yksittäisten parametrien määrittelyistä on annettu online-apua 
tiedostoissa. 
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4.3.14 Olemassa olevan V3 järjestelmän liittäminen

DIGSI® 4 tarjoaa käyttäjäystävällisen mahdollisuuden liittää V3 
järjestelmä DIGSI® 4 projektiin. Alkuperäisen projektin rakenne 
säilytetään automaattisesti.

Olemassa oleva V3 järjestelmä liitetään DIGSI® 4 projektiin seuraavasti:

• Valitaan Insert → DIGSI → Existing V3 system. Tällöin näyttöön 
avautuu Insert existing V3 system ikkuna

DIGSIGB156.GIF

Kuva 4-27  Olemassa olevan V3 järjestelmän liittäminen (esimerkki)

• Valitaan hakemisto Path ikkunassa jossa olemassa oleva V3 
järjestelmä sijaitsee.

• Painetaan Find painiketta: jonka jälkeen Found ikkunassa näytetään 
kaikki valitusta hakemistosta löydetyt V3 järjestelmät.
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DIGSIGB156a.GIF

Kuva 4-28  Löydetyt V3 järjestelmät (esimerkki)

• Valitaan hiirellä jokin löydetty järjestelmä, jolloin se tiedot esitetään 
Properties of the selected system kentässä.

• Löydetyistä projekteista voidaan valita yksi tai useampi Found 
ikkunassa V4 projektiin siirtämistä varten ja valinnat hyväksytään OK 
painikkeella.

DIGSIGB157.GIF

Kuva 4-29  DIGSI Manager ohjelmaan liitetyt V3 järjestelmät
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Järjestelmän rakenne säilytetään luotaessa: Kullekin luodulle 
järjestelmälle luodaan järjestelmän nimellä varustettu hakemisto. Näiden 
hakemistojen alla on järjestelmän rakenne, joiden hakemistoissa laitteet 
sijaitsevat. Kukin järjestelmä on varustettu IEC numeroinnilla, jotta 
järjestelmien väliset osoitenumeroinnit eivät olisi päällekkäisiä.
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4.4 Asetteluarvot

Laitetta voidaan käyttää Offline tai Online tiloissa, jolloin asetteluarvot 
voivat olla tallentuneina eri tavoin:

Tietokoneen väliaikaisessa muistissa,

Tietokoneen pysyvässä muistissa ja

SIPROTEC® laitteen pysyvässä muistissa. 

On-Offline.gif

Kuva 4-30  DIGSI 4 laitteiden hallinta, parametrien käsittely

Offline Muutokset Offline-tilassa tallentuvat vain tietokoneen väliaikaiseen 
muistiin. Jos ne halutaan pysyvään muistiin, tulee ne tallentaa.

Online Muutokset Online-tilassa tallentuvat vain tietokoneen väliaikaiseen 
muistiin. Jos ne halutaan käyttöön laitteelle, tulee ne siirtää sinne.
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4.4.1 Asetteluiden tallennus tietokoneen pysyvään muistiin

Asetteluarvojen muutokset tallentuvat ensin vain tietokoneen 
väliaikaiseen muistiin. Pysyvässä muistissa olevat tiedot eivät tällöin 
muutu. Käytössä ei ole automaattista tallennustoimintaa muutetuille 
asetteluille. 

• Valitaan File → Save asetteluarvojen tallentamiseksi. 

4.4.2 Asetteluarvojen siirto laitteelle

Tietokoneen 
pysyvästä
muistista

Asetteluarvot voidaan siirtää laitteen muistiin seuraavasti:

• Avataan laite Offline tilassa. Tiedot pysyvästä muistista siirtyvät 
tietokoneen väliaikaiseen muistiin. 

• Valitaan Device → DIGSI -> Device.

• Syötetään parametrimuutosten salasana Parameter set salasanan 
kyselyikkunassa Password query ja hyväksytään se OK 
painikkeella.

• Valitaan tiedonsiirtotapa online-tilaa varten tietokoneen ja laitteen 
välille.

Yhteys laitteelle muodostetaan ja asetteluarvot siirretään SIPROTEC® 
laitteen muistiin. Kun tiedonsiirto on päättynyt, katkaistaan 
liikennöintiyhteys automaattisesti.

Ohje:

Asetteluarvojen tallennus on mahdollista vain, jos kaikki asetteluikkunat 
on suljettu. Jos jokin asetteluikkuna on auki, eivät tehdyt muutokset 
tallennu.
118 SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Asetteluarvot
Tietokoneen
väliaikaisesta 
muistista

Asetteluarvot voidaan siirtää tietokoneen väliaikaisesta muistista 
laitteelle seuraavasti:

• Tehdään tarvittavat asettelumuutokset ja valitaan DIGSI -> Device 
ohjauspainike tai Device → DIGSI -> Device valikosta.

• Syötetään asetteluarvojen salasana Parameter set tai individual 
parameters salasanan kyselyikkunassa Password query ja 
hyväksytään se OK painikkeella.

Ohje:

DIGSI -> Device ohjauspainike on aktiivisena vain jos jotain 
asetteluarvoa on muutettu.

Riippuen muutetun asetteluarvon tyypistä, uusi asetteluarvo voidaan 
siirtää laitteelle yksittäin tai vain täydellisenä asetteluarvoryhmänä. 

Jos laitteelle lähetetään koko asetteluryhmä, suoritetaan SIPROTEC® 
laitteelle uudelleen käynnistys Resume (katso kappale 4.3.6). 
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4.4.3 Asetteluarvojen siirto laitteelta

Online yhteyden muodostuksen jälkeen kaikki asetteluarvot siirtyvät 
tietokoneen pysyvästä muistista sen väliaikaiseen muistiin. Näitä 
asetteluarvoja verrataan laitteen muistissa oleviin arvoihin. 

Jos laitteen tiedot poikkeavat tietokoneen tiedoista, tulee näyttöön Open 
Device Online ikkuna.

DIGSIGB018

Kuva 4-31  Ilmoitusikkuna avattaessa laite online tilaan

• Valitaan Device data vaihtoehto ja hyväksytään se OK painikkeella. 

Tietokoneen pysyvässä muistissa olevat asetteluarvot säilyvät 
muuttumattomina.

Laitetietojen 
tallennus

Jos aiemmin valittiin Device Data vaihtoehto, tallentuvat laitteen tiedot 
tietokoneen väliaikaiseen muistiin. Jos nämä tiedot halutaan tallentaa 
tietokoneen pysyvään muistiin, toimitaan seuraavasti:

• Valitaan File → Save. 

Ohje:

Asetteluarvojen tallennus on mahdollista vain, jos kaikki asetteluikkunat 
on suljettu. Jos jokin asetteluikkuna on auki, eivät tehdyt muutokset 
tallennu. 
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4.4.4 Asetteluarvojen vertailu

Online / Offline 
vertailu

Online tilassa on mahdollista vertailla SIPROTEC® laitteen ja 
tietokoneen pysyvässä muistissa olevia asetteluarvoja toisiinsa. 
Suodatustoiminnoin on mahdollista valita mitä asetteluarvoryhmiä 
verrataan. Vertailun jälkeen poikkeavat asetteluarvot tuodaan näytölle.

Tämä tapahtuu seuraavasti:

• Valitaan Device → Compare Parameters Online/Offline. 
Tällöin aukeaa Compare Parameters ikkuna näytölle.

DIGSIGB125

Kuva 4-32  Online/offline tietojen vertailu

Valittavissa olevat ryhmät on esitetty Filter ikkunassa. 

• Kun valintaruutu on aktivoitu, kuuluu asetteluryhmä vertailtaviin 
arvoihin.

• Jos valintaikkunaa ei ole aktivoitu, ei ryhmää vertailla. Tällöin 
valintamerkkiä ei ole ruudussa. 

• Kaikki asetteluryhmät voidaan joko valita tai poistaa niiden valinta 
Select All tai Deselect All painikkeilla.

• Start painikkeella käynnistetään asetteluarvojen vertailu. State 
kentässä näytetään vertailuprosessin eteneminen. 

Kun vertailu on päättynyt, poikkeamien lukumäärä esitetään  State 
kentässä. 

Toisistaan poikkeavat asetteluarvot esitetään Differences ikkunassa. 
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Objekti-sarakkeessa Objects on esitetty poikkeavien asetteluarvojen 
ryhmät, jotka ovat samoja kuin Filter ikkunassakin olevat. 

Device parameter set sarakkeessa näytetään asetteluarvo joka on 
tallentuneena SIPROTEC® laitteen pysyvään muistiin. 

File parameter set sarakkeessa näytetään asetteluarvo joka on 
tallentuneena tietokoneen pysyvään muistiin.

• Print painikkeella voidaan tulostaa havaitut poikkeamat tai tallentaa 
tulostustiedostoon. Lisätietoja tulostuksesta on esitetty kappaleessa 
4.10.

• Vertailuikkuna suljetaan Close painikkeella. 

Offline / Offline 
vertailu

Laiteparametrejä voidaan vertailla offline vertailulla seuraavasti:

• Avataan laite Offline tilassa ja valitaan valikosta Compare 
Parameters toiminta.

digsi700.gif

Kuva 4-33  Parametrien vertailu offline tilassa

• Painetaan Compare painiketta.
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• Valitaan vertailtavat ryhmät Filter ikkunassa ja painetaan Start 
painiketta.

digsi701.gif

Kuva 4-34  Parametrien vertailu, suodatus

Kahden laiteparametriryhmän väliset erot esitetään
Differences ikkunassa. 
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4.5 Käyttökieli

DIGSI® 4 ohjelmistossa on kolme eri käyttöaluetta, joihin käyttökieli 
voidaan valita toisistaan riippumattomasti.

DIGSI® 4 operating language
Kielen valinta käyttökieleksi, jota käytetään DIGSI 4 valikoissa. 

PC device language
Tietokoneen käyttökieli jota käytetään SIPROTEC® laitteiden tai 
SIPROTEC® varianttien käsittelyssä tietokoneella. Tämä vaikuttaa 
esimerkiksi DIGSI 4 ohjelmistossa parametrien nimiin valikkopuussa 
tai määrittelymatriisissa. 

SIPROTEC 4 device operating language
SIPROTEC® 4 laitteen käyttökieli. Valittua kieltä käytetään laitteen 
näytöllä oleviin teksteihin. 
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4.5.1 DIGSI 4 käyttökielen valinta

DIGSI 4 ohjelmiston käyttökieli on esivalittu DIGSI 4 ohjelmiston 
asennuksen yhteydessä. Kieli voidaan vaihtaa seuraavasti:

• Valitaan Options→Settings, jolloin aukeaa Customize ikkuna.

DIGSIMAN011

Kuva 4-35  Käyttökielen valinta

• Valitaan haluttu käyttökieli  Language ikkunassa kohdassa National 
Language ja vahvistetaan se OK painikkeella.

• Käynnistetään DIGSI® 4 Manager ohjelmisto uudelleen, jolloin valittu 
käyttökieli astuu voimaan. 

Kaikki laiteriippumattomat ohjauselementit ja tiedot esitetään nyt valitulla 
kielellä.

Ohje:

Edellytyksenä DIGSI® 4 käyttökielen valinnalle on, että vastaava kieli on 
aseteltu myös tietokoneelle. 
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4.5.2 Laitekielen valinta tietokoneelle

Laitekielen valinta tietokoneelle suoritetaan seuraavasti:

• Valitaan SIPROTEC® 4 laite tai SIPROTEC® 4 variantti ja oikealla 
hiiripainikkeella avautuvasta valikosta valitaan Object Properties 
toiminta, jolloin näyttöön aukeaa Properties ikkuna.

DIGSIMAN051

Kuva 4-36  Laitteen ominaisuudet, järjestelmän hallintasivu

• Valitaan System Management sivu ja valitaan PC device language 
alasvetovalikosta haluttu kieli.

• Hyväksytään ilmoitus onnistuneesta valinnasta OK painikkeella ja 
suljetaan myös Properties ikkuna OK painikkeella. 

Nyt tietokoneella esitetään laitteen tiedot valitulla kielellä.

Ohje:

Kun projektiin luodaan SIPROTEC® 4 laite tai SIPROTEC® 4 variantti, 
DIGSI 4 ohjelmiston käyttökieleksi laitteelle valitaan esivalintana 
ohjelmistolle määritelty käyttökieli.

Lisäksi on mahdollista muodostaa oma tekstitietokanta ja käyttää sitä 
laitteen kielenä tietokoneella. Toiminta on kuvattu kappaleessa 4.9. 
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4.5.3 SIPROTEC® laitteen käyttökieli

Kielen valinta on mahdollista vain jos laite tarjoaa halutun 
kielivaihtoehdon. Kieliominaisuudet on määritelty MLFB numerolla.

SIPROTEC® 4 laitteen käyttökieli määritellään seuraavasti:

• Avataan laite ja klikataan navigaatioikkunassa Parameters 
hakemistoa. 

• Valitaan Language toiminta tietoikkunassa, jolloin näyttöön aukeaa 
Change Device Operating Language ikkuna.

DIGSIGB060

Kuva 4-37  Laitteen käyttökielen valinta

• Valitaan haluttu käyttökieli Operating language available kentästä 
ja hyväksytään valinta OK painikkeella. 

Ohje:

Jos kentässä on mahdollista valita user-defined vaihtoehto, on 
käytettävissä käyttäjän itsensä määrittelemä kielitietokantatiedosto. 
Lisätietoja kielitietokannan toteutuksesta on esitetty kappaleessa 4.9. 
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4.6 Salasanat 

SIPROTEC®  4 laitteen asettelut ja ohjaustoiminnat voidaan suojata 
salasanoin. 

Seuraavat salasanamäärittelyt on suoritettu tehdasasetteluna: 

Ohjaukset/merkinantojen asetukset/päivitykset (salasana No. 1)

Lukitusehtojen ohitus (salasana No. 2)

Testaus ja diagnoositoiminnat (salasana No. 4)

Hardware-testivalikot (salasana No. 6)

Yksittäisten parametrien muuttaminen (salasana No. 5)

Parametriryhmien vaihto (salasana No. 7)

Web Monitor Käyttöoikeudet "Kaikki oikeudet" (vain SIPROTEC B&B)

Käyttöoikeudet "Muutosoikeudet" (vain SIPROTEC B&B)

Käyttöoikeudet "Vain lukuoikeudet" (vain SIPROTEC B&B)

Internet-selaimen ja Web Monitor toiminnan avulla SIPROTEC laitteen 
tietoja voidaan lukea ja muuttaa. Käyttöoikeudet voidaan määritellä 
salasanoin.

Salasanojen lisäksi käyttöoikeustasot tulee määritellä. 

Kytkinlaite-
salasanat

Käytettävissä on lisäksi kymmenen kytkinlaitesalasanaa. Nämä voidaan 
liittää vapaasti haluttuihin ohjauksiin. Kytkinlaitesalasanat on tarkoitettu 
käytettäväksi ohjaustoiminnoissa. Kytkinlaitesalasanaa kysytään kun  
toimintaan määriteltyä kytkilaitetta ohjataan. 

Salasanan syöttöpyyntö ilmestyy automaattisesti toiminnan edetessä 
määrättyyn pisteeseen käytettäessä suojaa DIGSI® 4 ohjelmistolla tai 
suoraan SIPROTEC®  suojan ohjauspaneelista. 

Ohje:

Salasanasuojaus luvatonta käyttöä vastaan on voimassa vain online 
käyttötilassa. Asettelumuutoksilta suojaava salasana aktivoituu vasta 
kun asettelut on ladattu laitteelle. Salasanalla ei ole merkitystä
Offline tilassa. 

Salasanojen määrittely pois käytöstä edellyttää että salasanat 
tunnetaan! 
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Salasanoja voidaan muuttaa ainoastaan  DIGSI® 4 ohjelmistolla. 

Salasanoja voidaan muuttaa seuraavasti: 

• Avataan laite, kaksoisklikataan Passwords symbolia, jolloin 
Passwords ikkuna aukeaa. 

digsi011.gif

Kuva 4-38  Salasanat

• Valitaan haluttu salasanaryhmä ja painetaan Change painiketta. 
Tällöin näyttöön aukeaa Change Password ikkuna.

DIGSIGB037

Kuva 4-39  Salasanan muuttaminen

• Syötetään olemassa oleva ja uusi salasana. Syötetyt merkit kuvataan 
tähtisymbolilla. Uusi salasana tulee syöttää myös Confirm new 
password kenttään.

Vahvistetaan muutokset OK painikkeella. 
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Ohje:

• Salasanana käytetään numeroita aina 8 numeroon saakka. 

Toimitettaessa kaikki salasanat on aseteltu tehdasasetteluna 
000000. Web Monitor toiminnan salasanat poikkeavat edellisestä: 
Esiasetteluna on 000002 "Kaikki oikeudet", 000001 "Muutosoikeudet" 
ja 000000 "Vain lukuoikeudet" käyttöoikeuksille.

• Web Monitor toiminnalla on seuraavat määrittelyt : 
Käyttöväylä Vain luku 
Huoltoväylä Vain luku  
Järjestelmäväylä Ei sallittu
Nämä asettelut tulee tarvittaessa muuttaa jotta SIPROTEC laitetta 
voidaan käsitellä halutulla tavalla.

Ohje:

Jos asetteluparametrien vaihtosalasana on unohtunut, voi hotline-
palvelusta pyytää väliaikaisen salasanan. Sen avulla voidaan määritellä 
uusi salasana. 
Hotline-tukipalvelu tarvitsee DIGSI® 4 ohjelmiston 
rekisteröintinumeron ohjelmiston asennuspakkauksesta! 
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Salasanan 
poistaminen 
käytöstä

Käytössä olevat salasanat voidaan tunnistaa salasanaryhmän vieressä 
olevan valintaruudun aktivointimerkistä. Salasanat voidaan ottaa pois 
käytöstä toisistaan riippumattomasti.

• Poistetaan Active sarakkeen valintaruudun merkki salasanan 
poistamiseksi käytöstä. 

DIGSIGB038

Kuva 4-40  Salasanan poistaminen käytöstä

• Syötetään olemassa oleva salasana Password kenttään. Jos 
salasana on syötetty oikein, aktivoituu OK painike. Vahvistetaan 
toiminta OK painikkeella. 

Esiasetteluna kaikki salasanaryhmät ovat käytössä. Salasanat voidaan 
ottaa pois käytöstä toisistaan riippumattomasti. Tällöin salasanat 
poistuvat käytöstä vain tässä istunnossa. Kaikki salasanat palautuvat 
kun DIGSI® 4 ohjelmisto käynnistetään uudelleen.

Salasanan 
aktivoiminen

Salasanat voidaan aktivoida toisistaan riippumattomasti.

• Valitaan Passwords ikkunassa valintaruutu Active sarakkeessa. 
Tällöin salasana aktivoituu ilman erillistä vahvistusta. 

Huomio:

Jos salasana on otettu pois käytöstä, ei sitä kysytä aktivoitaessa 
toimintoa tai ohjausta. Tulee huomata että tällä voi olla odottamattomia 
seurauksia!
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Kaikkien 
salasanojen 
palauttaminen

Jos salasanat ovat unohtuneet, on mahdollista palauttaa kaikki salasanat 
tehdasasetukseensa, 000000. Jotta salasanoja ei voisi palauttaa luvatta, 
ne on suojattu määrätyin menetelmin.

• Passwords ikkunassa painetaan Reset all painiketta. Tällöin 
näyttöön aukeaa Reset passwords ikkuna.

DIGSIGB100

Kuva 4-41  Salasanojen palauttaminen lisenssinumerolla

• Syötetään viisi ensimmäistä numeroa DIGSI® 4 lisenssinumerosta 
ja painetaan Next painiketta. 

DIGSI® 4 ohjelmisto laskee näistä numeroista määrätyllä algoritmilla 
numerosarjan. Tämä numerosarja esitetään Reset passwords 
kentässä.

DIGSIGB135

Kuva 4-42  Salasanojen palauttaminen lisenssiavaimella
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• Seuraavaksi soitetaan DIGSI hotline palveluun. Ilmoitetaan 
tukihenkilölle lisenssinumero ja laskennallisesti saatu DIGSI key 
numerosarja. Tukipalvelu ilmoittaa palautusavaimen (reset key). 

• Syötetään tämä arvokenttään ja painetaan Reset painiketta. 

Nyt kaikki salasanat on palautettu tehdasasetukseen, 000000.

• Painetaan Password ikkunassa OK painiketta, jolloin toiminta 
päättyy.

Salasanakysely Jos toiminta, esimerkiksi ohjaustoiminta tai asetteluarvojen muuttaminen 
on suojattu salasanalla, kysytään ennen toiminnan aktivoimista 
vastaavaa salasanaa Enter Password ikkunassa.

DIGSIGB040

Kuva 4-43  Salasanan syöttäminen

• Syötetään oikea salasana Password for... kentässä ja painetaan OK 
painiketta. 

Jos salasana on syötetty väärin, seuraa siitä virheilmoitus. Vain oikean 
salasanan syöttäminen mahdollistaa toiminnan aktivoinnin. 

Ohje:

Puhelimitse saatu palautusavain toimii vain kerran. 
Jos salasanat tulee palauttaa uudelleen, toimitaan vastaavalla tavalla 
kuin aiemminkin.
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4.7 Tietojen vienti / tuonti

Tuonti- ja vientitoiminnoin (import/export) DIGSI 4 Manager ohjelmisto 
mahdollistaa tietojen hallinnan monipuolisesti. Yrityksen sisäinen 
varmuuskopiointikonsepti tai kunnossapidon laatuohjeet voivat 
edellyttää tietojen eri tasoista tallennusta tai tietojen käytön 
mahdollistamista muiden osastojen tarpeisiin. 

Seuraavassa on lueteltu tiedot joita voidaan tuoda ja viedä projektissa.

SIPROTEC® laitteen tiedot kokonaisuudessaan

Suojaustoimintojen asettelut OMICRON formaatissa

Häiriötallenteet COMTRADE formaatissa

Konfigurointi ja suojaustoimintojen asettelut ELCAD formaatissa

Järjestelmäväylään määritellyt informaatiot DBASE formaatissa

Laite- ja asematiedot IEC 61850 kommunikaatiolle

Im-export.gif

Kuva 4-44  DIGSI 4 Manager, tietojen tuonti ja vienti

Sekä SIPROTEC® laitteen ja SIPROTEC variantin tietoja voidaan 
viedä ja tuoda. On myös mahdollista tuoda ja viedä informaatioita, joita 
tarvitaan IEC 61850 liikennöinnin määrittelyssä ja muodostaa niistä 
tarvittavat liikennöintimäärittelyt (sisältäen mahdollisesti myös muiden 
valmistajien laitteita).

Viennin aikana kaikki SIPROTEC® laitteen tiedot pakataan ja 
tallennetaan tiedostoon. Pakkaaminen ja tietojen uudelleen avaaminen 
suoritetaan automaattisesti. Kaikki toiminnan määrittelyt on esiaseteltu 
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eikä niitä voi muuttaa. Tietojen tuonnin yhteydessä SIPROTEC® laitteen 
tiedot avataan tästä tiedostosta alkuperäiseen muotoon. Tiedot ovat 
jälleen käytettävissä kun toiminta on suoritettu.

4.7.1 Tietojen vienti SIPROTEC® laitteelta

DIGSI 4 Manager ohjelmisto tukee laitteen ja aseman tietojen vienti- ja 
tuontitapahtumia. Viennin aikana kaikki laitteen tai IEC 61850 aseman 
tiedot pakataan ja tallennetaan tiedostoon. Tietojen tuonnin yhteydessä 
laitteen tiedot avataan tästä tiedostosta. Tiedot ovat jälleen käytettävissä 
kun toiminta on suoritettu.

Laitteen ja aseman tietojen vienti ja tuonti voi olla tarpeen seuraavista 
syistä:

• Laitteen tietoja halutaan arkistoida.

• Laitteen tiedot halutaan siirtää toiseen projektiin tai toiseen 
tietokoneeseen. 

• Halutaan liittää esimerkiksi muiden valmistajien laitteita IEC 61850 
projektin järjestelmätopologiaan.

• On tarve käsitellä muun valmistajan järjestelmäkonfiguraattorin 
luomaa asematietokantaa.

• On tarve liittää asemia, jotka on muodostettu toisen valmistajan 
järjestelmäkonfiguraattorilla, käsiteltävän projektin topologiaan.

SIPROTEC® laitteen tai SIPROTEC variantin tiedot voidaan viedä 
projektista seuraavasti: 

• DIGSI 4 Manager ohjelmistossa valitaan haluttu laite ja avataan 
oikealla hiiripainikkeella toimintavalikko ja valitaan sieltä edelleen 
Export Device toiminta, jolloin näyttöön aukeaa Export ikkuna.

DIGSMAN059

Kuva 4-45  Tietojen vienti projektista

• Valitaan haluttu tallennuspolku ja määritellään tiedostolle nimi. 
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DIGSI® 4 on määritellyt esiavalintana tiedostonimen valitun laitteen 
mukaisesti. SIPROTEC 4 laitteilla tiedoston päätteenä on .dex, 
SIPROTEC 3 laitteilla .de3 ja SIPROTEC 2 laitteilla .de2. Vietäessä 
tietoja IEC 61850 kommunikaatioon, on tiedoston päätteenä .icd 
(laite) tai .scd (asema).

• Vahvistetaan määrittelyt OK painikkeella. 
Tietojen vienti käynnistyy.

Ohje:

Tulee huomioida että vain ne tiedot, jotka ovat tallentuneina DIGSI® 4 
ohjelmiston muodostamaan hakemistoon, voidaan viedä projektista.  

Sähköaseman projektitiedostoja ei yleensä tallenneta DIGSI 
projektihakemistoon. SIEMENS suosittelee että projektin muut tiedostot 
varmuuskopioidaan erikseen.
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4.7.2 Tietojen tuonti projektiin

SIPROTEC® laitteiden tiedot voidaan tuoda projektiin eri menetelmin. 
Kohteen valinta määrittelee kuinka tuonti projektiin tapahtuu.

Uuteen objektiin SIPROTEC® 4 variantti - objektityyppi
Jos kohteeksi on valittu tämä objektityyppi, säilyy VD osoite tuotaessa 
alkuperäisenä. Tämän objektityypin kanssa voidaan kommunikoida 
samoin määrittelyin kuin alkuperäinen SIPROTEC® 4 laitetiedosto 
on ne määritellyt. Suoralla liikennöinnillä tässä tapauksessa 
tarkoitetaan että SIPROTEC® 4 laitetta ei tarvitse initialisoida. 
SIPROTEC® 4 variantti objektityypin haittana on se, että sitä ei voi 
hyödyntää täysin SICAM plusTOOLS ohjelmistossa.

SIPROTEC® 4 laite - objektityyppi
Kun tämä objektityyppi on valittu kohteeksi, päivitetään VD osoite 
siten, että vastaavaa osoitetta ei ole vielä projektissa käytetty. 
Käytettäessä SIPROTEC® 4 laite objektityyppiä tiedon tuontiin, 
edellyttää se että laite initialisoidaan ennen kuin sen kanssa voidaan 
kommunikoida. SIPROTEC® 4 laitteen objektityypin etuna on, että 
sitä voidaan käyttää SICAM plusTOOLS ohjelmistossa tietojen 
automaattiseen päivitykseen.

Objektityypit SIPROTEC® 2 variantti ja SIPROTEC® 3 variantti
Kun nämä objektityypit on valittu kohteeksi, säilyvät IEC osoitteet 
(laiteosoite) tuotaessa alkuperäisinä. Tämä mahdollistaa suoran 
kommunikoinnin SIPROTEC® 2 tai SIPROTEC® 3 laitteiden kanssa 
luodulla tiedostolla suoraan. Suoralla liikennöinnillä tässä 
tapauksessa tarkoitetaan että  SIPROTEC laitteen kanssa voidaan 
kommunikoida ilman että se tulisi ensin initialisoida. 

Objektityypit SIPROTEC® 2 laite ja SIPROTEC® 3 laite
Kun kohteeksi on valittu tämä objektityyppi, päivittyvät IEC osoitteet 
(laiteosoite) siten, että vastaavaa numeroa ei ole projektissa vielä 
käytetty. Tällöin SIPROTEC® laitteen kanssa kommunikointi juuri 
tuodulla tiedostolla edellyttää laitteen initialisointia.

Tiedot tuodaan projektiin seuraavasti:

• Valitaan DIGSI 4 Manager projektirakenteesta taso jolle SIPROTEC 
variantti halutaan tuoda ja valitaan Import Device toiminta valikosta, 
jolloin Import device ikkuna aukeaa näytölle.
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DIGSIMAN079.tif

Kuva 4-46  Laitetietojen tuonti projektiin

• Valitaan Type alasvetovalikosta minkä version SIPROTEC laite 
projektiin halutaan tuoda.

• Valitaan jompi kumpi objektityyppi vaihtoehto ja hyväksytään valinta 
OK painikkeella. 

DIGSMAN060

Kuva 4-47  Uuden objektin tuonti projektiin

• Valitaan haluttu .dex päätteinen tiedoston nimi, joka halutaan tuoda 
projektiin, Import ikkunasta.

Valitun SIPROTEC® laitteen tiedot esitetään ikkunan alaosassa 
olevassa kentässä. 

• Vahvistetaan määrittelyt OK painikkeella. 
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Kun tuontitapahtuma on päättynyt, on uusi objekti sijoitettu 
projektirakenteeseen.

Olemassa olevaan 
objektiin

SIPROTEC® laite voidaan tuoda suoraan olemassa olevaan SIPROTEC 
laitteeseen.

Toiminnan edellytyksenä on, että kohdeobjektin ominaisuudet ovat 
samat kuin tuotavalla objektillakin. SIPROTEC 4 laitteilla näitä ovat 
tilausnumero ja parametriryhmän versio, parametriryhmän ID tunnus ja 
VD osoite. SIPROTEC 2 ja SIPROTEC 3 laitteilla näitä ovat 
tilausnumero, firmware-versio ja IEC osoite (laiteosoite).

Tämä tapahtuu seuraavasti:

• DIGSI 4 Manager ohjelmistossa valitaan SIPROTEC laite jonka 
päälle halutaan tuoda uudet tiedot. Oikealla hiiripainikkeella avatusta 
valikosta valitaan Import Device, jolloin näyttöön aukeaa Import 
ikkuna.

DIGSMAN061

Kuva 4-48  Tietojen tuonti olemassa olevan laitteen päälle

Huomio:

Tuotaessa uusi objekti olemassa olevan päälle tuhoutuvat olemassa 
olevan  SIPROTEC laitteen tiedot!
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• Valitaan siirrettävä tiedosto ja hyväksytään valinta OK painikkeella.

Ennen tuontia DIGSI® 4 vertailee laitteen ja tuotavan tiedoston 
ominaisuudet. Jos tiedot eivät ole yhteneviä, keskeytyy tuontitapahtuma.

4.7.3 Suojaustoimintojen asetteluiden vienti

DIGSI® 4 ohjelmisto mahdollistaa määrättyjen suojausasettelutietojen 
viennin projektista OMICRON formaatissa. Näitä ovat suojaustoimintojen 
asetteluarvot joita voidaan hyödyntää 7VP15 OMICRON 
koestuslaitteessa.

Vientitoiminta voidaan suorittaa DIGSI 4 Device Editor ohjelmassa 
suojaustoimintojen asetteluikkunasta. Tällöin asetteluikkunassa on 
Export painike aktivoituna, jos suojaustoiminnan parametrejä voidaan 
hyödyntää  7VP15 koestuslaitteella. 

Tämä tapahtuu seuraavasti:

• Painetaan Export painiketta, jolloin näyttöön aukeaa RIO Export 
ikkuna. 

DIGSIGB053

Kuva 4-49  RIO Export

• Muutetaan OMICRON asetteluparametrejä tarvittaessa ja 
hyväksytään arvot OK painikkeella 

Asetteluiden merkitykset on kuvattu yksityiskohtaisesti OMICRON 
koestuslaitteen käyttöohjeessa. 

Tämän jälkeen näyttöön aukeaa Save As ikkuna.
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4.7.4 Häriötallenteiden vienti

Häiriötallenteet voidaan viedä COMTRADE formaatissa, jolloin häiriötä 
voidaan analysoida eri häiriöntallennin ohjelmistoilla. 
Häiriöntallennuksen tiedot viedään ensiöarvoina ASCII formaatissa. 
Joillakin SIPROTEC® 4 laitteilla ei ole häiriötallennin toimintaa (esim. 
6MD63 ja 6MD66).

Tämä tapahtuu seuraavasti:

• Avataan laite ja valitaan haluttu häiriö ja aktivoidaan valikosta Export 
toiminta.  

Jos kyseessä on SIPROTEC® distanssisuojatoiminta, viedään myös 
laukaisuaikaominaiskäyrän asetteluarvot. Näillä tiedoilla voidaan esittää 
impedanssivyöhykkeet häiriöntallennusten käsittelyohjelmistoissa, kuten 
esimerkiksi SIGRA ohjelmassa. 

Laukaisuominaiskäyrän asettelut voivat poiketa toisistaan eri 
asetteluryhmissä. Tästä syystä tulee käytetty asetteluryhmä valita käsin. 

• Select Parameter Group ikkunassa valitaan asetteluryhmä, joka on 
ollut häiriön aikana aktiivisena ja hyväksytään valinta OK painikkeella.

.

DIGSIGB124

Kuva 4-50  Asetteluryhmän valinta

Tällöin näyttöön aukeaa Export ikkuna. 

• Määritellään tiedostolle nimi ja tallennushakemisto ja hyväksytään 
määrittelyt OK painikkeella. Ohjelmisto määrittelee tiedostolle 
automaattisesti .cfg päätteen. 

Ohje:

Häiriöntallennus tallentuu eri tiedostoina, joiden päätteet ovat .cfg, .dat 
ja .rio.
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4.7.5 Konfigurointi ja suojausasetteluarvojen vienti

Projektin dokumentointia varten suojausasettelut, binääriset tulot, lähdöt, 
ledit ja järjestelmäväylään välitetyt tiedot voidaan viedä projektista 
ELCAD formaatissa. Asetteluparametrit ja määrittelyt jaetaan erillisille 
sivuille ja tallennetaan tiedostoon. 

Tämä tapahtuu seuraavasti:

• Avataan laite ja valitaan Export → Configuration and Protection 
Parameters valikosta ja valitaan edelleen Export - ASCII/ELCAD.

• Määritellään vietävän tiedoston nimi ja tallennuspolku ja hyväksytään 
määrittelyt  OK painikkeella. Tiedostolla on .elc pääte 
esimäärittelynä. 

Tällöin näyttöön aukeaa Export - ASCII/ELCAD ikkuna.

DIGSIGB150

Kuva 4-51  ASCII/ELCAD tiedoston vienti

Ohje:

Tiedosto voidaan avata vain viimeisimmällä ELCAD ohjelmistoversiolla. 
Vanhemmat versiot eivät välttämättä pysty tuomaan kaikkia tietoja 
tiedostosta.
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• Suoritetaan seuraavat määrittelyt:

System archive, järjestelmäarkiston nimi

Level 2, dokumenttityypin määrittely

Level 3, Z-osan määrittely

Level 4, sivun lyhyt määrittely

Level 5, sivunumero 

Type of form sheet, käytetty mallisivun tyyppi. 
Valittu mallisivu täytyy olla olemassa ELCAD ohjelmiston kirjastossa.

• Valitaan Use as standard, jos määriteltyjä asetteluita halutaan 
käyttää tulevissa vientitapahtumissa.

4.7.6 Järjestelmäväylän tietojen vienti

IEC järjestelmäväylään määritellyt informaatiot voidaan viedä projektista. 
Toiminnan avulla voidaan esimerkiksi määrittelymatriisin sisältöä 
käsitellä EXCEL ohjelmassa dokumentaatiota varten. 
Tarvittavat tiedot kuten informaatioteksti, funktionumero ja informaation 
tyyppi on tallennettu DBASE formaattiin.

Tämä tapahtuu seuraavasti:

• DIGSI 4 Manager ohjelmassa valitaan Export → System Interface, 
jolloin näyttöön aukeaa Interface Export ikkuna.

• Valitaan vietävälle tiedostolle nimi ja tallennuspolku ja vahvistetaan 
määrittelyt OK painikkeella. Tiedostolla on .dbf pääte 
esimäärittelynä. 

Näyttöön aukeaa Report ikkuna. Toiminnan kulku on kuvattu System 
Interface Export ikkunassa.
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4.8 SIPROTEC 4 laitetyyppien päivittäminen

SIPROTEC® 4 laitetyyppejä kehitetään ja parannetaan jatkuvasti. Uuden 
DIGSI 4 ohjelmistopaketin mukana toimitetaan kaikki siihen mennessä 
voimassa olevat laiteversiot. 
Tämän jälkeen uudet laitetyypit voidaan päivittää DIGSI 4 ohjelmistoon 
lataamalla ne internetistä sivulta www.siprotec.de. Asennuksen jälkeen 
ne ovat käytettävissä laitekatalogissa.

4.8.1 Uuden laitetyypin asennus

Uusi laitetyyppi asennetaan ohjelmistoon seuraavasti:

• Suljetaan kaikki DIGSI® 4 ohjelmiston komponentit ennen uuden 
SIPROTEC® 4 laitetyypin asennusta. 

• Sijoitetaan DIGSI 4 asennus-CD asemaan ja käynnistetään 
Setup.exe ohjelma hakemistosta ..:\Disk1\Siprotec\ directory.

• Seurataan asennusohjeita kunnes näyttöön tulee Install or Update 
Device Types ikkuna.

• Valitaan Install New Device Types vaihtoehto. 

• Siirrytään eteenpäin Next painikkeella, jonka jälkeen valitaan haluttu 
kieli ja mennään edelleen eteenpäin Next painikkeella.

Tällöin näyttöön aukeaa Install device types ikkuna.

DIGSIMAN082

Kuva 4-52  Uusien laitetyyppien asennus

• Valitaan kaikki halutut laitteet Components ikkunasta. 
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Laitenimet edustavat laitetyyppiryhmää, johon voi kuulua useampia eri 
laitteita. 
Esiasetteluna kaikki laitetyypit on valittuna. 
Jos on valittu laitetyyppi, joka on jo asennettuna tietokoneelle, 
päivitetään olemassa olevat versiot. 

• Jos laitetyyppien versioita halutaan muuttaa, painetaan halutun 
laitteen kohdalta Change painiketta, jolloin näyttöön tulee Select 
Sub-components ikkuna.

DIGSIMAN083

Kuva 4-53  Laiteversioiden valinta

• Valitaan asennettavat versiot ja hyväksytään valinnat Continue 
painikkeella. 

Valintaikkuna sulkeutuu. Näyttöön palaa Install device types ikkuna. 

• Käynnistetään asennustoiminta Next painikkeella. 

Asennuksen aikana näytöllä on esitetty asennusprosessin eteneminen.
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4.8.2 Olemassa olevien laitetyyppien päivittäminen

Olemassa olevien laitetyyppien versiot voidaan päivittää seuraavasti:

• Install or Update Device Types ikkunassa valitaan vaihtoehto 
Update existing device types. 

• Siirrytään eteenpäin Next, valitaan haluttu kieli ja jatketaan edelleen 
Next painikkeella.

Tällöin näyttöön aukeaa Specify scope ikkuna.

DIGSIMAN084

Kuva 4-54  Päivitettävien laitteiden valintaikkuna

• Valitaan Update all existing device types vaihtoehto, jos halutaan 
päivittää tietokoneelle asennetut laiteversiot, jonka jälkeen jatketaan 
asennusta Next painikkeella. 

Päivitysprosessi käynnistyy välittömästi.

• Valitaan User-defined selection vaihtoehto, jos halutaan määritellä 
mitkä laitetyypit päivitetään, jonka jälkeen asennusta jatketaan Next 
painikkeella. 

• Valitaan päivitettävät laitteet Update device types ikkunan 
Components kentässä ja jatketaan asennusta Next painikkeella.

Päivitysprosessi voidaan vaihtaa asennusprosessiin valitsemalla uusi 
laiteryhmä asennettavaksi (katso kappale 4.8.1).
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4.8.3 SIPROTEC 4 laitteiden päivitys projektissa

Uusien laitetyyppien tai olemassa olevien laitetyyppien päivitykset 
DIGSI® 4 ohjelmassa vaikuttavat vain laitetyyppeihin, jotka on 
valittavissa laitekatalogissa. Tämä ei vaikuta automaattisesti jo 
projektissa oleviin SIPROTEC® 4 laitteisiin tai SIPROTEC® 4 
variantteihin. DIGSI® 4 ohjelmistossa on mahdollisuus päivittää myös 
olemassa olevat objektit. Päivityksen yhteydessä asetteluparametrit ja 
laitetekstit päivittyvät. Päivityksen avulla saadaan uusi versio käyttöön 
ilman että objektia täytyisi luoda uudestaan.

Parametriryhmä on identifioitu versionumerolla. Valittaessa laitetta 
luontikatalogista valittavissa olevat laitteet on varustettu versionumeroin. 
Valittavissa on kaikki tietokoneeseen asennetut laiteversiot. 

DIGSIMAN007

Kuva 4-55  Laitekatalogi

Huomio:

Jos päivitetään parametriryhmää siten että sen ensimmäinen 
desimaalinumero muuttuu, tulee myös SIPROTEC® 4 laitteen firmware 
päivittää joka tapauksessa. Jos kuitenkin SIPROTEC®  4 laitteen 
firmware päivitetään, ei välttämättä parametriryhmän versiota tarvitse 
päivittää.
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Päivitystä ei tarvitse suorittaa jos päivitettäessä vaihtuu versionumeron 
toinen desimaalinumero. Eroja ei ole suoraan ilmaistu laitekatalogissa. 
Tarkempi versionumero esimerkiksi 4.0 versiolla esitetään kun laite on 
valittu 4.00 tai 4.01, jne. Parametriryhmän tarkka versionumero on 
esitetty laitekatalogin tilakentässä.

• Projektissa olemassa olevan SIPROTEC® 4 laitteen 
parametriryhmän versio on nähtävissä Object Properties valikosta 
aktivoitavissa olevassa Properties - SIPROTEC® 4 device 
ikkunassa. 

DIGSIman051.tif

Kuva 4-56  SIPROTEC 4 laitteen ominaisuudet ikkuna, Digsi Manager sivu

Digsi Manager sivulla on esitetty olemassa olevan parametriryhmän 
versio. 

Jos uusi parametriryhmäversio on asennettu tietokoneelle ja on 
nähtävissä laitekatalogissa, päivitetään olemassa olevan laitteen 
parametriryhmä seuraavasti:

• Valitaan SIPROTEC® 4 laite tai SIPROTEC® 4 variantti ja oikealla 
hiirinpainikkeella avautuvasta valikosta valitaan Update parameter 
set toiminta, jolloin näyttöön tulee Update parameter set ikkuna. 

DIGSIMAN075

Kuva 4-57  Parametriryhmän päivitys
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Ikkunassa on esitetty voimassa oleva parametriryhmän versio ja 
viimeisin mahdollinen versio johon päivitys on mahdollista. Jos New 
parameter set version kentässä ei ole mitään, tietokoneelle ei ole 
asennettuna uudempaa versiota kuin olemassa oleva parametriryhmä 
on. 

• Valitaan haluttu parametriryhmän versio johon päivitys halutaan 
suorittaa New parameter set version alasvetovalikosta ja 
hyväksytään valinta  OK painikkeella.

Näyttöön aukeaa Report ikkuna. Ikkunasta voidaan seurata 
päivitystapahtuman etenemistä.

DIGSIMAN076

Kuva 4-58  Raportti-ikkuna, esimerkki

Päivitystapahtuman päättyminen on esitetty raportissa. 

• Suljetaan Report ikkuna.
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Objektinimen 
muuttaminen

SIPROTEC® 4 laitetta tai SIPROTEC® 4 varianttia luotaessa DIGSI® 4 
ohjelmisto määrittelee objektin nimen ja automaattisesti myös sen 
hetkisen parametriryhmän versionumeron. 
Parametriryhmää päivitettäessä objektin nimessä oleva versio ei päivity 
automaattisesti. 

• Tarvittaessa objektin nimessä oleva versionumero tulee päivittää 
käsin.

Ohje:

Tulee ottaa yhteyttä DIGSI® 4 Hotline palveluun, jos päivityksessä 
esiintyy ongelmia. 
On suositeltavaa että käsillä on .txt ja .log päätteiset tiedostot ongelman 
selvitystä varten. Näiden tiedostojen tallennuspolku on esitetty 
tapahtumakentässä laitteen päivityksen yhteydessä (katso kuva 4-58 ).
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Käyttäjän määrittelemän tekstitietokannan luonti ja käyttö
4.9 Käyttäjän määrittelemän tekstitietokannan luonti ja käyttö

Kaikki kielivalintaan liittyvät tekstit tietokoneella ja laitteella on tallennettu 
tiedostoon. Jos käytettävissä on useampia kieliä, on jokaisella kielellä 
oma tiedostonsa. 

Tekstitiedoston nimi muodostuu seuraavista osista:

SIPROTEC® 4 laiteperheen tyyppitunnus,

Tunnistekirjain kielelle ja

Tiedoston päätetyyppi .dbf. 

Tiedosto 7SJ63x_a.dbf on esimerkiksi SIPROTEC® 4 laitteiden 7SJ63x 
(7SJ631, 7SJ632, jne.) saksankielinen (kirjaintunnus a) tekstitiedosto. 

Lisäksi on olemassa tiedosto ChrDef(x).dbf jokaiselle kielelle. (x) kuvaa 
kielitunnusta.

On mahdollista luoda oma tekstitietokanta käyttämällä 
tietokantaohjelmistoa, joka pystyy käsittelemään dBase formaatissa 
olevaa tiedostoa. Näin luotuja tekstejä voidaan käyttää tietokoneen tai 
laitteen teksteinä. Ei ole suositeltavaa käyttää tiedostojen käsittelyssä 
tavallista taulukkolaskentaohjelmaa.

Tiedostot on tallennettu polkuihin 
..\Manager\p7di\geratyps\<Type_group>, esimerkiksi 
k:\Siemens\DIGSI4\Manager\p7di\geratyps\7SJ63x. 

Tämä tapahtuu seuraavasti:

• Luodaan ensin kopiot yhteenkuuluvista tiedostoista, esimerkiksi 
tiedostot 7SJ63x_a.dbf ja ChrDefa.dbf. 
Tiedostoa ChrDefa.dbf ei saa muuttaa!

• Muutetaan tiedostojen kielitunnuskirjaimeksi i kopioituihin 
tiedostoihin. 

Jos DIGSI® 4 ohjelmisto tunnistaa yllämainitulla kirjaintunnuksella 
varustettuja tiedostoja hakemistopolussa, tulee kielen valintakenttään 
valittavaksi User-defined kielivaihtoehto. Lisätietoja kielen valinnasta on 
esitetty kappaleessa 4.5. 

• Avataan kopioitu tiedosto, esimerkiksi 7SJ63x_i.dbf, dBase 
formaattia käsittelevässä editorissa ja vaihdetaan Text ja D_Text 
kenttien tekstit halutulle kielelle. 

Ensimmäinen Text kenttä sisältää ns. lyhyen tekstin. Suurin sallittu 
merkkien määrä on esitetty L sarakkeessa. Mitään erikoismerkkejä ei 
saa käyttää. 
D_Text sarakkeessa on määritelty näyttöteksti. Suurin sallittu merkkien 
lukumäärä on esitetty D_L sarakkeessa.

Muissa sarakkeissa olevia arvoja ei saa muuttaa!

• Tallennetaan muutettu tiedosto.
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4.10 Tulostaminen

Projektin eri osiot voidaan tulostaa dokumentointia varten. Tulostusta 
varten käytetään Windows käyttöjärjestelmän vakiotoimintoja: 

Kirjoittimen valinta ja asetteluiden määrittely. Tällöin määritellään 
paperiformaatti, kirjasinlaji, tulostuslaatu, jne.

Tulostettavan sivun layout. Tällöin määritellään muun muassa 
"headers" ja "footers" osiot, sekä marginaalit, jne.

Objektiluettelo tulostetaan kokonaisuudessaan vain vaakaformaatissa.

Kun yllämainitut määrittelyt on suoritettu, on mahdollista:

Tulostaa objektiluettelo tai

Tulostaa valitut informaatiot.

4.10.1 Objektiluettelon tulostaminen

Projektissa olevat objektit voidaan tulostaa objektiluettelona. Listassa on 
esitetty informaatiot puurakenteena tai sisältöikkunana. 

Tämä tapahtuu seuraavasti:

• Valitaan File → Print → Object List, jolloin näyttöön aukeaa Print 
Object List ikkuna.

DIGSIMAN069

Kuva 4-59  Objektiluettelon tulostaminen
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Tulostaminen
• Valitaan tulostin, johon tulostus halutaan ohjata.

• Valitaan Print to file vaihtoehto, jos halutaan muodostaa 
tulostustiedosto. Tällöin tulostusta ei ohjata kirjoittimelle vaan se 
tallennetaan tiedostoon.

• Valitaan Tree window vaihtoehto, jos tulostus halutaan toteuttaa 
puurakenteena. Jos kaikki objektitasot halutaan esittää 
puurakenteessa, tulee lisäksi valita Show all levels valinta.

• Vaihtoehtoisesti voidaan valita Contents window, jos näkyvissä 
olevat objektit halutaan tulostaa listamuodossa. Tällöin tulostuu 
vastaavat tiedot kuin "detailed view" käyttötilassakin esitetään. Tällöin 
taulukossa esitetään objektin nimi, tyyppi, koko (yleensä 0), haltija, 
muutokset ja kommentit.

• Jos valitaan Print Total(s) vaihtoehto, lisätään "Size" sarakkeen 
arvot ja tulostetaan myös ne.

• Valitaan All vaihtoehto, jos halutaan tulostaa kokonaisuudessaan 
puurakenteen tai listanäytön näkyvissä oleva alue. 

• Vaihtoehtoisesti voidaan Select vaihtoehdolla valita tulostettavat 
osiot. Select valinta on käytettävissä vain jos tulostettavaksi on valittu 
objekti.

• Tulostus käynnistetään halutuin asetteluin OK painikkeella. 

Tulostettava informaatio täydentyy vielä valitun objektin nimellä ja 
projektihierarkian polulla. 
Jokaiselle sivulle tulostuu myös "header" ja "footer" osioihin tiedot jotka 
sinne on määritelty.

Objektiluettelo tulostetaan kokonaisuudessaan vain vaakaformaatissa. 
Jos pystyformaatti on valittu käyttöön, tulee ennen tulostusta näyttöön 
kysymysikkuna jossa pyydetään vahvistusta valinnalle.
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4.10.2 Valittujen tietojen tulostaminen

Koko ikkunassa olevan sisällön tulostuksen sijaan on mahdollista valita 
tulostettavaksi vain osa informaatiosta tai tulostaa ne kaikki.

Tämä tapahtuu seuraavasti:

• Avataan laite jonka tiedot halutaan tulostaa.

• Valitaan File → Print , jolloin näyttöön aukeaa Print Options ikkuna.

DIGISGB095

Kuva 4-60  Tulostettavien informaatioiden valinta

• Select kentässä valitaan informaatiot jotka halutaan tulostaa. 
Määrätyissä ryhmissä voidaan suorittaa vielä lisävalintoja. Kun 
haluttu ryhmä on valittu, tulee ryhmälle ominaiset käytettävissä olevat 
lisävalinnat valittaviksi tai vaihtoehtoisesti voidaan valita kaikki 
aktivoimalla All määritys. 

• Valitut määrittelyt hyväksytään OK painikkeella.
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Konfigurointi 5
Konfiguroinnilla SIPROTEC® laitteiden toiminnallisuus määritellään 
vastaamaan suojattavan kohteen ominaisuuksia.

Tässä kappaleessa on kuvattu SIPROTEC® laitteiden konfiguroinnin 
perustoiminnat. Kappaleessa käytetyt asettelut ja toiminnat ovat 
laitekohteisia ja täten tässä yhteydessä vain esimerkkejä.

Sisältö 5.1  Asetteluparametrit  156

5.2  SIPROTEC 4 laitteen ominaisuudet  159
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Konfigurointi
5.1 Asetteluparametrit

Parametrejä aseteltaessa SIPROTEC 4 laitteille määritellään:

Mitkä toiminnat tulevat käyttöön,

Mitä tietoja, mittaussuureita ja ohjauksia liitetään tuloihin ja lähtöihin,

Tarvittaessa muodostetaan DIGSI® 4 CFC logiikkatoimintoja,

Mitä tietoja esitetään laitteen näytöllä,

Mitä liikennöintiväyliä otetaan käyttöön,

Kuinka laitteen sisäinen kello tahdistetaan. 

SIPROTEC 4 laitteiden asettelut voidaan tehdä DIGSI® 4 ohjelmistolla 
Offline tilassa. Tällöin ei tarvitse olla yhteyttä laitteeseen. 

Käytössä olevia asetteluita voidaan myöhemmin muuttaa suoraan 
laitteella Online tilassa tai ilman laitetta Offline tilassa. 

Käyttö- ja asettelumahdollisuudet offline ja online tiloissa on kuvattu 
kappaleessa 4.3.3.  Tietoja asetteluiden muuttamisesta ja 
tallennuksesta on esitetty kappaleessa 4.4.

Ohje:
Online tilassa asettelut ja CFC toiminnat on suojattu 
asetteluryhmäsalasanalla. 

Yksittäisten asetusten muuttaminen online tilassa on suojattu 
yksittäisten asetteluiden salasanalla.
156 SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Asetteluparametrit
Toiminnan kulku • Ensin luodaan laite projektiin (katso kappale 4.3.1). 

• Avataan laitteen ominaisuudet Object properties ikkunaan ja 
tarkastetaan siellä olevat asettelut ja tarvittaessa muutetaan (katso 
kappale 5.2).

• Avataan laite Offline tilassa (katso kappale 4.3.4).

• Valitaan navigaatioikkunasta hakemisto Settings.

Parametrien asettelumahdollisuudet avautuvat ikkunaan ja ne ovat 
riippuvaisia laitteen toiminnallisuudesta.

DIGSIGB035

Kuva 5-1  Toiminnat, esimerkki

Toiminnallisuus (Device Configuration)
Laitteen toimintojen määrittely käyttöön.

Määrittelymatriisi (Masking I/O)
Laitteen informaatioiden liittäminen ja niiden ominaisuuksien 
määrittely matriisissa.

Perusnäyttö (Default display)
SIPROTEC 4 laitteen perusnäytön määrittely tai muuttaminen DIGSI 
4 Display Editor ohjelmalla. 

Ohjausnäyttö (Control display)
SIPROTEC 4 laitteen ohjausnäytön määrittely tai muuttaminen DIGSI 
4 Display Editor ohjelmalla. 

CFC 
Loogisten funktioiden luonti SIPROTEC 4 laitteelle DIGSI 4 CFC 
ohjelmalla. 

Mitta-arvon muuntimet (Measuring transducers)
Mitta-arvonmuunnin toiminnat.

Tahdistus (Synchronization)
Tahdistustoiminnat.
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Konfigurointi
Suojattavan kohteen tiedot (Power system data)
Asetteluryhmän riippumattomat tiedot suojattavasta kohteesta.

Asetteluryhmät A ... D (Setting Group A ... D)
Asetteluparametrien ryhmät.

Asetteluryhmien vaihtotoiminta (Change group)
Käytössä olevan asetteluryhmän määrittely tai asetteluryhmän 
vaihtotavan valinta.

Häiriöntallennus (Oscillographic Records)
Häiriötallennintoiminnan asettelut.

Laitemäärittelyt (General Devise Settings)
Laitteen perusominaisuuksien määrittely asetteluryhmistä 
riippumattomasti.

Ajantahdistus (Time synchronization)
Sisäisen kellon tahdistustavan määrittely.

Liikennöintiväylät (Serial Ports)
DIGSI® 4 ja muiden laitteen liikennöintiväylien asettelut. 

Salasanat (Passwords)
Laitteen salasanojen määrittely luvatonta käyttöä vastaan.

Käyttökieli (Language)
Laitteen etupaneelin käyttökielen määrittely.

Ohje:
Käytettävissä olevat objektit riippuvat  DIGSI 4 ohjelmistoversiosta,  
SIPROTEC® laitteen tyypistä, toiminnallisuuden ja MLFB numeron 
määrittelyistä DIGSI 4 Manager ohjelmistossa. Esimerkiksi 
asetteluryhmät B ... D ja asetteluryhmien vaihtotavan määrittely ovat 
käytettävissä vain jos asetteluryhmät on aktivoitu käyttöön laitteen 
toiminnallisuutta määriteltäessä. Käyttökieltä määriteltäessä valittavissa 
ovat vain kielet jotka on määritelty MLFB numerossa.
158 SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


SIPROTEC 4 laitteen ominaisuudet
5.2 SIPROTEC 4 laitteen ominaisuudet

Laitetta luotaessa DIGSI 4 Managerilla projektiin määritellään oleellisia 
tietoja laitteesta, kuten laitteen tyyppi MLFB numerolla. DIGSI 4 Manager 
ohjelmassa voidaan näyttää ja tarvittaessa muuttaa laitteen 
ominaisuuksia (Object properties). 

• Valitaan laite DIGSI 4 Manager ikkunassa ja avataan oikealla 
hiiripainikkeella valikosta Object properties, jolloin näyttöön aukeaa 
Properties -SIPROTEC 4 device ikkuna.

Properties - SIPROTEC 4 device ikkunassa on seuraavat sivut:

Yleistä (General)
Laitteen yleisiä omianisuuksia.

MLFB
Laitteen toiminnallisuuden ja version määrittelevä MLFB 
numerosarja.

Kommunikaatiomodulit (Communications modules)
Alkuperäisten tai vaihdettujen liikennöintimodulien määrittelyt, sekä 
lisäprotokollien PROFIBUS DP, DNP 3.0 ja MODBUS määrittelyt ja 
mahdollisen laitekohtaisen prosessiväylän ominaisuudet.

Järjestelmän hallinta (System management)
Tietoja laitekohtaisista hakemistoista ja käyttökielen valinta 
tietokoneelle.

FMS / IEC asettelut (FMS / IEC setting)
Järjestelmäväylän liikennöintiasettelut IEC tai PROFIBUS FMS 
protokollilla.

Laitteiden välinen kommunikaatio (Inter Relay Communication)
Laitteiden välinen suora kommunikaatio on mahdollista määrätyillä 
SIPROTEC 4 laitteilla. 

SIPROTEC 4 variantin ominaisuudet ovat vastaavat kuin SIPROTEC 4 
laitteenkin.

Ohje:
Jos tietokoneelle on asennettu täysi STEP 7 ohjelmisto, on käytettävissä 
myös PROFIBUS FMS Connections sivu. 
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5.2.1 MLFB sivu

MLFB sivulla määritellään SIPROTEC 4 laitteen MLFB tilausnumero 
DIGSI® 4 ohjelmistolle. Laitteen tyyppi ja ominaisuudet on koodattu 
tähän tilausnumeroon. 

Tilausnumeron määrittely vaikuttaa DIGSI® 4 ohjelmiston tarjoamiin 
määrittelymahdollisuuksiin. Muodostettaessa yhteyttä DIGSI® 4 
tietokoneen ja SIPROTEC 4 laitteen välille verrataan DIGSI® 4 
ohjelmistoon tallennettua ja SIPROTEC 4 laitteen MLFB numeroa 
toisiinsa. Yhteys muodostuu vain jos MLFB numerot ovat identtisiä.

DIGSIMAN048

Kuva 5-2  Ominaisuudet - SIPROTEC laite, MLFB sivu

Tilausnumeron 
määrittely

• Valitaan alasvetovalikoista tilauskoodintunnukset, jotka vastaavat 
laitteen tilauskoodia. Alasvetovalikoissa esitetään vain kulloinkin 
kyseessä olevan SIPROTEC 4 laitteen valintamahdollisuudet. 

Joillakin laitetyypeillä on vielä lisäksi lisämääritetunnukset valittavana. 

• Klikataan alasvetovalikon oikealla puolella olevaa painiketta, jolloin 
näyttöön aukeaa MLFB-Extension ikkuna.
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DIGSIMAN049

Kuva 5-3  MLFB lisämääritetunnuksen valintaikkuna

• Valitaan halutut vaihtoehdot alasvetovalikosta ja hyväksytään 
valinnat OK painikkella, jolloin palataan edelliseen ikkunaan. 
Toistetaan tämä toimenpide tarvittaessa myös muille näin 
määriteltäville ominaisuuksille.

5.2.2 Kommunikaatiomodulit sivu

Kommunikaatiomodulit Communications Modules ikkunassa 
määritellään vaihdettavissa olevien kommunikaatiomodulien tyypit. Jos 
liikennöintimoduli on vaihdettu tai lisätty jälkikäteen, tulee  DIGSI® 4 
ohjelmistolle määritellä käytössä olevat modulit tässä ikkunassa. 
Riippuen käyttöön määritellystä liikennöintimodulista, voi olla tarpeen 
muuttaa joitakin asetteluita konfiguroinnissa (katso kappale 7).

5.2.3 Järjestelmän hallinta sivu

Järjestelmän hallinta System Management ikkunassa on esitetty 
muutamia laitekohtaisia tietoja. Lisäksi ikkunassa voidaan määritellä 
käyttökieli tietokoneelle (katso kappale 4.5.2).

5.2.4 Kommunikaatiomodulit sivu

Kommunikaatiomodulit sivulla määritellään asetteluparametrit IEC 
60870-5-103, IEC 61850, PROFIBUS FMS ja kanavakytkin liikennöintien 
ominaisuudet. Näkyvissä on vain asetteluparametrit jotka ovat tarpeen 
kulloinkin kyseessä olevan liikennöintitavan määrittelyssä. Lisätietoja 
kommunikaatioväylien asettelusta on esitetty kappaleessa 7.
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5.3 SIPROTEC 4 laitteen toimintojen määrittely

SIPROTEC 4 laitteen kaikki käytettävissä olevat toiminnat on esitetty 
laitekonfiguraatio Device Configuration ikkunassa DIGSI 4 Device 
Editor ohjelmassa. Ikkunassa voidaan määritellä mitkä käytettävissä 
olevat toiminnat tulevat käyttöön ja samalla määritellä myös toimintojen 
perusasetteluita, kuten esimerkiksi ylivirtaportaan 
laukaisuaikaominaiskäyrän tyyppi. Toiminnallisuuden määrittely 
vaikuttaa myöhemmin näkyvissä oleviin asettelumahdollisuuksiin ja 
käytettävissä oleviin informaatioihin.

Käytettävissä olevien toimintojen määrittelyt voidaan lukea myös 
suoraan laitteen etupaneelista. Siinä niitä ei kuitenkaan voida muuttaa. 
Toiminnat saadaan näyttöön valitsemalla
MAIN MENU → Settings → Device Config. 

Ohje:
Käytettävissä olevat asetteluparametrit on esitetty laitekohtaisissa 
SIPROTEC® käyttöohjeissa. 

Ohje:
Laitteen toimintojen määrittelyt on suojattu asetteluryhmät salasanalla. 
Ilman salasanan syöttöä asettelut voidaan vain lukea. 

Ohje:
Määrätyillä laitteilla ei ole valittavissa olevia toimintoja 
laitekonfiguraatioikkunassa (Device Configuration).
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SIPROTEC 4 laitteen toimintojen määrittely
Laitteen toiminnallisuus määritellään seuraavasti:

• Avataan laite, klikataan setting symbolia kahdesti jolloin näyttöön 
aukeaa Device Configuration ikkuna. 
Käytettävissä olevat toiminnat on esitetty Device Configuration 
ikkunassa.

DIGSIGB042

Kuva 5-4  Laitteen toiminnallisuuden määrittelyikkuna

Device Configuration ikkunassa on esitetty kaikki käytettävissä olevat 
toiminnat funktionumeroin varustettuna. Toiminnan tila on esitetty Scope 
sarakkeessa.

Toiminnallisuuden 
muuttaminen

• Toiminnallisuuden olemassa olevien asetteluiden määrittelyitä 
muutetaan klikkaamalla halutun toiminnan Scope saraketta ja 
valitaan alasvetovalikosta haluttu vaihtoehto.

Toimintakohtaiset 
tiedot

• Valitaan Scope sarake ja klikataan Info painiketta. Näyttöön  tulee 
lisätietoja toiminnasta.

Asetteluiden siirto 
laitteelle

• Valitaan DIGSI -> Device painike, jolla voidaan siirtää muutetut 
määrittelyt SIPROTEC 4 laitteelle. Painike on aktiivinen jos vähintään 
yhtä määrittelyä on muutettu (katso kappale 4.4).

Asetteluiden 
hyväksyntä

• OK painikkeella hyväksytään muutetut asettelut. 
Painike on aktiivinen jos vähintään yhtä asettelua on muutettu. 
Asetteluita ei ole vielä tallennettu parametriryhmään, vaan ne on 
siirretty vasta tietokoneen väliaikaiseen muistiin (katso kappale 4.4). 
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Konfigurointi
5.4 Asetteluryhmien käyttö

Joidenkin SIPROTEC 4 laitteen toimintojen asetteluparametrit on jaettu 
asetteluryhmiin. Yleensä SIPROTEC 4 laitteella on neljät toisistaan 
riippumattomat asetteluryhmät. Ne ovat sisällöltään identtisiä ja 
ainoastaan asetteluarvot yksittäisissä parametreissä voivat poiketa 
toisistaan. Joillakin SIPROTEC 4 laitteilla (esim. 6MD63, 6MD66 ja 
6MD665) ei ole asetteluryhmiä.

Jotta asetteluryhmien aktivointimäärittely Change Group olisi 
käytettävissä, tulee toiminta olla määriteltynä käyttöön existing 
toimintojen määrittelyn yhteydessä. Jotkin toiminnat ovat 
asetteluryhmistä riippumattomia. Näitä ovat esimerkiksi CFC 
logiikkatoiminnat, tahdistustoiminnat ja kellonajan tahdistukset. Nämä 
toiminnat on esitetty DIGSI® 4 ohjelmistossa omina objekteinaan.

Asetteluryhmiä käytetään tallentamaan toimintojen eri tilanteissa 
vaatimat asetteluarvot. Kaikki nämä asetteluryhmät siirretään 
SIPROTEC 4 laitteen muistiin ja niitä voidaan muuttaa:

Käyttäjän toimesta paikallisesti

Tapahtumaohjatusti binäärisin tuloin

Käyttäjän toimesta järjestelmäväylän kautta 

Vain yksi asetteluryhmä on kerrallaan aktiivisena. Voimassa oleva 
asetteluryhmä on esitetty ominaisuudet ikkunassa.

Toimitaan seuraavasti:

• Avataan laite ja klikataan Device → Operating State. Tällöin 
näyttöön aukeaa Operational Status ikkuna.

digsi029.gif

Kuva 5-5  Laitteen toimintatila

• Kaksoisklikataan Change Group objektia. Tällöin näyttöön aukeaa 
Change Group ikkuna.
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Asetteluryhmien käyttö
DIGSIGB044

Kuva 5-6  Asetteluryhmien vaihtotavan määrittely

• Valitaan haluttu toimintatapa Value sarakkeessa alasvetovalikosta:

Jokin asetteluryhmistä A ... D
Työskenneltäessä laitteen kanssa Online tilassa, siirretään käyttöön 
valittu asetteluryhmämuutos DIGSI -> Device painikkeella laitteen 
muistiin. Muussa tapauksessa muutettu asettelu tallennetaan ja se 
aktivoituu vasta kun seuraavan kerran asettelut siirretään laitteelle.

Valinta binäärisin tuloin 
Asetteluryhmien aktivointi suoritetaan tuomalla binäärisin tuloin 
haluttu tieto ohjaamaan asetteluryhmiä. Määrittelymatriisissa valitaan 
mitkä binääriset tulot ohjaavat asetteluryhmiä. 

Valinta liikennöintiprotokollalla
Asetteluryhmien aktivointi suoritetaan kauko-ohjattuna 
järjestelmäväylää pitkin.

Asetteluryhmien 
kopiointi

Seuraavassa on kuvattu kuinka yhden ryhmän kaikki asetteluarvot 
voidaan kopioida toiseen ryhmään:

• Valitaan asetteluryhmä jonka arvot halutaan kopioida ja hiirellä kiinni 
pitäen vedetään "drag-and-drop" menetelmällä sen asetteluryhmän 
päälle johon arvojen halutaan kopioituvan. 

• Vahvistetaan kopiointitapahtuma vastaamalla Yes näyttöön 
aktivoituneeseen kyselyikkunaan.
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Asetteluryhmien 
palauttaminen

Kun laitteen toiminnallisuus on määritelty, on asetteluryhmissä 
perusasettelut voimassa. 
Jos asetteluarvoja on muutettu, voidaan ne palauttaa alkuperäisiksi 
valikko-ohjauksella.

• Valitaan asetteluryhmä ja valitaan Reset valikkoikkunasta tai 

• Valitaan asetteluryhmä ja klikataan Reset painiketta (katso sivu 166). 

• Vahvistetaan toiminta vastaamalla Yes näyttöön aktivoituneeseen 
kyselyikkunaan.

DIGSIGB046

Kuva 5-7  Kysymys halutaanko asetteluryhmien arvot palauttaa alkuperäisiksi

Asetteluryhmien 
editointi

Jos asetteluryhmän parametrejä halutaan muuttaan, toimitaan 
seuraavasti:

• Kaksoisklikataan DIGSI® 4 ohjelmistossa haluttua asetteluryhmää 
(A ... D). Tällöin näyttöön aukeaa ikkuna, jossa on esitetty käyttöön 
määritellyt toiminnat funktionumeroineen. 

Huomio:
Kaikki asetteluarvot kohteeksi valitussa ryhmässä kirjautuvat yli. 
Kuitenkin muutokset ovat tässä vaiheessa vasta tietokoneen 
väliaikaisessa muistissa.  Jos kopiointi suoritettiin vahingossa 
virheellisesti, suljetaan laite tallentamatta ja avataan uudelleen. Tällöin 
kuitenkin menetetään muut mahdolliset muutokset joita ei vielä oltu 
tallennettu.

Huomio:
Kaikki valitun asetteluryhmän asettelut palautuvat alkuperäisiksi. Jos 
palautus suoritettiin vaihingossa virheellisesti, suljetaan laite 
tallentamatta ja avataan uudelleen. 
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DIGSIGB130

Kuva 5-8  Asetteluryhmä

• Painetaan Reset painiketta.  Tällä painikkeella voidaan palauttaa 
toiminnan asetteluarvot alkuperäisiksi.

• Valitaan toiminta ja klikataan Settings painiketta asetteluarvojen 
muuttamiseksi. Näyttöön aukeaa ikkuna, jossa on esitetty kaikki 
toimintaan liittyvät asetteluparametrit. Parametrit on jaettu 
mahdollisesti erillisille sivuille parametrien tyypeistä ja lukumääristä 
riippuen.

Lisätietoja parametrien muuttamisesta asetteluryhmissä on esitetty  
kappaleessa 5.18, kappaleessa 5.19 ja kappaleessa 5.20.
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5.5 Informaatioiden määrittely

5.5.1 Yleistä

Määrittelymatriisi on monipuolinen työkalu SIPROTEC 4 laitteen 
informaatioiden määrittelyyn. Informaatioilla tarkoitetaan DIGSI® 4 CFC 
logiikkatoimintojen käyttämien suureiden lisäksi mittaus- ja laskuriarvoja, 
merkinantoja ja ohjauksia.

Määrittelymatriisia on mahdollista käsitellä vain DIGSI® 4 ohjelmistolla. 
Laitteella voidaan lukea informaatioiden määrittelyt mutta niitä ei voi 
muuttaa.

Informaatioiden 
liittäminen

Määrittelymatriisissa informaatiot voidaan liittää SIPROTEC 4 laitteen eri 
komponentteihin, kuten binäärisiin tuloihin, ohjauksiin, ledeille, 
päiväkirjoihin, näyttöihin jne. Informaatioiden liittämisen lisäksi 
määritellään samalla toiminnallisuuksia, kuten esimerkiksi informaatio 
voidaan liittää lediin muistavana tai muistamattomana. Informaatioille 
määritellään niiden lähde ja/tai kohde. Informaation määrittely 
lähteeseen tarkoittaa määrittelyä mikä informaation aktivoi. Informaation 
määrittely kohteseen tarkoittaa mihin tieto välitetään edelleen tai minkä 
tapahtuman tieto voi aktivoida. Itsevalvonta estää virheelliset määrittelyt. 

Luettelo määrittelymahdollisuuksista on esitetty Liitteessä A.2. 
Määrittelymahdollisuudet riippuvat myös SIPROTEC 4 laitteen tyypistä ja 
käyttöön määritellyistä toiminnoista. 

Toimitettaessa laitteella on jo määritelty informaatioita etupaneelin 
ledeille, osalle funktiopainikkeista, binäärisiin tuloihin ja laitteen 
ohjauskoskettimille. Esimäärittelyt on muutettavissa vastaamaan 
kulloinkin kyseessä olevan kohteen vaatimuksia. 

Informaatioiden
ominaisuudet

Informaatioilla on eri ominaisuuksia, kuten esimerkiksi mittausarvojen 
suureyksikkö ja desimaalien lukumäärä. Matriisissa olevan informaation 
ominaisuudet esitetään valikosta aktivoitavissa olevassa ikkunassa.

Funktio-
parametrit

Määrittelymatriisissa voidaan asetella myös määrättyjä 
funktioparametrejä. 

Ohje:
Jos määrittelyitä muutetaan jälkikäteen, voivat merkinannot ja 
määrättyjen tapahtumien laskuriarvot kadota. Tämän vuoksi on syytä 
tarvittaessa varmuuskopioida käyttö- ja häiriöpäiväkirjat sekä 
laskuriarvot (katso kappale 6.2.7).
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Informaatioiden määrittely
Määrittely Informaatiot määritellään seuraavasti:

• Avataan laite, valitaan setting hakemisto ja kaksoisklikataan 
Configuration objektia. 
Määrittelymatriisi aukeaa näytölle.

• Sijoitetaan kursori soluun, joka yhdistää informaation rivin sekä lähde- 
ja kohdesarakkeen (rivi ja sarake on korostettu eri värillä). Jos kursori 
muuttuu esto-merkiksi, ei informaatiota ole mahdollista liittää valittuun 
kohteeseen tai lähteeseen. Jos kursorin esitystapa ei muutu, on 
informaatio määriteltävissä teoriassa eli jos jotain muuta sääntöä ei 
loukata. Esimerkiksi enintään 30 tapahtumaa voidaan liittää yhteen 
binääriseen koskettimeen. 

• Klikataan solua oikealla hiiripainikkeella. Avautuvassa ikkunassa on 
esitetty vaihtoehdot jotka ovat mahdollisia tälle informaatiotyypille 
kohteessa tai lähteessä. Valitaan jokin esitetyistä vaihtoehdoista. 
Valittu toiminta esitetään solussa. Aina on olemassa vaihtoehto, jossa 
määrittelyä ei suoriteta lainkaan _(not configured). Tämä poistaa 
myös aiemmin suoritetun valinnan.

tai

• Klikataan solua ja syötetään valinta näppäimistöltä. 
Vahvistetaan määrittely Return painikkeella tai klikataan jotain muuta 
solua. 
Syötetty merkkijono tarkastetaan ja tarvittaessa virheilmoitus 
aktivoituu. Kuitataan virheilmoitus OK painikkeella ja korjataan 
syötetty määrittely.

Ohje:
Ohjausta määriteltäessä toiminta varaa tarvittavat solut valinnan oikealta 
puolelta. Jos jokin näistä määrittelyistä poistetaan, poistuvat 
automaattisesti muidenkin solujen määrittelyt. Määritellyt solut on 
varustettu kirjaintunnuksin Tr (= auki) ja Cl (= kiinni).
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DIGSIGB025

Kuva 5-9 Osakuva määrittelymatriisista

Matriisin sarakkeet ja rivit on jaettu toiminnallisiin ryhmiin. Näiden 
ryhmien nimikentät ovat tyypiltään ohjauspainikkeita, joilla voidaan 
suorittaa määrättyjä toimenpiteitä määrittelymatriisin esitystavan 
muuttamiseksi. 

Informaation liitos lähteeseen ja kohteeseen on merkitty kirjaintunnuksin. 
Kirjaintunnukset määräytyvät informaation, lähteen ja kohteen tyypin 
mukaisesti. 

Vaakarakenne Määrittelymatriisi on jaettu vaakatasossa informaatio Information, lähde 
Source ja  kohde Destination osioihin. Informaation tyypistä riippuen 
sillä voi olla eri tyyppisiä lähteitä ja kohteita. 
Määrittelymahdollisuudet on esitetty Liitteessä A.2. 

Ohje:
Näytetyt lähteet ja kohteet riippuvat laitteen tyypistä, käyttöön 
määritellyistä toiminnoista ja valitusta näyttötavasta. Esimerkiksi 
analogiatulojen sarakkeet ovat käytettävissä vain jos SIPROTEC 4 
laitteella on vastaavat mittaussisääntulot ja nämä on määritelty käyttöön. 
Nämä sarakkeet ovat näkyvissä vain jos näyttötavaksi on valittu mittaus- 
ja laskuriarvojen esitys.
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Informaatioiden määrittely
Informaatiot Informaatiot ovat objekteja jotka tulee määritellä esimerkiksi 
merkinannoiksi tai ohjauksiksi. Informaatio muodostuu määrätyistä 
osista.

Numero (Number)
Informaation tunnistusta ja laitedokumentaation toiminnallisuuden 
havainnollistamista varten.

Näyttöteksti (Display text)
Informaation teksti, joka esitetään SIPROTEC 4 laitteen näytöllä.

Pitkä teksti (Long text)
Informaation yksityiskohtaisempi määrittely.

Tyyppi (Type)
Informaation tarkka määrittely, esimerkiksi BR_D2 kaksoisohjaus 
varustettuna takaisinkytkennällä.

Lähde Lähde määrittelee kuinka informaatio aktivoituu laitteella. Lähteitä voivat 
olla:

Binäärinen tulo BI
Optinen liityntäpiiri, jolla voidaan vastaanottaa tapahtumatietoja 
kojeistolta. Binääristen tulojen lukumäärä riippuu laitteen tyypistä.

Analogiatulo
Muunnintulo analogiasignaalien, kuten jännite ja virta, 
vastaanottamiseksi. Jännite- ja virtatulojen lukumäärä on 
laitekohtainen.

Funktiopainike (Function key)
Informaation lähteeksi voidaan määritellä funktiopainike, joka voi 
esimerkiksi aktivoida SIPROTEC 4 ohjaustoiminnan.

CFC 
Informaatio aktivoidaan DIGSI 4 CFC logiikkatoiminnan ohjaamana.

Järjestelmäväylä (System interface)
Informaatio aktivoidaan kaukokäytöltä järjestelmäväylän kautta. 

Laitteiden välinen kommunikaatio (Inter Relay Communication)
Laitteiden välisellä kommunikaatiolla voidaan vaihtaa informaatioita 
suoraan SIPROTEC 4 laitteiden välillä. Laitteilla joilla releen välinen 
kommunikaatio (IRC) on mahdollista, voidaan tämä toimintatapa 
liittää informaatiolähteeksi. 
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Kohde Kohde määrittelee mille laitteen komponentille informaatio välitetään. 
Kohteita voivat olla:

Binäärinen ulostulo (Binary output)
Kosketin jolla binäärinen signaali välitetään edelleen. Binääristen 
ulostulojen lukumäärä on laitekohtainen.

LED
Ledi voi olla kohteena määrätyille informaatiotyypeille. Ledien 
lukumäärä on laitekohtainen.

Järjestelmäväylä (System interface)
Informaatio voidaan välittää edelleen kaukokäytölle järjestelmäväylän 
kautta. 

CFC 
Informaatio voidaan liittää DIGSI 4 CFC logiikkaan meneväksi. 

Ohjausnäyttö (Control display)
Informaatio voidaan määritellä esitettäväksi joko graafisesti tai 
tekstimuodossa ohjausnäytöllä.

Perusnäyttö (Default display)
Informaatio voidaan määritellä esitettäväksi joko graafisesti tai 
tekstimuodossa perusnäytöllä. 

Ohjaus (Control CO)
Ohjattavat toimilaitteet ja merkkaukset esitetään laitteen näytöllä 
Control valikossa. 

Päiväkirjat (Buffer)
Informaatiot voidaan tallentaa SIPROTEC 4 laitteella käyttö-, 
maasulku-, häiriö- tai hälytyspäiväkirjoihin.

Laitteiden välinen kommunikaatio (Inter Relay Communication)
Laitteiden välisellä kommunikaatiolla voidaan vaihtaa informaatioita 
suoraan SIPROTEC 4 laitteiden välillä. Informaatioiden välitys 
laitteiden välillä on mahdollista jos laitteessa on IRC toiminta. Tällöin 
IRC voidaan määritellä informaation kohteeksi.

Pystyrakenne Informaatiot on jaettu toiminnoittain ryhmiin pystysuunnassa. 
Tehdasasetuksin määriteltyjen ryhmien lisäksi käyttäjä voi lisätä 
informaatioita tai informaatioryhmiä. Esimääriteltyjä informaatioryhmiä ei 
voi nimetä uudelleen tai poistaa (katso kappale 5.7). 

Ohje:
Määrittelymatriisissa esitetyt informaatiot ovat riippuvaisia laitteen 
tyypistä ja käyttöön määritellyistä toiminnoista.
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Informaatioiden määrittely
Väritys Määrittelymatriisi on jaettu vaakasuunnassa keltaisiin ja valkoisiin 
riveihin. Tällä värityksellä on tarkoitus vain havainnollistaa 
määrittelymahdollisuuksia eikä sillä ole toiminnallista merkitystä.

Piilotetut sarakkeet tai rivit esitetään harmaana. 

Jos yritetään syöttää virheellinen määrittely, muuttuu solu harmaaksi.
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5.5.2 Informaatioiden määrittely binäärisiin tuloihin (lähde)

Seuraavan tyyppiset informaatiot voidaan määritellä binäärisiin tuloihin 
(BI):

Yksinapaiset merkinannot

Kaksinapaiset merkinannot

Bittimalli merkinannot

Muuntajan käämikytkimen asentomerkinannot

Pulssimittausarvot

Ehdot  Ei ole mahdollista määritellä yhtä informaatiota useampaan binääriseen 
tuloon. Esimerkiksi, jos yksinapainen merkinanto on määritelty 
binääriseen tuloon, poistuu tämä valinta automaattisesti jos se liitetään 
johonkin toiseen tuloon.

Ei ole myöskään mahdollista määritellä informaation lähteeksi binääristä 
tuloa, jos lähteeksi on jo määritelty CFC. Näin toimittaessa seuraa 
virheilmoitus. 

Yksinapaisen 
merkinannon 
määrittely

Valittavissa on jokin seuraavista vaihtoehdoista:

H (työvirtaperiaate)
Merkinanto aktivoituu, jos binääriseen tuloon tuodaan jännite.

L (lepovirtaperiaate)
Merkinanto aktivoituu, jos jännite poistuu binääriseltä tulolta.

_ (ei määrittelyä)
Informaatiota ei ole määritelty binääriseen tuloon.

Kaksinapaisten 
merkinantojen 
määrittely

Valittavissa on jokin seuraavista vaihtoehdoista:

X (määriteltynä)
Merkinanto aktivoituu, jos binääriseen tuloon tuodaan jännite.

_ (ei määrittelyä)
Informaatiota ei ole määritelty binääriseen tuloon.

Kun kaksinapainen merkinanto liitetään binääriseen tuloon, varataan 
automaattisesti numerojärjestyksessä seuraava binäärinen tulo. Jos 
jompi kumpi näistä määrittelyistä perutaan, poistuu toinenkin määrittely 
automaattisesti ja tuloja ei ole tällöin määritelty not configured. 
Kaksinapaista merkinantoa ei ole mahdollista määritellä viimeiselle 
binääriselle tulolle, koska toista binääristä tuloa ei tällöin voida määritellä.

Binääristen tulojen tiloilla on kiinteä määritys. AUKI (OFF) tila on aina 
ennen KIINNI (ON) tilaa. 
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Bittimalli 
merkinantojen 
määrittely

Valittavissa on jokin seuraavista vaihtoehdoista:

X (määriteltynä)
Merkinanto aktivoituu, kun binääriselle tulolle tuodaan jännite.

_ (ei määrittelyä)
Informaatiota ei ole määritelty binääriseen tuloon.

Kun bittimalli merkinanto määritellään binääriselle tulolle, valitaan 
automaattisesti numerojärjestyksessä seuraavat tarvittavat tulot. 
Tarvittavien binääristen tulojen lukumäärä määräytyy bittimalli 
merkinannon bittien lukumäärän mukaisesti. Ensimmäinen tulo tulee 
määritellä siten, että sen perässä on riittävästi binäärisiä tuloja 
käytettävissä. Muussa tapauksessa näyttöön aktivoituu virheilmoitus. 
Jos jokin näistä määrittelyistä poistetaan, poistuvat kaikki muutkin 
määrittelyt automaattisesti (not configured). Jos merkinannon 
ominaisuudet ikkunassa muutetaan bittien lukumäärää, muuttuu 
tarvittavien binääristen tulojen lukumäärä automaattisesti.

Käämikytkimen 
asentomerkin-
annon määrittely

Valittavissa on jokin seuraavista vaihtoehdoista:

X (määriteltynä)
Merkinanto aktivoituu, jos binääriseen tuloon tuodaan jännite.

_ (ei määrittelyä)
Informaatiota ei ole määritelty binääriseen tuloon.

Kun käämikytkimen asentomerkinanto määritellään binääriselle tulolle, 
varataan automaattisesti numerojärjestyksessä seuraavat tarvittavat 
binääriset tulot. Tarvittavien binääristen tulojen lukumäärä määräytyy 
käämikytkimen asennon esityksessä käytettyjen bittien lukumäärän 
mukaisesti. Jos jokin näistä määrittelyistä poistetaan, poistuvat kaikki 
muutkin määrittelyt automaattisesti (not configured).

Pulssimittaus-
arvojen määrittely

Valittavissa on jokin seuraavista vaihtoehdoista:

X (määriteltynä)
Pulssilaskuriarvo kasvaa, kun binääriselle tulolle tuodaan 
jännitepulssi.

_ (ei määrittelyä)
Pulssimittausarvoa ei ole liitetty binääriseen tuloon.
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5.5.3 Informaatioiden määrittely analogiatuloihin (lähde)

Vain measured value channel informaatiotyyppi voidaan liittää 
analogiatuloon (U tai I) lähteeksi. Esimerkiksi mittausarvokanavaa 
voidaan käyttää mitta-arvon muunnin tulona.

Ehdot  Jännitteen mittauskanavan voi liittää vain jännitteen mittauspiiriin. 
Vastaavasti virran mittauskanavan voi liittää vain virran mittauspiiriin.

Yhtä tyypiltään "measured value channel" informaatiota ei voi liittää 
useampaan tuloon samanaikaisesti. Jos mittausarvokanava on jo 
määritelty ja se liitetään toiseen kanavaan, poistuu alkuperäinen valinta 
automaattisesti.

Mittausarvo-
kanavan määrittely

Valittavissa on jokin seuraavista vaihtoehdoista:

X (määriteltynä)
Toimintalohko sisältää virta- tai jännitearvon, jos mittaussignaali on 
liitetty analogiatuloon.

_ (ei määrittelyä)
Mittausarvokanavaa ei ole liitetty analogiatuloon.
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5.5.4 Informaatioiden määrittely funktiopainikkeille (lähde)

On mahdollista liittää sisäinen yksinapainen merkinanto johonkin 
neljästä funktiopainikkeesta. 

Funktiopainike on voitu määritellä jo johonkin toimintaan, esimerkiksi 
valintapainikkeeksi. Esimerkiksi toimitettaessa F1 painikkeella siirrytään 
käyttöpäiväkirjaan, F2 painikkeella ensiömittausarvoihin ja F3 
painikkeella viimeiseen häiriöpäiväkirjatapahtumaan. 

Ehdot  SIPROTEC 4 laitteella tulee olla funktiopainikkeet käytettävissä. Kukin 
funktiopainike voidaan liittää vain yhteen sisäiseen merkinantoon (IE tai 
tagging). Jos sisäinen merkinanto liitetään funktiopainikkeelle jolla on jo 
määritys, seuraa valinnasta virteilmoitus. 

Sisäisten 
merkinantojen 
määrittely

Valittavissa on jokin seuraavista vaihtoehdoista:

1 (funktiopainike 1) ... 4 (funktiopainike 4)
Informaatio aktivoituu välittömästi kun sille määriteltyä 
funktiopainiketta painetaan SIPROTEC 4 laitteen etulevyssä.

_ (ei määrittelyä)
Informaatiota ei ole liitetty funktiopainikkeelle.

Ohje:
Kun informaatio on määritelty funktiopainikkeelle, poistuvat tehtaan 
esiasetukset painikkeelta. DIGSI® 4 ohjelmistossa on mahdollista 
palauttaa funktiopainikkeille niissä esimerkiksi tehdasasetuksina olleet 
toiminnat. Täten perusasetteluiden palautus ei edellytä laitteen 
uudelleen luontia.

Ohje:
Jos funktiopainike on jo määritelty (katso kappale 6.5.5), seuraa 
uudelleen määrittelystä virheilmoitus.
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5.5.5 Informaation määrittely binääriselle ulostulolle (kohde)

Seuraavan tyyppiset informaatiot voidaan määritellä binäärisille 
ulostuloille (BO):

Yksinapaiset merkinannot

Ulostulomerkinannot

Arvomerkinannot

Sisäiset yksinapaiset merkinannot

Ulkoiset yksinapaiset merkinannot

Ohjaukset

Ehdot  Enintään 30 merkinantoa ja ohjausta voidaan liittää yhteen binääriseen 
ulostuloon. Vastaavasti yksi merkinanto voidaan liittää enintään 10 
binääriseen ulostuloon ja lediin.

Määrittely-
vaihtoehdot

Valittavissa on jokin seuraavista vaihtoehdoista:

 L (Latched)
Merkinanto voidaan määritellä binääriseen ulostuloon 
pitotoimintaperiaatteella. Tällöin määritelty kosketin sulkeutuu 
välittömästi kun siihen liitetty merkinanto aktivoituu, mutta palautuu 
vasta kun pitotoiminta kuitataan. Kuittaus voidaan suorittaa 
paikallisesti laitteelta painamalla "LED Reset"  painiketta, binäärisellä 
tulolla johon on liitetty informaatio > LED Reset tai järjestelmäväylän 
kautta. 
Toimintaa voidaan käyttää esimerkiksi merkinannoille jotka tulee 
kuitata käyttäjän toimesta. CFC logiikan avulla voidaan haluttaessa 
toteuttaa esimerkiksi määrätyn ajan kuluttua suoritettava 
automaattinen kuittaus.

U (Unlatched)
Merkinanto voidaan määritellä binääriseen ulostuloon ilman 
pitotoimintaa. Kosketin sulkeutuu välittömästi kun siihen määritelty 
merkinanto aktivoituu. Kosketin avautuu kun siiihen liitetty informaatio 
palautuu.

_ (ei määrittelyä)
Merkinantoa ei ole määritelty binääriselle ulostulolle.
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Ohjausten 
määrittely

Valittavissa on jokin seuraavista vaihtoehdoista:

X (määriteltynä)
Informaatio on määritelty binääriselle ulostulolle.

I (Info)
Binäärinen ulostulo on mahdollista määritellä signaalikoskettimeksi. 
Signaalikosketin on sulkeutuneena niin kauan aikaa kun 
ohjaustapahtuma on aktiivinen, ohjaussuunnasta riippumatta. On 
mahdollista liittää useampi ohjaus samaan signaalikoskettimeen.

C (Central common contact)
Binäärinen ulostulo on määritelty yhteiseksi koskettimeksi. On 
mahdollista käyttää yhtä binääristä ulostuloa yhteisenä paluupiirin 
koskettimena erityyppisissä yksinapaisissa kaksoisohjauksissa, joka 
säästää binäärisiä ulostuloja. Edellytyksenä on, että yhteiseen 
koskettimeen liitetään eri ohjaustoimintojen yhteinen potentiaali. 
Esimerkki: Yhteinen miinuspiiri.

_ (ei määrittelyä)
Informaatiota ei ole määritelty binääriselle ulostulolle.

Kun informaatio määritetään ohjauskoskettimelle, varataan 
numerojärjestyksessä tarvittava määrä koskettimia määritellyn 
koskettimen oikealta puolelta. Jos jokin näistä koskettimista määritellään 
pois käytöstä, poistuvat myös muiden binääristen ulostulojen määrittelyt 
automaattisesti (not configured).

Ohje:
Kun informaatio määritellään ohjauskoskettimelle, varataan 
numerojärjestyksessä tarvittava määrä koskettimia määritellyn 
koskettimen oikealta puolelta. Jos jokin näistä koskettimista määritellään 
pois käytöstä, poistuvat myös muiden binääristen ulostulojen määrittelyt 
automaattisesti. Ulostulot on merkitty tunnuksin Tr (= auki) ja Cl (= kiinni).
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Nopeat binääriset 
ulostulot

Riippuen tilatusta versiosta on määrätyillä laitetyypeillä käytettävissä 
nopeita ulostuloja joiden toiminta-aika on noin 3 ms. Niitä käytetään 
yleensä suojaustoimintojen laukaisuihin tai suojaustoimintojen signaalin 
siirtoon vasta-asemille. Lisätietoja toiminnasta on esitetty 
laitekohtaisissa käyttöohjeissa.

Binääriset ulostulot 
kytkinlaitteille

Tulee ottaa huomioon seuraava seikka määriteltäessä binäärisiä 
ulostuloja kytkinlaitteille. Ohjaustyypit (esimerkiksi yksi- tai 
kaksinapainen ohjaus varustettuna takaisinkytkennällä tai ilman) on 
määritelty valmiiksi tehdasasetuksena matriisissa binäärisille 
koskettimille. Jos esimääritellyt ohjaustyypit eivät vastaa käyttöön 
tulevaa tarvetta, tulee ne liittää käyttäjän toimesta informaatiokatalogista 
matriisiin. 

5.5.6 Informaatioiden määrittely ledeille (kohde)

Seuraavat informaatiotyypit voidaan liittää ledeille (LE):

Yksinapaiset merkinannot

Ulostulomerkinannot

Sisäiset yksinapaiset merkinannot

Ulkoiset yksinapaiset merkinannot

Arvomerkinannot

Ehdot  Yhdelle ledille voidaan liittää enintään 10 informaatiota. Vastaavasti yksi 
merkinanto voidaan liittää enintään 10 lediin ja ohjauskoskettimeen.

Informaatioiden 
määrittely

Informaatioita määriteltäessä valitaan jokin seuraavista vaihtoehdoista 
käyttöön:

 L (Latched)
Merkinanto voidaan määritellä ledille pitotoimintaperiaatteella. Tällöin 
ledi syttyy välittömästi kun siihen liitetty informaatio aktivoituu, mutta 
palautuu vasta kun pitotoiminta kuitataan. 

U (Unlatched)
Merkinanto voidaan määritellä ledille ilman pitotoimintaa. Ledi syttyy 
välittömästi kun siihen määritelty informaatio aktivoituu. Se palautuu 
välittömästi kun siihen liitetty informaatio ei ole enää aktiivisena.

_ (ei määrittelyä)
Merkinantoa ei ole määritelty ledille.
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5.5.7 Informaatioiden määrittely järjestelmäväylään (lähde)

Seuraavat informaatiotyypit voidaan liittää järjestelmäväylään (S) lähde-
suunnassa:

Ulostulomerkinannot (vain tehtaalla esimääritellyt informaatiot)

Sisäiset yksinapaiset merkinannot

Sisäiset kaksinapaiset merkinannot

Ohjaukset varustettuna takaisinkytkennällä ja ilman (IEC ja muissa 
protokollissa käämikytkimen asentotyyppiä ei voi liittää)

Ulkoiset ohjaukset varustettuna takaisinkytkennällä ja ilman

Rajat (vain PROFIBUS FMS ja vastaavat protokollat)

Käyttäjän määrittelemät rajat (vain PROFIBUS FMS ja vastaavat 
protokollat)

IEC 61850 liikennöintiprotokollan määrittelyt on esitetty taulukossa 
kappaleessa A.2.1.

Informaatioiden 
määrittely

Informaatioita määriteltäessä valitaan jokin seuraavista vaihtoehdoista 
käyttöön:

X (määriteltynä)
SIPROTEC laitteella oleva informaatio aktivoidaan järjestelmäväylän 
kautta.

_ (ei määrittelyä)
Informaatiota ei ole liitetty järjestelmäväylään.

Huomio:
Jos SIPROTEC 4 laite on liitetty SICAM ala-asemaan, tulee SICAM 
export toiminta suorittaa, jos laitteen informaatioihin on tehty muutoksia 
järjestelmäväylää koskien.
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5.5.8 Informaatioiden määrittely järjestelmäväylään (kohde)

Seuraavat informaatiotyypit voidaan liittää järjestelmäväylään (S) kohde-
suunnassa:

Yksinapaiset merkinannot

Kaksinapaiset merkinannot

Ulostulomerkinannot

Arvomerkinannot

Sisäiset yksinapaiset merkinannot

Sisäiset kaksinapaiset merkinannot

Ulkoiset yksinapaiset merkinannot

Ulkoiset kaksinapaiset merkinannot

Bittimalli merkinannot (vain PROFIBUS FMS)

Ulkoiset bittimalli merkinannot (vain PROFIBUS FMS)

Käämikytkimen asentomerkinannot (vain PROFIBUS FMS)

Raja-arvot (IEC 60870-5-103, vain luku)

Käyttäjän määrittelemät raja-arvot (IEC 60870-5-103, vain luku)

Mittausarvot (IEC 60870-5-103, vain luku)

Ajalla varustetut mittausarvot (IEC 60870-5-103, vain luku)

Käyttäjän määrittelemät mittausarvot (IEC 60870-5-103, vain luku)

Pulssilaskuriarvot

Mittausarvoista lasketut laskuriarvot

Ulkoiset laskuriarvot

Vain luku Read only tarkoittaa tässä tapauksessa että informaatio 
esitetään mutta sitä ei voi muuttaa.

IEC 61850 liikennöintiprotokollan määrittelyt on esitetty taulukossa 
kappaleessa A.2.1.

Informaatioiden 
määrittely

Informaatioita määriteltäessä valitaan jokin seuraavista vaihtoehdoista 
käyttöön:

X (määriteltynä)
Informaatio on liitetty järjestelmäväylään meneväksi.
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_ (ei määrittelyä)
Informaatiota ei ole liitetty järjestelmäväylään.

Jos SIPROTEC 4 laite liitetään ylemmän tason ohjausjärjestelmään IEC 
60870-5-103 protokollalla ja laitteelle on jo määritelty IEC osoite, tulee 
lisäksi määritellä seuraavat kohdat ohjausten, merkinantojen tai 
mittausten liittämiseksi järjestelmäväylään.

Seuraavat asettelut tulee suorittaa:

Funktiotyyppi (Function type)
IEC 60870-5-103 protokollassa funktiotyyppi määrittelee SIPROTEC 
4 laitteen toiminnan. Esimerkiksi distanssisuojalle tai 
generaattorisuojalle on omat funktiotyyppinsä. Lisätietoja 
käytettävissä olevista funktiotyypeistä on esitetty erillisessä 
protokollaa kuvaavassa käyttöohjeessa. Joitakin numeroita ei ole 
käytetty lainkaan. Nämä voidaan vapaasti määritellä käyttöön ilman 
että IEC yhteensopivuus vaarantuisi.

Informaationumero (Information number)
Informaatiolla on funktiotyyppinumeron lisäksi juokseva 
informaationumero. Tämä informaationumero määrittelee 
informaation tyypin (ohjaus, merkinanto tai mittausarvo) joka 
välitetään järjestelmäväylää pitkin. Sillä erotetaan informaation osoite 
muista vastaavan funktiotyypin informaatioista eli yhdessä laitteessa 
ei saa olla kahta informaatiota joilla on samat funktiotyypit ja 
informaationumerot.  

Informaatiotyyppi (DU type)
Informaatiotyyppi koskee vain informaatioita. Käyttäjä voi määritellä 
informaatiolle käyttötarkoituksen mukaisen tyypin. Informaatiotyypiksi 
voidaan valita käyttömerkinanto Operational indication tai 
häiriömerkinanto Fault indication.

Yllä mainitut asettelut määritellään Object Properties - IEC 60870-5-
103 ikkunassa.

DIGSIGB099

Kuva 5-10  Object Properties - IEC 60870-5-103  määrittelyikkuna

Huomio:
Jos SIPROTEC 4 laite on liitetty SICAM ala-asemaan, tulee SICAM 
export toiminta suorittaa, jos laitteen informaatioihin on tehty muutoksia 
järjestelmäväylää koskien.
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Asetteluiden 
suoritus

• Valitaan funktiotyyppi, informaationumero ja tarvittaessa 
informaatiotyyppi alasvetovalikoista.

Asetteluiden 
hyväksyntä

• OK painikkeella suoritetut asettelut tallentuvat tietokoneen 
väliaikaiseen muistiin. 
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5.5.9 Informaatioiden määrittely perus- ja ohjausnäytöille (kohde)

Seuraavat informaatiot voidaan liittää perus- ja ohjausnäytölle (D, C):

Yksinapaiset merkinannot

Kaksinapaiset merkinannot

Ulostulomerkinannot

Sisäiset yksinapaiset merkinannot

Sisäiset kaksinapaiset merkinannot

Ulkoiset yksinapaiset merkinannot

Ulkoiset kaksinapaiset merkinannot

Käämikytkimen asentomerkinannot

Ohjaukset varustettuna takaisinkytkennällä ja ilman

Ulkoiset ohjaukset varustettuna takaisinkytkennällä ja ilman

Mittaussuureet

Mittausarvot aikaleimalla

Käyttäjän määrittelemät mittausarvot

Pulssilaskuriarvot

Mittausarvoista lasketut laskuriarvot

Ulkoiset laskurit

Informaatioiden 
määrittely

Informaatioita määriteltäessä valitaan jokin seuraavista vaihtoehdoista 
käyttöön:

X (määriteltynä)
Informaatio on esitettävissä ohjaus- ja/tai perusnäytöllä.

_ (ei määrittelyä)
Informaatiota ei voida käyttää ohjaus- ja/tai perusnäytöllä.
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5.5.10 Informaatioiden määrittely päiväkirjoihin (kohde)

Seuraavat informaatiotyypit voidaan liittää päiväkirjoihin (B):

Yksinapaiset merkinannot

Kaksinapaiset merkinannot

Ulostulomerkinannot

Arvomerkinannot

Sisäiset yksinapaiset merkinannot

Sisäiset kaksinapaiset merkinannot

Käämikytkimen asentomerkinannot

Bittimalli merkinannot

Ulkoiset yksinapaiset merkinannot

Ulkoiset kaksinapaiset merkinannot

Ulkoiset bittimalli merkinannot

Ohjaukset ilman takaisinkytkentämerkinantoa

Käytettävissä on enintään neljä erityyppistä päiväkirjaa: Käyttöpäiväkirja 
(O), maasulkupäiväkirja (G), hälytyspäiväkirja (W) ja häiriöpäiväkirja (N). 
Liitteen A.2 taulukossa on esitetty mitkä eri informaatiotyypit voidaan 
liittää eri päiväkirjoihin. Erillisissä laitekäyttöohjeissa on esitetty 
yksityiskohtaisesti mihin eri informaatiot ovat liitettävissä.

Informaatioiden 
määrittely

Informaatioita määriteltäessä valitaan jokin seuraavista vaihtoehdoista 
käyttöön:

O (ON)
Merkinanto kirjautuu päiväkirjaan tullessaan. Tätä määrittelyä ei 
voida käyttää hälytyspäiväkirjassa.

OO (ON/OFF)
Tällä määrittelyllä informaatio kirjautuu päiväkirjaan tullessaan ja 
poistuessaan. Tätä määrittelyä ei voida käyttää hälytyspäiväkirjassa.

X (määriteltynä)
Merkinanto kirjautuu päiväkirjaan tullessaan. Tätä määrittelyä 
voidaan käyttää vain hälytyspäiväkirjassa.

_ (ei määrittelyä)
Merkinantoa ei ole määritelty päiväkirjaan.
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5.5.11 Informaatioiden määrittely mittausikkunaan (kohde)

Seuraavan tyyppiset informaatiot voidaan liittää mittausikkunaan:

Raja-arvot (vain luku "Read Only")

Käyttäjän määrittelemät raja-arvot (vain luku "Read Only")

Käyttäjän määrittelemät mittausarvot

Vain luku Read only tarkoittaa tässä tapauksessa että informaatio 
esitetään mutta sitä ei voi muuttaa.

Informaatioiden 
määrittely

Informaatioita määriteltäessä valitaan jokin seuraavista vaihtoehdoista 
käyttöön:

X (määriteltynä)
Informaatio esitetään mittausikkunassa.

_ (ei määrittelyä)
Informaatiota ei esitetä mittausikkunassa.

Laitteeseen esimääriteltyjen mittausarvojen lisäksi on myös mahdollista 
liittää käyttäjän toimesta matriisiin mittaus- ja raja-arvoja. Nämä 
itseluodut informaatiot voidaan myös liittää mittausikkunaan. 

5.5.12 Informaatioiden määrittely laskuriarvoikkunaan (kohde)

Seuraavan tyyppiset informaatiot voidaan liittää laskuriarvoikkunaan:

Pulssilaskuriarvot

Mittausarvoista lasketut laskuriarvot

Informaatioiden 
määrittely

Informaatioita määriteltäessä valitaan jokin seuraavista vaihtoehdoista 
käyttöön:

X (määriteltynä)
Informaatio esitetään laskuriarvoikkunassa.

_ (ei määrittelyä)
Informaatiota ei esitetä laskuriarvoikkunassa.
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5.5.13 Informaatioiden määrittely ohjaukseen (kohde)

Seuraavat informaatiotyypit voidaan liittää ohjauksiin (CO):

Yksinapaiset merkinannot (vain SI, ei SI_F)

Kaksinapaiset merkinannot

Käämikytkimen asentomerkinannot

Sisäiset yksinapaiset merkinannot

Sisäiset kaksinapaiset merkinannot

Ulkoiset yksinapaiset merkinannot (vain ExSI, ei ExSI_F)

Ulkoiset kaksinapaiset merkinannot

Bittimalli merkinannot

Ulkoiset bittimalli merkinannot

Ohjaukset varustettuna takaisinkytkennällä ja ilman

Ulkoiset ohjaukset varustettuna takaisinkytkennällä ja ilman

Yksinapaisten, 
kaksinapaisten ja 
muuntajan 
käämikytkimen 
asentomerkin-
antojen määrittely

Valittavissa on jokin seuraavista vaihtoehdoista:

X (määriteltynä)
Informaation olemassa oleva tila esitetään DIGSI 4 Device 
Configuration ohjelman Equipment ikkunassa, sekä suoraan 
SIPROTEC 4 laitteella. Voimassa olevaa tilaa voidaan muuttaa 
SIPROTEC 4 laitteella.

_ (ei määrittelyä)
Informaation olemassa olevaa tilaa ei voida muuttaa.

Sisäsen yksi- ja 
kaksinapaisen 
merkinannon 
määrittely

Valittavissa on jokin seuraavista vaihtoehdoista:

X (määriteltynä)
Informaation voimassa oleva tila esitetään DIGSI 4 Device 
Configuration ohjelman Tagging ikkunassa, sekä SIPROTEC 4 
laitteella. Informaation olemassa olevaa tilaa voidaan muuttaa 
ikkunassa ja SIPROTEC 4 laitteella.

_ (ei määrittelyä)
Informaation olemassa olevaa tilaa ei voida muuttaa.

Ohjausten 
määrittely

Valittavissa on jokin seuraavista vaihtoehdoista:

X (määriteltynä)
Informaation olemassa oleva tila esitetään DIGSI 4 Device 
Configuration ohjelman Equipment ikkunassa, sekä suoraan 
SIPROTEC 4 laitteella. Informaation olemassa olevaa tilaa voidaan 
muuttaa ikkunassa ja SIPROTEC 4 laitteella.

_ (ei määrittelyä)
Informaation olemassa olevaa tilaa ei voida muuttaa.
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Bittimalli 
merkinantojen 
määrittely

Valittavissa on jokin seuraavista vaihtoehdoista:

X (määriteltynä)
Merkinanto luodaan, jos määritellyille binäärisille tuloille tulee 
signaaleja.

_ (ei määrittelyä)
Informaatiota ei ole määritelty binääriseen tuloon.

Kun bittimalli merkinanto määritellään binääriselle tulolle, varataan 
automaattisesti numerojärjestyksessä seuraavat tarvittavat tulot. 
Tarvittavien binääristen tulojen lukumäärä määräytyy bittimalli 
merkinannon bittien lukumäärän mukaisesti. Ensimmäinen tulo tulee 
määritellä siten, että sen perässä on riittävästi binäärisiä tuloja 
käytettävissä. Muussa tapauksessa näyttöön aktivoituu virheilmoitus. 
Jos jokin näistä määrittelyistä poistetaan, poistuvat kaikki muutkin 
määrittelyt automaattisesti (not configured). Jos merkinannon 
ominaisuudet ikkunassa muutetaan bittien lukumäärää, muuttuu 
tarvittavien binääristen tulojen lukumäärä automaattisesti.
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5.5.14 Informaatioiden määrittely CFC logiikalle (kohde)

Toiminta Jos informaatiota halutaan käyttää DIGSI 4 CFC logiikkatoiminnan 
tulosuureena, tulee se määritellä määrittelymatriisissa CFC (kohde) 
sarakkeessa. Tämän jälkeen informaatiota voidaan käyttää CFC 
logiikassa tulosuureena logiikkasivun vasemmassa reunassa. Tällä 
menetelmällä voidaan liittää esimerkiksi virrat raja-arvovalvontalohkoihin 
ja muodostaa niistä edelleen hälytys. Virrat ja valvontarajojen asetukset 
määritellään matriisissa CFC kohteeksi ja syntynyt hälytys CFC 
lähteeksi.

cfc-links.gif

Kuva 5-11  CFC logiikkia, tulosuureiden liittäminen, esimerkki

Lisätietoja graafisen logiikan toteutuksesta on esitetty käyttöohjeessa 
DIGSI CFC, Manual /2/.
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Seuraavat informaatiotyypit voidaan liittää CFC (C)  logiikkaan kohteeksi:

Yksinapaiset merkinannot

Kaksinapaiset merkinannot

Ulostulomerkinannot

Arvomerkinannot (firmware versiosta 4.5 lähtien)

Sisäiset yksinapaiset merkinannot

Sisäiset kaksinapaiset merkinannot

Ohjaukset

Ulkoiset ohjaukset

Raja-arvot

Käyttäjän määrittelemät raja-arvot

Mittaussuureet

Käyttäjän määrittelemät mittaussuureet

Pulssilaskuriarvot

Mittausarvoista lasketut laskuriarvot

Ulkoiset laskuriarvot

Informaatioiden 
määrittely

Informaatioita määriteltäessä valitaan jokin seuraavista vaihtoehdoista 
käyttöön:

X (määriteltynä)
Informaatiota voidaan käyttää logiikkatoiminnan tuloinformaationa.

_ (ei määrittelyä)
Informaatiota ei voida liittää logiikkaan.
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5.5.15 Informaatioiden määrittely CFC logiikalle (lähde)

Toiminta Jos DIGSI 4 CFC logiikalla muodostettua tulosta halutaan käyttää, tulee 
vastaava informaatio liittää matriisissa CFC (lähde) sarakkeeseen. 
Tällöin informaatio voidaan liittää CFC logiikan lähtöinformaatioksi 
logiikkasivun oikeassa reunassa.

cfc-rechts

Kuva 5-12  CFC logiikka, lähtöinformaatioiden liittäminen, esimerkki

Seuraavat informaatiotyypit voidaan liittää CFC (C)  logiikkaan lähteeksi:

Yksinapaiset merkinannot

Kaksinapaiset merkinannot

Ulostulomerkinannot

Arvomerkinannot (firmware versiosta 4.5 lähtien)

Sisäiset yksinapaiset merkinannot

Sisäiset kaksinapaiset merkinannot

Ohjaukset

Ulkoiset ohjaukset

Käyttäjän määrittelemät mittaussuureet

Raja-arvot
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Käyttäjän määrittelemät raja-arvot

Ulkoiset laskuriarvot

Informaatioiden 
määrittely

Informaatioita määriteltäessä valitaan jokin seuraavista vaihtoehdoista 
käyttöön:

X (määriteltynä)
Informaation tila määräytyy loogisen toiminnan ohjaamana.

_ (ei määrittelyä)
Informaatiota ei voida liittää logiikkaan.

Ohje:
Ei ole myöskään mahdollista määritellä informaation lähteeksi binääristä 
tuloa, jos lähteeksi on jo määritelty CFC. Näin toimittaessa seuraa 
virheilmoitus.
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5.6 Informaatioiden esitys

5.6.1 Suodatus

Suodatusten avulla voidaan rajoittaa matriisissa esitettävien tietojen 
määrää. 

Työkaluvalikossa on kaksi alasvetovalikkoa suodatusten 
määrittelemiseksi.

Informaatiotyypin 
mukaisesti

• Käyttöön voidaan valita jokin seuraavista vasemmanpuoleisesta 
alasvetovalikon vaihtoehdoista:

Vain merkinannot ja ohjaukset (Only indications and commands)

Vain merkinannot (Only indications)

Vain ohjaukset (Only commands)

Vain mittaukset ja laskuriarvot (Only measured and metered 
values)

Jos käyttöön on määritelty informaation tyyppiin perustuva suodatus, ei 
tällöin muiden informaatiotyyppien esitys ole samanaikaisesti 
mahdollista. On mahdollista että suodatusasetusten määrittelyn jälkeen 
aiemmin auki ollut informaatioryhmä informaatioineen onkin tyhjä ja 
piilotettu.

Informaatiotyyppiin perustuva suodatus vaikuttaa määrittelymatriisissa 
vaakatasossa. Riippuen käyttöön määritellystä suodatuksesta, on 
mahdollista että lähde- ja kohdesarakkeisiin tulee uusia kenttiä ja 
informaatiotyypille tarpeettomat kentät on piilotettu. 

Määrittelytavan 
mukaisesti

Toinen mahdollisuus rajoittaa näytettäviä informaatioita on määritellä 
suodatus määrittelytavan mukaisesti.

• Käyttöön voidaan valita jokin seuraavista oikeanpuoleisesta 
alasvetovalikon vaihtoehdoista:

Määritelty BI, BO tai LED (Configured to BI, BO, or LED)
Vain ne informaatiot esitetään jotka on määritelty vähintään yhteen 
objektiin eli binääriseen tuloon, binääriseen lähtöön tai ledille. 
Informaatiot jotka on liitetty muihin kuin yllämainittuihin objekteihin, 
ovat piilotetut. 

Informaatio määriteltynä (Configured information items) 
Vain ne informaatiot näytetään jotka on määritelty mihin tahansa 
lähteeseen tai kohteeseen.

Määrittelemättömät informaatiot (Non-configured information 
items) 
Vain ne informaatiot näytetään, joita ei ole määritelty mihinkään 
lähteeseen tai kohteeseen.
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Ei suodatusta (No filter)

Informaatiot jotka eivät täytä suodatusehtoja on piilotettu näkyvistä. 
Suodatuksen piilottamat informaatiot saadaan takaisin näkyviin 
muuttamalla suodatusehtoja.

5.6.2 Rivien tai sarakkeiden esitys / piilotus

Informaatioryhmä on mahdollista sulkea siten, että siitä on näkyvissä 
vain nimikenttä. 

• Kaksoisklikataan auki olevaa ryhmää ryhmän nimikentässä. 
Sulkeutunut ryhmä on esitetty näytöllä harmaalla rivillä.

• Kaksoisklikataan ryhmän nimikenttää uudelleen, jolloin yksittäiset 
informaatiot tulevat taas näkyviin. 

Matriisin leveyttä voidaan rajoittaa seuraavasti:

Näyttötapaa voidaan muuttaa vakionäyttötavan Standard ja 
lyhennetyn näyttötavan Short View välillä joko työkalurivin ikoneilla 
tai View valikosta. Tämä asetus vaikuttaa kaikkiin sarakkeisiin niin 
lähde kuin kohde ryhmissäkin. Määrittely ei vaikuta 
informaationimiryhmän sarakkeisiin. 

Esitetään tai piilotetaan kaikki yksittäiset sarakkeet. 

Sarakkeet saadaan näkyviin tai piilotettua seuraavasti:

• Kaksoisklikataan sarakkeen ylintä otsikkoa. Tällöin auki olleet 
sarakkeet sulkeutuvat yhdeksi yhteiseksi sarakkeeksi. Yksittäiset 
sarakkeet saadaan taas näkyviin kaksoisklikkaamalla sarakkeen 
ylintä otsikkoriviä. 

Yhteisen sarakkeen kussakin solussa ilmaistaan kunkin informaation 
määrittelytapa kirjaintunnuksella. Esimerkiksi R5 BI solussa tarkoittaa, 
että informaatio on määritelty toimimaan työvirtaperiaatteella binääriseen 
tuloon 5. Jos jokin informaatio on liitetty useampaan kohteeseen 
samanaikaisesti, on ne esitetty samassa solussa pilkuin erotettuina. 
Kaikki tunnukset saadaan näkyviin kaksoisklikkaamalla solua. Tämän 
jälkeen siirretään tekstikursori vaakatasossa solun sisään.

Ohje:
View valikossa on toimintoja, joilla voidaan vaikuttaa määrittelymatriisin 
esitystapaan. 
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5.7 Informaatioiden lisääminen ja poistaminen

Informaatiotyypit Määrittelymatriisissa esitettävät informaatiot riippuvat laitteen tyypistä ja 
käyttöön valituista toiminnoista. Lisäksi informaatioita voidaan lisätä 
myös käyttäjän toimesta. 

Taul. 5-2 Informaatiotyypit

Informaatiotyypit Lyhenne

Merkinannot Yksinapainen merkinanto SI

Yksinapainen hipaisumerkinanto SI_F

Kaksinapainen merkinanto DP

Kaksinapainen merkinanto välitilalla DP_I

Ulostulomerkinanto OUT 

Ulostulo hipaisumerkinanto OI_F

Muuntajan käämikytkimen asentomerkinanto TxTap

Arvomerkinanto VI

Sisäinen yksinapainen merkinanto IS

Sisäinen yksinapainen hipaisumerkinanto IS_F

Sisäinen kaksinapainen merkinanto ID

Sisäinen kaksinapainen merkinanto välitilalla ID_S

Ulkoinen yksinapainen merkinanto ExSI

Ulkoinen yksinapainen hipaisumerkinanto ExSI_F

Ulkoinen kaksinapainen merkinanto ExDP

Ulkoinen kaksinapainen merkinanto välitilalla ExDP_I

Bittimalli merkinannot 8, 16 ja 32 bittiä BM8, BM16, BM32

Ulkoiset bittimalli merkinannot 8, 16 ja 32 bittiä ExBM8, ExBM16, ExBM32

Ulkoinen laskuri ExMV

Ohjaukset Yksinapainen ohjaus C_S / CF_S

Yksinapainen käänteinen ohjaus C_SN / CF_SN

2-nap. ohjaus 1-koskett. (2 bin. ulostuloa BO) C_D2 / CF_D2

2-nap. ohj., 1-AUKI ja 2-KIINNI kosketinta (3 BO) C_D12 / CF_D12

2-nap ohj. 1.5-kosketinta (3 bin. ulostuloa BO) C_D3 / CF_D3

2-nap. ohj. 2-kosketinta (4 bin. ulostuloa BO) C_D4 / CF_D4

2-nap ohj., käänt. 1-kosketin (2 bin. ulostuloa BO) C_D2N / CF_D2N

Ulkoinen yksi- / kaksinapainen ohjaus ExC / ExCS

1-nap. onj. 2-kosketinta (2 bin. ulostuloa BO) C_S2 / CF_S2

2-nap. ohj., 2-KIINNI ja 1-AUKI kosketinta (3 BO) C_D21 / CF_D21

2-nap. ohj., 2-KIINNI ja 2-AUKI kosketinta (4 BO) C_D22 / CF_D22

2-nap. ohj., 3-AUKI ja 1-KIINNI kosketinta (4 BO) C_D31 / CF_D31

2-nap. ohj., 3-AUKI ja 3-KIINNI kosketinta (6 BO) C_D33 / CF_D33

2-nap. ohj., 4-AUKI ja 4-KIINNI kosketinta (8 BO) C_D44 / CF_D44
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Mittausarvot Käyttäjän määrittelemä mittauksen raja-arvo LVU

Mittauksen raja-arvo LV

Mittausarvokanava MC

Suojausmittausarvo MV

Suojausmittausarvo aikaleimalla MVT

Käyttäjän määrittelemä suojausmittausarvo MVU

Pulssilaskuriarvot Pulssilaskuriarvo PMV

Mittausarvosta laskettu pulssilaskuriarvo MVMV

Taul. 5-2 Informaatiotyypit

Ohje:
Ulostulomerkinannoilla tarkoitetaan suojaustoimintojen aktivoimia 
informaatioita ja sisäisillä merkinannoilla merkkauksia (taggings).
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5.7.1 Informaatioiden lisääminen ryhmiin

Informaatioita voidaan lisätä ryhmiin informaatiokatalogista. Toimitaan 
seuraavasti:

• Informaatiokatalogi avataan valitsemalla
Insert → Information tai View → Information catalog.

DIGSIGB064

Kuva 5-13  Informaatiokatalogi

Informaatio-
katalogin rakenne

Informaatiokatalogi on jaettu seuraaviin informaatiotyyppiryhmiin

Merkinannot (Indications) 

Ohjaukset ilman takaisinkytkentää (Commands without 
feedback) 

Ohjaukset varustettuna takaisinkytkennällä (Commands with 
feedback)

Mittausarvot (Measured values) 

Laskuripulssiarvot (Metered values) 

Näiden informaatioryhmien alla on yksittäiset informaatiotyyppiluokat, 
kuten esimerkiksi
yksinapaiset merkinannot (single point indication), kaksinapaiset 
merkinannot (double point indication) tai ulostulomerkinannot 
(output indication). 
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Informaation 
lisääminen

• Avataan hakemistoja kunnes haluttu informaatiotyyppi on näkyvissä. 
Valitaan haluttu informaatiotyyppi. Pidetään hiiren vasenta painiketta 
alhaalla ja siirretään informaatiotyyppi määrittelymatriisiin halutun 
informaatioryhmän nimikentän päälle ja vapautetaan vasen 
hiiripainike. Tällöin informaatio on lisätty ryhmään. Informaation 
näyttötekstinä esitetään informaatiotyypin lyhenne ja pitkänä tekstinä 
informaatiokatalogissa esitetty nimi. 

5.7.2 Informaatioryhmän lisääminen

Yksittäisten informaatioiden lisäämisen lisäksi on mahdollista myös lisätä 
käyttäjän toimesta informaatioryhmiä määrittelymatriisiin, johon voidaan 
edelleen lisätä käyttäjän määrittelemiä informaatioita.

Nämä itseluodut ryhmät ja informaatiot ovat poistettavissa tarpeen 
vaatiessa.

Toimitaan seuraavasti:

• Klikataan informaatioryhmän nimikenttää jonka ylä- tai alapuolelle 
uusi ryhmä halutaan luoda ja valitaan oikealla hiiripainikkeella Insert 
Group - Before tai Insert Group - After valikosta. 
Tällöin aukeaa Insert Group ikkuna näytölle.

DIGSIGB063

Kuva 5-14  Ryhmän lisääminen määrittelymatriisiin

• Display text kenttään voidaan kirjoittaa enintään 15 merkillä ryhmän 
nimi, jota käytetään ryhmän nimikentän tekstinä. 

• Long text kenttään voidaan kirjoittaa enintään 30 merkillä ryhmän 
nimi, jota käytetään "tooltip" tekstinä. Tämä teksti tulee näkyviin kun 
kursori viedään ryhmän nimikentän päälle. 

• Asettelut hyväksytään OK painikkeella.

Ohje:
Kun matriisiin liitetään informaatiotyyppi ohjaus varustettuna 
takaisinkytkennällä (Command with feedback), luo ohjelma 
automaattisesti yhden rivin ohjaukselle ja toisen takaisinkytkentä 
merkinannolle.
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Asetteluita ei ole vielä tallennettu asettelutiedostoon, vaan ne on siirretty 
vasta tietokoneen väliaikaiseen muistiin. Lisätietoja asetteluiden 
tallennuksesta on esitetty kappaleessa 4.4.

5.7.3 Ryhmien ja informaatioiden nimeäminen

Käyttäjän määrittelemien ryhmien ja informaatioiden nimeäminen 
suoritetaan seuraavasti:

Ryhmän 
nimeäminen

• Valitaan oikealla hiiripainikkeella halutun ryhmän nimikenttä ja 
valitaan Rename Group toiminta valikosta. 
Tällöin aukeaa Group Properties ikkuna näytölle.

DIGSIGB065

Kuva 5-15  Ryhmän ominaisuudet - ikkuna

• Muutetaan ryhmän näyttö- (lyhyt) ja pitkä teksti tarvittaessa ja 
hyväksytään muutokset OK painikkeella. Määrittelyikkuna sulkeutuu 
ja ryhmän nimi päivittyy.

Informaation 
nimeäminen

Informaatio nimetään seuraavasti:

• Kaksoisklikataan nimikenttää, syötetään haluttu nimi ja hyväksytään 
muutos Return painikkeella.

Ohje:
Uusia ryhmiä voidaan lisätä matriisiin vain pystysuunnassa 
informaatiotoimintaluokkina.
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5.7.4 Ryhmien ja informaatioiden poistaminen

Käyttäjän määrittelemien ryhmien ja informaatioiden poistaminen 
suoritetaan seuraavasti: 

• Valitaan oikealla hiiripainikkeella poistettavan ryhmän nimikenttää ja 
valitaan Delete Group toiminta valikosta.  

• Vahvistetaan toiminta vastaamalla Yes näyttöön aktivoituneeseen 
kyselyikkunaan. 

Ryhmä on tällöin poistettu.

Informaatioiden 
poistaminen

Klikataan oikealla hiiripainikkeella poistettavaa informaatiota ja valitaan 
Delete Information valikosta ja vahvistetaan poistotapahtuma Yes 
painikkeella. 

Huomio:
Kun ryhmä poistetaan, poistuvat automaattisesti myös kaikki ryhmässä 
olleet informaatiot. Toimintaa ei voi palauttaa suoraan. Jos vahingossa 
on poistettu ryhmä jota ei pitänyt poistaa, suljetaan laite tallentamatta ja 
avataan uudelleen. Tällöin kuitenkin menetetään muut mahdolliset 
muutokset joita ei vielä oltu tallennettu.
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Konfigurointi
5.8 Informaatioiden ominaisuudet

Jokaisella informaatiolla on informaatiotyypin mukaiset ominaisuudet, 
joita voidaan muuttaa muista informaatioista riippumatta. On esimerkiksi 
mahdollista määritellä kullekin informaatiolle erikseen esitetäänkö se 
häiriötallenteessa binäärisenä signaalina tai voidaan määritellä minkä 
tilan informaatio saa kun laite käynnistyy. Informaatioiden ominaisuudet 
ovat myös liikennöintiprotokollakohtaisia, jolloin kaikki 
liikennöintiprotokollat eivät tue kaikkia mahdollisia ominaisuuksia. 

Ominaisuuksien 
muuttaminen

Ominaisuuksia voidaan muuttaa seuraavasti:

• Valitaan haluttu informaatio oikealla hiiripainikkeella ja valitaan 
Properties toiminta valikosta. 
Tällöin aukeaa Object properties ikkuna näytölle.

DIGSIGB148

Kuva 5-16  Informaation ominaisuudet, esimerkki

Asetteluikkunan
rakenne

Ikkunan otsikkokentässä esitetään informaation lyhyt teksti (näyttöteksti) 
ja informaatiotyypin lyhenne. 

Yksittäiset ominaisuudet on jaettu eri sivuille. Sivujen ja asetteluiden 
lukumäärä on riippuvainen: 

SIPROTEC 4 laitteen tyypistä

Informaation tyypistä

Parametriryhmäversiosta

Ominaisuuksien 
hyväksyminen

• Määritellyt ominaisuudet hyväksytään sulkemalla ominaisuudet 
ikkuna OK painikkeella. 
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Informaatioiden ominaisuudet
• Apply painikkeella voidaan hyväksyä siihen mennessä suoritetut 
muutokset ja jatkaa työskentelyä ikkunassa sen sulkeutumatta. 

Molemmissa tapauksissa siihen mennessä muutetut arvot tallentuvat 
tietokoneen väliaikaiseen muistiin. Niitä ei vielä ole tallennettu pysyvästi 
parametritiedostoon (katso kappale 4.4). 

5.8.1 Esimäärittely

DIGSIGB139

Kuva 5-17  Esimerkki esimäärittelyt kentästä

• Aktivoidaan Default selection during first startup valintaruutu, 
jolloin Setting value during first startup valikkokenttä aktivoituu.

• Valitaan informaatiolle Setting value during first startup 
alasvetovalikosta haluttu tila, joka informaatiolle halutaan määritellä 
laitteen noustessa ensimmäistä kertaa ylös. Joissakin laitteissa tulee 
haluttu tila-arvo syöttää suoraan.

• Valitaan Default selection during restart tarkastusvalintakenttä, 
jolloin Setting value during restart alasvetovalikko aktivoituu.

• Valitaan Setting value during restart alasvetovalikosta haluttu tila, 
joka informaatiolle halutaan määritellä laitteen tehdessä uudelleen 
käynnistyksen. Joissakin laitteissa tulee haluttu tila-arvo syöttää 
suoraan.

Ohje:
Tietoja uudelleen käynnistyksen (restart) ja käynnistyksen (resume) 
ominaisuuksista on esitetty kappaleessa 4.3.6.
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Konfigurointi
5.8.2 Liittäminen häiriötallenteeseen

DIGSIGB144

Kuva 5-18  Esimerkki informaation liittämisestä häiriötallenteeseen

• Valitaan Select message in fault record valintakenttä, jolloin 
informaatio esitetään häiriötallenteessa binäärisenä palkkina. Tämä 
valintakenttä voidaan aktivoida enintään 40 informaatiolle (joissakin 
tapauksissa SIPROTEC laitteen tyypistä riippuen valittavien 
informaatioiden lukumäärä voi olla poikkeava). 

5.8.3 Kosketinvärähtely ja suodatus

DIGSIGB140

Kuva 5-19  Kosketinvärähtely ja suodatusominaisuuksien määrittelyikkuna, 
esimerkki

• Valitaan Activate chatter blocking tarkastusruutu, jos 
kosketinvärähtelytoiminta halutaan aktivoida tälle informaatiolle. 
Määrätyillä informaatioilla tämä ominaisuus ei ole valittuna 
tehdasasetuksena.

• Syötetään haluttu suodatusaika millisekunteina Software filter time 
kenttään. Suodatusaika määrittelee kuinka kauan aikaa signaalin 
tulee olla aktiivisena jotta informaatio aktivoituisi lopullisesti. 
Asettelualue on 0 ... 86400000 ms (noin 1 päivä). 

• Valitaan Retrigger filter valintakenttä, jos halutaan että laskuri alkaa 
uudestaan nollasta jos informaatio poistuu välillä ja tulee uudelleen. 
Tämä valintaruutu aktivoituu vasta kun suodatusaikakenttään on 
syötetty hyväksyttävä asetteluarvo.
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Informaatioiden ominaisuudet
• Aktivoidaan Indication filter time toiminta, jos halutaan että 
informaatio varustetaan aikaleimalla joka vastaa signaalin todellista 
aktivoitumista.  Tällöin Retrigger filter valintaruutu aktivoituu 
samanaikaisesti. 
Jos valintaa ei ole aktivoitu, varustetaan merkinanto aikaleimalla joka 
on ollut voimassa suodatusajan kuluttua umpeen. 

• Valitaan Suppress intermediate position toiminta jos halutaan että 
merkinanto ei muuta tilaansa sen ollessa väliasennossa.

5.8.4 Käämikytkimen asennot

DIGSIGB141

Kuva 5-20  Esimerkki käämikytkimen asentomäärittelyistä

• Valitaan käämikytkimen asennon informaatiotyyppi Encoding 
alasvetovalikosta, vaihtoehtojen ollessa Binary, 1 of n, BCD tai 
Table. Valitaan Table tyyppi, jos halutaan määritellä koodaustapa 
itse.

• Käämikytkimen asentojen lukumäärä syötetään Number of taps 
kenttään.

• Syötetään käämikytkimen asentojen esityksessä tarvittava bittien 
lukumäärä  Number of bits kenttään. Syötettävä lukumäärä on 
riippuvainen käytetystä koodaustavasta. Esimerkiksi jos halutaan 
esittää kahdeksan käämikytkimen asentoa binäärisesti koodattuna, 
tarvitaan kolme bittiä. Jos käytössä on jo määrittely, voi tämä rajoittaa 
valittavissa olevien bittien lukumäärää. 

• Syötetään Display offset kenttään arvo joka rajaa suurimman 
esitettävissä oleva arvon positiivisessa tai negatiivisessa suunnassa. 
Asetteluarvoalue on  -127 ... +127. 

• Asetetaan yhdellä kertaa ohjautuvien portaiden lukumäärä Tap 
interval kenttään. Askellukumäärät voidaan syöttää käsin. Tämä 
arvo määrittelee portaiden lukumäärän, joita kenttäyksikkö ohjaa 
ylös- tai alaspäin 
(alueella 1 ... 8).
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Esimerkki:
Tap interval = 2: 2 porrasta 0,5 välein
Tap interval = 4: 4 porrasta 0,25 välein

• Valitaan Representation of coding kentässä lukujärjestelmä jolla 
koodaustaulukko halutaan syöttää. Vaihtoehtoja ovat Binary (2), 
Octal (8), Decimal (10) ja Hexadecimal (16). Valittu toimintatapa 
vaikuttaa kaikkiin Encoding sarakkeessa syötettyihin arvoihin. Jos 
lukujärjestelmää muutetaan kun kooditaulukko on jo syötetty, 
muunnetaan syötetyt koodit automaattisesti vastaamaan uutta 
lukujärjestelmää. Syöttöalue esitetään välittömästi kun Table asettelu 
on valittu Encoding kentässä. 

• Syötetään yksittäisen portaan luku Code table kentän Encoding 
sarakkeeseen. Syötetyn arvon tulee olla desimaalialueella 0 ... 256 ja 
sen tulee vastata valittua lukujärjestelmää. Aseteltavien 
porrasarvojen lukumäärä määräytyy automaattisesti. Apply 
painikkeella voidaan syöttää numeerinen arvo Number of taps 
kenttään.Syöttöalue esitetään välittömästi kun Table asettelu on 
valittu Encoding kentässä. 

• Aktivoidaan Moving contact toiminta, jos halutaan että uutta asentoa 
ei päivitetä niin kauan aikaa kuin liikkuva kosketin kuvaa 
käämikytkimen olevan vielä liikkeessä.

Esimerkki Neljä käämikytkimen asentoa esitetään arvoina 3 ... 6 kolmea binääristä 
tuloa hyödyntäen (BI 1 ... BI 3). Koodaustyyppinä käytetään binääristä 
menetelmää. 

Ohje:
Jos mikään koodauksessa käytettävistä binäärisistä tuloista ei ole 
aktiivisena, on näytöllä virheellinen asennon osoitus (jota ei tule sekoittaa 
"display offset" arvoon). Tällöin näytöllä on _____ tunnus osoituksena 
väärästä asennosta.

Tilat Näytetty asento
BI 1 BI 2 BI 3

- - - 63.00

X - - 3.00

- X - 4.00

X X - 5.00

- - X 6.00

X - X 63.00
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Binäärisellä koodauksella ja kolmella binäärisellä tulolla voidaan esittää 
enintään 23 = 8 porrasta. Käämikytkimen asentojen osoitukset alkavat 
arvosta 3. Tällöin informaation ominaisuudet tulee asetella seuraavasti: 

Käyttöön tulee määritellä aina kolme peräkkäistä binääristä tuloa ilman 
välejä, esimerkiksi BI 1, BI 2 ja BI 3.

5.8.5 Pulssityyppi ja virhe sisääntulo

DIGSIGB143

Kuva 5-21  Pulssityyppi ja virhe sisääntulo ikkuna

• Valitaan Wiping pulse / S0 vaihtoehto Pulse type kentässä, jos 
halutaan että pulssin nouseva reuna lisää laskuriarvoa yhdellä. 
Valitaan Double current pulse vaihtoehto jos halutaan että 
nousevan reunan lisäksi pulssin tulee myös osoittaa laskevaa reunaa, 
jotta laskuriarvo lisääntyisi yhdellä.

• Valitaan Use fault input valintaruutu, 
jos käyttöön halutaan määritellä häiriösisääntulo joka kuvaa 
pulssimittauksen toimivan virheellisesti.

Koodaus Binääri
Askelten 
lukumäärä

4

Bittien lukumäärä 3
Display offset 2
Askelväli 1
207SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Konfigurointi
5.8.6 Energiamittausarvojen lähetys ja energian suunta

DIGSIGB142

Kuva 5-22  Energiamittausarvojen lähetys ja energian suunnan määrittelyt

• Valitaan Cyclic vaihtoehto Restore trigger kentästä, jos 
energiamittausarvot halutaan lähettää kaukokäytölle jaksottaisin 
aikavälein. Muussa tapauksessa valitaan None vaihtoehto. 

• Energiamittausarvojen lähetykseen yleisesti liittyviä asetteluita voi 
suorittaa aktivoimalla määrittelyikkuna Set painikkeella. 

• Energy flow direction kentässä määritellään onko summattu 
energia toimitettu vai vastaanotettu. Nämä vaihtoehdot ovat 
määriteltävissä vain käyttäjän määrittelemille energian 
mittausarvoille.

5.8.7 Mittausarvojen määrittelyt

DIGSIGB138

Kuva 5-23  Esimerkki mittausarvojen määrittely ikkunasta

• Valitaan haluttu suure mittaukselle Dimension alasvetovalikosta tai 
syötetään se kenttään suoraan. Tällöin mittausarvo esitetään 
mittausarvoikkunassa valitulla suureella. Suureen määrittely on 
mahdollista vain käyttäjän määrittelemille mittauksille ja raja-arvoille.

• Conversion factor kenttään syötetään lukuarvo, jolla mitattu suure 
kerrotaan ennen sen esittämistä. Määritelty kerroin vaikuttaa mitatun 
suureen tulosignaaliin ja mittaukseen mahdollisesti liittyvät raja-arvot 
vertaavat toiminnassaan lopullista laskettua arvoa. Muunnoskerroin 
on mahdollista asetella vain käyttäjän määrittelemille mittauksille ja 
raja-arvoille.
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• No. of decimal places kentässä määritellään mittausarvon 
esityksessä käytettyjen desimaalien lukumäärä. Mittausarvolle on 
mahdollista määritellä enintään 10 desimaalia. Desimaalien 
lukumäärä on määriteltävissä vain käyttäjän määrittelemille 
mittausarvoille.
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5.8.8 Bittimallit

DIGSIGB145

Kuva 5-24  Esimerkki bittimallin määrittelyikkunasta

• Number of bits kentässä määritellään bittimalli merkinannon bittien 
lukumääräksi 8, 16 tai 32 bittiä. Jo binäärisiin tuloihin määritellyn 
merkinannon suurinta asettelua voi rajoittaa ensimmäisen binäärisen 
tulon määrittely ja sen oikealla puolella määriteltävissä olevat 
binääriset tulot. 

5.8.9 Lukitukset

DIGSIGB147

Kuva 5-25  Lukitukset ikkuna
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Vyöhykeohjaus •  Check zone control valintaruutu aktivoidaan, jos lukitusehdot tulee 
tarkastaa ennen ohjauksen toteutusta. Lukitusehdot voidaan 
tarkastaa ohjauksille sekä kiinni että auki suunnassa. Lukitusehdon 
tilat määräytyvät Release ON command ja  Release OFF command 
kentissä määriteltyjen merkinantojen ohjaamina. Kun toiminta on 
määritelty käyttöön, ohjaus ei ole mahdollista elleivät lukitusehdot salli 
sitä. Jos käyttöön on valittu vaihtoehto Release when system 
locking OR zone control completed, on ohjaus mahdollista jos 
paikalliset lukitusehdot täyttyvät.

• Release ON and OFF commands kenttiin määritellään 
lukitusehtojen tilaa kuvaavat merkinannot. Jos jompaan kumpaan 
suuntaan halutaan suorittaa ohjaus ilman että lukitusehtoja 
tarkastetaan, valitaan tuohon kenttään alasvetovalikosta None 
vaihtoehto. Alasvetovalikossa esitetään kaikki matriisissa esitetyt 
informaatiorivit, joista tapahtumat voidaan valita. Valintakentät 
aktivoituvat välittömästi kun Check zone control  valintaruutu on 
aktivoitu. 

Asematason 
lukitukset

• Kun  Check system locking valintaruutu aktivoidaan, kysytään 
ennen ohjauksia ulkoiselta keskusyksiköltä lupaa asematason 
lukitukselta ohjaukselle. Jos asematason lukitusehdoista ei saada 
lupaa ohjaukselle, ei ohjausta suoriteta. Jos Release when system 
locking OR zone control completed vaihtoehto on aktivoitu,voidaan 
ohjaus toteuttaa jos lupa asematason lukituksilta on saatu, vaikka 
paikalliset lukitusehdot estäisivätkin ohjauksen.

• Kun Release when system locking AND zone control completed 
vaihtoehto on aktivoitu, on ohjaus mahdollista vain kun sekä 
asematason että kenttätason lukitusehdot sallivat ohjauksen. 

• Kun Release when system locking OR zone control completed 
vaihtoehto on aktivoitu, on ohjaus mahdollista jos ohjauslupa 
saadaan joko asematason tai kenttätason lukitusehdoilta. 
Toiminta on valittavissa vain SIPROTEC 4 laitteilla versiosta V4.2 
lähtien. Toiminta on käytettävissä jos Check zone control ja Check 
system locking valintaruudut on molemmat aktivoitu. 

Muut lukitukset • Kun Blocking for protection activation valintaruutu on aktivoitu, 
tarkastetaan suojaustoimintojen tilat ennen ohjauksen toteutusta. 
Ohjaustoiminta on estetty jos jokin laitteen suojien toiminnoista on 
havahtuneena. Tällöin ohjaus ei ole mahdollista. Tämä ehto ei vaikuta 
AUKI-suunnan ohjauksiin. Tulee huomioida että esimerkiksi termisen 
ylikuormitussuojan hälytysporras tai herkkä maasulun suuntatoiminta 
voi lukita ohjauksen pidemmäksi aikaa, jona aikana kiinniohjaus ei ole 
mahdollista. Jos tätä tarkastusta ei kuitenkaan määritellä päälle, tulee 
huomioida että esimerkiksi moottorin uudelleenkäynnistyksen 

Ohje:
Asematason lukitukset ovat mahdollisia vain kun laite on liitetty 
PROFIBUS FMS liikennöinnillä SICAM SAS ohjausjärjestelmään.
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estotoiminta ei automaattisesti lukitse moottorin kiinniohjausta. 
Tällöin moottorin kiinnikytkentä tulee estää toisin menetelmin, 
esimerkiksi määrittelemällä esto CFC logiikassa.

• Double operation Valintaruudun aktivointi estää kahden 
yhtäaikaisen ohjauksen suorituksen. Jos laitteella on käynnissä 
ohjaustoiminta, ei uuden aktivointi ole mahdollista ennen kun 
ensimmäinen on päättynyt.

• Double activation blockage valintaruudulla estetään myös 
useamman yhtäaikaisen ohjauksen toteutus (1-N tarkastus). Jos 
laitteella on jo ohjaus aktiivisena, ei uutta ohjausta toteuteta ennen 
kuin ensimmäinen on päättynyt.

• Aktivoimalla Check switching authority at local commands 
valintaruutu tarkastetaan SIPROTEC 4 laitteen paikallisohjauksessa 
että ohjausoikeuksien avainkytkin on Local asennossa. Vain tällöin 
paikallisohjaus on mahdollinen.

• Aktivoimalla  Check switching authority at remote commands 
valintaruutu tarkastetaan SIPROTEC 4 laitteen kauko-ohjauksessa 
että ohjausoikeuksien avainkytkin on Remote asennossa. Vain tällöin 
paikallisohjaus on mahdollinen.

Lukitusehtojen 
ohitus

Tarvittaessa yllä mainitut lukitusehdot voidaan ohittaa. Jotta toiminta olisi 
mahdollista, tulee  Bypass interlock valintaruutu olla aktivoitu 
Equipment kentässä. Oikein syötetyn salasanan jälkeen ohjaus 
suoritetaan lukitusehdoista välittämättä. Tällöin joka tapauksessa 
otetaan huomioon lukitusehdot, jotka on määritelty Unclearable locks 
kentissä. Nämä ehdot otetaan huomioon vaikka Bypass interlock 
olisikin aktivoituna.

• Kun Device status (nominal = actual) valintaruuru on aktivoitu, 
suoritetaan ohjaussuunnan tarkastus vertaamalla sitä kytkinlaitteen 
olemassa olevaan asentoon. Jos kytkinlaite on jo tilassa johon sitä 
oltaisiin ohjaamassa, ei ohjausta toteuteta. Kytkinlaitteen tilatarkastus 
on käytössä riippumatta siitä ovatko lukitusehdot käytössä vai 
ohitettuina.

• Password alasvetovalikossa voidaan käyttöön määritellä jokin 10:stä 
kytkinlaite salasanasta. Tätä salasanaa kysytään aina ennen 
ohjauksen suoritusta. Yksittäiset salasanat on muutettavissa (katso 
kappale 4.6). 

• Release ON and OFF commands kenttiin määritellään 
lukitusehtojen tilaa kuvaavat merkinannot. Jos jompaan kumpaan 
suuntaan halutaan suorittaa ohjaus ilman että lukitusehtoja 
tarkastetaan, valitaan tuohon kenttään alasvetovalikosta None 
vaihtoehto. Alasvetovalikossa esitetään kaikki matriisissa esitetyt 
informaatiorivit, joista tapahtumat voidaan valita. 

Ohje:
Saman kytkinlaitteen päällekkäinen ohjaus on aina estetty.
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5.8.10 Ajat

DIGSIGB137

Kuva 5-26  Ohjausaikojen määrittely

• Jos ohjausmenetelmäksi on valittu pulssiulostulo Pulse output 
operating mode kentässä, syötetään Output kenttään ohjausaika 
sekunnin kymmenyksinä ja pitoaika Seal-in time myös sekunnin 
kymmenesosina. Ohjausaikaa jatketaan tällä ajalla, jos kytkinlaite ei 
todellisuudessa ole saavuttanut vielä lopullista asentoaan vaikka 
takaisinkytkentämerkinanto olisikin jo vastaanotettu. Seal-in time 
määrittely on tarpeen kytkinlaitteille, joilla takaisinkytkentämerkinanto 
tulee ennen kuin ohjaustoiminta on lopullisesti päättynyt.

• Takaisinkytkennän valvonta-aika asetellaan  Feedback monitoring 
kentässä sekunnin kymmenyksinä. Kytkinlaitteen asentotiedon 
takaisinkytkentämerkinannon tulee aktivoitua tämän ajan sisällä. Jos 
asentotieto tulee vasta valvonta-ajan kuluttua umpeen, käsitellään 
sitä spontaanina tilamuutoksena.

• Jos ohjauksen toimintatavaksi on valittu Pulse output, voidaan 
ohjauksen pitoaika asetella Command end delay kentässä sekunnin 
kymmenyksinä. Tämä aikaviive käynnistyy kun ohjausaika on 
päättynyt. Aikaviivettä voidaan käyttää ohjaussekvensseissä 
viivästämään seuraavan toiminnan aloitusta.

• Ohjauksen toimintatapa voidaan määritellä Mode alasvetovalikossa. 
Valittavissa on jatkuva ohjaus Persistent output ja pulssiohjaus 
Pulse output. Jos samalle binääriselle ulostulolle on määritelty 
useampia ohjauksia, tulee niillä kaikilla olla sama toimintatapa 
määriteltynä.

Ohjausten 
aikavasteet

Ohjaustoiminnat noudattavat 100 millisekunnin aikaintervalli väliä.

Ohjaus aktivoituu välittömästi kun ohjaus on käynnistetty ja tarkastukset 
suoritettu. Kaikki muut käsittely- ja valvontatoiminnat ovat aikaohjattuja.

Määritellyt valvonta-ajat (esim. ohjausaika, takaisinkytkennän valvonta-
aika, jne.) ovat taattuja minimiaikoja, eli todellinen valvonta/käyntiaika voi 
vaihdella aika-alueella +0 ... +99 ms:

Valvonta/käyntiajat = asettelu + (0 … 99 ms)
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Koska laitteen paikallisohjausissa on käytössä sama 100 ms 
aikaintervalliväli, tulee paikallisohjauksiin (Local Control , (VQ_LOCAL)) 
aina +99 ms lisäaika. 

Esimerkki:
Aseteltu ohjauksen kesto = 5.0 s riippuen ohjauksen lähteestä:

Ohjauksen lähde Ohjausaika

Paikallisohjaus (etupaneelilta) = 5099 ms

Kaikki muut ohjauslähteet = 5000...5099 ms
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5.8.11 Lähetyskynnys

Lähetyskynnys määrittelee mittausarvojen lähetysvälin. Se asetellaan 
prosentteina. Jos asetteluksi on valittu nolla, lähetetään kaikki 
mittausarvomuutokset ylemmälle ohjaustasolle. Jos asetteluksi on valittu 
jokin muu kuin nolla, lisätään muutosarvo viimeksi lähetettyyn 
mittausarvoon. Kun tämä summa-arvo saavuttaa asetellun 
prosenttiarvon, lähetetään uusi mittausarvo ylemmälle tasolle. 

Transmission threshold sivu on käytettävissä, jos mittausarvo on 
määritelty lähetettäväksi järjestelmäväylän kautta ulkoiseen 
järjestelmään.

DIGSIGB146

Kuva 5-27  Lähetyskynnyksen määritellyikkuna

Kynnysarvo • Use Central Threshold (10%) valintaruudun aktivointi ottaa käyttöön 
esiasetellun 10% lähetyskynnyksen. Tämä valinta ohittaa kaikki muut 
tämän sivun asettelut.

• Asetteluarvoksi voidaan määritellä 0 ... 2000 Parameterized 
Threshold asettelukentässä. Aseteltu arvo kerrotaan 0.1% lopullisen 
kynnysarvon määrittelemiseksi. Tätä arvoa käytetään 
lähetyskynnyksenä, edellyttäen että Central threshold valintaruutua 
ei ole aktivoitu. 

Vaihtotoiminta Merkinannon tila voidaan vaihtaa 10% tehdasasettelun ja parametroidun 
kynnysarvon välillä. Merkinannon ollessa tulleena ON tai INCOMING, on 
aseteltu kynnysarvo käytössä. Merkinannon ollessa poistuneena OFF tai 
OUTGOING, on 10% tehdaskynnysarvo käytössä. 

• Switching over alasvetovalikossa valitaan merkinanto, joka ohjaa 
kynnysarvojen toimintaa. 
Valittavissa on merkinannot Switching Object ryhmästä. 
Jos käytössä on vain 10% esiasetus tai aseteltu kynnysarvo, valitaan 
vaihtoehdoksi No threshold switching.
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5.8.12 IEC 103 (IEC 60870-5-103)

DIGSIGB136

Kuva 5-28  Esimerkki IEC 103 määrittelysivusta

• Function type kentässä valitaan SIPROTEC 4 laitteen 
merkinannolle toiminnallisesti sidottu funktiotyyppi, esimerkiksi tässä 
tapauksessa distanssisuojatoiminta. Funktiotyypit on lueteltu 
protokollan käyttöohjeessa. Joitakin numeroita ei ole määritelty 
standardissa. Nämä voidaan vapaasti määritellä käyttöön ilman että 
IEC yhteensopivuus vaarantuisi.

•  DU type  alasvetovalikossa informaation tyypiksi voidaan määritellä 
käyttömerkinanto Operational indication tai häiriömerkinanto Fault 
indication. 

• Information number kentässä määritellään informaatiolle 
järjestysnumero. Sillä erotetaan informaation osoite muista 
vastaavan funktiotyypin informaatioista eli yhdessä laitteessa ei saa 
olla kahta informaatiota joilla on samat funktiotyypit ja 
informaationumerot. DIGSI ohjelma valvoo numerointeja eikä anna 
valita kahta samaa numeroparia samalla laitteella. 
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5.8.13 Protokollainformaatio

DIGSIGB154

Kuva 5-29  Esimerkki protokollainformaation lähde sivusta

DIGSIGB155

Kuva 5-30  Esimerkki protokollainformaation kohde sivusta

Nämä sivut ovat käytettävissä vain muilla protokollilla. Riippuen siitä 
onko informaatio liitetty järjestelmäväylään lähteenä vai kohteena, on 
toinen tai molemmat sivut käytettävissä. Protocol info - Destination tai 
Protocol info - Source ikkunoiden parametrit määräytyvät käytetyn 
protokollan mukaisesti. 

Liikennöintimodulin mukana toimitetaan tarvittaessa 
protokolladokumentaatio. Tässä dokumentaatiossa on kuvattu 
asetteluparametrien merkitykset.
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5.8.14 Mittausarvot - kohde

DIGSIGB153

Kuva 5-31  Esimerkki mittausarvojen kohde ikkunasta

Tämä sivu on käytettävissä vain muilla protokollilla. Sitä käytetään 
mittausarvojen skaalaukseen. Mittausarvon skaalaus on yleensä 
tarpeen, jos mittausarvon resoluutiota tulee alentaa. Jos esimerkiksi 32-
bittinen mittausarvo tulee alentaa 16-bittiseksi, on seurauksena 
informaation menetys joka voi olla merkittävää mittausarvojen 
käsittelyssä. Skaalaamalla voidaan muunnoksesta aiheutuva haitta 
estää. 

Seuraavat skaalausparametrit ovat aina aseteltavissa:

• Type kentässä valitaan onko kyseessä prosentti-, ensiö- tai 
toisioarvo.

• Scaling factor kentässä määritellään mittausarvolle kerroinarvo.

• Zero offset kentässä määritellään arvo joka lisätään mittausarvoon.

Riippuen käytetystä protokollasta voi käytössä vielä olla myös muita 
asetteluparametrejä, kuten esimerkiksi lähetyskynnysarvo Threshold 
value, DNP protokollalla.
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5.9 Energiamittausarvojen lähetystoiminnan määrittely

SIPROTEC 4 laitteen muistissa olevien energiamittausarvojen 
lähetystapa on määriteltävissä. Laskuriarvot lähetetään jaksottaisesti. 
Käyttöön valitaan aikaperusta joka toimii jaksottaisen lähetyksen 
perustana. Lisäksi määritellään lähetysaikaväli ja nollataanko laskuri 
lähetyksen jälkeen vai ei.

Toimitaan seuraavasti:

• Valitaan Options → Metered Values. Tällöin näyttöön aukeaa 
Restore Metered Values ikkuna.

DIGSIGB081

Kuva 5-32  Laskuriarvojen lähetysvälin määrittely

• Jos aktivointi suoritetaan aikavälein käyttäen absoluuttista aikaa, 
aktivoidaan Triggering with absolute time valintaruutu. Jos ruutua 
ei ole valittu, on käytössä suhteellinen aikaperusta.

• Time interval alasvetovalikossa määritellään laskuriarvojen 
lähetysaikaväli.

• Aktivoidaan Delete valintaruutu, jos laskureiden halutaan nollautuvan 
lähetyksen jälkeen.

• Valitaan DIGSI -> Device painike, jolla voidaan siirtää muutetut 
määrittelyt SIPROTEC 4 laitteelle. Painike on käytettävissä vain jos 
käytössä on Online käyttötila ja vähintään yhtä arvoa on muutettu.

• Asettelut hyväksytään OK painikkeella. Tällöin muutokset on 
tallennettu vasta tietokoneen väliaikaiseen muistiin, mutta ei 
tiedostoon.

Ohje:
Suoritetut asettelut vaikuttavat yleisesti kaikille laskuriarvoille. 
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5.10 Kosketinvärähtelytoiminnan määrittely

Kosketinvärähtelyn valvontatoiminta tarkkailee binäärisen informaation 
muutosten lukumäärää määrätyn aikavälin sisällä. Jos muutosten 
lukumäärä ylittää valvontarajan, lukittuu informaation päivittyminen 
määrätyksi ajaksi jotta päiväkirja ei täyttyisi tarpeettomasti.

Jos binäärisellä tulolla on kosketinvärähtelytilanne ja tulo on 
lukittuneena, ilmaistaan se merkinannolla, jossa on lisäpääte FLS. 
Lisäksi kosketinvärähtelymerkinanto Chatter blocking kirjautuu 
käyttöpäiväkirjaan.

Värähtelevä ja lukittu yksinapainen merkinanto asetetaan tullut tilaan, 
jos sen toimintatapana on työvirtaperiaate. 

Värähtelevä ja lukittu yksinapainen merkinanto asetetaan poistunut 
tilaan, jos sen toimintatapana on lepovirtaperiaate. 

Merkinantoa voidaan käyttää esimerkiksi lukituksissa CFC logiikassa. 

Värähtelevä kaksinapainen merkinanto asetetaan virhetilaan (Fault). 

Ohje:
Valvonta-asettelut pätevät yhteisesti kaikille binäärisille tuloille. 
Jokaiselle binääriselle tulolle voidaan kuitenkin toisista riippumattomasti 
määritellä kuuluuko se kosketinvärähtelyvalvonnan alaisuuteen vai ei 
(katso kappale 5.8.3). 
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Kosketinvärähtelytoiminnan määrittely
Toimitaan seuraavasti:

• Valitaan Options → Chatter Blocking. Tällöin näyttöön aukeaa 
Chatter Blocking ikkuna.

DIGISGB082

Kuva 5-33  Kosketinvärähtelyvalvonnan määrittely

Valvontaehdot Kosketinvärähtelyvalvonta määritellään seuraavin parametrein: 

• Number of permissible state changes kenttään syötetään 
muutosten lukumäärä 0 ... 65535. Asettelu määrittelee kuinka monta 
kertaa binäärinen tulo voi muuttaa tilaansa valvonta- ja 
vapautusaikojen sisällä. Jos tämä luku ylittyy, lukittuu binäärinen 
sisääntulo tai pysyy lukittuneena. Jos asetteluarvo on 0, ei 
kosketinvärähtelyvalvonta ole käytössä.

• Initial test time kenttään syötetään arvo alueella 1 ... 65535. Aika 
asetellaan sekunteina.
Binäärisen tulon tilojen muutosten lukumäärä lasketaan tämän 
aikaikkunan sisällä. Aika käynnistyy kun binäärisen tulon 
ensimmäinen tilamuutos tulee. 

• Number of chatter tests kenttään syötetään asetteluarvo alueella -1 
... 32767. Asetteluarvo määrittelee kuinka monta valvontajaksoa 
enimmillään suoritetaan ennen kuin binäärinen tulo lukittuu 
lopullisesti. Asetteluksi voidaan määritellä myös ääretön. Ääretön 
asettelu määritellään joko kirjoittamalla kenttään oo tai arvo -1.
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•  Chatter idle time kenttään syötetään asetteluarvo alueella 1 ... 
65535. Aika asetellaan minuutteina. Jos binäärisen tulon 
tilamuutosten sallittu lukumäärä ylittyy valvonta- tai vapautusaikana, 
käynnistyy tämän asettelun pituinen estoaika. Binäärinen tulo on 
lukittuneena tämän ajan. Tähän kenttään voidaan syöttää 
asetteluarvo vain jos valvontatoistokenttään (chatter checks) on 
määritelty nollaa suurempi asetteluarvo.

•  Subsequent test time kenttään määritellään asetteluarvo alueella 2 
... 65535. Aika asetellaan sekunteina. Binäärisen tulon tilojen 
muutosten lukumäärä lasketaan uudelleen tämän aikaikkunan sisällä. 
Aika käynnistyy kun kosketinvärähtelyn estoaika on päättynyt. Jos 
tilamuutosten lukumäärä on sallittujen rajojen sisällä, vapautuu 
binäärinen tulo normaaliin käyttöön. Jos muutosten lukumäärä on 
edelleen liian suuri, käynnistyy uusi estoaika ellei suurinta sallittua 
valvontojen lukumäärää ole vielä saavutettu. Tähän kenttään voidaan 
syöttää asetteluarvo vain jos valvontatoistokenttään (chatter checks) 
on määritelty nollaa suurempi asetteluarvo.

• Valitaan DIGSI -> Device painike, jolla voidaan siirtää muutetut 
määrittelyt SIPROTEC 4 laitteelle. Painike on käytettävissä vain jos 
käytössä on Online käyttötila ja vähintään yhtä arvoa on muutettu.

• Asettelut hyväksytään OK painikkeella. Tällöin muutokset on 
tallennettu vasta tietokoneen väliaikaiseen muistiin, mutta ei 
tiedostoon.

Ohje:
Kosketinvärähtelyä ei voi määritellä käyttöön esimääritellyille 
suojausmerkinannoille.
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Mitta-arvon muuntimien asettelu
5.11 Mitta-arvon muuntimien asettelu

Mittausarvojen käsittely on toteutettu seuraavin esimääritellyin 
toimintalohkoin:

Mitta-arvonmuunnin U (MU U)

Mitta-arvonmuunnin I (MU I)

Yksivaiheinen mitta-arvonmuunnin (MU1P)

Kolmivaiheinen mitta-arvonmuunnin (MU3P)

Aron mitta-arvonmuunnin (MUAron)

Mitta-arvonmuunnin lohkot on määritelty virta- ja jännitekanaviin 
DIGSI® 4 määrittelymatriisissa. Ne muodostavat määrätyt 
mittaussuureet näistä tulosuureista. Määrätyt mitta-arvonmuunnin lohkot 
aktivoidaan laitteen toiminnallisuuden määrittelyn yhteydessä ja ovat 
tämän jälkeen nähtävissä DIGSI® 4 määrittelymatriisissa tulo- ja 
lähtökanavineen. Lähtösuureet voidaan liittää edelleen haluttuihin 
kohteisiin. 

Mitta-arvonmuunnin lohkojen toiminnallinen kuvaus ja niihin liittyvät 
asetteluparametrit, informaatiot ja liityntäesimerkit on esitetty erillisessä 
laitekäyttöohjeessa. 

Seuraavaksi on kuvattu toimintatapa pääpiirteissään.

Toimitaan seuraavasti:

• Valitaan laitteen toiminnallisuuden määrittelyn yhteydessä haluttu 
mittamuunnin lohko, joka täyttää käyttökohteen vaatiman 
toiminnallisuuden (katso kappale 5.3). 

• Liitetään mittausarvokanavat DIGSI® 4 määrittelymatriisissa lähde 
puoleltaan jännite- tai virtapiireihin. 
Määritellään lasketut suureet haluttuihin kohteisiin, esimerkiksi 
järjestelmäväylään, CFC:lle tai näytölle.

Ohje:
Muista SIPROTEC laitteista poiketen yllä mainitut toimenpiteet tulee 
suorittaa vain määrätyissä tapauksissa ohjausyksiköille, joilla ei ole 
suojaustoimintoja. Ohjausyksiköillä voi olla tehdasasetteluna vain 
muutama määrittely esimerkkinä. 

Näillä laitteilla mittausarvojen määrittely poikkeaa oleellisesti muihin 
SIPROTEC laitteisiin verrattuna. 
223SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Konfigurointi
5.12 Mittausraja-arvojen määrittely

Mittausarvorajoilla voidaan valvoa mittausarvon nousua tai laskua 
määrätyn rajan yli. 

Määrittely suoritetaan seuraavasti:

Mittausarvon 
lisääminen

• Avataan DIGSI® 4 määrittelymatriisi ja lisätään katalogista uusi 
mittausarvo Measured Values → Limit Measured Values 
hakemistosta joko Limit Measured Value (LVU) tai Operational 
Measured Value (OMV) ja siirretään se Measured Values ryhmään 
(katso kappale 5.7.1).

Mittausvalvontaraja liitetään automaattisesti kohteena Measured Value 
Window sarakkeeseen. 

• Määritellään käyttömittausarvo User MV kohteeksi Measured Value 
Window sarakkeeseen. 

• Määritellään käyttömittausarvon lähteeksi ja kohteeksi CFC (C) ja 
mittausvalvontarajan kohteeksi CFC (C) (katso kappale 5.5.14 ja 
5.5.15).

• Määritellään mittausarvojen ominaisuudet (katso kappale 5.8.7).

Merkinannon 
lisääminen

• Valitaan suodattimeksi Indications Only, jotta merkinannot tulisivat 
näkyviin matriisissa. 

• Valitaan Annunciation → Tagging hakemisto informaatiokatalogista 
ja valitaan ON / OFF (IE) merkinanto ja siirretään se Measured 
Values ryhmään. 

• Määritellään informaation lähteeksi CFC (C) ja kohteeksi 
järjestelmäväylä (S) ja perusnäyttö (D). 

CFC • Lisätään uusi CFC kaavio. 

• Lisätään toimintalohko lohkokatalogista CFC kaavioon. LIVE_ZERO 
lohko sallii mittausarvon välittämisen edelleen näyttöä ja vertailua 
varten. 

• Liitetään toimintalohkon tulot ja lähdöt.

• Määritellään LIVE_ZERO lohko, käännetään kaavio ja siirretään 
tiedot laitteelle. 

Raja-arvo voidaan lukea ja (kun salasana on syötetty) muuttaa 
Measured Values hakemistossa Limits kohdassa. 
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5.13 Käyttäjän määrittelemän CFC logiikan toteuttaminen

DIGSI 4 CFC ohjelmalla voidaan luoda käyttäjän määrittelemiä 
logiikkatoimintoja graafisesti, kuten esimerkiksi lukitusehdot, 
kytkentäsekvenssit tai raja-arvovalvonnat. Tällöin liitetään halutut 
informaatiot toimintalohkojen tuloihin ja lähtöihin, käännetään 
logiikkakaavio ja ladataan laitteen CPU modulille käytettäväksi.

• Avataan laite, kaksoisklikataan CFC hakemistoa navigaatioikkunassa 
ja kaksoisklikataan CFC kaaviota tiedot-ikkunassa. 
Tällöin näyttöön aukeaa DIGSI 4 CFC logiikkakaavio.

DIGSIGB062

Kuva 5-34 DIGSI 4 CFC

Lisätietoja ykstyiskohtaisesta työskentelystä, luonnista, käännöstä ja 
CFC logiikkojen lataamisesta laitteelle on annettu käyttöohjeessa
DIGSI CFC, Manual /2/. 
225SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Konfigurointi
5.14 Perus- ja ohjausnäyttöjen editointi

Graafisella näytöllä varustetulla SIPROTEC 4 laitteella voidaan esittää 
tietoja perus- ja ohjausnäytöillä. 

SIPROTEC laitteen näytöllä esitettäväksi halutulle informaatiolle tulee 
DIGSI® 4 määrittelymatriisissa kohteeksi määritellä perus- ja/tai 
ohjausnäyttö.

Luodaan näyttö DIGSI Display Editor ohjelmalla ja liitetään 
SIPROTEC 4 laitteen informaatio kuvaobjektiin.

Perusnäyttö Perusnäytöllä (Default display) tarkoitetaan näyttöä, joka tulee 
automaattisesti näkyviin laitteen ollessa lepotilassa eli sillä ei ole 
suoritettu mitään toimenpidettä määrätyn ajan sisällä. 

Perusnäytöllä voi olla useampia sivuja.

4-rivisellä näytöllä varustetuilla laitteilla perusnäytössä esitetään 
käyttöinformaatioita ja/tai mittausarvoja. 

Graafisella näytöllä varustetuilla laitteilla perusnäytössä esitetään 
yleensä siihen liitetty lähtö graafisena pääkaaviona, joka on vapaasti 
määriteltävissä. Perusnäytöltä ei voida suorittaa ohjaustoimenpiteitä. 
Käytön kannalta tärkeät mittausarvot, kuten virrat ja jännitteet, voidaan 
esittää jatkuvasti. Näyttöä voidaan käyttää myös pelkkien 
käyttömittausarvojen esittämiseen. 

Toimitettaessa laitteelle on määritelty esiasetteluna esimerkki 
perusnäyttö. Esiaseteltua perusnäyttöä voidaan muuttaa tai se voidaan 
kokonaan korvata vastaamaan käyttökohteen vaatimuksia. 
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Ohjausnäyttö Graafisella näytöllä varustetuilla laitteilla ohjausnäytöllä esitetään 
kytkinlaitteet sen hetkisillä tiloilla varustettuna. Ohjausnäytöllä voidaan 
suorittaa kytkinlaitteiden ohjauksia, merkkauksia tai kytkinlaitteiden 
asentojen käsimuutoksia. Ohjausnäytöllä voi olla useampia sivuja. 

Toimitettaessa laitteelle on määriteltynä ohjausnäyttö esiaseteltuna 
esimerkkinä. Esiaseteltua perusnäyttöä voidaan muuttaa tai se voidaan 
kokonaan korvata vastaamaan käyttökohteen vaatimuksia. 

• SIPROTEC 4 laitteen näytöllä voidaan kutsua ohjausnäyttö 
painamalla CTRL painiketta, jolloin perusnäytön tilalle aktivoituu 
ohjausnäyttö.

Parametrien siirto Perus- ja ohjausnäyttö ovat osa SIPROTEC laitteen parametriryhmää, 
joka voidaan ladata SIPROTEC 4 laitteelle valitsemalla  
Device → DIGSI → Device.

Ohje:
Seuraavissa kappaleissa esitetyt ohjeet on kirjoitettu siten että niissä on 
hyödynnetty valikko-ohjauskäskyjä.

Monet valikko-ohjaukset voidaan kutsua nopeammin käyttämällä 
työkaluvalikon ikoneja.
Valitsemalla View → Toolbars... voidaan määritellä mitkä työkalurivit 
ovat näkyvissä ja ovatko esimerkiksi työkaluohjeet käytössä. Määrittelyt 
suoritetaan Toolbars määrittelyikkunassa.
Kun kursori siirretään työkalurivin ikonin päälle, tulee näyttöön kyseessä 
olevan toiminnan valikkokäsky, edellyttäen että työkaluvihjeet on 
aktivoitu. 

Monilla toiminnoilla on käytössä myös pikavalintakäskyt näppäimistöltä. 
Nämä pikanäppäinvalinnat on esitetty kunkin menu-valikko-ohjauksen 
perässä.

Hyödyllistä lisätietoa esitetään myös tila-rivillä, joka voidaan piilottaa tai 
kutsua takaisin näyttöön valitsemalla View → Status Bar:

Siinä esitetään käytössä oleva työkalu tai näyttötilassa kursorin 
sijainti piirustusalueella,

Näytöllä oleva sivu ja sivujen lukumäärä,

Vapaana olevien merkkien lukumäärä uusien symbolien ja laitteiden 
luomiseksi,

Kirjastosta valitun symbolin tai laitteen nimi,

Kirjastosta valitun symbolin tai laitteen koko,

Näytön zoomauskerroin ja

Lukittujen painikkeiden tilat (esim. num lock, shift, jne).
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5.14.1 Perus- ja ohjausnäyttöjen luonti

Uusia näyttöjä luotaessa luodaan ensin tyhjä perus- ja ohjausnäyttö.

Tyhjän näytön 
määrittely

Seuraavassa on kuvattu kuinka tyhjä perusnäyttö luodaan:

• Avataan laitetiedosto.

• Valitaan Parameters hakemisto DIGSI® 4 navigointi-ikkunassa ja 
kaksoisklikataan sisältöikkunassa Default display symbolia.

Näyttöeditoriohjelma käynnistyy ja ikkunaan aukeaa perusnäyttö.

• Tyhjennetään vakioperusnäyttö valitsemalla Display → New.

de001.gif

Kuva 5-35  Vakioperusnäytön tyhjennys
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• Tallennetaan tyhjä perusnäyttö valitsemalla Display → Save.

de002.gif

Kuva 5-36  Tyhjän perusnäytön tallennus

Tyhjän 
ohjausnäytön 
luonti

Seuraavassa on kuvattu kuinka tyhjä ohjausnäyttö luodaan:

• Avataan ohjausnäyttö valitsemalla Display → Open Control 
Display. Tällöin ikkunaan aukeaa vakio-ohjausnäyttö.

• Vakio-ohjausnäyttö tyhjennetään valitsemalla Display → New.

• Tyhjä ohjausnäyttö tallennetaan valitsemalla Display → Save.
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Laitefonttien esitys Näyttöeditorilla luodut kaaviot esitetään SIPROTEC laitteen näytöllä 
puoligraafisesti. SIPROTEC laitteet käyttävät esityksessä laitefontteja. 
Laitteen perus- ja ohjausnäytöillä esitettävien symbolien ja toimilaitteiden 
esityksessä kuvat muodostuvat  laitefontin merkeillä.

Voimassa olevat laitefontit ja määriteltävissä olevat vapaat merkit 
saadaan näytölle:

• Valitaan View → Display Device Font. Tällöin näyttöön aukeaa 
Device Font ikkuna.

Esimerkissä perus- ja ohjausnäytöt ovat tyhjiä.

de003.gif

Kuva 5-37  Laitefonttien esitys, esimerkkinä saksankielinen merkistö

• Zoomatulla näytöllä voidaan >> tai << kutsua toinen puolikas 
laitefonteista näyttöön.

Ohje:
Laitteen perus- ja ohjausnäytöille voidaan lisätä symboleita ja 
toimilaitteita jos jäljellä on vapaita merkkejä. Suurin määrä vapaita 
merkkejä on käytettävissä tyhjillä perus- ja ohjausnäytöillä.
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5.14.2 Perusnäytön piirtäminen ja määrittely

Perusnäytön piirtämisessä ja määrittelyssä on seuraavat vaiheet:

• Avataan perusnäyttö.

• Syötetään otsikko.

• Piirretään topologia (esimerkiksi kokoojakisko, lähtö ja 
maadoituspiiri).

• Sijoitetaan toimilaitteet (kytkilaitteiden tilojen esitys SIPROTEC 
laitteella).

• Sijoitetaan symbolit (esimerkiksi maadoituselektrodisymboli).

• Sijoitetaan tekstit.

• Tarkastetaan perusnäytön valmius.

• Tallennetaan perusnäyttö ja poistutaan näyttöeditorista.

Ohje:
Näyttöeditorilla luodut kaaviot esitetään SIPROTEC laitteen näytöllä 
puoligraafisesti. Laitteen perus- ja ohjausnäytöille voidaan lisätä 
symboleita ja toimilaitteita jos jäljellä on vapaita merkkejä.

Tarvittaessa tulee vapauttaa merkkejä, jotta tarvittavat symbolit ja 
toimilaitteet saataisiin sijoitettua näytölle:

• Luodaan tyhjät perus- ja ohjausnäytöt 
(katso kappale 5.14.1).

Olemassa olevaa perusnäyttöä voidaan muuttaa seuraavasti ja lisätä 
tarvittavat symbolit ja toimilaitteet:

• Poistetaan symbolit ja toimilaitteet joita ei tarvita perusnäytöllä ja 
tallennetaan näyttö.

• Poistetaan symbolit ja toimilaitteet joita ei tarvita ohjausnäytöllä ja 
tallennetaan näyttö.
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Piirretty ja 
määritelty
perusnäyttö

Piirretään ja määritellään perusnäyttö esimerkkinä:

de005.gif

Kuva 5-38  Esimerkki perusnäytöstä
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Perusnäyttö avataan seuraavasti:

• Valitaan Display → Open Default Display.

Tällöin perusnäyttö aukeaa piirustusalueelle.

de006.gif

Kuva 5-39  Tyhjä perusnäyttö näyttöeditoriohjelmassa (kohdistusverkkoa ei ole 
esitetty)

Ohje:
Tilarivillä esitetään vapaina olevien merkkien lukumäärä uusien 
symbolien ja toimilaitteiden lisäämiseksi näytölle.

Näytön kokoa voidaan zoomata suuremmaksi valitsemalla 
View → Zoom In tai pienemmäksi View → Zoom Out.
Lisäksi piirustusta helpottava kohdistusverkko saadaan kytkettyä päälle 
ja pois valitsemalla View → Grid.
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de007.gif

Kuva 5-40  Tyhjä perusnäyttö näyttöeditoriohjelmassa (kohdistusverkko 
esitettynä)

Otsikon 
syöttäminen

Otsikko syötetään perusnäyttöön seuraavasti:

• Valitaan Tools → Select.

• Klikataan vasemmalla hiiripainikkeella otsikkoaluetta. Tekstin 
syöttökenttä aukeaa.

de008.gif

Kuva 5-41  Avoin syöttökenttä otsikon syöttämiseksi

• Syötetään haluttu teksti avoinna olevaan tekstin syöttökenttään.
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de009.gif

Kuva 5-42  Otsikon tekstin syöttökenttä

• Hyväksytään syötetty otsikko ENTER painikkeella tai klikkaamalla 
syöttökentän oikeassa reunassa olevaa hyväksymispainiketta.

Ohje:
SIPROTEC laitteen näytön otsikkoon voidaan syöttää enintään 14 
merkkiä. Tekstin syöttökenttä rajoittaa lukumäärän suurimpaan sallittuun.
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5.14.3 Topologian piirtäminen

Topologiamäärittelyssä piirretään kokoojakisko, lähtö ja maadoituspiiri 
perusnäyttöön. Linjat piirretään käyttämällä pysty- ja vaakasuuntaisia 
viivasymboleja. Linjat muodostuvat yksittäisistä viivasymboleista.
Pysty- ja vaakalinjojen piirrossa käytetyt viivasymbolit voidaan kutsua 
käyttöön viivasymbolikirjastosta.

Topologialla 
varustettu 
perusnäyttö

Topologia piirrettynä esimerkkinä:

de014.gif

Kuva 5-43  Topologialla varustettu perusnäyttö (kohdistusverkko esitettynä)

Pystylinjojen 
piirtäminen

Pystylinjat piirretään seuraavasti:

• Valitaan Library → Select Library.... Tällöin näyttöön aukeaa Select 
Library ikkuna.

• Valitaan viivasymbolikirjasto (Line) Library valintaluettelosta ja 
hyväksytään valinta painamalla OK. 
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• Valitaan sopiva pystyviivasymboli (esimerkiksi L2v).

• Perusnäytön piirustusalueella valitaan lähtöpiste hiiripainikkeella ja 
pidetään hiiripainike alas painettuna.

• Siirretään osoitin viivan päätepisteeseen ja vapautetaan hiiren 
painike. 

de010.gif

Kuva 5-44  Pystylinjojen piirtäminen

Ohje:
Jos halutaan luoda omia viivasymboleja, tallennetaan ne User Line 
kirjastoon (katso kappale 5.14.13). 

Ohje:
Kun kursori viedään normaalinäytössä kirjastossa olevan symbolin 
päälle, tulee näyttöön symbolin nimi jos työkaluvihjeet on aktivoitu (esim. 
L2v). 
Lisäksi symbolinäyttöä voidaan suurentaa valitsemalla Library 
→ Zoom In. Zoomauskerroin määritellään valitsemalla 
Options → Settings....
Kirjastovalikko Library sisältää myös lajittelutoiminnat.
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Vaakalinjojen 
piirtäminen

Vaakalinjat piirretään seuraavasti:

• Valitaan Library → Select Library.... Tällöin näyttöön aukeaa Select 
Library ikkuna.

• Valitaan viivasymbolikirjasto (Line) Library valintaluettelosta ja 
hyväksytään valinta painamalla OK.

• Valitaan sopiva vaakaviivasymboli (esimerkiksi L3h, L2h).

• Perusnäytön piirustusalueella valitaan lähtöpiste hiiripainikkeella ja 
pidetään hiiripainike alas painettuna.

• Siirretään osoitin viivan päätepisteeseen ja vapautetaan hiiren 
painike.

de011.gif

Kuva 5-45  Vaakalinjojen piirtäminen
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Yhdistysten 
piirtäminen

Pysty- ja vaakalinjojen yhdistykset voidaan piirtää seuraavasti:

• Valitaan Library → Select Library.... Tällöin näyttöön aukeaa Select 
Library ikkuna.

• Valitaan viivasymbolikirjasto (Line) Library valintaluettelosta ja 
hyväksytään valinta painamalla OK.

• Valitaan sopiva viivasymboli (esimerkiksi A3h2u).

de012.gif

Kuva 5-46  Sopivan yhdistyssymbolin valinta

• Valitaan hiirellä perusnäytön kohta, johon yhdistys halutaan.

de013.gif

Kuva 5-47  Yhdistyksen piirtäminen

Viivasymbolien 
poistaminen

Viivasymboleja voidaan poistaa seuraavasti:

• Valitaan Tools → Erase.

• Valitaan perusnäytön piirustusalueelta haluttu viivasymboli.
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Alueen 
poistaminen

Alue voidaan poistaa seuraavasti:

• Valitaan Tools → Select.

• Vasen hiiripainike alas painettuna piirretään halutun alueen ympäri 
nelikulmio ja vapautetaan hiiripainike. Tällöin valittu alue on korostettu 
kehyksellä.

• Klikataan valittua aluetta oikealla hiiripainikkeella ja valitaan toiminta 
Delete valikosta. 

Kaikkien symbolien 
poistaminen

Kaikki näytöllä olevat symbolit voidaan poistaa seuraavasti:

• Valitaan Tools → Select.

• Valitaan Edit → Select All. Tällöin kaikki näytöllä olevat kohteet on 
valittu otsikkoa lukuun ottamatta.

• Klikataan valittua aluetta oikealla hiiripainikkeella ja valitaan toiminta 
Delete valikosta.

Ohje:
Tällä toiminnalla poistetaan valitulta alueelta kaikki symbolit (sisältäen 
viiva- ja toimilaitesymbolit sekä tekstit)
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5.14.4 Toimilaitteiden sijoittaminen

SIPROTEC 4 laitteen perusnäytöllä voidaan esittää toimilaitteiden tiloja 
tai arvoja.

Näytöllä esitettävät informaatiot tulee valita ennalta DIGSI® 4 
määrittelymatriisissa (katso kappale 5.5.9) ja näyttöeditoriohjelmassa 
informaatiot liitetään edelleen haluttuihin toimilaitteisiin tai symboleihin.

Perusnäyttö ja 
sijoitetut toimilaite-
symbolit

Esimerkissä sijoitetut toimilaitteet on merkitty nuolilla:

de018.gif

Kuva 5-48  Perusnäytölle sijoitetut toimilaitteet
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Toimilaitteiden 
sijoittaminen

SIPROTEC 4 laitteen näytölle voidaan sijoittaa toimilaiteobjekti ja liittää 
se informaatioon, jolloin ensin valitaan haluttu toimilaite 
symbolikirjastosta seuraavasti:

• Valitaan Library → Select Library.... Tällöin näyttöön aukeaa Select 
Library ikkuna.

• Valitaan symbolikirjasto Library valintaluettelosta ja hyväksytään 
valinta painamalla OK painiketta. 

Toimilaitesymboli sijoitetaan perusnäytön piirustusalueelle seuraavasti:

• Valitaan toimilaitesymboli. 

Ohje:
Toimilaitekirjastot on varustettu "-" tunnuksella.

Riippuen toimilaitteen tyypistä (arvonäyttö, DIN toimilaite, SIPROTEC 
toimilaite tai käyttäjän määrittelemä), voi toimilaitesymboli sijaita 
samanaikaisesti useammassa kirjastossa.

Jos halutunlaista symbolia ei löydy mistään kirjastoista, tulee se luoda 
itse (katso kappale 5.14.14).

Ohje:
Kun kursori viedään normaalinäytössä kirjastossa olevan symbolin 
päälle, tulee näyttöön symbolin nimi jos työkaluvihjeet on aktivoitu

Lisäksi symbolikirjastonäyttöä voidaan suurentaa valitsemalla Library 
→ Zoom In. Zoomauskerroin määritellään valitsemalla 
Options → Settings....
Kirjastovalikko Library sisältää myös lajittelutoiminnat.
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de015.gif

Kuva 5-49  Toimilaitesymbolien valinta kirjastosta

• Klikataan haluttua kohtaa piirustusnäytöltä toimilaitteen 
sijoittamiseksi. 

Ohje:
Jos hiiripainiketta pidetään alas painettuna, on mahdollista siirtää 
toimilaitesymbolia piirustusalueella.

Toimilaitesymboleja ei voi sijoittaa toisten symbolien päälle.
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de016.gif

Kuva 5-50  Toimilaitesymbolin sijoitus perusnäytöllä

Kun toimilaitesymboli on sijoitettu näytölle, aukeaa Link ikkuna, jossa 
toimilaitesymboli voidaan linkittää SIPROTEC laitteen informaatioon:

• Valitaan haluttu informaatio luettelosta.
Haluttu informaatio on löydettävissä havainnollisesti hyödyntäen 
informaatioryhmä Group, näyttöteksti Display Text ja  tyyppi Type 
sarakkeita.

• Hyväksytään valinta OK painikkeella.

Ohje:
Link valintaikkunassa esitetään vain ne informaatiot jotka on määritelty  
DIGSI® 4 määrittelymatriisissa perusnäytölle meneviksi.
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de017.gif

Kuva 5-51  Toimilaitesymbolin linkitys informaatioon

Kun toimilaitesymboli on linkitetty informaatioon, aukeaa näytölle tekstin 
syöttökenttä, johon toimilaitteen tunnus voidaan kirjoittaa perusnäytölle:

• Syötetään haluttu tunnus tekstin syöttökenttään. Jos symbolille ei 
haluta tunnusta, suljetaan kenttä klikkaamalla oikeanpuolimmaista 
risti-painikketta.

• Hyväksytään syötetty tunnus tekstin syöttökentän 
hyväksymispainikkeella. 

Ohje:
Suurin sallittu tunnuksessa käytettävien merkkien lukumäärä rajoittuu 
tekstin sijoituspaikan mukaisesti. Pituus rajoitetaan automaattisesti.

Jos halutaan kirjoittaa pidempi tunnus kuin tekstin syöttökenttä sallii, 
tulee tekstiä siirtää piirustusalueella vasemmalle päin:

• Hyväksytään ensin lyhyempi tunnus.

• Valitaan Tools → Select.

• Valitaan teksti ja pidetään hiiripainike alas painettuna.

• Siirretään teksti vasemmalle sopivaan kohtaan ja vapautetaan 
hiiripainike. Tekstiä ei saa viedä toimilaitesymbolin päälle.

• Kaksoisklikataan tekstiä, jolloin näyttöön aukeaa tekstin syöttökenttä.

• Syötetään pidempi tunnus ja hyväksytään teksti käyttöön.
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Sijoitetun 
toimilaitteen 
siirtäminen

Sijoitettua toimilaitetta voidaan siirtää seuraavasti:

• Valitaan Tools → Select.

• Valitaan toimilaite ja pidetään hiiripainike alas painettuna.

• Siirretään toimilaite haluttuun kohtaan ja vapautetaan hiiripainike. 
Toimilaitetta  ei saa sijoittaa toisen päälle.

Toimilaitteiden 
uudelleen linkitys

Toimilaite voidaan linkittää uudelleen informaatioon seuraavasti:

• Valitaan toimilaite oikealla hiiripainikkeella ja valitaan valikosta Link 
toiminta.

• Näyttöön aukeaa Link valintaikkuna, jossa mahdolliset informaatiot 
on esitetty.

• Valitaan uusi informaatio luettelosta.
Haluttu informaatio on löydettävissä havainnollisesti hyödyntäen 
informaatioryhmä Group, näyttöteksti Display Text ja  tyyppi Type 
sarakkeita.

• Hyväksytään valinta OK painikkeella.
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Sijoitetun laitteen 
poistaminen

Sijoitettu toimilaite voidaan poistaa seuraavasti:

• Valitaan toimilaite oikealla hiiripainikkeella ja valitaan valikosta Delete 
toiminta. 

5.14.5 Käyttäjän määrittelemien tekstien valinta

"User Text" symbolilla voidaan esittää näytöllä dynaamisia tiloja 
teksteinä.

Esimerkiksi kauko-paikallis-avainkytkimen määrittelemä ohjauspaikka 
voidaan esittää näytöllä tekstinä "User Text" symbolilla.

Käyttäjätekstin 
sijoittaminen

Käyttäjäteksti (User Text) sijoitetaan näytölle seuraavasti:

• Valitaan Library → Select Library.... Tällöin näyttöön aukeaa Select 
Library ikkuna.

• Valitaan symbolikirjasto Displayed Values  Library valintaluettelosta 
ja hyväksytään valinta painamalla OK painiketta.

• Valitaan toimilaite.

de050.gif

Kuva 5-52  Käyttäjätekstin sijoittaminen

Ohje:
Toimilaitesymbolin sijoittamisen yhteydessä määritelty tekstitunnus ei 
poistu kun toimilaitesymboli poistetaan, vaan se tulee poistaa erikseen:

• Valitaan tekstisymboli oikealla hiiripainikkeella ja valitaan toiminta 
Delete valikosta.
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• Klikataan haluttua kohtaa piirustusnäytöltä toimilaitteen 
sijoittamiseksi.

• Valitaan Link valintaluettelosta haluttu informaatio, joka halutaan 
liittää käyttäjätekstiin.

de051.gif

Kuva 5-53  Informaation valinta

Ohje:
Jos hiiripainiketta pidetään alas painettuna, on mahdollista siirtää 
toimilaitesymbolia piirustusalueella.
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• Valinta hyväksytään OK painikkeella. Tällöin näyttöön aukeaa ikkuna 
johon teksti voidaan syöttää.

• Suljetaan tekstin syöttöikkuna hylkäämällä se risti-painikkeella. 
Tällöin tekstisymbolille ei määritetä lainkaan staattista tekstitunnusta.

Tekstin 
syöttäminen

Tiloja kuvaavat tekstit syötetään seuraavasti:

• Valitaan Edit → Object Properties. Tällöin näyttöön aukeaa Object 
Properties - User Text ikkuna.

• Syötetään halutut tiloja kuvaavat tekstit syöttökenttiin.

de052.gif

Kuva 5-54  Tilatekstien syöttäminen

• Display-sarakkeessa valitaan tekstirivi, joka esitetään 
näyttöeditoriohjelmassa.

• Hyväksytään valinta OK painikkeella.

Ohje:
Käyttäjätekstisymboli (User Text) muodostuu kahdesta osasta eli 
staattisesta tekstistä static text ja dynaamisesta tekstistä dynamic text.
Staattinen teksti syötetään tekstin syöttökentässä. Dynaaminen teksti 
määritellään kuvaamaan halutun toimilaitteen tiloja määrittelemällä 
tekstit Object Properties User Text ikkunassa.

Ohje:
Jos määrätylle tilalle ei haluta syöttää tekstiä, tyhjennetään 
asianomainen syöttökenttä.

Tällöin näytöllä ei esitetä mitään kun tämä tila on voimassa.
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5.14.6 Symbolien sijoittaminen

Symboleilla voidaan piirtää perusnäyttöön kiinteitä kuvaelementtejä.

Perusnäytölle 
sijoitetut
symbolit

Esimerkissä sijoitetut symbolit on osoitettu nuolilla:

de005.gif

Kuva 5-55  Perusnäytölle sijoitetut symbolit
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Symbolin 
sijoittaminen

Symbolin sijoittamiseksi perusnäytölle valitaan haluttu symbolikirjasto, 
jossa sijoitettava symboli sijaitsee:

• Valitaan Library → Select Library.... Tällöin näyttöön aukeaa Select 
Library ikkuna.

• Valitaan symbolikirjasto Library valintaluettelosta ja hyväksytään 
valinta painamalla OK painiketta.

Symboli sijoitetaan perusnäytön piirustusalueelle seuraavasti:

• Valitaan symboli.

de019.gif

Kuva 5-56  Symbolin valitseminen sijoitusta varten

Ohje:
Symbolikirjastoilla ei ole  "-"  tunnusta.

Symbolin tyypistä riippuen (DIN, SIPROTEC tai käyttäjän määrittelemä), 
voi symboli sijaita saman nimisenä useammassa kirjastossa tai 
tarvittaessa symboli täytyy luoda itse (katso kappale 5.14.13). 

Ohje:
Kun kursori viedään normaalinäytössä kirjastossa olevan symbolin 
päälle, tulee näyttöön symbolin nimi, jos työkaluvihjeet on aktivoitu.

Lisäksi symbolikirjastonäyttöä voidaan suurentaa valitsemalla Library 
→ Zoom In. Zoomauskerroin määritellään valitsemalla 
Options → Settings....
Kirjastovalikko Library sisältää myös lajittelutoiminnat.
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Konfigurointi
• Klikataan haluttua kohtaa piirustusnäytöltä symbolin sijoittamiseksi. 

de020.gif

Kuva 5-57  Symbolin sijoitus peruskuvaan

Sijoitetun symbolin 
siirtäminen

Sijoitettua symbolia voidaan siirtää seuraavasti:

• Valitaan Tools → Select.

• Valitaan symboli ja pidetään hiiripainike alas painettuna.

• Siirretään symboli haluttuun kohtaan ja vapautetaan hiiripainike. 
Symbolia ei saa sijoittaa toimilaitesymbolin päälle.

Symbolin 
poistaminen

Sijoitettu symboli voidaan poistaa seuraavasti:

• Valitaan symboli oikealla hiiripainikkeella ja valitaan valikosta Delete 
toiminta.

Ohje:
Kun hiiri- ja CTRL-painiketta pidetään yhtäaikaa painettuna symbolia 
sijoitettaessa, voidaan symbolia siirtää piirustusalueella. 

Symboleja ei saa sijoittaa toimilaitesymbolien päälle.

Symbolin sijoittaminen kuvaan toisen symbolin päälle, poistaa jo kuvassa 
olevan symbolin uuden symbolin alueelta (tarkoittaen viivasymboleja, 
symboleja ja tekstejä).
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Perus- ja ohjausnäyttöjen editointi
5.14.7 Tekstin sijoittaminen

Teksti voidaan sijoittaa perusnäyttöön seuraavasti:

• Valitaan Tools → Insert Text.

• Klikataan tekstin alkupistettä piirustusalueella.

• Syötetään haluttu teksti tekstin syöttökenttään.

• Hyväksytään syötetty teksti klikkaamalla tekstin oikealla puolella 
olevaa hyväksymissymbolia.

Sijoitetun tekstin 
siirtäminen

Sijoitettu teksti voidaan siirtää seuraavasti:

• Valitaan Tools → Select.

• Valitaan teksti ja pidetään hiiripainike alas painettuna.

• Siirretään teksti haluttuun kohtaan ja vapautetaan hiiripainike. Tekstiä 
ei saa sijoittaa toimilaitesymbolin päälle.

Sijoitetun tekstin 
poistaminen

Sijoitettu teksti voidaan poistaa seuraavasti:

• Valitaan teksti oikealla hiiripainikkeella ja valitaan valikosta Delete 
toiminta.

Ohje:
Tekstejä ei saa sijoittaa toimilaitesymbolien päälle.

Tekstin sijoittaminen kuvaan toisen symbolin päälle poistaa jo kuvassa 
olevan symbolin uuden tekstisymbolin alueelta (tarkoittaen 
viivasymboleja, symboleja ja tekstejä).

Syötettävän tekstin pituus määräytyy sijoituskohdan oikealle puolelle 
jäävien vapaiden merkkien mukaisesti, jolloin syötettävän tekstin pituus 
rajoittuu automaattisesti.

Jos halutaan kirjoittaa pidempi tunnus kuin tekstin syöttökenttä sallii, 
tulee tekstiä siirtää piirustusalueella vasemmalle päin:

• Hyväksytään ensin lyhyempi tunnus. 

• Valitaan Tools → Select.

• Valitaan teksti ja pidetään hiiripainike alas painettuna.

• Siirretään teksti vasemmalle sopivaan kohtaan ja vapautetaan 
hiiripainike. Symbolia ei saa sijoittaa toimilaitesymbolin päälle.

• Kaksoisklikataan tekstiä, jolloin näyttöön aukeaa tekstin syöttökenttä.

• Syötetään pidempi tunnus ja hyväksytään teksti käyttöön.
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5.14.8 Perusnäytön tarkastaminen

Perusnäytön tarkastuksessa voidaan käyttää seuraavia aputoimintoja

Piilottaa kohdistusristikko piirustusalueelta,

Korostaa sijoitettuja toimilaitesymboleja,

Esittää perusnäyttö oikean kokoisena,

Tulostaa perusnäyttö.

Kohdistusristikon 
piilotus

Kohdistusristikko voidaan piilottaa piirustusalueelta seuraavasti:

• Valitaan View → Grid. Verkko poistuu näytöltä.

de022.gif

Kuva 5-58  Kohdistusristikon piilotus

• Jos valitaan uudelleen View → Grid, kohdistusristikko tulee 
uudelleen näkyviin. 

Ohje:
Jos näytön koko on liian pieni, ei ristikkoa voi esittää. Tällöin 
valikkotoiminta on piilotettuna. Jos ristikko halutaan näkyviin, tulee 
kuvakokoa suurentaa View → Zoom In.
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Perus- ja ohjausnäyttöjen editointi
Toimilaite-
symbolien 
korostaminen

Toimilaitesymboleja voidaan korostaa piirustusalueella seuraavasti:

• Valitaan View → Highlight Display. Tällöin toimilaitesymbolit on 
korostettu harmaalla taustalla. 

de023.gif

Kuva 5-59  Näytön korostaminen

• Jos valitaan uudelleen View → Highlight Display, korostus poistuu.

Ohje:
Toimilaitesymbolien lisäksi niiden tekstitunnukset (katso kappale 5.14.4) 
ja otsikko (katso kappale 5.14.4) on korostettu myös harmalla taustalla.

Toimilaitesymbolit jotka on jo linkitetty SIPROTEC informaatioon, on 
esitetty kirkkaan sinisellä.

Toimilaitesymbolit ei ole vielä linkitetty SIPROTEC informaatioihin, on 
esitetty tumman sinisellä.
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Perusnäytön esitys
oikeassa
koossa

Jos näytön koko pienennetään oikeaan kokoon, esitetään näytöllä 
SIPROTEC laitteen etupaneeli kokonaisuudessaan:

• Valitaan View → Normal Size.

de024.gif

Kuva 5-60  Perusnäyttö oikeassa koossa

• Jos valitaan uudelleen View → Zoom In, poistuu SIPROTEC 4 
laitteen etupaneeli näytöstä.
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Perus- ja ohjausnäyttöjen editointi
Perusnäytön
tulostaminen

Perusnäyttö voidaan tulostaa seuraavasti:

• Valitaan Display → Print.... Tällöin näyttöön aukeaa Print / Print 
Preview ikkuna.

• Valitaan Display näytön tulostamiseksi.
Lisäksi tulostukseen voidaan vaikuttaa lisätoiminnoin 
Fit display to page (sovita näyttö sivulle) ja Print display with front 
panel (tulosta koko laitteen etupaneeli).

de039.gif

Kuva 5-61  Näytön tulostaminen

• Perusnäytölle sijoitetut toimilaitesymbolit ja niihin liittyvät 
ominaisuudet voidaan tulostaa taulukkomuodossa valitsemalla 
Dynamics.

• OK painikkeella hyväksytään määritelyasettelut ja näyttöön aukeaa 
tällöin normaali tulostus Print ikkuna.
Tulostus käynnistetään Print ikkunasta. 

Ohje:
On mahdollista tulostaa valittu kirjasto valitsemalla Library hakemistosta 
Print / Print Preview toiminta.
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5.14.9 Perusnäytön tallennus

Perusnäyttö voidaan tallentaa parametritiedostoon seuraavasti:

• Valitaan Display → Save.

• Vastataan esitettyyn kysymykseen Yes painikkeella.

Ohje:
Jos olemassa olevaa perusnäyttöä halutaan käyttää uudelleen 
(esimerkiksi ohjausnäytön pohjana), voidaan se tallentaa mallinäyttönä 
(template):

• Valitaan Display → Template → Save As....

• Näyttöön aukeaa Save As ikkuna. Valitaan haluttu 
tallennushakemisto ja syötetään näytölle nimi. Tiedostotyyppi on 
esivalittu.

• Painetaan Save painiketta.

Tallennettu mallikuva saadaan kutsuttua käyttöön:

• Ladataan mallikuva perusnäytön tyhjälle sivulle valitsemalla Display 
→ Template → Open... (katso kappale 5.14.1).

• Linkitetään näytössä olevat toimilaitesymbolit SIPROTEC 4 laitteen 
informaatioihin (katso kappale 5.5.9).

• Valitaan Display → Save perusnäytön tallentamiseksi 
parametritiedostoon.
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5.14.10 Ohjausnäytön piirtäminen ja määrittely

Toteutustapa Ohjausnäyttö luodaan tai sitä muutetaan käyttäen DIGSI® 4 ohjelmiston 
näyttöeditori Display Editor toimintaa. Perustoimintatapa on sama kuin 
perusnäytön luonnissa ja määrittelyssäkin (katso kappale 5.14.1ff.). 

Ohjausnäytön peruslähtökohtana on luoda tarvittavat toimilaitesymbolit 
ja ohjauksissa tarvittavat tilatiedot. Toimilaitesymbolit on liitetty 
dynaamisesti informaatioihin, jolloin toimilaitteiden kulloinkin voimassa 
olevat tilat esitetään näytöllä. 

Tehdasasetuksena määriteltyä ohjausnäyttöä voidaan käsitellä 
vastaavin menetelmin kuin perusnäyttöäkin. 

Seuraavassa on kuvattu kuinka ohjausnäyttö voidaan piirtää ja 
määritellä:

• Avataan ohjausnäyttö valitsemalla
Display → Open Control Display.

• Syötetään otsikko.

• Piirretään topologia.

• Sijoitetaan toimilaitesymbolit.

• Sijoitetaan symbolit.

• Sijoitetaan tekstit.

• Tarkastetaan valmis ohjausnäyttö.

• Tallennetaan ohjausnäyttö. 

Ohje:
Jos toimilaitetta halutaan ohjata ohjausnäytöltä, tulee toimilaitesymboli 
määritellä käyttäjän ohjattavaksi symbolin sijoituksen jälkeen (katso 
kappale 5.14.11).

Lisäksi määritellään esivalintatoimilaite, joka on valittuna kun 
ohjausnäyttö aktivoidaan, edellyttäen että ohjattavia toimilaitteita on 
useampia (katso kappale 5.14.12).
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Piirretty ja 
määritelty
ohjausnäyttö

Piirretään ja määritellään ohjausnäyttö esimerkkinä:

de025.gif

Kuva 5-62  Ohjausnäyttö
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Perus- ja ohjausnäyttöjen editointi
5.14.11 Sijoitetun toimilaitesymbolin määrittely ohjattavaksi

Ohjausnäytölle sijoitettu toimilaitesymboli määritellään käyttäjän 
ohjattavaksi seuraavasti:

• Kaksoisklikataan toimilaitesymbolia ohjausnäytöllä.

• Valitaan toiminta Object operator-controllable valintaruutu Object 
Properties - Symbol ikkunassa.

• Hyväksytään valinta OK painikkeella.

de026.gif

Kuva 5-63  Toimilaitesymbolin määrittely ohjattavaksi

Ohje:
Toiminta on aktiivisena vain ohjausnäytöllä. Toimilaitteen ohjaaminen ei 
ole mahdollista perusnäytöllä.
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5.14.12 Ensimmäisen ohjattavan toimilaitesymbolin määrittely

Lisäksi määritellään esivalintatoimilaite, joka on valittuna kun 
ohjausnäyttö aktivoidaan, edellyttäen että ohjattavia toimilaitteita on 
useampia.

• Kaksoisklikataan toimilaitesymbolia ohjausnäytöllä.

• Valitaan Default object valintaruutu Object Properties -Symbol 
ikkunassa.

• Hyväksytään valinta OK painikkeella. 

de027.gif

Kuva 5-64  Ensimmäisen toimilaitesymbolin määrittely

Ohje:
Vain yksi toimilaitesymboli voidaan valita ensimmäiseksi toimilaitteeksi. 
Tämä valinta poistetaan automaattisesti muilta symboleilta.

On suositeltavaa määritellä esivalituksi toimilaitteeksi kytkinlaite jota 
ohjataan aina ensimmäiseksi esimerkiksi häiriötilanteessa (yleensä 
katkaisija).
262 SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Perus- ja ohjausnäyttöjen editointi
5.14.13 Symbolien luonti

Uusi symboli voidaan luoda seuraavasti:

• Avataan perus- tai ohjausnäyttö näyttöeditori Display Editor 
ohjelmalla.

• Valitaan symbolikirjasto johon uusi symboli halutaan sijoittaa.

• Luodaan tyhjä symboli.

• Piirretään symboli.

• Tallennetaan symboli. 

Uuden 
moottorisymbolin 
luonti

Seuraavassa esimerkissä luodaan uusi moottorisymboli Motor new:

de028.gif

Kuva 5-65  Uusi moottorisymboli (ilman kohdistusristikkoa ja kohdistusristikolla)

Symbolkirjaston 
valinta

Symbolikirjasto valitaan seuraavasti:

• Valitaan Library → Select Library.... Tällöin näyttöön aukeaa Select 
Library ikkuna.

• Valitaan symbolikirjasto Library valintaluettelosta ja hyväksytään 
valinta painamalla OK painiketta. 

Ohje:
Edit → Rename... toiminnalla voidaan olemassa olevan symbolin nimeä 
muuttaa.

Edit → Duplicate... toiminnalla voidaan kopioida ja uudelleen nimetä 
olemassa oleva symboli.

Ohje:
Uusia symboleja voidaan luoda käyttäjän toimesta vain 
symbolikirjastoihin (DIN Symbol, SIPROTEC Symbol tai User Symbol).

Symbolikirjastoilla ei ole  "-"  tunnusta.
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Kirjaston 
tulostaminen

Valittu kirjasto voidaan tulostaa seuraavasti:

• Valitaan Display → Print....  Tällöin näyttöön aukeaa 
Print / Print Preview ikkuna.

• Valitaan Library vaihtoehto kirjaston tulostamiseksi.

de040.gif

Kuva 5-66  Kirjaston tulostaminen

• OK painikkeella hyväksytään määritelyasettelut ja näyttöön aukeaa 
tällöin normaali tulostus Print ikkuna.
Tulostus käynnistetään Print ikkunasta.

Tyhjän symbolin 
luonti

Uutta symbolia määriteltäessä tulee luoda ensin tyhjä symboli:

• Valitaan Library → New Symbol....

• Näyttöön aukeavassa New Symbol ikkunassa määritellään uuden 
symbolin ominaisuudet:

• Syötetään uuden symbolin tunnus Name tekstikenttään.

• Valitaan symbolin leveys Width syöttökentässä (1 ... 8 merkkiä). 

• Valitaan symbolin korkeus Height syöttökentässä (1 ... 8 merkkiä).
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Perus- ja ohjausnäyttöjen editointi
de029.gif

Kuva 5-67  Uuden symbolin luonti

• Valitut asettelut hyväksytään  OK painikkella. 

Tämän jälkeen piirustusalueella esitetään tyhjä symboli.

Ohje:
OK painikkeen painamisen jälkeen näyttöeditori tarkastaa että uudelle 
symbolille on annettu nimi Name kentässä ja tarkastaa myös että nimi ei 
ole jo käytössä tässä kirjastossa.

Virhetilanteessa näyttöön tulee ilmoitus ja New Symbol ikkuna jää auki 
jotta virhe olisi korjattavissa.
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de030.gif

Kuva 5-68  Uusi tyhjä symboli

Uuden symbolin 
piirtäminen

Näyttöeditoriohjelmassa on useampia työkaluja, joita voidaan käyttää 
uuden symbolin piirtämisessä:

Kynä (Pencil)
Työkalu voidaan valita käyttöön valisemalla Tools → Pencil, jolloin 
kynän piirustusleveys on 1 pikseli. 

Pensseli (Brush)
Pensselin leveys määritellään Tools → Brush valikosta ja 
valitsemalla edelleen Options → Settings....

Viiva, neliö ja ympyrä (Line, rectangle ja circle)
Piirtoviivan leveys voidaan määritellä valitsemalla Tools 
→ Line, Rectangle ja Circle ja sieltä edelleen 

Options → Settings....

Täyttö (Filling)

Ohje:
Kun kursori viedään normaalinäytössä kirjastossa olevan symbolin 
päälle, tulee näyttöön symbolin nimi, jos työkaluvihjeet on aktivoitu.
Työkaluvihjeet voidaan aktivoida valitsemalla View → Toolbars....
Lisäksi symbolikirjastonäyttöä voidaan suurentaa valitsemalla Library 
→ Zoom In. Zoomauskerroin määritellään valitsemalla 
Options → Settings....
Kirjastovalikko Library sisältää myös lajittelutoiminnat.
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Piirto vapaalla 
kädellä

Vapaalla kädellä voidaan piirtää valitsemalla työkalut Tools → Pencil tai 
Tools → Brush.

Viivan piirtäminen Viiva piirretään seuraavasti:

• Valitaan Tools → Line.

• Valitaan viivan alkupiste ja pidetään hiiripainike alas painettuna.

• Vedetään kursori viivan päätepisteeseen hiiripainike alaspainettuna 
ja vapautetaan hiiripainike.

Nelikulmion 
piirtäminen

Nelikulmio piirretään seuraavasti:

• Valitaan Tools → Rectangle.

• Valitaan nelikulmion alkupiste hiirellä ja pidetään hiiripainike alas 
painettuna.

• Vedetään kursori halutun nelikulmion vastakkaiseen kulmaan ja 
vapautetaan hiiripainike.

Ellipsin piirtäminen Ellipsi piirretään seuraavasti:

• Valitaan Tools → Circle.

• Valitaan ellipsin alkupiste ja pidetään hiiripainike alas painettuna.

• Vedetään kursori halutun ellipsin vastakkaiseen reunaan ja 
vapautetaan hiiripainike.

 

Alueen täyttäminen Valitsemalla Tools → Fill ja klikkaamalla haluttua pistettä täytetään 
viereiset ruudut seuraavaan rajaan saakka.

Ohje:
Oikealla hiiripainikkeella voidaan poistaa piirretyt pisteet tarvittaessa 
jälkikäteen.

Ohje:
Kun pidetään SHIFT painiketta alas painettuna ellipsin piirron aikana, 
piirretään tällöin ympyrä ellipsin sijaan.
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de031.gif

Kuva 5-69  Uuden symbolin piirtäminen

Pisteiden 
poistaminen

Pisteet voidaan poistaa tarvittaesa seuraavasti:

• Valitaan Tools → Erase.

• Poistetaan yksittäiset pisteet klikkaamalla hiirellä tai pitämällä vasen 
hiiripainike alas painettuna maalataan kaikki poistettavat pisteet 
samalla kertaa.

Alueen 
poistaminen

Alue voidaan poistaa seuraavasti:

• Valitaan Tools → Mark.

• Hiiripainike alas painettuna piirretään nelikulmio halutun alueen 
päälle ja vapautetaan hiiripainike. Tällöin valittu alue on korostettu 
kehyksellä.

• Valitaan Edit → Delete. 

Ohje:
Käytettäessä kynä- tai pensselityökaluja pisteet voidaan poistaa 
maalaamalla oikea hiiripainike alas painettuna.
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Kaikkien 
poistaminen

Symbolin kaikki pisteet voidaan poistaa seuraavasti:

• Valitaan Edit → Select All. Tällöin koko alue on valittuna.

• Valitaan Edit → Delete. 

Alueen siirtäminen Alue voidaan siirtää seuraavasti:

• Valitaan Tools → Select.

• Hiiripainike alas painettuna piirretään nelikulmio halutun alueen 
päälle ja vapautetaan hiiripainike. Tällöin valittu alue on korostettu 
kehyksellä.

• Valitaan Edit → Cut. 

• Valitaan Edit → Paste.

• Valitaan haluttu sijoituspiste piirustusalueelta.

Alueen 
kopioiminen

Alue voidaan kopioida seuraavasti:

• Valitaan Tools → Mark.

• Hiiripainike alas painettuna piirretään nelikulmio halutun alueen 
päälle ja vapautetaan hiiripainike. Tällöin valittu alue on korostettu 
kehyksellä.

• Valitaan Edit → Copy. 

• Valitaan Edit → Paste.

• Valitaan haluttu sijoituspiste piirustusalueelta.

Ohje:
Kun sijoitettaessa pidetään vasenta hiiripainiketta alas painettuna, 
voidaan sijoitettavaa aluetta siirrellä näytöllä. Kopioitavan alueen sisältö 
esitetään näytöllä läpinäkyvänä.

Ohje:
Kun sijoitettaessa pidetään vasenta hiiripainiketta alas painettuna, 
voidaan sijoitettavaa aluetta siirrellä näytöllä. Kopioitavan alueen sisältö 
esitetään näytöllä läpinäkyvänä.
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Symbolin 
tallentaminen

Uusi symboli tallennetaan aktiiviseen kirjastoon seuraavasti:

• Valitaan Tools → Accept. Tällöin uusi symboli ilmestyy kirjastoon.

de031a.gif

Kuva 5-70  Uuden symbolin hyväksyminen

Symbolin 
poistaminen

Symboli voidaan poistaa aktiivisesta kirjastosta seuraavasti:

• Valitaan symboli oikealla hiiripainikkeella ja valitaan valikosta Delete 
toiminta.

Ohje:
Uusi symboli tallentuu pysyvästi aktiivisena olevaan kirjastoon. 
Symboleja voidaan käyttää kaikilla SIPROTEC 4 laitteilla, jotka on 
varustettu suurella graafisella näytöllä perus- ja ohjausnäyttöjen 
esittämistä varten.
270 SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Perus- ja ohjausnäyttöjen editointi
5.14.14 Toimilaitesymbolin luonti

Toimilaitesymboli luodaan seuraavasti:

• Avataan perus- tai ohjausnäyttö näyttöeditori DisplayEditor 
ohjelmalla.

• Valitaan symbolikirjasto johon uusi symboli halutaan sijoittaa.

• Luodaan halutun tyyppinen toimilaitesymboli.

• Määritellään toimilaitesymbolin ominaisuudet. 

Katkaisija-
toimilaitteen 
luonti

Esimerkissä luodaan uusi CB New Symbol tyyppinen toimilaitesymboli  
(toimilaitesymbolilla esitetään katkaisijan voimassa olevat tilat). 
Käytetään toimilaitteen määrittelyssä DIN Symbol library-kirjaston 
symboleja: 2v LS_x, 2v LS_aus ja 2v LS_ein:

de033.gif

Kuva 5-71  Uuden katkaisijatoimilaitesymbolin luonnissa käytettävät kiinteät 
symbolit (välitila 00, AUKI, KIINNI ja virhetila 11)  

Ohje:
Edit → Rename... toiminnalla voidaan olemassa olevan symbolin nimeä 
muuttaa.

Edit → Duplicate... toiminnalla voidaan kopioida ja uudelleen nimetä 
olemassa oleva symboli.

Ohje:
Toimilaitesymbolin eri tilojen esityksessä käytetään yksittäisiä kiinteitä 
symboleja.

Jos tarvittavaa symbolia ei vielä ole, tulee se luoda ensin (katso kappale 
5.14.13).
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Toimilaitekirjaston 
valinta

Toimilaitekirjasto valitaan seuraavasti:

• Valitaan Library → Select Library.... Tällöin näyttöön aukeaa Select 
Library ikkuna.

• Valitaan symbolikirjasto Library valintaluettelosta ja hyväksytään 
valinta painamalla OK painiketta. 

Toimilaitesymbolin 
luonti

Toimilaitesymboli luodaan seuraavasti:

• Valitaan Library → New Device....

Näyttöön aukeavassa New Symbol ikkunassa määritellään uuden 
toimilaitteen ominaisuudet:

• Syötetään uuden toimilaitteen tunnus Name tekstikenttään.

• Määritellään toimilaitteen tyyppi Type kentässä.
Tyypillä määritellään minkä tyyppisiä SIPROTEC laitteen 
informaatioita  näytöllä voidaan esittää.

• Valitaan toimilaitteen leveys Width syöttökentässä (1 ... 8 merkkiä).

• Valitaan toimilaitteen korkeus Height syöttökentässä
 (1 ... 8 merkkiä). 

Ohje:
Toimilaiteobjektit voidaan luoda vain toimilaitekirjastoon (value display, 
DIN state display, SIPROTEC state display tai user display).

Toimilaitekirjastot on varustettu  "-"  tunnuksella.

Ohje:
Leveys Width ja korkeus Height asettelukentät ovat aktiivisena vain jos 
toimilaitesymbolin tyypiksi on valittu Symbol.
Symbolin leveyden ja korkeuden määrityksessä tulee ottaa huomioon 
koko jossa tilat halutaan esittää. Toimilaitesymbolin koon tulee olla sama 
kuin siinä esitettävien kiinteiden symbolien kokokin on.
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de034.gif

Kuva 5-72  Uuden toimilaitesymbolin luonti

• Valitut asettelut hyväksytään  OK painikkella. 

Tämän jälkeen näyttöön aukeaa Object Properties - Symbol ikkuna.

de035.gif

Kuva 5-73  Symbolin ominaisuuksien määrittely

• Valitaan Object operator-controllable valintaruutu, jos 
katkaisijasymbolista halutaan ohjattava.

• Valitut asettelut hyväksytään  OK painikkella.

Ohje:
OK painikkeen painamisen jälkeen näyttöeditori tarkastaa että uudelle 
symbolille on annettu nimi Name kentässä ja tarkastaa myös että nimi ei 
ole jo käytössä tässä kirjastossa.

Virhetilanteessa näyttöön tulee ilmoitus ja New Device ikkuna jää auki 
jotta virhe olisi korjattavissa.
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Toimilaitesymbolin 
ominaisuuksien 
määrittely

Dynaamisen toimilaitesymbolin eri tilojen esittämiseksi valitaan jokaiselle 
tilalle kiinteä symboli seuraavasti:

• Valitaan luotu toimilaite ja valitaan edelleen Edit → Open Object. 
Tällöin dynaaminen editori aukeaa.

• Valitaan Tools → Select Library... tai valitaan haluttu kirjasto 
työkaluriviltä (näytön yläreunassa).

de032.gif

Kuva 5-74  Kirjaston valinta

Ohje:
Valitusta kirjastosta näytetään vain ne kiinteät symbolit joilla on sama 
koko kuin luodulla toimilaitteellakin.
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• Valitaan haluttu symboli ja vedetään se hiiripainike alas painettuna 
toimilaitteen halutun tilan päälle. Symboli hyväksytään käyttöön 
vapauttamalla hiiripainike.

de032a.gif

Kuva 5-75  Toimilaitteen eri tilojen määrittely

• Valitaan kullekin tilalle haluttu symboli.
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• Hyväksytään määrittelyt valitsemalla Tools → Accept. Tällöin uusi 
toimilaitesymboli ilmestyy kirjastoon.

de038.gif

Kuva 5-76  Toimilaitesymbolin ominaisuuksien hyväksyminen
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Liikennöintiväylien määrittelyt
5.15 Liikennöintiväylien määrittelyt

SIPROTEC® laitteet voidaan varustaa liikennöintiväylin.

Laite liitetään ylemmän tason ohjausjärjestelmään järjestelmäväylällä  
system interface. Seuraavat liikennöintiprotokollat ovat käytettävissä 
laitteen tyypistä ja rakenteesta riippuen:

IEC 60870-5-103

PROFIBUS FMS

PROFIBUS DP

DNP3.0 taso 2

MODBUS ASCII/RTU

IEC 61850 (Ethernet)

Radiokello ajantahdistus voidaan liittää ajantahdistusväylään time 
control interface. 

Etähallintakäyttöä varten DIGSI® 4 ohjelmistolla laitteeseen on 
mahdollista lisätä huoltoväylä service interface modeemia ja/tai 
tähtijakajaa varten. DIGSI® 4 toiminnat ovat mahdollisia tämän väylän 
kautta. 

Käyttöväylää operator interface käytetään tietokoneen ja  DIGSI® 4 
ohjelmiston paikallista liittämistä varten. Tämän väylän kautta laite 
voidaan parametroida ja käyttää DIGSI® 4 ohjelman ominaisuuksia, 
kuten esimerkiksi häiriötallenteiden tai käyttömerkinantojen luku 
laitteelta. 

Liikennöintiväylät määritellään DIGSI® 4 ohjelmistolla. Jotta yhteys 
SIPROTEC 4 laitteen ja tietokoneen välillä onnistuisi, tulee näissä olla 
yhtenevät liikennöintimäärittelyt. Lisätietoja eri tyyppisten 
liikennöintiväylien määrittelyistä on annettu  kappaleessa 7.

Ohje:
Laitteen järjestelmäväyläksi voidaan valita jokin seuraavista 
liikennöintitavoista: valokuituyhteys,  RS485 tai RS232 väylä.
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5.16 Päivämäärän ja kellonajan asetus

Tapahtumatietojen tarkka aikaleimaus edellyttää että laitteen sisäinen 
kello on tahdistettu asianmukaisesti. Integroidulla päivämäärän ja 
kellonajan asettelulla mahdollistetaan tarkat aikaleimat tapahtumille, joita 
ovat esimerkiksi häiriö- ja käyttömerkinannot, sekä mittausarvojen 
minimi-maksimi-osoitukset.

SIPROTEC 4 laitteella on mahdollista suorittaa ajantahdistus 
seuraavin vaihtoehdoin:

Sisäinen kello (Internal clock) (esiasetus)
SIPROTEC 4 laitteen sisäinen kello pitää päivämäärän ja kellonajan  
myös apusähkön katkoksissa pariston ylläpitämänä, vaikka ulkoista 
tahdistusta ei olisikaan. Aika voidaan asetella käsin (katso kappale 
6.5.1).

Liikennöintiväylä (Interface)
Ajantahdistus liikennöintitelegrammilla (IEC 60870-5-103, 
PROFIBUS FMS, laitetyyppi kohtainen protokolla). 

Radiokellomoduli (Radio clock module)
Ajantahdistus suoritetaan radiopulssilla. Tarkoitusta varten 
laitteeseen tulee liittää vastaanotin tai aikasignaaligeneraattori 
IRIG B, DCF 77 tai SIMEAS-Sync.-Box toimintaperiaatteella.
Jos ulkoinen tahdistuslähde häiriintyy, pitää laite aikaa yllä sisäisellä 
kellolla tahdistamattomana. 

Binäärinen tulo (Binary input)
Ajantahdistus binääriseen tuloon tuodulla aikapulssilla.

Laitekohtaiset mahdollisuudet

Ajantahdistus määritellään seuraavasti:

• Avataan laite, valitaan navigointi-ikkunasta Setting hakemisto ja 
kaksoisklikataan Time Synchronization objektia. Tällöin näyttöön 
aukeaa Time Synchronization & Time Format ikkuna.

DIGSIGB056

Kuva 5-77  Ajantahdistus ja aikaformaatti
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• Valitaan tahdistustapa Source of time synchronization valikosta. 
Jos käyttöön valitaan binäärinen tulo, valitaan myös kyseinen tulo 
alasvetovalikosta.

• Määritellään aikasignaalien pisin aikaväli Fault indication after 
ruudussa, joka sijaitsee Monitoring kentässä. Asettelu voidaan 
määritellä aikavälillä 1 ... 65535 minuuttia (45.5 päivää). Jos asetellun 
aikavälin sisällä tahdistussignaalia ei tule, aktivoituu laitteen 
ajantahdistus häiriömerkinanto. 
Yleensä laitteeseen liitetyt ajantahdistusjärjestelmät välittävät 
aikasynkronoinnin minuutin välein poikkeuksena binäärisen tulon 
kautta suoritettava tahdistus, jossa pulssien väli voi olla useampia 
minuutteja.  
Jos tahdistuspulssi tulee minuutin välein, tulee Fault indication after 
ruudussa asetteluksi valita vähintään 2 minuuttia ja jos kyseessä on 
radiokello, signaalin häiriintyessä valvonta-ajan tulee olla jopa 
pidempi. 

• Valitaan päivämäärän esitystapa Time format for display kentässä.

• Jos käyttöön on valittu IRIG B, DCF 77 tai Synch.Box 
tahdistusmenetelmä, voidaan korjaus vastaanotettuun aikaan 
määritellä Time correction kentässä. Tämä mahdollistaa esimerkiksi 
vastaanotetun ajan muuntamisen vastaamaan paikallista aikaa. 
Asettelu määritellään tunteina ja minuutteina Offset to time signal 
kentässä. Suurin aikakorjaus voi olla: ±23 h 59 min = ±1439 min. 

• Valitaan aikavyöhyke ja kesäajan vaihto Time zone and summer 
time kentässä. Aikavyöhyke määritellään Time zone offset to GMT 
ruudussa. Kesäajan vaihtomäärittelyt voidaan vastaanottaa 
tietokoneelta tai syöttää ne käsin.

Ohje:
Tahdistettaessa kello binääriseen tuloon tuodulla pulssilla, siirtyy 
kellonaika seuraavan minuutin nolla sekuntiin, jos aikasignaalin nouseva 
reuna tunnistetaan binäärisellä tulolla yli 30 sekunnin ajan hetkellä. Jos 
pulssi tulee ennen 30 sekuntia, siirtyy aika käyvän minuutin nolla sekunti 
hetkeen. Signaalia ei valvota ja jokainen pulssi vaikuttaa suoraan 
kellonaikaan.

Ohje:
Käytettäessä radiokelloa, tulee huomata että laitteen ylösnoususta voi 
kulua jopa 3 minuuttia ennen kuin aika voidaan koodata luotettavasti. 
Vasta tämän jälkeen laitteen sisäinen kello tahdistuu. 

Käytettäessä IRIG B tahdistusta tulee vuosi syöttää käsin, sillä tämä 
standardi ei tue lainkaan vuoden lähetystä. Jos vahingossa syötetään 
pienempi vuosiluku kuin "1991" IRIG B tahdistuksessa, määrittelee laite 
automaattisesti vuodeksi "1991" ensimmäisessä tahdistuksessa. 
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Tahdistuksen
vaihtaminen

Jos tahdistustapaa vaihdetaan, päivittyy uusi tahdistustapa käyttöön 
välittömästi kun määrittelyt on ladattu laitteelle. Jaksoittainen tahdistus 
on aluksi menetetty ja laite ilmaisee ajantahdistushäiriön olevan 
voimassa, kunnes uusi tahdistusmenetelmä saa tahdistuksen 
toimintakuntoon. 

Jaksottaista tahdistusta ei menetetä, jos esimerkiksi muutetaan 
aikavyöhykekorjausta tai määritellään IRIG B menetelmässä vuosiluku. 
Tällöin on mahdollista että syntyy ns. aikahyppäys. Laite ilmaisee 
muutoksen ennen uutta tahdistusta Fault Clock ON  merkinannolla ja 
kun tahdistus on taas toimintakunnossa Fault Clock OFF merkinannolla. 

Aika-asetusten 
käyttömerkinannot

Fault Clock ON merkinannon jälkeen voi seurata aikahyppäys. Tämä 
merkinanto aktivoituu seuraavassa tapauksessa: 

Tahdistushäiriömerkinanto aktivoituu jos tahdistuspulssia ei 
vastaanoteta Fault indication after asettelun kuluttua umpeen tai 
kun tahdistusmenetelmää on vaihdettu; 

Jos aikahyppäys suoritetaan taaksepäin, on merkinannon 
aikaleimaus varustettuna ajalla ennen aikahyppäystä. 

Fault Clock OFF merkinanto aktivoituu seuraavissa tapauksissa: 

Kun tahdistustoiminta palaa toimintakuntoon (esimerkiksi kun 
radiokellon häiriöt poistuvat),

Välittömästi aikahyppäyksen jälkeen. Merkinanto varustetaan 
aikaleimalla aikahyppäyksen jälkeen, jolloin nähtävissä on kuinka 
suuri aikahyppäys on kyseessä. 

5.16.1 Päivämäärän / kellonajan asettelu laitteilla, jotka on varustettu 
suojausliikennöintiväylällä

Integroidulla päivämäärän ja kellonajan hallinnalla saavutetaan 
tapahtumille tarkat aikaleimaukset esim. käyttö- tai häiriötapahtumille 
sekä minimi- ja maksimi arvoille.

Aikaa voidaan ylläpitää seuraavin vaihtoehdoin:

• Sisäinen kello (RTC = Real Time Clock),

• Ulkoisen tahdistuslähteen avulla  (DCF77, IRIG B, SyncBox, IEC 
60870-5-103),

• Binääriseen sisääntuloon tuodulla ulkoisella pulssilla.

Kun kaksi tai kolme 7SA522 distanssisuojaa tai kaksi ... kuusi 7SD52 
suojaa on liitetty yhteen suojausliikennöintiväylällä (edellyttää että laitteet 
on tilattu toiminnoin), päivitetään yleensä vain yhden laitteen sisäinen 
kello ulkoisella tahdistuksella, tämän laitteen toimiessa tällöin ns. 
aikamasterina (absolute time master), joka määritellään antamalla 
laitteen järjestysnumeroksi 1 (Index = 1). Tämä laite tahdistaa muut 
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yhteen liitetyt laitteet suojausliikennöintiväylänsä kautta. Näin voidaan 
varmistaa että samassa suojausjärjestelmässä toimivien laitteiden 
kellonajat ovat tarkasti samassa ajassa.

Ajantahdistus Ajantahdistusmäärittelyt suoritetaan DIGSI® 4  ohjelmistossa Settings - 
Time Synchronization toiminnalla (kuva 5-78).

Kuva 5-78  DIGSI® 4 asetteluikkuna - esimerkki

Kaksoisklikataan Time Synchronization objektia. Tällöin aukeaa Time 
Synchronization & Time Format  valintaikkuna (kuva 5-79).

Ohje:
Toimitettaessa tehdasasetuksena tahdistustavaksi on määritelty aina 
sisäinen kello, riippumatta siitä onko laite varustettu järjestelmäväylällä 
vai ei. Jos ulkoinen ajantahdistus halutaan käyttöön, tulee se määritellä.
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Kuva 5-79  DIGSI 4 ohjelmiston ajantahdistus ja aikaformaatti-ikkuna - esimerkki

Ikkunassa voidaan määritellä ajan tahdistukseen liittyvät toiminnat. 
Taulukossa 5-2 on esitetty valittavissa olevat ajantahdistusmenetelmät:

Taul. 5-2 Ajantahdistusmenetelmät

No. Tahdistustapa Selitys

1 Internal Sisäinen tahdistus RTC-kellon avulla (esiasettelu)

2 IEC 60870-5-103 Ulkoinen tahdistus järjestelmäväylän kautta (IEC 60870-5-103)

3 Time telegram IRIG B Ulkoinen tahdistus IRIG B signaalin avulla

4 Time telegram DCF77 Ulkoinen tahdistus DCF77 aikatelegrammilla

5 Time telegram Sync.-Box Ulkoinen tahdistus SIMEAS–Synch.Box  aikatelegrammilla

6 Minute pulse via binary input Ulkoinen tahdistus binääriseen tuloon tuodulla minuuttipulssilla

7 Fieldbus Ulkoinen tahdistus kenttäväylän avulla

8 Internal clock or timing master

Vain laitteille jotka on varustettu 
suojauskommunikaatioväylällä:
Samat kuin yllä mainitut 1 ... 7 menetelmät, mutta 
ajantahdistus suoritetaan aikamasterin toimesta. Jos 
aikamasterin ylläpitämä tahdistus häiriintyy, astuu voimaan 
laittelle aseteltu tahdistustapa.

9 IEC 60870-5-103 or timing 
master

10 Time telegram IRIG B or timing 
master

11 Time telegram DCF77 or 
timing master

12 Time telegram Sync.-Box or 
timing master

13 Minute pulse via binary input or 
timing master

14 Field bus or timing master
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Sisäinen varmennusparisto mahdollistaa kellonajan ylläpidon vaikka 
laitteen apujännite olisikin väliaikaisesti katkaistu. Sisäinen kello on 
toiminnassa aina ensin kun laitteeseen kytketään jännite päälle 
apujännitekatkoksen jälkeen, riippumatta käyttöön valitusta kellon 
tahdistustavasta.

Jos toimintatavaksi on valittu Internal Clock, pidetään aikaa yllä vain 
sisäisellä kellolla. Kellonaika voidaan asetella myös käsin. Päivämäärän 
ja kellon asettelut on kuvattu kappaleessa 6.5.1.

Jos käyttöön on valittu jokin ulkoinen tahdistuslähde, tällöin käytetään 
vain tätä määriteltyä lähdettä. Jos ulkoinen tahdistus häiriintyy, käy 
sisäinen kello edelleen tahdistamattomana.

Jos kello halutaan tahdistaa ulkoisesta ohjausjärjestelmästä, tulee 
käyttöön valita joko IEC60870-5-103 tai PROFIBUS FMS käytössä 
olevan liikennöintiväylän mukaisesti (see Figure5-79 ).

Käytettäessä tahdistuksessa ulkoista aikasignaalia (radiokello) tulee 
huomioida, että laitteen käynnistyksen jälkeen kestää jonkin aikaa esim. 
3 minuuttia, kunnes vastaanotettu aikasignaali on avattu luotettavasti. 
Vasta tämän jälkeen laitteen sisäinen kello tahdistuu.

Käytettäessä IRIG B tahdistusta tulee vuosi syöttää käsin, sillä tämä 
standardi ei tue lainkaan vuoden lähetystä. Ohje: Jos vahingossa 
syötetään pienempi vuosiluku kuin "1991" IRIG B tahdistuksessa, 
määrittelee laite automaattisesti vuodeksi "1991" ensimmäisessä 
tahdistuksessa.

Tahdistettaessa kello binääriseen tuloon tuodulla pulssilla, siirtyy 
kellonaika seuraavan minuutin nolla sekuntiin, jos aikasignaalin nouseva 
reuna tunnistetaan binäärisellä tulolla yli 30 sekunnin ajan hetkellä. Jos 
pulssi tulee ennen 30 sekuntia, siirtyy aika käyvän minuutin nolla sekunti 
hetkeen. Signaalia ei valvota ja jokainen pulssi vaikuttaa suoraan 
kellonaikaan.

Käyttöön voidaan valita vaihtoehto „... or timing master“ (No. 8 ... 14 
Taulukossa Taul. 5-2) laitteilla, joiden sisäinen kello tahdistetaan 
aikamasterin toimesta suojausliikennöintiväylää pitkin. Laite käyttää sille 
määriteltyä ulkoista tahdistustapaa vain, jos aikamasterin toiminta on 
häiriintynyt.

Tahdistuksen 
aikakorjaus

Parametrillä Synchronization offset (Offset to time signal) voidaan 
sovittaa vastaanotettu radioaika vastaamaan paikallista aikaa 
(aikavyöhyke). Suurin aikakorjaus voi olla: 23 h 59 min = 1439 min.

Ajanvastaan-
ottohäiriö

Ajanvastaanoton valvonta-aika (Fault indication after) määrittelee kuinka 
kauan ajantahdistus voi olla pois toiminnasta ennen kuin vastaava 
häiriömerkinanto aktivoituu.

Ulkoinen tai sisäinen tahdistus suoritetaan yleensä minuutin välein. 
(Käytettäessä ulkoista tahdistusta binääriselle sisääntulolle tuotuna on 
poikkeus, sillä sitä ei valvota koska aikapulssi voi tulla useamman 
minuutin välein.) Tästä johtuen valvontaparametri tulee asetella 
vähintään 2 minuuttiin. Jos radiosignaalin vastaanotto-olosuhteet eivät 
ole hyvät, voidaan häiriön merkinantoa viivästää edelleen.
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Tahdistustavan 
muuttaminen

Toimintatilaa vaihdettaessa vaihtuu asetteluiden jälkeen tahdistuslähde 
noin yhden sekunnin kuluessa tallennuksesta. Jaksoittainen tahdistus on 
aluksi menetetty ja laite ilmaisee ajantahdistushäiriön olevan voimassa, 
kunnes uusi tahdistusmenetelmä saa tahdistuksen toimintakuntoon.

Jos tahdistuslähdettä on vaihdettu ja aiemmin käytössä ollut IRIG B on 
edellyttänyt vuosiluvun syötön, ei tahdistusta menetetä mutta 
aikahyppäys voi olla mahdollista. Laite ilmaisee muutoksen ennen uutta 
tahdistusta Fault Clock ON  merkinannolla ja kun tahdistus on taas 
toimintakunnossa Fault Clock OFF merkinannolla.

Aika-asetusten 
käyttömerkinannot

Fault Clock ON merkinannon jälkeen voi seurata aikahyppäys. Tämä 
merkinanto aktivoituu seuraavassa tapauksessa:

- Ajantahdistushäiriö on ollut pidempään voimassa kuin yllä mainittu 
valvonta-aika-asettelu tai vaihdettaessa tahdistustapaa.

- Jos aikahyppäys suoritetaan taaksepäin, on merkinannon aikaleimaus 
varustettuna ajalla ennen aikahyppäystä.

Fault Clock OFF merkinanto aktivoituu seuraavissa tapauksissa:

- Kun tahdistustoiminta palaa toimintakuntoon (esimerkiksi kun 
radiokellon häiriöt poistuvat),

- Välittömästi aikahyppäyksen jälkeen. Merkinanto varustetaan 
aikaleimalla aikahyppäyksen jälkeen, jolloin nähtävissä on kuinka suuri 
aikahyppäys on kyseessä.

Aikaformaatti Käyttöön voidaan valita joko eurooppalainen aikaformaatti 
(PP.KK.VVVV) tai amerikkalainen aikaformaatti (KK/PP/VVVV).
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5.17 Muiden parametrien asettelu

DIGSI 4 Device Configuration laitekonfiguraatiossa on muita aseteltavia 
objekteja laitteen tyypistä ja käyttöön määritellystä toiminnallisuudesta 
riippuen. Näiden objektien sisältämät asettelut vaikuttavat SIPROTEC 4 
laitteen toimintoihin riippumatta aktiivisena olevasta asetteluryhmästä. 
Näitä objekteja ovat:

Suojattavan kohteen tiedot (Power system data)
Tämä objekti sisältää tietoja suojattavasta kohteesta, kuten 
kiertokentän suunnan tai nimellistaajuuden.

Laitemäärittelyt (General Devise Settings)
Tässä objektissa määritellään laitekohtaiset asettelut, kuten 
ilmaisinledien aktivoitumistapa.

Häiriöntallennus (Oscillographic Records)
Tässä objektissa määritellään häiriöntallentimen ominaisuudet.

Mitta-arvon muuntimet (Measuring transducers)
Tämä objekti on hakemisto, jonka alla on muita objekteja. Kukin 
aliobjekti kuvaa yksittäistä mitta-arvon muunninlohkoa (katso kappale 
5.11).

Ajantahdistus (Synchronization)
Tämä objekti on hakemisto, jonka alla on muita objekteja. Jokainen 
näistä aliobjekteista sisältää ajantahdistukseen liittyvät asettelut.

Asetteluparametrit • Kaksoisklikataan objektia. Jos kohteeksi valittiin hakemisto, 
toistetaan kaksoisklikkaus uudelle objektille. Tällöin näyttöön aukeaa 
asetteluikkuna, jossa määrittelyt voidaan suorittaa. Suoritetaan 
asettelut käyttökohteen vaatimusten mukaisesti. 
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5.18 Asetteluparametrien määrittely asetteluryhmissä

Aseteltaessa asetteluryhmissä olevia toimintoja, aukeaa ensin ikkuna 
jossa käyttöön määritellyt toiminnat on esitetty.

Tämä tapahtuu seuraavasti:

• Kaksoisklikataan esimerkiksi Setting Group A objektia. 

Tällöin näyttöön aukeaa Setting Group ikkuna. 

DIGSIGB130

Kuva 5-80  Setting Group asetteluryhmäikkuna

Toimintojen yhteydessä on esitetty myös niiden funktionumero. Esitetyt 
toiminnat ovat riippuvaisia käyttöön määritellyistä toiminnoista. 

Asetteluryhmän 
palauttaminen

• Reset painikkeella voidaan palauttaa kaikki asetteluryhmän 
asetukset tehdasasetuksiin.

Toimintakohtaiset 
tiedot

• Jos toiminnasta halutaan lisätietoja, valitaan se ja klikataan tämän 
jälkeen  Info painiketta. 

Parametrien 
muuttaminen

Asetteluryhmän toiminnan asetteluita voidaan muuttaa seuraavasti:

• Valitaan haluttu toiminta ja klikataan Customize painiketta. 

Näyttöön aukeaa toiminnan asetteluparametrit. Parametrit on jaettu 
mahdollisesti erillisille sivuille parametrien tyypeistä ja lukumääristä 
riippuen:

Sivu teksti- ja numeroparametreille
Yksittäiset asettelut määritellään joko valitsemalla alasvetovalikosta 
tai syöttämällä asettelu numeroin.
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Asetteluparametrien määrittely asetteluryhmissä
Sivu taulukkomuotoisille parametreille
Tätä esitystapaa käytetään esimerkiksi käyttäjän määriteltävissä 
olevan ominaiskäyrän muodostuksessa.

• Suoritetaan halutut muutokset. 

• Painetaan Apply asetteluiden hyväksymiseksi. Painike on aktiivinen 
jos vähintään yhtä asettelua on muutettu. Painikkeen painamisen 
jälkeen valintaikkuna jää auki. 

• Valitaan DIGSI -> Device painike asetteluiden siirtämiseksi  
SIPROTEC 4 laitteelle. Jos työskentely tapahtuu Online tilassa, on 
DIGSI -> Device aktiivisena, jos jotain asettelua on muutettu. 

• OK painikkeella hyväksytään muutetut asettelut. 

Asetteluarvojen 
vienti

Jos asetteluarvot on vietävissä ulkoiseen järjestelmään, on Export 
painike aktiivisena. Lisätietoja tietojen viennistä on esitetty kappaleessa 
4.7.1.

Ohje:
Asettelut on tallennettu vasta tietokoneen väliaikaiseen muistiin. Niitä ei 
vielä ole tallennettu pysyvästi parametritiedostoon. Asettelut on kirjattu 
vasta tietokoneen työskentelymuistiin. 
Lisätietoja asetteluiden tallennuksesta on esitetty kappaleessa 4.4.
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Konfigurointi
5.18.1 Teksti- ja numeroparametrien määrittely

DIGSIGB048

Kuva 5-81  Toiminnan asettelut teksti- ja numeroparametrein

Parametrin numero
Määrittelee parametrin ja on täten käyttäjäystävällisesti 
tunnistettavissa myös laitedokumentaatiosta.

Parametri
Parametrin määrittely pitkällä tekstillä, lyhyttä tekstiä käytetään vain  
SIPROTEC 4 laitteen näytöllä. 

Arvo
Asetteluparametrin arvo. Sitä voidaan muuttaa parametrin tyypistä 
riippuen joko tekstimuotoisena ON, OFF, jne. alasvetovalikosta tai 
syöttämällä haluttu arvo Value kenttään. 
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Asetteluparametrien määrittely asetteluryhmissä
Arvojen 
asettelualueet

• Sijoitetaan kursori halutun asettelun Value kenttään. Muutaman 
sekunnin kuluttua näyttöön tulee sallittu asettelualue työkaluvihjeenä. 

Syöttö- ja 
esitystavan valinta

Asetteluarvot voidaan syöttää ja esittää joko ensiö- tai toisioarvoina. 

• Esitystapaa vaihdettaessa tulee ensin asetteluikkuna sulkea. Tämän 
jälkeen valitaan Options → Primary parameter tai Options → 
Secondary parameter halutun esitystavan valitsemiseksi. Tämän 
jälkeen haluttu asetteluikkuna avataan uudelleen.

Lisäasetteluiden 
esitys

Jos Display Additional Settings ruutu on valittu, ovat toiminnan kaikki 
asettelut nähtävissä. Yleensä nämä piilotettavissa olevat asettelut 
voidaan jättää tehdasasetuksiinsa. Määrätyt asettelut tulee ehdottomasti 
ottaa huomioon, kuten esimerkiksi alijännitetoiminnan palautumissuhde. 

Ohje:
Määrätyillä parametreillä on mahdollista asetella myös ääretön arvo. 
Tämä arvo määritellään syöttämällä oo.

Ohje:
Erikoisasettelut Advanced alueella on esiaseteltu tehtaalla ja niitä tulee 
muuttaa vain jos todella tiedetään niille käyttökohdetta paremmin 
vastaavat määrittelyt. 
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5.18.2 Taulukkoparametrien muuttaminen

Taulukkomuotoisin parametrein määritellään yleensä käyttäjän 
määriteltävissä olevat laukaisuominaiskäyrät.

DIGSIGB050

Kuva 5-82  Taulukkomuotoiset asetteluparametrit

Ominaiskäyrät määritellään arvopareina. Nämä arvoparit muodostavat 
yhdessä parametrin arvon. Tämän tyyppisiä asetteluita kutsutaan 
taulukkoparametreiksi. Sarakkeen Value 1 ja Value 2 kentissä olevat 
arvot muodostavat ominaiskäyrän pisteen.

Käyttäjän määrittelemä ominaiskäyrä on voimassa kaikille 
asetteluryhmille. Ominaiskäyrä voidaan esittää myös graafisessa 
muodossa, jossa sitä voidaan myös editoida hiirellä (katso kappale 
5.19).

Asetteluikkunassa määritellään valitun ominaiskäyrän edellyttämät 
parametrit:

Parametrien lukumäärät

X-akselin minimi- ja maksimiarvot (Value 1) ja

Y-akselin minimi- ja maksimiarvot (Value 2). 

Lisätietoja voidaan kutsua näytölle About painikkeella.

• Kaksoisklikataan Value 1 tai Value 2 sarakkeen kenttää jonka arvoa 
halutaan muuttaa. Kursori vaihtuu tekstikursoriksi. Syötetään haluttu 
arvo kenttään ja hyväksytään se Return painikkeella.
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Käyttäjän määrittelemän ominaiskäyrän käsittely
5.19 Käyttäjän määrittelemän ominaiskäyrän käsittely

Käyttäjän määrittelemä ominaiskäyrä voidaan esittää myös graafisesti ja 
sitä voidaan editoida hiirellä. 

Tämä tapahtuu seuraavasti:

• Avataan SIPROTEC 4 laitetiedosto ja kaksoisklikataan Settings 
Group objektia. Näyttöön aukeaa asetteluryhmän sisältämät 
toiminnat.

DIGSIGB130

Kuva 5-83   Asetteluryhmä A

• Kaksoisklikataan ylivirtasuojatoimintaa eli esimerkiksi directional 
DMT/IDMTL. Näyttöön aukeaa toiminnan asetteluikkuna. Valitaan 
sivu, jossa ominaiskäyrän asettelut sijaitsevat.
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DIGSIGB050

Kuva 5-84  Ominaiskäyrän taulukkoparametrit

• Painetaan Characteristic painiketta. 

DIGSIGB051

Kuva 5-85 Laukaisuaikaominaiskäyrä
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Käyttäjän määrittelemän ominaiskäyrän käsittely
5.19.1 Ominaiskäyrän muuttaminen

Ominaiskäyrää voidaan muuttaa numeerisesti tai graafisesti. 

Numeerinen 
muutos

• Valitaan asettelutaulukosta asettelu jonka arvoa halutaan muuttaa ja 
syötetään uusi arvo.

• Painetaan Characteristic painiketta. Ominaiskäyrä esitetään uusin 
asetteluarvoin.

Graafinen muutos • Sijoitetaan kursori ominaiskäyrän pisteen päälle. Kursori muuttaa 
muotoaan käsikursoriksi. Painetaan vasenta hiiripainiketta ja 
siirretään pistettä hiiripainike alas painettuna haluttuun kohtaan ja 
vapautetaan hiiren painike. 

Arvot muuttuvat taulukkoon automaattisesti.

Asetteluarvojen ylärajat kaavion ylä- ja oikeassa reunassa on esitetty 
pistekatkoviivoin. Jos hiiren avulla määritelty piste sijaitsee näiden 
viivojen ulkopuolella, määritellään arvo "äärettömäksi".
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5.20 Vyöhykekaavioiden käyttö

Vyöhykekaavioilla esitetään distanssi- ja impedanssisuojien 
vyöhykeominaiskäyrät graafisessa muodossa. Häiriöntallennetta 
käsiteltäessä vyöhykekaaviossa esitetään myös vikapaikan sijainti.   
Toiminta on käytettävissä jos SIPROTEC 4 laitteen toimintojen 
määrittelyn yhteydessä distanssisuojaustoiminta on määritelty käyttöön.

Vyöhykekaavio saadaan näyttöön seuraavasti:

• Valitaan View → Trip Characteristic. Valittavissa on enintään neljän 
asetteluryhmän määrittelyt. Jos mikään näistä vaihtoehdoista ei ole 
aktiivisena, ei SIPROTEC 4 laitteelle ole määritelty 
distanssisuojatoimintaa käyttöön. Jos valittavissa on vähemmän 
asetteluryhmiä kuin neljä, on joko asetteluryhmien vaihtotoiminta 
määritelty pois käytöstä Disabled suojan toimintojen määrittelyn 
yhteydessä tai SIPROTEC 4 laite ei tue neljää asetteluryhmää.

• Valitaan asetteluryhmä, jonka vyöhykekaavio halutaan esittää. 
Tällöin vyöhykekaavio aukeaa näytölle omassa ikkunassaan. 

Vikapaikan sijainti voidaan kutsua näytölle häiriöntallenteesta 
seuraavasti:

• Avataan häiriöntallenne ja valitaan View → Trip Characteristic ja 
valitaan haluttu asetteluryhmä. 
Tällöin vyöhykekaavio aukeaa näytölle omassa ikkunassaan.

Jos vikapaikan sijainteja ei haluta näytölle:

• Valitaan halutun asetteluryhmän asetteluikkuna. Painetaan Graph 
painiketta. Tällöin vyöhykekaavio aukeaa näytölle omassa 
ikkunassaan. 

Vyöhykekaavion 
sulkeminen

• OK painikkeella voidaan sulkea vyöhykekaavio.
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Vyöhykekaavioiden käyttö
DIGSIGB055.tif

Kuva 5-86 Vyöhykekaavio

Vyöhykkeiden 
esitys ja piilotus

Avautuneessa ikkunassa esitetään kaikki käytössä olevat vyöhykkeet. 
Jos vyöhykkeitä halutaan piilottaa tai kutsua takaisin näyttöön, toimitaan 
seuraavasti: 

• Klikataan hiirellä näytölle ja valitaan Signals toiminta valikosta. 
Näyttöön avoimessa ikkunassa näytettäviksi määritellyillä 
vyöhykkeillä on valintamerkki aktivoituna. Klikataan vyöhykkeen 
nimeä joka halutaan piilottaa tai esittää. Valitun vyöhykkeen tunnus 
piilotetaan tai tuodaan takaisin näyttöön samalla kertaa.

Näytön 
suurentaminen ja 
pienentäminen

Vyöhykekaavion koko määritellään automaattisesti vastaamaan näytöllä 
olevan ikkunan kokoa. Zoomaustoiminnoin voidaan haluttua vyöhykkeen 
aluetta suurentaa.

• Painetaan Zoom painiketta työkaluvalikosta. Kursori muuttuu 
suurennuslasiksi. 

• Valitaan kursorilla zoomattavan ikkunan vasen yläkulma ja vedetään 
vasen hiiripainike alas painettuna zoomausikkunan oikeaan 
alareunaan ja vapautetaan hiiripainike.

• Zoomaustoiminta saadaan pois päältä klikkaamalla suurennuslasia 
uudelleen työkaluvalikosta. Tällöin kursorin esitystapa palautuu 
normaaliksi.
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5.21 Häiriömerkinantojen esitystavan määrittely

SIPROTEC laitteen näytölle voidaan määritellä häiriömerkinantojen 
esitysjärjestys kuudelle riville käyttäjän määrittelemän 
tärkeysjärjestyksen mukaisesti (katso kappale 6.2.3). On myös 
mahdollista määritellä että rivillä ei esitetä häiriömerkinantoa.

Häiriömerkinantojen esitysjärjestys voidaan muuttaa seuraavasti:

• Avataan määrittelymatriisi.

• Valitaan Options> Display valikosta. Valikkotoiminta on aktiivisena 
vain jos määrittelymatriisi on avoinna. Näyttöön aukeaa Display after 
fault ikkuna.

• Valitaan kullekin riville esitettävä merkinannon tyyppi 
alasvetovalikosta. Jos rivillä ei haluta esittää merkinantoja, valitaan 
asetteluksi "None" tälle riville.

• OK painikkeella hyväksytään muutetut asettelut ja suljetaan 
asetteluikkuna. Asettelut on tallennettu vasta tietokoneen 
väliaikaiseen muistiin. Niitä ei vielä ole tallennettu pysyvästi 
parametritiedostoon. 

 

Ohje:

Esitettäviksi määrätyt merkinantotyypit on valittu asetteluin. Asettelua ei 
voida muuttaa käyttäjän toimesta. Täten esimerkiksi käyttäjän itsensä 
lisäämiä merkinantoja ei voida esittää häiriön yhteydessä.
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Toimenpiteet käytön aikana 6
Tässä kappaleessa on kuvattu kuinka SIPROTEC® laitetta voidaan 
käsitellä käytön aikana. Kappaleessa käydään läpi muun muassa

Kuinka tiedot voidaan lukea laitteelta

Kuinka laitteen toimintoja voidaan käyttää käytön aikana ja

Kuinka kojeistoa voidaan ohjata laitteelta. 

Kappaleessa ei käsitellä laitteen toimintoja yksityiskohtaisesti. 
Edellytyksenä on, että laitteen konfigurointi on jo suoritettu kuten 
kappaleessa 5 on kuvattu ja ennen kaikkea tulojen ja lähtöjen määrittelyt 
tulee olla suoritettuna. 

Tulee huomioida, että esimerkeissä esitetyt toiminnat ovat yleisesti 
päteviä ja eri toiminnallisuudet voivat poiketa tapauskohtaisesti. On 
myös mahdollista, että kaikki toiminnat eivät ole käytettävissä johtuen 
laitteen versiosta. Yksityiskohtaista tietoa kunkin laitteen toiminnoista ja 
käsittelystä on esitetty laitteen käyttöohjeessa.

Sisältö 6.1  Kaikkien prosessitietojen luku laitteelta  298

6.2  Merkinannot  299

6.3  Mittaus- ja energialaskuriarvot  320

6.4  Häiriötallentimen tiedot  328

6.5  Laitetoimintojen käyttö  332

6.6  Katkaisijan koestustoiminta  345

6.7  Kytkinlaitteiden ohjaukset  349
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Toimenpiteet käytön aikana
6.1 Kaikkien prosessitietojen luku laitteelta

Laitteelta on saatavissa runsaasti informaatioita joko paikallisesti tai 
tiedonsiirtoväylien kautta: 

Merkinannot,

Käyttömittausarvot ja lasketut energiatiedot,

Häiriötallenteet. 

Kaikki nämä tiedot voidaan lukea yhdellä kertaa laitteen muistista 
DIGSI® 4 ohjelmalla. Toimintaa varten tarvitaan vain tyhjä projekti.

Tämä tapahtuu seuraavasti:

• DIGSI 4 Manager ohjelmalla valitaan laite, josta tiedot halutaan lukea. 

• Oikealla hiiripainikkeella avautuvasta valikosta valitaan Read out 
process data toiminta.

Kuva 6-1  Prosessitietojen luku laitteelta.

• Valitaan haluttu liityntätapa, määritellään liitynnän ominaisuudet ja 
käynnistetään tiedonsiirto OK painikkeella.

Prosessitiedot, merkinannot ja mittausarvot sekä häiriötallenteet siirtyvät 
tietokoneen muistiin. Tietokoneella niitä voidaan käsitellä välittömästi tai 
siirtää ulos jatkokäsittelyä varten. 

Ohje:

Jos tietokoneella ei ole olemassa tälle laitteelle tiedostoa, voidaan tiedot 
(asettelut ja prosessitiedot) lukea "Plug and Play" menetelmällä (katso 
kappale 7.2).
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6.2 Merkinannot

Merkinannot antavat käyttäjälle tietoa käytön aikaisista 
mittausvalvonnoista, aseman tiedoista ja laitteen itsensä tiloista. 
Verkkohäiriön jälkeen informaatiot antavat havainnollisen yleiskuvan 
häiriöstä, laitteen toiminnoista sekä niitä voidaan hyödyntää 
monipuolisesti koestusten ja käyttöönoton yhteydessä. Merkinannot 
voidaan siirtää joko spontaanisti tai yleiskyselyllä. Merkinannot on 
varustettu aikaleimoin. 

Merkinannot on jaettu ryhmiin ja ne voidaan lukea laitteen näytöltä tai 
DIGSI 4 ohjelmalla tietokoneelle.

Ohje:

Täydellinen luettelo laitteen muodostamista merkinannoista 
funktionumeroin varustettuna on esitetty kunkin laitteen käyttöohjeen 
Liitteessä. 

Ohje:

Merkinantojen luku laitteelta ei edellytä salasanan syöttöä. 
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Toimenpiteet käytön aikana
6.2.1 Yleistietoja merkinantojen lukemisesta

Merkinannot tai merkinantoryhmät voidaan lukea SIPROTEC 4 laitteelta 
suoraan etupaneelin näytöltä tai tietokoneelle asennetulla DIGSI 4 
ohjelmalla. Seuraavassa on kuvattu toimintatavat informaatioiden 
lukemiseksi

Informaatioiden 
luku 
ohjauspaneelilta

Informaatiot voidaan lukea SIPROTEC 4 laitteen etupaneelilta 
seuraavasti: 

• Kun laite on käyttökunnossa kutsutaan päävalikko MAIN MENU 
näytölle. 

Näytössä on tällöin alivalikkojen otsikot. 

Näytön oikeassa yläreunassa oleva numero kuvaa kuinka monta 
alivalikkoa tai informaatiota näytöllä on. 

Numero kenoviivan vasemmalla puolella ilmaisee kuinka mones 
merkinanto tai alivalikko on valittuna tai näytettynä (katso kuva 6-2, 
ensimmäinen rivi). 

• Nuolipainikkeilla voidaan siirtyä haluttuun  alivalikkoon, kuten 
esimerkissä käyttöpäiväkirjaan (Event Log).

Kuva 6-2  Merkinantojen luku näytöltä - esimerkki

MAIN MENU            01/
05
---------------------
> Annunciation      –> 

ANNUNCIATION     01/05
---------------------
>Event log  –> 01
  Trip Log    –> 02
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Merkinannot
Merkinantojen luku 
DIGSI 4 ohjelmalla

Informaatioiden lukemiseksi DIGSI 4 ohjelmalla tulee tietokone liittää 
laitteeseen joko käyttösarjaliikenneväylän operator interface tai 
huoltoväylän service interface kautta. Huoltoväylää käytetään jos suojat 
on liitetty yhteen tiedonsiirtoväylään tai liikennöidään modeemin kautta. 

Käytettävissä olevien informaatioiden tyypit ja määrät ovat riippuvaisia 
laitteen versiosta ja kuinka merkinannot on määritelty 
määrittelymatriisissa. 

Tämä tapahtuu seuraavasti:

• Avataan laitetiedosto.

• Kaksoisklikataan navigaatioikkunasta Annunciation hakemistoa.

• Kaksoisklikataan Event Log objektia.

Tällöin tiedot ikkunaan tulee näkyviin symboli varustettuna päivämäärällä 
ja kellonajalla ja jota kaksoisklikkaamalla saadaan yksittäiset 
merkinannot näytölle.
I

DIGISGB097

Kuva 6-3  Informaatioiden luku laitteelta

Offline tila Työskenneltäessä Offline tilassa voidaan käsitellä tietokoneen 
pysyvään muistiin tallentuneita prosessitietoja. 

Online tila Työskenneltäessä Online tilassa voidaan käsitellä SIPROTEC® laitteen  
muistiin tallentuneita prosessitietoja. 
Tiedot voidaan lukea laitteelta, esittää näytöllä ja tallentaa tietokoneen 
pysyvään muistiin. Tämä ei vaikuta tietoihin jotka ovat jo tallennettu 
aiemmin tietokoneen muistiin (katso kappale 4.4). 

Laitteen muisteissa olevat tiedot eivät poistu kun ne luetaan 
tietokoneelle. Muistit voidaan tyhjentää käsin käyttäjän toimesta (katso 
kappale 6.2.7). 
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Toimenpiteet käytön aikana
Näytön
päivittäminen

Online tilassa spontaanit merkinannot spontaneous indications 
siirretään automaattisesti  laitteelta tietokoneen  DIGSI® 4 ohjelmaan 
kun uusia merkinantoja aktivoituu. Luettelo tietokoneen näytöllä on aina 
päivitetty. 

Käyttöpäiväkirja Event Log, häiriöpäiväkirja Trip Log ja yleiset tilatiedot 
General Interrogation voidaan päivittää käsin Online tilassa. 

• Aktivoidaan merkinantoikkuna ja valitaan View → Update. Valitun 
informaatioryhmän tiedot siirretään tietokoneelle DIGSI® 4 
ohjelmaan. Näyttö on nyt päivitetty.

Kaiken tyyppiset informaatiot esitetään yhdessä prosessitietoryhmässä 
poikkeuksena häiriömerkinannot  fault indications ja 
maasulkumerkinannot earth-fault indications, joissa voi olla 0 ... n 
prosessidataryhmää. 

Merkinantojen 
esitys

Merkinannot esitetään seuraavin tiedoin:

Merkinantorivillä on esitetty merkinannon syntytapa Initiator 
sarakkeessa. Jos syy on negatiivinen, esitetään myös lisämäärite 
selväkielisenä tekstinä, kuten esimerkiksi määrittelyvirhe Configuration 
fault. Lisäksi tilasarakkeessa State esitetään onko esimerkiksi 
tiedonsiirron esto IB tai kosketinvärähtelytoiminta CB aktiivisena. 

Ohje:

DIGSI® 4 ohjelmalla voidaan esittää eri tyyppisiä informaatioita saman 
aikaisesti eri ikkunoissa (katso kappale 4.2.7).

Käyttöpäiväkirja 
(Event Log):

Päivämäärä ja kellonaika

Häiriöpaiväkirja 
(Trip Log):

Verkkohäiriön numero, päivämäärä ja 
kellonaika

Herkkä 
maasulkupäiväkirja 
(Sensitive Ground 
Fault Log):

Järjestysnumero, päivämäärä ja 
kellonaika

Yleiset tilatiedot 
(General 
Interrogation):

Päivämäärä ja kellonaika

Spontaanit 
merkinannot 
(Spontaneous 
Annunciation):

Päivämäärä ja kellonaika

SPN Spontaani
GI Yleiskysely
CA+ Ohjausvahvistus positiivinen
CA- Ohjausvahvistus negatiivinen
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Merkinannot
Lisäksi esitetään myös lähderyhmät initiator category sarakkeessa.

6.2.2 Käyttöpäiväkirja (Event Log)

Käyttömerkinannot ovat informaatioita, jotka laite muodostaa käytön 
aikana käyttötapahtumista. Näitä tietoja ovat muun muassa laitteen 
toimintojen tilat, mittausarvovalvonnat, kojeiston tiedot, jne.
Laite tallentaa yli 100 käyttömerkinantoa ajallisesti järjesteltynä. Uudet 
merkinannot lisääntyvät olemassa olevien perään. Jos suurin 
muistiinsopiva lukumäärä täyttyy, poistuvat vanhimmat merkinannot 
muistista. 

Positiiviset ja negatiiviset valvontarajamerkinannot ovat 
käyttömerkinantoja. Rajoja voidaan muuttaa käytön aikana (katso 
kappale 6.3.3)

Verkkohäiriöt kirjautuvat yhtenä yleishäiriömerkinantona (network fault) 
varustettuna häiriön juoksevalla numerolla. Yksityiskohtaiset 
merkinannot verkkohäiriöstä tallentuvat häiriöpäiväkirjaan  (kappale 
6.2.3). 

FB+ Ohjauksen takaisinkytkentä positiivinen
FB- Ohjauksen takaisinkytkentä negatiivinen
ZWI Ohjauksen takaisinkytkentä välitilassa
AB+ Keskeytyssuoritus positiivinen
AB- Keskeytyssuoritus negatiivinen
COE Ohjaustoiminta päättynyt
FPL Odottaa vahvistusta

VQ = Local Paikallisohjaus
VQ = SICAM Asemaohjaus
VQ = Remote Kauko-ohjaus
VQ = Auto 
SICAM

Automaattinen ohjaus (suoritettu aseman 
ohjausjärjestelmän CFC logiikalla)

VQ = Auto Automaattinen ohjaus (paikallisesti kenttätasolla)
VQ = DIGSI DIGSI
VQ = Error Laitteen sisäinen häiriö
VQ = Blocked Laitteen sisäinen lukitus
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Toimenpiteet käytön aikana
Laitteella joka on varustettu herkällä maasulkutoiminnalla, verkon 
maasulkutilanne kirjataan käyttöpäiväkirjaan yleishäiriömerkinannolla 
earth fault ja maasulun järjestysnumerolla. Yksityiskohtaiset 
merkinannot maasulkutapahtumasta tallentuvat maasulkupäiväkirjaan 
SENSITIVE GROUND FAULT LOG (katso kappale 6.2.4). 

Luku 
laitteelta 

• Siirrytään nuolipainikkeilla käyttöpäiväkirjaan Event Log.
Tällöin näytössä on käyttöpäiväkirja EVENT LOG. 

Tapahtumat ja tilatiedot on järjestetty luetteloon ajalliseen järjestykseen. 
Kun käyttöpäiväkirja kutsutaan näytölle, on näytössä päivämäärältään ja 
kellonajaltaan viimeisin tapahtuma. 
Jos luettelo ei ole täynnä, on viimeisenä tapahtumana End tieto. 
Jos luettelo on tyhjä, tulee siitä myös näytölle ilmaisu List is empty.

Kuva 6-4  Käyttöpäiväkirja laitteen näytöllä

• Luettelossa merkinantoja voidaan selata nuolipainikkein.

• MENU painikkeella voidaan siirtyä takaisin päävalikkoon MAIN 
MENU.

Luku 
DIGSI® 4  
ohjelmalla

Tämä tapahtuu seuraavasti:

• Kaksoisklikataan navigaatioikkunasta Annunciation hakemistossa 
olevaa Event Log symbolia. 

Ohje:

Kaikki käytettävissä olevat käyttömerkinannot on esitetty 
taulukkomuodossa selityksineen kunkin laitteen käyttöohjeessa. 

Kunkin merkinannon kohdalla on määritelty onko se toimintatavaltaan

Tapahtuma (vain tullut reuna) vai

Tila (sekä tullut että poistunut reuna).

OPERAT. INDIC.   19/19
---------------------
19.06.99 11:52:05,625
Reset LED         ON 
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Merkinannot
digsi602

Kuva 6-5  DIGSI® 4 ohjelmassa käyttötapahtumien valinta, esimerkki

• Kaksoisklikataan tieto ikkunassa olevaa symbolia.

Näyttöön aukeaa Event Log ikkuna, jossa kaikki merkinannot 
lisätietoineen on esitetty. 

digsi603.gif

Kuva 6-6  Käyttömerkinannot DIGSI® 4 ohjelman ikkunassa, esimerkki

6.2.3 Häiriöpäiväkirja (Trip Log)

Laitteelle tallentuvat häiriötapahtumat 8 viimeisestä verkkohäiriöstä.

Spontaani näyttö Häiriötapahtuman jälkeen näyttöön tulee laitteen yleishavahtuman 
aktivoimana tärkeimmät tapahtumatiedot häiriöstä. 
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Toimenpiteet käytön aikana
Kuva 6-7  Spontaanit merkinannot laitteen näytöllä, esimerkki

• Spontaanit merkinannot voidaan kuitata LED painikkeella. Tällöin 
näyttöön palaa perusnäyttö. 

Vikapaikan 
etäisyys-
määrittely

Riippuen laitteen tyypistä ja määrittelyistä, voidaan vikapaikan 
etäisyystieto välittää ulkoiseen järjestelmään, esittää laitteen näytöllä ja 
DIGSI® 4 ohjelmalla.   

Jos laite on varustettu BCD ulostulomodulilla vikapaikan etäisyyden 
jälleenantoa varten, voidaan etäisyystieto siirtää ulkoiselle BCD 
muuntimella varustetulle näytölle, josta vikapaikan etäisyystieto 
voidaan lukea prosentteina johdon pituudesta häiriön jälkeen. 
Numeroilla on seuraavat merkitykset: 

Jos laite on varustettu vähintään yhdellä analogiaulostulolla, voidaan 
vikapaikan etäisyys siirtää myös sitä kautta. Vikapaikan etäisyys 
ilmaistaan välittömästi häiriön jälkeen. 

Havahtunut suojaustoiminta, esim. distanssisuoja varustettuna 
vaihetiedoin

Laukaissut suojaustoiminta, esim. kolmivaiheinen distanssisuoja

Kulunut aika yleishavahtumasta yleispalautumiseen

Kulunut aika yleishavahtumasta ensimmäiseen laukaisuun

Vikapaikan etäisyys d kilometreinä tai maileina

Dis. Pickup L12

Dis. Trip L123

PU Time 93 ms
Trip Time 25 ms

d    = 

0 ... 195 Laskettu vikapaikan etäisyys prosentteina johdon 
pituudesta
(jos arvo on yli 100%, on häiriö edessäpäin suojattavan 
johdon takana)

197 Laskennan tuloksena on saatu negatiivinen etäisyysarvo
(häiriö ei ole suojattavalla johdolla, vaan se on takana 
päin)

199 Ylivuoto (laskettu vikapaikan etäisyys on kauempana kuin 
järjestelmä pystyy sen esittämään eli 195%)

Ohje:

Tulee huomioida että vikapaikan laskettu etäisyysarvo toimii vain kun 
suojattava johto muodostuu koko matkaltaan samasta johtotyypistä ja jos 
verkkohäiriö sijaitsee suojattavalla johdolla. Muussa tapauksessa häiriöt 
voivat vaikuttaa laskentaan, kuten esimerkiksi johdon varrella olevien 
syöttöpisteiden häiritsevät vaikutukset. 
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Merkinannot
Tallennetut
tapahtumat 

Verkkohäiriön spontaanien merkinantojen lisäksi laitteelta voidaan lukea 
kahdeksan viimeisen verkkohäiriön tapahtumat. 

Verkkohäiriömäärittely tarkoittaa tilannetta jossa verkolla on häiriö ja joka 
päättyy vasta kun suojan viimeinenkin toiminta on palautunut. Jos 
käytössä on automaattiset jälleenkytkennät, päättyy verkkohäiriö vasta 
kun viimeinen jälleenkytkentäjakso on päättynyt onnistuneesti tai 
epäonnistuneesti. Tämä tarkoittaa että jälleenkytkentöjen yhteydessä 
useat toistuvat häiriöt kirjautuvat yhdeksi häiriötapahtumaksi. Tällöin 
häiriötapahtuma voi sisältää useampia suojaustoimintojen havahtumisia 
ja palautumisia. Ilman jälleenkytkentöjä jokainen verkkohäiriö kirjautuu 
omaksi tapahtumakseen. 

Jos häiriöpäiväkirja on täynnä, poistuu vanhin tapahtuma muistista 
uuden aktivoituessa. 

Käytettävissä olevat häiriömerkinannot on esitetty kunkin laitteen 
käyttöohjeessa selityksineen taulukkomuodossa. 

Luku 
laitteelta 

• Siirrytään nuolipainikkeilla häiriöpäiväkirjahakemistoon Trip Log.
Tällöin näytössä on luettelo tallentuneista häiriötapahtumista. Jos 
tallennettuja merkinantoja ei ole, on taulukko tyhjä.

Tapahtumat on tallennettu ajallisessa järjestyksessä kustakin 
verkkohäiriöstä. 

Verkkohäiriön alkuhetki on kirjattu päivämäärällä ja kellonajalla tunteina, 
minuutteina ja sekunteina (millisekunnin tarkkuudella). 

Yksittäiset merkinannot on varustettu suhteellisella aikaleimalla 
verkkohäiriön alkuhetkestä laskettuna. Näytöllä esitetään vähintään yksi 
merkinanto tietoineen. 

Kuva 6-8  Häiriömerkinanto laitteen näytöllä, esimerkki

• Häiriötapahtumia voidaan selata näytöllä nuolipainikkein.

• MENU painikkeella voidaan siirtyä takaisin päävalikkoon MAIN 
MENU.

Trip Log   01/08
---------------------
>Last fault ..        .–
>  1

jne.

LAST FAULT      01/10
--------------------
22.06  23:49:34,845
Network Fault  6   ON
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Toimenpiteet käytön aikana
Luku 
DIGSI® 4  
ohjelmalla

Tämä tapahtuu seuraavasti:

• Kaksoisklikataan navigaatioikkunasta Annunciation hakemistossa 
olevaa Trip Log objektia. 

Tieto ikkunaan ilmestyy luettelo verkkohäiriöistä.

digsi605.gif

Kuva 6-9  Verkkohäiriötapahtumat DIGSI® 4 ohjelmistossa, esimerkki

• Kaksoisklikataan haluttua häiriötapahtumaa.

Trip Log ikkunassa on esitetty verkkohäiriön tapahtumat. Tapahtumat 
on järjestetty aikajärjestykseen alkaen verkkohäiriön päivämäärästä ja 
kellonajasta. Viimeisin tapahtuma on esitetty alimpana. 

digsi606.gif

Kuva 6-10  Verkkohäiriön tapahtumat DIGSI® 4 ohjelmistossa, esimerkki
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6.2.4 Herkkä maasulkupäiväkirja (Sensitive Ground Fault Log)

Laitteilla jotka on varustettu herkällä maasulkutoiminnalla, on 
käytettävissä myös erillinen maasulkupäiväkirja. Maasulkupäiväkirja 
luodaan kun

Herkkää maasulkutoimintaa ei ole määritelty laukaisevaksi vaan 
pelkästään hälyttäväksi Indication only ja

Maasulku on voimassa riittävän kauan aikaa suojaustoiminnan 
havahduttamiseksi. 

Luku 
laitteelta 

• Siirrytään nuolipainikkeilla maasulkupäiväkirjahakemistoon 
Sensitive Ground Fault Log. Tällöin näytössä on luettelo 
tallentuneista maasulkupahtumista. Jos tallennettuja merkinantoja ei 
ole, on taulukko tyhjä.

Tapahtumat maasulkupäiväkirjassa on tallennettu ajallisessa 
järjestyksessä vanhimmasta uusimpaan. 

Maasulkutapahtuman alkuhetki on kirjattu päivämäärällä (ilman vuotta) 
ja kellonajalla tunteina, minuutteina ja sekunteina (millisekunnin 
tarkkuudella). 

Kuva 6-11  Maasulkupäiväkirja laitteen näytöllä, esimerkki

• Luettelossa merkinantoja voidaan selata nuolipainikkein.

• MENU painikkeella voidaan siirtyä takaisin päävalikkoon MAIN 
MENU.

Laite tallentaa tapahtumat kolmesta viimeisestä maasulusta.

Ohje:

Kaikki käytettävissä olevat maasulkumerkinannot on esitetty 
taulukkomuodossa selityksineen kunkin laitteen käyttöohjeessa. 
Käytännössä näyttöön tulevat vain käytettävissä olevat ja laitteen 
aktivoimat merkinannot. 

LAST FAULT     01/04
--------------------
>22.11.  09:37:23.203
 Earth Fault 1    ON

EARTH FAULT INDIC. 01/03
---------------------
>Last Fault           –>  1
>2nd Last Fault    –>  2

jne.
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Toimenpiteet käytön aikana
Luku 
DIGSI® 4  
ohjelmalla

Tämä tapahtuu seuraavasti:

• Kaksoisklikataan navigaatioikkunasta Annunciation hakemistossa 
olevaa  Sensitive Ground Fault Log symbolia. 

Näyttöön ilmestyy luettelo tallentuneista maasulkutapahtumista. 

• Kaksoisklikataan haluttua maasulkutapahtumaa.

• Maasulkutapahtuman merkinannot aukeavat erilliseen ikkunaan. 

digsi632.gif

Kuva 6-12  Herkkä maasulkupäiväkirja DIGSI 4 ohjelmistossa, esimerkki
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Merkinannot
6.2.5 Yleiset tilatiedot

Luku 
DIGSI® 4  
ohjelmalla

SIPROTEC® laitteen toimintojen tilatiedot voidaan lukea laitteen 
muistista DIGSI® 4 ohjelmalla. Tämä tapahtuu seuraavasti:

• Kaksoisklikataan navigaatioikkunasta Annunciation hakemistossa 
olevaa  General Interrogation symbolia. 

• Kaksoisklikataan tieto ikkunassa olevaa päivämäärällä ja 
kellonajalla varustettua symbolia.

Näyttöön auenneessa ikkunassa esitetään kaikki laitteen tilatiedot 
voimassa olevine tiloineen. 

digsi604.gif

Kuva 6-13  Yleiset tilatiedot DIGSI® 4 ohjelmassa, esimerkki
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Toimenpiteet käytön aikana
6.2.6 Spontaanit merkinannot (Spontaneous Indications)

Luku 
DIGSI® 4  
ohjelmalla

DIGSI® 4 ohjelmistossa on mahdollista esittää aktivoituvat merkinannot 
välittömästi automaattisesti päivitettynä. 
Tämä tapahtuu seuraavasti:

• Kaksoisklikataan navigaatioikkunasta Annunciation hakemistossa 
olevaa Spontaneous Annunciations symbolia. 

• Kaksoisklikataan tieto ikkunassa olevaa päivämäärällä ja 
kellonajalla varustettua symbolia.

Näytössä olevassa ikkunassa on esitetty tapahtumat laitteen muistista ja 
näyttö päivittyy automaattisesti uuden merkinannon aktivoituessa. 

digsi607.gif

Kuva 6-14  Spontaanit merkinannot DIGSI® 4 ohjelmassa, esimerkki
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6.2.7 Merkinantomuistien tallentaminen ja poistaminen 

Normaalisti laitteen merkinantomuisteja ei tarvitse tyhjentää käytön 
aikana. Kun uusi tapahtuma tulee, poistuu vanhin automaattisesti, jos 
muisti on täynnä. On kuitenkin suositeltavaa tyhjentää muistit esimerkiksi 
käyttöönottokoestusten jälkeen, jotta muistissa olisi vain todellisia 
häiriötapahtumia. 

Muistit voidaan tyhjentää eri merkinantoryhmillä toisistaan 
riippumattomasti. 

Luku 
laitteelta 

Merkinantomuistit voidaan poistaa seuraavasti:

• Siirytään nuolipainikkein ANNUNCIATION hakemistossa olevaan 
Delete/Set toimintaan.

• Valitaan merkinantoryhmä joka halutaan tyhjentää ja painetaan 
ENTER painiketta. 

• Syötetään parametrien muutossalasana ja hyväksytään se ENTER 
painikkeella. 

• Vahvistetaan muutos painamalla ENTER painiketta. 

Toimitaan seuraavasti jos merkinantomuistia ei haluta tyhjentää:

• Vastataan näyttöön tulleeseen kysymykseen siirtämällä kursori 
nuolipainikkeella No vastaukseen ja vahvistetaan se ENTER 
painikkeella. 
Vaihtoehtoisesti poistotapahtuma voidaan perua ESC painikkeella. 

Ohje:

Kun häiriötapahtumat poistetaan, poistuvat myös vastaavat 
häiriötallenteet. Samalla nollataan myös verkkohäiriötapahtumien 
juokseva numerointi. Jos häiriötallenteet poistetaan, ei häiriöiden 
juokseva numerointi nollaudu.

Ohje:

Ennen laitteen merkinantomuistien tyhjentämistä on suositeltavaa 
tallentaa ne tietokoneen kovalevylle DIGSI® 4 ohjelmalla. 
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Toimenpiteet käytön aikana
Kuva 6-15  Merkinantomuistien poistaminen, esimerkkinä käyttömerkinantojen 
poistaminen laitteen etupaneelista

Luku 
DIGSI® 4  
ohjelmalla

Merkinannot jotka on siirretty laitteen muistista DIGSI® 4 ohjelman 
näytölle, tulee tallentaa erikseen, jos ne halutaan tietokoneen pysyvään 
muistiin. 

Tämä tapahtuu seuraavasti:

• Avataan laite Online tilassa.

• Valitaan haluttu merkinantoryhmä ja tallennetaan se valitsemalla 
File → Save. 

Tiedot voidaan poistaa laitteen muistista seuraavasti:

• Valitaan haluttu merkinantoryhmä ja oikealla hiiripainikkeella 
auenneesta valikosta valitaan Delete toiminta ja vahvistetaan 
poistotapahtuna Yes painikkeella. 

Salasana Kun laitteen muistiin tallentuneita merkinantoja poistetaan, kysyy 
järjestelmä yksittäisten parametrien muutoksessa käytettävää 
salasanaa, joka kysytään ensimmäistä merkinantoryhmää poistettaessa. 

• Syötetään salasana Password kenttään ja hyväksytään se OK 
painikkeella. 

DELETE/SET 01/04
---------------------
>Event log     1
>Trip Log      2

jne. S

Are you sure?
>YES     NO

ENTER
PW Parameter Change?
     = -------
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Merkinannot
6.2.8 Kytkinlaitteiden laskureiden ja muistien lukeminen

Toimintakertalaskurimerkinantoja ovat

Katkaisijan toiminnat laitteen ohjaamana ja

Laitteen suojaustoimintojen suorittamien laukaisujen yhteenlasketut 
virrat. 

Tiedot voidaan lukea laitteen näytöltä tai DIGSI® 4 ohjelmalla. 
Tapahtumien luku ei edellytä salasanan syöttämistä. 

Laitteen suorittamilla laukaisutoiminnoilla tallennetaan laukaistut 
vikavirrat vaiheittain. Tallennetut virrat on esitetty ensiösuureina. 
Laukaistut vikavirrat lisätään summalaskuriin. 

Laitteilla jotka on varustettu automaattisin jälleenkytkennöin, lasketaan 
myös suoritettujen jälleenkytkentöjen lukumäärä yksivaiheisina (jos 
toiminta käytettävissä) ja kolmivaiheisina, sekä erikseen ensimmäisen ja 
muiden jaksojen toimintakerrat. 

Laskurimuistit on varmennettu puskuriparistolla apusähkön katkoksien 
varalle. 

Luku 
laitteelta 

• Siirrytään nuolipainikkeilla Statistics menu valikkoon. Tällöin 
näytössä on laitteen tallentamat laskuriarvot. 

Kuva 6-16  Laitteen laskuriarvot esimerkkinä laitteen näytöllä

STATISTICS       1/08
---------------------
 SIL1=       0.00kA
 SIL2= 0.00kA

jne.
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Toimenpiteet käytön aikana
Luku 
DIGSI® 4  
ohjelmalla

Kaksoisklikataan navigaatioikkunasta Annunciation hakemistossa 
olevaa Statistic objektia. 

• Kaksoisklikataan tieto ikkunassa olevaa Statistics objektia.

Laskuritiedot avautuvat näytölle Statistic ikkunaan. 

digsi608.gif

Kuva 6-17  Laskuriarvot DIGSI® 4 ohjelmassa,esimerkki

6.2.9 Toimintakertalaskureiden asetus ja nollaus

Toimintakertalaskuriarvot tallentuvat laitteen muistiin. Nämä tiedot eivät 
katoa laitteen muistista apujännitekatkoksessa. Laskuriarvot voidaan 
nollata tai asettaa haluttuun arvoon käsin toimintarajojen sisällä. 

Luku 
laitteelta 

• Statistics valikossa valitaan haluttu laskuriarvo joka halutaan asettaa 
ja vahvistetaan valinta ENTER painikkeella. 

• Syötetään yksittäisten parametrien muuttamisessa vaadittu salasana.

• Kirjoitetaan uusi arvo olemassa olevan päälle ja vahvistetaan se 
ENTER painikkeella.

Jos syötetty arvo ei ole sallittujen rajojen sisällä, tulee laitteen näytön 
alareunaan sallittu maksimi- tai minimiarvo. 

Kuva 6-18  Laskuriarvon asetus, esimerkki

Trip Count=       34ENTER

STATISTICS       04/05
---------------------
 SIL3=      214.53kA
 Trip Count=>> >              
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Merkinannot
Luku 
DIGSI® 4  
ohjelmalla

• Statistic ikkunassa valitaan haluttu laskuriarvo ja oikealla 
hiiripainikkeella klikkaamalla avatusta valikosta valitaan Set toiminta. 

digsi610.gif

Kuva 6-19  Laskuriarvon asetus DIGSI® 4 ohjelmalla

• Syötetään yksittäisten salasanojen muuttamisessa vaadittu salasana 
ja kirjoitetaan uusi arvo olemassa olevan päälle Set statistic value 
ikkunassa.

6.2.10 Ilmaisinledien kuittaaminen

Yksittäiset merkinannot tai merkinantoryhmät voidaan määritellä 
SIPROTEC laitteen etupaneelissa oleville ilmaisinledeille. Määrittelyt 
suoritetaan määrittelymatriisissa (katso kappale 5.5.6). 

Vihreä ledi "RUN" palaa jatkuvasti laitteen toimiessa häiriöttömästi. 

Punainen ilmaisinledi "ERROR" palaa, jos prosessorijärjestelmä on 
tunnistanut sisäisen häiriön. Jos se palaa käytön aikana, ei laite ole enää 
käyttökunnossa. kappale 8.5 on esitetty toimenpiteet jotka on 
suoritettavissa häiriötilanteessa. 

Muut etupaneelissa olevat ilmaisinledit ilmaisevat informaatioiden tiloja 
jotka on määritelty niille. Ledeille määritellyt informaatiot voidaan 
kirjoittaa ledien vieressä olevaan uraan sijoitettavaan liuskaan. 

Toimintatiloja kuvaavat ledit palavat niin kauan aikaa kun tila on 
voimassa. Tilatapahtumia ei yleensä asetella tallentaviksi. 

Jos ilmaisinledien toiminta on määritelty tallentavaksi (esimerkiksi 
suojaustoiminnan havahtuminen), voidaan ledi kuitata paikallisesti 
etupaneelista tai kauko-ohjattuna. 

Kuittauspainiketta käytetään myös ilmaisinledien kunnon valvontaan. 
Kaikkien ledien tulee palaa, kun kuittauspainiketta painetaan. 
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Toimenpiteet käytön aikana
6.2.11 Tallentavien binääristen ulostulojen kuittaus

Binäärisille koskettimille määritellyt informaatiot välitetään ulkoiseen 
merkinantojärjestelmään merkinantojännitepiirillä. Yleensä apujännite 
syötetään piiriin ulkoiselta hälytyskeskukselta. 

Jos binääriset ulostulot on määritelty tallentaviksi, voidaan ne palauttaa 
paikallisesti LED painikkeella tai kauko-ohjattuna. 

6.2.12 Prosessitietojen kopiointi, siirto ja poisto

SIPROTEC® laitetiedostoon tallennettuja prosessitietoja voidaan 
kopioida ja siirtää toisiin SIPROTEC® laitteisiin. Tämä voi olla tarpeen, 
kun tiedot luetaan paikallisesti ja tallennetaan tietokoneen pysyvään 
muistiin, mutta tietoja hallinnoidaan keskitetysti (katso kappale 4.4). 

Informaatioita voidaan siirtää tai kopioida vain samojen 
informaatioryhmien sisällä, esimerkiksi käyttömerkinannot voidaan 
kopioida vain käyttömerkinantoryhmään. Molempien SIPROTEC® 
laitteiden tulee olla samaa tyyppiä.

Tämä tapahtuu seuraavasti:

• Avataan Offline tilaan kaksi SIPROTEC® laitetiedostoa, joiden välillä 
kopiointi tai siirto halutaan suorittaa.

Kopiointi • Valitaan tiedot ja kopioidaan ne Drag & Drop menetelmällä, 
käyttämällä Copy ja Paste toimintoja valikosta tai Copy ja Paste 
ikoneja työkalurivistä.

Siirto • Tiedot voidaan siirtää Cut ja Paste toiminnoilla tai Drag & Drop 
menetelmällä (siirto hiiripainike alas painettuna). 
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 Poistaminen Kaikki Offline tilassa näkyvät tiedot on tallennettu tietokoneen pysyvään 
muistiin. Jos prosessitiedot poistetaan tässä tilassa, poistuvat ne 
tietokoneen pysyvästä muistista. Prosessitietoryhmä voidaan poistaa 
yksitellen tai saman ryhmän tiedot kaikki samalla kertaa.

Tämä tapahtuu seuraavasti:

• Valitaan informaatioryhmä, esimerkiksi Event Log ja valitaan 
edelleen haluttu tallenne ja valitaan oikealla hiiripainikkeella 
avautuneesta valikosta Delete toiminta. 

digsi602.gif

Kuva 6-20  Prosessitietojen poistaminen DIGSI® 4 ohjelmassa

• Vahvistetaan poistotapahtuma vastaamalla Yes näyttöön 
aktivoituneeseen kyselyikkunaan.

tai

• Valitaan informaatioryhmä, esimerkiksi Event Log ja oikealla 
hiiripainikkeella avautuneesta valikosta valitaan Delete toiminta, joka 
poistaa kaikki ryhmään kuuluvat tallenteet.

digsi611.gif

Kuva 6-21  Kokonaisen ryhmän prosessitietojen poistaminen DIGSI® 4 ohjelmassa

• Vahvistetaan poistotapahtuma vastaamalla Yes näyttöön 
aktivoituneeseen kyselyikkunaan.
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6.3 Mittaus- ja energialaskuriarvot

Käyttömittaus- ja energialaskuriarvot muodostetaan 
prosessorijärjestelmässä taustatoimintona. Ne voidaan lukea 
paikallisesti laitteen näytöltä, tietokoneelle asennetulla DIGSI® 4 
ohjelmalla tai siirtää kaukokäyttöjärjestelmään järjestelmäväylää pitkin. 

Mittaus- ja energialaskuriarvojen luku ei edellytä salasanan syöttämistä. 
Mittausarvot päivittyvät DIGSI® 4 ohjelman näytöllä Online tilassa 
jaksottaisesti. Päivitysväli on ennalta määritelty ja se on esitetty ikkunan 
alareunassa olevalla tilarivillä. Arvot päivittyvät muutaman sekunnin 
välein laitteen näytöllä. 

Suurin osa mittausarvoista voidaan esittää joko ensiö- tai toisioarvoina 
sekä suhteellisina arvoina nimellisarvoihin verrattuna. Edellytys arvojen 
oikealle esitykselle on, että kojeiston nimellisarvot on määritelty laitteelle 
oikein. Toisiosuureet ovat joko laitteen liittimiltä mitattuja arvoja tai niistä 
edelleen laskettuja. 

Mittausraja-arvovalvonnat on varustettu aikaleimoin. 

Nelirivisellä tekstinäytöllä varustetuissa laitteissa perusnäytöllä esitetään 
käyttömittausarvoja. 

Kuva 6-22  Esimerkki nelirivisen näytön perusnäytöstä

%   I     ULE   ULL
L1 100.1 102.0 102.2
L2 102.5 102.5 100.0
L3  98.7  98.7  99.8
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Mittaus- ja energialaskuriarvot
Mittausarvotyypit Käyttömittausarvot
Näitä ovat jännitteiden, virtojen, taajuuksien ja esim. painearvojen 
tehollisarvot. Tarvittaessa näistä arvoista lasketaan edelleen muita 
suureita kuten esimerkiksi näennäisteho tai tehokerroin. 
Arvot voidaan esittää ensiö-, toisio- tai prosenttiarvoina 
nimellisarvoihin verrattuna.  

Herkät maasulkumittaukset
Tässä ryhmässä on esitetty herkän maasulkusuojatoiminnan 
muodostamat virtasuureet.
Ne voidaan esittää ensiö- tai toisioarvoina.

Termiset mittausarvot
Tässä ryhmässä on termisen ylikuormitussuojan muodostamat 
mittausarvot. DIGSI® 4 ohjelmassa ne tallentuvat Other measured 
values ryhmään.

Käyttäjän määrittelemät mittausarvot
Tässä ryhmässä esitetään mitatuista suureista edelleen laskettuja 
arvoja. Laskentamäärittelyt asetellaan laitteen konfiguroinnin 
yhteydessä. DIGSI® 4 ohjelmassa ne tallentuvat Other measured 
values ryhmään.

Energialaskuriarvot
Energialaskuriarvot tallentavat eri energiakomponentteja, kuten 
esimerkiksi pätö- ja loisenergiat.

Minimi-,maksimi- ja 
keskiarvot 

Mittausarvoista muodostetut minimi- ja maksimiarvot tallennetaan 
erikseen. Mittausarvoista muodostetaan myös keskiarvot. 

Keskiarvot
Pitkäaikaiset keskiarvot virta- ja tehosuureista.

Keskiarvojen minimi- ja maksimiarvot
Pitkäaikaisten keskiarvojen minimi- ja maksimiarvot varustettuna 
päivityshetken päivämäärällä ja kellonajalla.

U ja I mittausten minimi- ja maksimiarvot
Jännitteiden ja virtojen minimi- ja maksimiarvot varustettuna 
päivityshetken päivämäärällä ja kellonajalla.

P, f ja cos phi mittausten minimi- ja maksimiarvot
Pätö-, lois- ja näennäistehojen, taajuuden ja tehokertoimen minimi- ja 
maksimiarvot varustettuna päivityshetken päivämäärällä ja 
kellonajalla.

Ohje:

Täydellinen luettelo mittausarvoista on esitetty kunkin SIPROTEC® 
laitteen käyttöohjeessa. 
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6.3.1 Käyttömittausarvot

Käyttömittausarvojen luku laitteen näytöltä ja DIGSI® 4 ohjelmalla on 
kuvattu käyttäen esimerkkinä käyttömittausarvojen ensiösuureita 
Operational measured values primary.

Luku 
laitteelta 

• Päävalikossa MAIN MENU valitaan Measurement valikko ja 
siirrytään sinne. 

• Valitaan edelleen Operation. pri valikko (ensiökäyttömittausarvot) ja 
siirrytään sinne.   

Mittausarvojen valinta — esimerkkinä nelirivinen näyttö

Luku 
DIGSI® 4  
ohjelmalla

Tämä tapahtuu seuraavasti:

• Kaksoisklikataan navigaatioikkunasta Measurement hakemistossa 
olevaa Primary Values objektia. 

digsi612.gif

Kuva 6-23  Käyttömittausarvojen valinta DIGSI® 4 ohjelmassa

• Kaksoisklikataan navigointi-ikkunassa Operational values, primary 
objektia.

• Kaksoisklikataan tieto ikkunassa olevaa objektia.

Näyttöön aukeaa käyttömittausarvot OPERATIONAL VALUES, 
PRIMARY ikkunassa. 

jne.

MAIN MENU       04/05
--------------------
   Annunciation      –> 1
>Measurement      –> 2 MEASUREMENT     01/14

--------------------
>Operation. pri         
01
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digsi613.gif

Kuva 6-24  Käyttömittausarvot DIGSI® 4 ohjelmassa, esimerkki

6.3.2 Energialaskuriarvot

Energialas-
kuriarvojen 
lukeminen

Laajimmillaan SIPROTEC® laitteilla on energialaskurit pätö- ja 
loisenergioille (Wp, Wq) erikseen osto- ja myyntisuunnille, sekä 
loisenergioilla erikseen kapasitiiviselle ja induktiiviselle loistehon 
suunnalle. Suunnan määrityksessä on oleellista että virtamuuntajien 
tähtipisteen sijainti on määritelty laitteelle oikein. 

Luku 
laitteelta 

• Päävalikossa MAIN MENU valitaan Measurement valikko ja 
siirrytään sinne. 

• Sieltä valitaan edelleen Energy Counter hakemisto. 

• Yksittäiset energialaskuriarvot saadaan kutsuttua näytölle 
nuolipainikkein. 

Luku 
DIGSI® 4  
ohjelmalla

Tämä tapahtuu seuraavasti:

• Kaksoisklikataan navigaatioikkunasta Measurement hakemistossa 
olevaa  Other objektia. 

• Kaksoisklikataan navigointi-ikkunassa Energy Counter objektia.

• Kaksoisklikataan tieto ikkunassa olevaa objektia.

Näyttöön aukeaa Energy Counter ikkuna.
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6.3.3 Raja-arvojen asettelu

SIPROTEC® suojalla voidaan määritellä valvontarajat määrätyille 
mittaus- ja laskuriarvoille. Jos käytön aikana aseteltu raja-arvo ylittyy tai 
alittuu, laite aktivoi tapahtumasta merkinannon joka kirjautuu 
käyttöpäiväkirjaan. Merkinanto voidaan liittää ledeille ja/tai koskettimille, 
lähettää järjestelmäväylän kautta ulkoiselle valvontajärjestelmälle sekä 
liittää DIGSI 4 CFC-logiikkakaavioon. 

Lisäksi DIGSI® 4 CFC-kaaviolla voidaan määritellä mittaus- ja 
laskuriarvoille valvontarajoja ja liittää lopputuloksena muodostettu 
merkinanto DIGSI® 4 määrittelymatriisissa. 

Määrittely 
laitteen etu-
paneelista 

• Valitaan päävalikossa MAIN MENU hakemisto Measurement . 

• Sieltä valitaan edelleen Set Points (MV) valikko. 

• Taulukossa olevat yksittäiset raja-arvot saadaan kutsuttua näytölle 
nuolipainikkein. 

• Valitaan haluttu raja-arvo ja vahvistetaan valinta ENTER painikkeella. 

• Syötetään parametrien muutossalasana ja hyväksytään se ENTER 
painikkeella. 

Tällöin näyttöön tulee voimassa oleva raja-arvo vilkkuvalla kursorilla 
varustettuna. 

• Kirjoitetaan olemassa olevan arvon päälle uusi arvo. Jos syötetty arvo 
ei ole sallittujen rajojen sisällä, tulee laitteen näytön alareunaan 
sallittu maksimi- tai minimiarvo. 

• Vahvistetaan arvo ENTER painikkeella.  

Uusi arvo on näkyvissä nyt asetteluarvoluettelossa. 

• Poistutaan tältä tasolta MENU painikkeella tai nuolipainikkeilla 
kunnes näyttöön tulee kysely muutettujen asetteluiden 
hyväksymisestä, johon vastataan  Yes tai jos muutettuja asetteluita ei 
haluta hyväksyä No. 

Kuva 6-25  Raja-arvojen asettelu näytöllä — esimerkki

MEASUREMENT     13/14
--------------------
>Set Points (MV)
>Reset             81

jne.

ENTER

SET POINTS (MV)  01/11
--------------------
IL<       >                
80.0%

ENTER
PW Parameter Change?
     =-------

IL<        90.0%    

ENTER
Are you sure?
>Yes NO Escape  
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Luku 
DIGSI® 4  
ohjelmalla

Mittausarvojen raja-arvot ovat käsiteltävissä vain Online tilassa. 

Tämä tapahtuu seuraavasti:

• Kaksoisklikataan navigaatioikkunasta Measurement hakemistossa 
olevaa  Other objektia. 

• Kaksoisklikataan Set points for measured values objektia.

• Kaksoisklikataan tieto ikkunassa olevaa symbolia.

Näyttöön aukeaa Set points for measured values ikkuna.

• Valitaan haluttu raja-arvo ja oikealla hiiripainikkeella avautusta 
valikosta valitaan Set toiminta. 

• Syötetään yksittäisten parametrien muuttamisessa vaadittu salasana.

• Syötetään uusi raja-arvo Set measured value ikkunassa ja 
hyväksytään määrittely OK painikkeella.

Muutettu arvo siirretään laitteelle ja Set points for measured values 
ikkuna päivittyy. 

digsi614.gif

Kuva 6-26  Valvontarajat DIGSI® 4 ohjelmassa, esimerkki
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6.3.4 Energialaskureiden ja minimi-/maksimiarvojen nollaus 

Mittausarvoista lasketut energia-arvot ja minimi- ja maksimimuistit 
nollautuvat kaikki yhtäaikaa. 

Määrittely 
laitteen etu-
paneelista 

• Päävalikossa MAIN MENU valitaan Measurement valikko ja 
siirrytään sinne. 

• Sieltä valitaan edelleen Reset  valikko. 

• Siirrytään poistettavan muistin päälle nuolipainikkeilla ja vahvistetaan 
poisto ENTER painikkeella. 

• Syötetään salasana ja vahvistetaan se ENTER painikkeella. 

• Muutostasolta voidaan poistua muutokset hyväksyen Yes 
painikkeella tai jos muutoksia ei haluta ottaa käyttöön No painikkeella. 

Kuva 6-27  Energialaskureiden ja minimi-/maksimiarvojen nollaus

Luku 
DIGSI® 4  
ohjelmalla

Tämä tapahtuu seuraavasti:

• Navigointi-ikkunassa valitaan Measurement hakemistosta  
Energy counter tai Minimum and maximum values ryhmä ja 
valitaan oikealla hiiripainikkeella avautuvasta valikosta Reset 
toiminta.

• Syötetään yksittäisten parametrien muuttamisessa vaadittu salasana.

Laskureiden nollaustoiminta on toteutettu. 

 

Are you sure?
>YES     NO

ENTER
PW Parameter Change?
     =-------

RESET           01/02
--------------------
>ResMinMax        ON
>Meter res            ON

Ohje:

Reset toiminta nollaa kaikki laskurit ilman erilliskyselyä. Toimintaa ei voi 
peruuttaa.
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6.3.5 Käyttäjän määrittelemien laskuriarvojen luku ja palautus

DIGSI® 4 CFC ohjelmalla on mahdollista muodostaa käyttäjän toimesta 
pulssilaskureita. Nämä voidaan nollata käyttäjän toimesta. 

Määrittely 
laitteen etu-
paneelista 

• Päävalikosta MAIN MENU siirrytään Measurement alivalikkoon. 

• Sieltä valitaan edelleen User Counter objekti ja siirrytään ENERGY 
COUNTER valikkoon. 

Kuva 6-28  Laskuriarvojen nollaus etupaneelista, esimerkki

• Siirrytään poistettavan muistin päälle nuolipainikkeilla ja vahvistetaan 
poisto ENTER painikkeella. 

• Syötetään parametrien muutossalasana ja hyväksytään ENTER 
painikkeella. 

• Kuitataan näytöllä oleva ilmoitus Change OK. Kuittaus tapahtuu 
vahvistamalla Continue painamalla ENTER painiketta.

Laskurin nollaus suoritetaan. 

Luku 
DIGSI® 4  
ohjelmalla

Tämä tapahtuu seuraavasti:

• Navigointi-ikkunassa valitaan Measurement valikosta Other.  

• Kaksoisklikataan User-defined metered values objektia ja valitaan 
muutettava laskuri, sekä oikealla hiiripainikkeella avautuvasta 
valikosta valitaan Set toiminta.

• Syötetään yksittäisten parametrien muuttamisessa vaadittu salasana.

• Syötetään uusi arvo Set values ikkunassa, esimerkiksi nolla ja 
vahvistetaan toiminta OK painikkeella. 

Määritelty arvo siirretään laitteelle ja näyttö päivittyy. 

ENTER
ENERGY COUNTER 
-------------------
Counter1    >0>
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6.4 Häiriötallentimen tiedot

Jokaisessa verkkohäiriössä tallennetaan useita suureita 
hetkellisarvoina. Nämä hetkellisarvot tallentuvat häiriötallenteeksi. 
Verkkohäiriö voi muodostua useammasta yksittäisestä häiriöstä. Tällöin 
esimerkiksi peräkkäiset jälleenkytkennät muodostavat yhden 
häiriötallenteen. Häiriötallenteiden ominaisuudet määritellään 
parametroinnin yhteydessä (katso kappale 5). 

Häiriötallenteet tallentuvat laitteen muistiin ja ne voidaan lukea laitteelta 
ja käsitellä niitä graafisesti ComtradeViewer tai SIGRA 4 ohjelmilla.

6.4.1 Häiriötallenteiden luku

Luku 
DIGSI® 4  
ohjelmalla

Häiriötallenteita voidaan käsitellä seuraavasti: 

• Kaksoisklikataan navigaatioikkunasta Oscillographic Records 
hakemistossa olevaa Oscillographic Fault Records objektia. 

Tieto ikkunassa on esitetty käytettävissä olevat häiriötallenteet häiriön 
järjestysnumerolla, sekä päivämäärällä ja kellonajalla varustettuna. 
Yksi häiriötallenne voi sisältää useampia verkkohäiriöitä. 

digsi615.gif

Kuva 6-29  Häiriöntallennus DIGSI® 4 ohjelmassa, esimerkki

• Kaksoisklikataan tieto ikkunassa haluttua häiriötallennetta.
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Häiriötallentimen tiedot
SIGRA 4 ohjelmisto esikäsittelee häiriötallenteen tiedot. Mitatuista 
suureista ohjelma laskee muita suureita, kuten impedanssit tai suureiden 
tehollisarvot, jotka helpottavat häiriötallenteen analysointia. 

Suureet voidaan esittää eri tyyppisissä kaavioissa, kuten

• Aikasignaaleina  

• Vektorikaavioina 

• Impedanssikaaviona

• Harmoonisina yliaaltoina 

Haluttu näyttöikkuna voidaan aktivoida View valikosta tai työkalurivin 
ikoneista. 

Lisäksi on mahdollista lisätä tallenteeseen muita tallenteita, esimerkiksi 
tallennus johdon vastapäästä ja ne voidaan kohdistaa ajallisesti oikein.

digra009.gif

Kuva 6-30  Häiriöntallennus SIGRA 4 ohjelmassa, esimerkki

Kunkin vaiheen virrat ja jännitteet, sekä maasulkuarvot esitetään eri 
kaavioissa. Lisäksi tallenteessa on esitetty häiriön tapahtumahetken 
päivämäärä ja kellonaika. 
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Toimenpiteet käytön aikana
Esitystavaksi voidaan valita joko ensiö- tai toisiosuureet. 
Referenssiarvona virroille ja jännittelle käytetään mittamuuntimien 
toision nimellisarvoja. Kaikilla virroilla on käytetty samaa skaalausta 
suurimman toisiovirran (hetkellisarvo) määräämänä ja vastaavasti 
jännitteiden skaalaus määräytyy suurimman toisiojännitteen 
(hetkellisarvo) mukaisesti. 

Aikasignaali-ikkunassa esitetään määrätyt binääriset signaalit (kuten 
esim. yleishavahtuminen ja yleislaukaisu) sekä niiden tilat 
palkkiesityksenä. 

digsi616.gif

Kuva 6-31  Aikasignaali-ikkunan binääriset signaalit SIGRA 4 ohjelmassa, esimerkki

Aika-akselille on sijoitettu kaksi kursoria. Aikasignaali-ikkunassa kursorit 
näkyvät kaikkien kaavioiden yli piirtyvinä pystyviivoina. 
Impedanssikaaviossa kursorit esitetään ristikkosymbolein. Jos jonkin 
suureen tarkka hetkellisarvo halutaan lukea, siirretään kursori tämän 
signaalin haluttuun kohtaan. Tällöin signaalin nimi sekä tehollis- ja 
hetkellisarvo on esitetty näytön taulukossa 
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Häiriötallentimen tiedot
Monipuoliset zoomaustoiminnat mahdollistavat häiriön tarkan analyysin. 

Tulostaa voidaan joko koko häiriötallenne tai vain valitut kaaviot. 
Tulosteessa voidaan ottaa huomioon näytön esitystapa. 
Käyttäjäprofiileilla user profiles voidaan määritellä signaalien esitystapa 
yksittäisissä kaavioissa, tunnukset, viivatyypit, jne. Nämä tallentuvat 
tietokoneen pysyvään muistiin ja niitä voidaan käyttää eri 
häiriötallenteiden esitystavan muuttamisessa. 

Lisätietoja on esitetty käyttöohjeessa SIPROTEC SIGRA 4, Manual /3/.  

6.4.2 Häiriötallenteen tallennus

Häiriötallenteen 
tallennus

Vastaanotetut häiriötallennetiedot eivät automaattisesti tallennu 
tietokoneen pysyvään muistiin. Tästä syystä häiriötallenne tulee tallentaa 
erikseen. 

Tämä tapahtuu seuraavasti:

• Valitaan häiriöntalennus ja valitaan edelleen File → Save. 

Tämä valikkotoiminta on aktiivisena vain jos valitaan häiriötallenne, jota 
ei vielä ole jo tallennettu. DIGSI® 4 ohjelmisto muodostaa 
automaattisesti hakemiston johon häiriöntallennus tallentuu. 

Tallennettuja häiriötallenteita ei tarvitse poistaa laitteelta, koska 
tallenteet tallentuvat laitteelle rengasmuistiin vanhimman tallenteen 
poistuessa uuden tilalta. 
331SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Toimenpiteet käytön aikana
6.5 Laitetoimintojen käyttö

Laitteen käytön aikana on mahdollista vaikuttaa määrättyjen toimintojen 
ja tapahtumien ominaisuuksiin. Muistien asettelut ja nollaukset on 
kuvattu jo aiemmissa kappaleissa ja tässä kappaleessa käsitellään 
seuraavat mahdollisuudet:

Päivämärän ja kellonajan asetus

Toimintaparametrien asettelu (asetteluryhmien vaihto)

Koestusmerkinantojen lähetys järjestelmäväylään testaustoiminnalla

Toimintatilan muuttaminen

Vaara!

Toimintojen käsittely käytön aikana tulee suorittaa suurta 
varovaisuutta noudattaen ja suojattavan järjestelmän ominaisuudet 
tuntien. Toimintojen huolimaton käyttö voi johtaa kuolemaan, 
vakavaan loukkaantumiseen ja laitteiden vaurioitumiseen.
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Laitetoimintojen käyttö
6.5.1 Päivämäärän ja kellonajan luku ja asettelu

Laitteen käynnistyessä voi olla tarpeen asetella sisäisen kellon aika 
uudelleen. Tämä voi tapahtua automaattisesti ulkoisella tahdistuksella 
esimerkiksi DCF77 tai GPS signaaleilla tai se voidaan suorittaa myös 
käsin. 

Aikanäytöllä voi olla eri tiloja kunnes laitteen sisäinen kello on tahdistettu 
ja aika on asetettu oikeaksi. 

Ajan tila Päivämäärän ja kellonajan lisäksi esitetään myös niiden toimintatila. 
Kellon asetteluikkunassa voidaan esittää toiminnan eri tilat:  

Tilatunnuksilla on seuraavat merkitykset:  

Taul. 6-1 Ajan toimintatilat

No. Tilateksti Tila
1 -- -- -- --

Tahdistettu
2 -- -- -- SZ

3 -- -- ST --

Tahdistamaton4 -- -- ST SZ

5 -- UG ST --

6 -- UG -- --

UG Aika väärin Uudelleen käynnistyksen jälkeen aikaa ei ole aseteltu 
käsin tai ulkoisesti tahdistettuna.
Jos sisäinen kello tahdistetaan järjestelmäväylän 
kautta, on virhetila voimassa kunnes aikatahdistus 
vastaanotetaan järjestelmäväylästä.

ST Aikavirhe Aikatahdistusta ei ole vastaanotettu valvonta-ajan 
sisällä (aika voi olla väärä).

SZ Kesäaika Viimeiseksi vastaanotetussa 
aikatahdistustelegrammissa on kesäaikabitti päällä 
(Keski-Euroopan kesäaika).

Ohje:

Häiriötön aikatila ilmaistaan näytöllä taulukossa 6-1 esitetyillä riveillä 1 tai 
2.
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Toimenpiteet käytön aikana
Ajan esitys Merkinantojen tai mittausarvojen aikaleimauksissa aika voidaan esittää 
eri ominaisuuksin.

No. 1 esiintyy jos sisäistä kelloa ei ole tahdistettu. Merkinantomuistissa 
tapahtumilla on aluksi päiväys 01.01.1990. 

• Päivämäärä ja kellonaika tulee asetella käsin. 

No. 2 esiintyy jos aikaa ei ole vielä tahdistettu. Näin voi käydä: 

− Välittömästi laitteen ylönousun jälkeen,

− Jos ajantahdistusta ei ole vastaanotettu valvonta-ajan sisällä. 

• Tarkastetaan ulkoisen tahdistuksen liitynnät ja asettelut. 

No. 3 voi esiintyä tilanteessa jossa sisäinen kello on määritellyt 
kellonajan ja päivämäärän oikein, mutta niitä ei ole aseteltu käsin tai 
ulkoisesti tahdistettuna.

• Päivämäärä ja kellonaika määritellään käsin tai odotetaan että 
jaksottainen tahdistus päivittää kellon. 

No. 4 esiintyy normaalissa tilassa, jolloin aika on tahdistettu jaksottaisesti 
valvonta-ajan sisällä. 

No. 5 esiintyy jos vastaanotettu aika on tunnistettu virheelliseksi 
järjestelmäväylän kautta. 

No Näyttö Vuosi Aika-
virhe

Aika
väärinPäivämäärä Aika

1 **.**.**** 15?07:15 Vuosi = 1990 Ei merkitystä

2 04.09.1998 15?07:15

1990<Vuosi<209
0

Kyllä Ei

3 04?09.1998 15?07:15 Kyllä Kyllä

4 04.09.1998 15:07:15 Ei Ei

5 **?**.**** 15?07:15 Ei Kyllä
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Laitetoimintojen käyttö
Ajan asettelu Aika voidaan asetella seuraavasti

Käsin laitteen etupaneelilta tai DIGSI® 4 ohjelmistolla,

Määrittelemällä kellon asetusten yhteydessä käytössä oleva ulkoinen 
tahdistus. 

Ajan käsin asettelu on mahdollista jos toimintaan on määritelty sisäinen 
kello ilman tahdistusta, sekä jos tahdistukseksi on määritelty binäärinen 
tulo. Ajan asettelussa syntynyt aikahyppäys ilmaistaan 
käyttömerkinannoin Fault Clock ON ja Fault Clock OFF. Kun 
tahdistustavaksi on valittu binäärinen sisääntulo, aktivoituu Fault Clock 
OFF merkinanto välittömästi kun tahdistuspulssi on vastaanotettu 
binäärisellä tulolla aika-asetuksen jälkeen. 

Kellonajan käsin asettelu on mahdollista muilla tahdistustavoilla vain jos 
ulkoisen tahdistuksen on tunnistettu olevan häiriössä. IRIG-B 
menetelmässä vuoden asettelu on aina mahdollista; tämä kirjautuu 
muistiin Fault Clock ON ja Fault Clock OFF merkinannoin. 

Päivämäärän ja kellonajan korjauksessa voidaan käyttää 
korjausasetusta "Diff.-time" kentässä (+/– 23:59:59). Tätä asettelua ei 
tule sekoittaa Offset asetteluun (katso kappale 5), jota käytetään 
aikakorjaukseen radiosignaalitahdistuksessa. 

Päivämäärän/
kellonjajan asettelu

Tulee huomioida että sisäinen kello käy enintään yhden vuorokauden 
ajan jos ulkoinen apujännite on poissa. Jos apujännite on pidempään 
poissa, palautuvat päivämäärä ja kellonaika lähtöarvoihinsa.
335SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Toimenpiteet käytön aikana
Määrittely 
laitteen etu-
paneelista 

• Päävalikossa MAIN MENU valitaan Settings hakemistosta SETUP/
EXTRAS objekti. 

• Sieltä valitaan edelleen Date/Time valikko ja siirrytään sinne. 

Kuva 6-32  Päivämäärän ja kellonajan asettelu laitteella

• Nuolipainikkeilla siirrytään päivämäärän/kellonajan tai aikaeron 
päälle ja vahvistetaan toiminta ENTER painikkeella

• Syötetään yksittäisten parametrien muuttamisessa vaadittu salasana.

• Kirjoitetaan uudet arvot tekstikentässä vanhan päälle kursorin 
vilkkuessa. Tulee varmistua että arvot syötetään oikein.

• Vahvistetaan arvo ENTER painikkeella.  

 Jos aikasignaalissa on siirtymä, voidaan se korjata Time offset tai 
Tolerance time asetteluin.

• Valitaan Setup/Extras valikko. 

• SETUP/EXTRAS valikossa siirrytään edelleen Clock Setup 
valikkoon. 

• Kirjoitetaan uusi arvo Offset kenttään tai jos virhepoikkeama on 
aikatahdistussignaalissa, kirjoitetaan uusi arvo Error Time kenttään.

• Vahvistetaan arvo ENTER painikkeella.  

Kuva 6-33  Päivämäärän ja kellonajan asettelu näytöltä

SETUP/EXTRAS    01/06
--------------------
>Date / Time  –> 1
>Clock Setup  –> 2

DATE/TIME
Status:     -- -- --
>12.08.1998 21:07:32
Diff.–time: --------

SETUP/EXTRAS    02/06
-------------------
>Date / Time  –> 1
>Clock Setup  –> 2

CLOCK SETUP   01/03
--------------------
 Offset > >> >               
0min
Error Time                     
2min
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Laitetoimintojen käyttö
Luku 
DIGSI® 4  
ohjelmalla

Päivämäärä ja kellonaika voidaan asetella käsin seuraavasti: 

• Avataan laite Online tilassa.

• Valitaan Device → Set Date and Time. 

digsi617.gif

Kuva 6-34  Kellonajan asettelu DIGSI® 4 ohjelmassa, esimerkki

digsi618.gif

Kuva 6-35  Päivämäärän ja kellonajan asettelu DIGSI® 4 ohjelmassa

Set clock & date in device ikkunassa esitetty päivämäärä ja kellonaika 
kuvaavat laitteessa olevia tietoja. Viikonpäivä määräytyy automaattisesti 
päivämäärän mukaisesti eikä sitä voida muuttaa. 

• Syötetään uudet arvot date ja time kenttiin. Tulee varmistua että 
arvot syötetään oikein. 

• Valitut määrittelyt hyväksytään OK painikkeella.

Muutetut arvot siirretään laitteelle. 
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Toimenpiteet käytön aikana
Time Offset / 
Tolerance Time

Time offset tai tolerance time asetteluita voidaan muuttaa seuraavasti:

• Kaksoisklikataan Settings hakemistoa ja kaksoisklikataan edelleen 
Time Synchronisation objektia. 

digsi619.gif

Kuva 6-36  Ajantahdistustavan valinta DIGSI® 4 ohjelmassa

digsi620.gif

Kuva 6-37  Ajantahdistus ja aikaformaatti DIGSI® 4 ohjelmassa

• Määritellään aikatahdistuksen valvonta-aika "Fault indication after" 
ruudussa, joka sijaitsee Monitoring kentässä ja tarvittaessa 
aikakorjaus Offset to time signal kentässä. 
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Laitetoimintojen käyttö
6.5.2 Asetteluryhmien vaihtotoiminta

Suojaustoimintojen asetteluille on käytettävissä neljä asetteluryhmää 
(A ...D). Voimassa olevaa asetteluryhmää voidaan vaihtaa käytön 
aikana. Vaihtotapa määritellään konfiguroinnin yhteydessä. 

Määrittely 
laitteen etu-
paneelista 

• Päävalikossa MAIN MENU valitaan Settings hakemisto ja siirrytään 
SETTINGS alivalikkoon. 

• Siirrytään edelleen Change Group hakemistoon. 
Näytössä esitetään aktiivisena oleva asetteluryhmä.

• Valitaan CHANGE to toiminta ja vahvistetaan valinta ENTER 
painikkeella. 

• Syötetään yksittäisille asetusmuutoksille liittyvä salasana ja 
siirrytään nuolipainikkein haluttuun ryhmään.

• Jos käyttöön valitaan vaihtotoiminta binäärisin tuloin Via Binary 
Input, ohjataan asetteluryhmiä binäärisille tuloille tuoduilla 
signaaleilla.

•  Jos vaihtotavaksi valitaan järjestelmäväylän kautta vastaanotettu 
ohjaus Via Protocol, ohjataan asetteluryhmiä ulkoisesta 
ohjausjärjestelmästä IEC 60870-5-103 protokollalla. 

Kuva 6-38  Asetteluryhmien vaihtotoiminta

 

 

  

 

ENTER

ENTER

Are you sure?
Yes            NoENTER

0302 CHANGE to   02
    >         Group A

>Group A
  Group B
  Group C
  Group D
  Binary input
  Via Protocol

CHANGE GROUP   01/02
--------------------
0301 ACTIVE GROUP   01
         Group A
339SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Toimenpiteet käytön aikana
Luku 
DIGSI® 4  
ohjelmalla

• Avataan laite Online tilassa. 

• Kaksoisklikataan Settings hakemistoa ja kaksoisklikataan edelleen 
Change Group objektia. 

digsi621.gif

Kuva 6-39  Asetteluryhmien vaihtotoiminta DIGSI® 4 ohjelmassa

digsi622.gif

Kuva 6-40  Asetteluryhmien valinta DIGSI® 4 ohjelmassa

Aktiivisena oleva asetteluryhmä esitetään näytöllä. 

• Value kentässä alasvetovalikosta valitaan joko suoraan käyttöön 
tuleva asetteluryhmä Group, binäärinen tulo Binary Input 
vaihtomenetelmäksi tai järjestelmäväylän kautta tapahtuva vaihto 
Protocol, jonka jälkeen DIGSI -> Device painikkeella asetusmuutos 
siirretään laitteelle. 

• Syötetään yksittäisten parametrien muutossalasana ja hyväksytään 
se OK painikkeella. 
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Laitetoimintojen käyttö
6.5.3 Järjestelmäväylän toiminta testaustilassa

Jos laite on liitetty järjestelmäväylän kautta ulkoiseen 
ohjausjärjestelmään, voidaan tiedon siirtoon vaikuttaa käytön aikana. 

Määrätyillä protokollilla voidaan välittää kaikki merkinannot ja 
mittausarvot ulkoiseen ohjausjärjestelmään, kun laitetta koestetaan 
paikallisesti. Tällöin kaikkien informaatioiden lähetyssyyksi on määritelty 
testaustila Test mode. 

Jos tiedonsiirron esto transmission block on aktivoitu, ei merkinantoja 
välitetä järjestelmäväylään testauksen aikana. (PROFIBUS FMS 
liikennöintiprotokollassa merkinannot lähetetään tällöin varustettuna 
erillisellä tilabitillä).

Tiedonsiirron esto voidaan aktivoida binäärisellä tulolla tai suoraan 
laitteen painikkeistolta, sekä sarjaliikenneväylään liitetyllä tietokoneella 
DIGSI ohjelmistolla.  

Määrittely 
laitteen etu-
paneelista 

• Päävalikossa MAIN MENU valitaan Test / Diagnose valikko ja 
siirrytään TEST/DIAGNOSTICS alivalikkoon. 

• Sieltä valitaan edelleen Test Enable valikko ja siirrytään  TEST 
ENABLE alivalikkoon. 

Kuva 6-41  Testaustilan määrittely etupaneelista

• Valitaan Test mode toiminta ja vahvistetaan valinta ENTER 
painikkeella. 

• Syötetään testaus- ja diagnoositoimintojen muutossalasana ja 
hyväksytään se ENTER painikkeella.

• Seuraavaksi näyttöön tulevassa ikkunassa vastataan halutulla tavalla 
toiminta päälle ON tai pois päältä OFF. 

Jos tila on vaihtunut onnistuneesti, tulee näyttöön ilmoitus Change OK.

Testaustoiminta määritellään pois päältä valitsemalla toimintatilaksi 
OFF. 

Jos testaustila Test mode on päällä ON, lisätään IEC 60870-5-103 
telegrammeihin testaustila lähetyssyyksi. 

TEST/DIAGNOSTICS 02/06
--------------------
 Device Reset        –>  
01
>Test Enable          –

TEST ENABLE
--------------------
>Test mode    >              
OFF
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Toimenpiteet käytön aikana
• Tiedonsiirron esto aktivoidaan vastaavalla tavalla.

Kuva 6-42  Tiedonsiirron eston asetus (yksinkertaistettuna)

Jos toiminta on aktivoituna ON, ei merkinantoja ja mittauksia välitetä 
järjestelmäväylään. 

Luku 
DIGSI® 4  
ohjelmalla

• Haluttu toiminta aktivoidaan valitsemalla Device →  Test Mode tai 
Block Data Transmission.

digsi623.gif

Kuva 6-43  Tiedonsiirron eston asetus DIGSI® 4 ohjelmassa

Aktiivisena oleva tiedonsiirron esto tai testaustila esitetään valikossa 
valintamerkillä.

• Klikataan hiirellä Test Mode tai Block Data Transmission toimintaa 
sen aktivoimiseksi tai pois päältä kytkemiseksi.

• Syötetään testaus- ja diagnoositoimintojen muutossalasana ja 
hyväksytään se OK painikkeella.

TEST/DIAGNOSTICS  03/06
--------------------
> Blk Data Trans       –
> 03

BLK DATA TRANS
--------------------
>DataStop   >              
OFF

Ohje:

Kun koestustoimenpiteet on suoritettu, tulee muistaa määritellä 
asetellut estot pois päältä!
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Laitetoimintojen käyttö
6.5.4 Toimintatilan vaihtaminen 

Koestuksen ajaksi määrätyillä laitteilla voidaan toimintatila muuttaa, jotta 
koestukset eivät häiritsisi normaalia käyttöä. Tämän tyyppisiä toimintoja 
on lähinnä erovirtasuojilla. 

Toimintaa ei ole määritelty kaikille laitteille. Tästä syystä lisätietoja on 
saatavissa laitteiden käyttöohjeista.
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Toimenpiteet käytön aikana
6.5.5 Funktiopainikkeiden valikkokutsujen määrittely

DIGSI 4 ohjelmassa on mahdollista määritellä funktiopainikkeille 
valikkojen suorakutsutoimintoja. Funktiopainiketta painettaessa näyttöön 
aukeaa suoraan funktiopainikkeelle määritelty valikkotaso.

Funktiopainikkeiden valikkokutsut määritellään seuraavasti:

• Valitaan Options → Set function keys määrittelymatriisin valikosta. 
Näyttöön aukeaa Set function keys ikkuna.

digsi633.gif

Kuva 6-44  Funktiopainikkeiden määrittely

• Valitaan alasvetovalikosta haluttu funktiopainike. 
Jos funktiopainikkeelle on jo määritelty valikkokutsu, on se ilmaistu 
valintamerkillä valikkopuuikkunassa.

• Valitaan haluttu kohta valikkopuusta aktivoimalla valintamerkki. 
Valittavissa ei ole perusnäyttöä Default Display, ohjausnäyttöä  
Control Display tai alkukäynnistysnäyttöä Start-up Display.

• Vahvistetaan valinnat OK painikkeella. 
Tällöin määrittelymatriisissa suoritettu aiempi määrittely poistuu.

Ohje:
Jos funktiopainikkeelle on määritelty jo yksittäisen sisäisen merkinannon 
aktivointi (katso kappale 5.5.4), tulee siitä näyttöön ilmoitus.
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6.6 Katkaisijan koestustoiminta

Ilman paikallisohjausmahdollisuutta olevilla laitteilla voidaan suorittaa 
katkaisijan ohjaukset testaustoiminnalla. Jos laite on varustettu 
yksivaiheisin laukaisutoiminnoin, voidaan katkaisijan vaiheet koestaa 
yksitellen.

Katkaisijan KIINNI ja AUKI ohjaukset voidaan aktivoida käyttäjän 
toimesta laitteella. 

Edellytyksenä on että koestusohjaukset on määritelty ohjauskoskettimille 
konfiguroinnin yhteydessä. Katkaisijan vaiheet voidaan koestaa myös 
yksitellen, edellyttäen että katkaisija ja sen ohjausjohdotukset sekä 
toimintojen konfiguroinnit on suoritettu yksivaiheisesti. 

Käytössä on enintään neljä eri koestusohjelmaa. 
Katkaisijalle voidaan suorittaa yksi- ja kolmivaiheiset KIINNI ja AUKI 
ohjaukset. Jos katkaisija voidaan ohjata vain kolmivaiheisesti, 
käytettävissä on vain koestus numero 4. 

Jos katkaisijan asento on tuotu katkaisijan apukoskettimilta binäärisiin 
sisääntuloihin, voidaan koestusjakso käynnistää ainoastaan jos 
katkaisija on kiinni asennossa. 

Edellytyksenä koestusjakson käynnistykselle on myös, että laitteen 
suojaustoiminnat eivät ole havahtuneina ja katkaisija on käyttökunnossa. 

Laite ilmaisee koestusjaksojen etenemisen merkinannoin laitteen tai 
tietokoneen näytöllä. Jos laite ei suostu käynnistämään 
koestusohjelmaa, ei jokin vaadituista lähtötilanteista ole täyttynyt. Syy 
koestustoiminnan keskeytymiseen ilmaistaan merkinannolla laitteen tai 
tietokoneen näytöllä.

Taul. 6-2 Katkaisijan koestusohjelmat 

No. Koestusohjelma Käyttömerkinannot
1 1-vaiheinen AUKI/KIINNI jakso 

vaiheelle  L1
CB1-TEST TRIP 
command - Only L1

2 1-vaiheinen AUKI/KIINNI jakso 
vaiheelle  L2

CB1-TEST TRIP 
command - Only L2

3 1-vaiheinen AUKI/KIINNI jakso 
vaiheelle  L3

CB1-TEST TRIP 
command - Only L3

4 Kolmivaiheinen AUKI/KIINNI jakso CB1-TEST TRIP 
command L123

Kiinniohjaus CB1-TEST CLOSE 
command
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Seuraavassa kaaviossa on esitetty koestustoiminnan periaatteellinen 
kulku:  

Kuva 6-45  AUKI-KIINNI koestusjakso

CB-TEST running Katkaisijan koestus käynnissä

CB-TSTstop FLT. Katkaisijan koestustoimintaa ei voi käynnistää, 
koska voimassa on verkkohäiriö

CB-TSTstop OPEN Katkaisijan koestustoimintaa ei voi käynnistää, 
koska katkaisija ei ole kiinni

CB-TSTstop NOT Katkaisijan koestustoimintaa ei voi käynnistää, 
koska katkaisija ei ole toimintakunnossa

CB-TSTstop CLOS Katkaisijan toiminta on keskeytetty, koska 
katkaisija on vielä kiinni (jälleenkytkentä 
koestuksen yhteydessä)

CB-TST .OK. Katkaisijan koestustoiminta on päättynyt 
onnistuneesti

AUKI 

KIINNI 

tT TRIPCOM MIN T CLS. CMD MAX.T PAUSE TEST

VAARA! 
Onnistunut koestustoiminta voi ohjata katkaisijan kiinni! 
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Katkaisijan koestustoiminta
Määrittely 
laitteen etu-
paneelista 

• Päävalikossa MAIN MENU valitaan Test / Diagnose valikko ja 
siirrytään TEST/DIAGNOSTICS alivalikkoon. 

• Valitaan sieltä edelleen CB Test valikko ja valitaan haluttu 
koestusohjelma ja aktivoidaan se ENTER painikkeella. 

• Syötetään testaus- ja diagnoositoimintojen edellyttämä salasana 
ja vahvistetaan se ENTER painikkeella, sekä vastataan seuraavaksi 
kysymykseen onko katkaisija kiinni Breaker closed? vaihtoehdolla 
Yes ja vahvistetaan se ENTER painikkeella, jos katkaisija on 
todellisuudessa kiinni. 

Jos katkaisijan apukoskettimet on jo liitetty laitteelle ja määritelty 
käyttöön, ei koestusjakso käynnisty jos apukoskettimilta ei saada tietoa 
katkaisijan kiinniolosta, vaikka käyttäjä olisikin vastannut kysymykseen 
myöntävästi. Vain jos katkaisijan asentoa ei ole tuotu laitteelle, hyväksyy 
laite käyttäjän vastauksen sellaisenaan. 

Kuva 6-46  Katkaisijan koestusjakso laitteen etupaneelin näytöllä

CB TEST        01/08
---------------------
>CB1tst  L1                    
1

jne.

S

Breaker closed?
>YES     NO

ENTER
PW Test+Diagnosis?
     =-------

MAIN MENU       05/05
---------------------
>Settings                                 
4 TEST DIAGNOSIS  07/07

---------------------
>SIEMENS internal             
12

CB TEST        01/08
---------------------
>CB1tst  L1                      
1

ENTER
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Luku 
DIGSI® 4  
ohjelmalla

• Avataan laite Online tilassa. 

• Kaksoisklikataan Settings hakemistoa ja kaksoisklikataan edelleen 
Circuit Breaker Test objektia. 

digsi627.gif

Kuva 6-47  Katkaisijan koestustoiminnan valinta DIGSI® 4 ohjelmassa

digsi628.gif

Kuva 6-48  Katkaisijan koestustoiminta DIGSI® 4 ohjelmassa, esimerkki

• Kaksoisklikataan Circuit breaker test objektia ja syötetään testaus- 
ja diagnoositoimintojen edellyttämä salasana ja vahvistetaan se 
OK painikkeella. 

Katkaisijakoestuksen eteneminen takaisinkytkentämerkinantoineen 
esitetään Spontaneous Annunciation ikkunassa. 

digsi629.gif

Kuva 6-49  Katkaisijan koestustoiminnan eteneminen spontaanissa päiväkirjassa, esimerkki
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6.7 Kytkinlaitteiden ohjaukset

SIPROTEC laitteilla on paikallisohjaustoiminnat

Tahdistamattomat ohjaustoiminnat katkaisijoille, erottimille ja 
maadoituserottimille

Askelohjaukset muuntajan käämikytkimen ylös- ja alas ohjauksille ja

Aika-asetuksin määriteltävissä olevat asetusohjaukset tähtipistekelan 
(Petersenin kela) ohjauksiin. 

Ohjaustoiminnan varmuusmekanismit takaavat, että ohjaus suoritetaan 
vasta kun kaikki määritellyt tarkastusehdot on suoritettu (esim. 
lukitusehdot). 

Lähdön kytkinlaitteet voidaan ohjata kiinni ja auki laitteen etupaneelista 
tai DIGSI® 4 ohjelmalla.

Konfiguroinnin yhteydessä kytkinlaitteiden ohjauksia varten määritellään 
tarvittavat toiminnat binäärisille tuloille ja lähdöille, sekä tarvittaessa 
lähdön lukitusehdot DIGSI® 4 CFC logiikalla. 

Jos käytettävissä on kytkinlaitteen asentotiedot apukoskettimilta (auki ja 
kiinni), sekä ne on johdotettu ja määritelty laitteelle, voidaan 
kytkinlaitteiden asentoja käyttää ohjaustoiminnan valvonnassa 
takaisinkytkentämerkinantoina. 

Jos AUKI tai KIINNI asentotietoja ei vastaanoteta laitteelta, ilmaistaan 
kytkinlaitteen olevan väliasennossa ja tällöin on mahdollista estää 
ohjaukset lukitusehtojen toimesta. 

Ohjaustoiminnat voidaan aktivoida: 

Paikallisesti laitteen etupaneelista,

Laitteelle liitetyllä DIGSI® 4 ohjelmalla,

Binäärisillä tuloilla,

Kaukokäytöltä järjestelmäväylää pitkin. 

Ohjausoikeudet on määriteltävissä switching authority. 
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Kun ohjaukset suoritetaan lukitusehdot huomioiden (interlocked 
switching) tulee kaikkien lukitusehdoissa määriteltyjen tilojen täyttyä, 
jotta ohjaus olisi suoritettavissa. Jos ehdot eivät täyty, ei ohjausta 
suoriteta ja vastaava käyttömerkinanto aktivoituu. 

Laitteelle on määritelty tehdasasetuksena mallilukitusehdot. Niitä 
voidaan muuttaa vastaamaan kulloinkin kyseessä olevan kentän 
vaatimuksia. 

Seuraavat tarkastukset voidaan määritellä käyttöön tai pois käytöstä 
kytkinlaitteiden auki- tai kiinniohjauksille: 

Ohjausoikeudet (kauko/paikallis),

Kentän lukitukset (esim. CFC logiikalla),

Aseman lukitusehdot (järjestelmäväylää pitkin ulkoisesta 
ohjausjärjestelmästä),

Kaksoisohjausesto (estää kahden toimilaitteen yhtäaikaisen 
ohjauksen),

Ohjausesto suojaustoiminnan ollessa havahtuneena 
(suojaustoimintojen havahtuminen estää kytkinlaitteen ohjaukset),

Kytkinlaitteen tilan valvonta (toivottu tila = voimassa oleva tila).

6.7.1 Ohjaus ylemmältä tasolta

Jos SIPROTEC® laite on liitetty ulkoiseen ohjausjärjestelmään, esim. 
SICAM SAS ohjausjärjestelmä, voidaan kytkinlaitteita ohjata esim. 
SICAM WinCC paikallisohjauspisteeltä. 

Laite on varustettu liikennöintiväylällä, jolla se voidaan liittää ylemmän 
tason ohjausjärjestelmään. Järjestelmäväylän kautta laite voi 
vastaanottaa standardin mukaisia ohjaustelegrammeja, joilla voidaan 
ohjata kytkinlaitteita, asettaa sisäisiä merkinantoja, aktivoida CFC 
logiikkatoimintoja tai käynnistää kytkentäsekvenssejä. 

Riippuen laitteen versiosta ja liityntöjen toteutustavasta, voidaan laitteen 
kanssa liikennöidä myös etäisesti esim. modeemin kautta huoltoväylää 
hyödyntäen.
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Kytkinlaitteiden ohjaukset
6.7.2 Kytkinlaitteiden asennon osoitukset ja ohjaukset 

Määrittely 
laitteen etu-
paneelista 

Graafisella näytöllä varustetuilta laitteilta voidaan kytkinlaitteiden 
olemassa olevat tilat lukea perus- ja ohjausnäytöiltä. Ohjausnäytöltä 
voidaan myös ohjata kytkinlaitteita KIINNI/AUKI painikkeilla ja muuttaa 
ohjaustoimintoihin liittyviä tiloja laitteen etupaneelin avainkytkimiltä. 

Tämä tapahtuu seuraavasti:

• CTRL painikkeella aktivoidaan ohjausnäyttö ja valitaan ohjattavaksi 
haluttu kytkinlaite nuolipainikkein.

• Valitaan kiinni ON tai auki OFF painikkeella haluttu ohjaussuunta.

Tällöin kytkinlaitesymboli alkaa vilkkumaan halutussa ohjaussuunnassa. 

• Vahvistetaan ohjaustapahtuma ENTER painikkeella. 

• Vahvistetaan näytölle tullut kysely ohjauksen jatkamisesta ENTER 
painikkeella tai se voidaan keskeyttää ESC painikkeella. Jos 
ohjaustoimintaa ei vahvisteta minuutin sisällä, ohjaussuunnan 
vilkutus päättyy ja kytkinlaitteen voimassa oleva tila esitetään 
näytöllä. 

Jos ohjaustoimenpide on suoritettu, esitetään näytöllä kytkinlaitteen uusi 
voimassa oleva tila ja näytön alareunaan aktivoituu ilmoitus End of 
command. Jos ohjaus on varustettu takaisinkytkennän valvonnalla, 
esitetään ennen ohjauksen päättymismerkinantoa tieto vastaanotetusta 
takaisinkytkentämerkinannosta FB reached. 

Jos ohjaustoimenpidettä ei ole voitu suorittaa lukitusehtojen estäessä 
toiminnan, tulee siitä ilmoitus näytölle.

• Vahvistetaan ilmoitus ENTER painikkeella. 

Kytkinlaitteiden asennot voidaan lukea valikosta ja sieltä voidaan myös 
aktivoida kytkinlaitteiden ohjaustoiminnat (laitteet 4-rivisellä 
tekstinäytöllä tai graafisella ohjausnäytöllä). 

• Päävalikossa MAIN MENU valitaan Control hakemisto ja siirrytään 
CONTROL alivalikkoon 

• Sieltä valitaan edelleen Breaker/Switch valikko ja siirrytään  
BREAKER SWITCH alivalikkoon. 

Kuva 6-50  Kytkinlaitteiden ohjaukset laitteen näytöltä

MAIN MENU       03/05
---------------------
   Measurement               
–> 2 CONTROL       01/03

--------------------
>Breaker/Switch         
–> 1
>Tagging                     
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• Valitaan Display  valikko ja siirrytään edelleen DISPLAY  
alivalikkoon. Kytkinlaitteiden asennot on esitetty näytöllä. 

Kuva 6-51  Kytkinlaitteiden asennot laitteen näytöllä — esimerkki

Kytkinlaitteita voidaan ohjata seuraavasti:

• Valitaan Control  valikko ja siirrytään edelleen CONTROL 
alivalikkoon. Kytkinlaitteiden voimassa olevat asennot on esitetty 
näytöllä. 

• Valitaan nuolipainikkein haluttu kytkinlaite ja vahvistetaan valinta 
ENTER painikkeella.

• Syötetään salasana (interlocked switching) ja vahvistetaan se 
ENTER painikkeella.

Salasana on voimassa kytkinlaitteiden ohjauksia varten kunnes 
BREAKER/SWITCH valikosta poistutaan. 

Kuva 6-52  Kytkinlaitteiden ohjaus laitteen näytöltä, esimerkki

• Riippuen kytkinlaitteen ja ohjauksen ominaisuuksista ikkunassa on 
esitetty mahdolliset toimenpiteet jotka voidaan suorittaa.  Valitaan 
haluttu ohjaussuunta ja vahvistetaan se ENTER painikkeella. 

• Vahvistetaan näytölle tullut kysymys vastaamalla Yes ja 
vahvistamalla se ENTER painikkeella. 

BREAKER/SWITCH 01/04
--------------------
>Display      –>  1
>Control      –>  2

Display            01/
03
--------------------
>BREAKER      OPEN

BREAKER/SWITCH 02/04
---------------------
>Display        –>  1
>Control        –>  2 CONTROL       01/03

--------------------
 Breaker      >>               
CLOS
 Disc.Swit.                      

Ohje:

Jos kytkinlaitteiden ohjauksissa ei lukitusehtoja oteta huomioon, ovat 
kaikki ohjaustoimenpiteet mahdollisia. Tällöin tulee syöttää lukitusehdot 
ohittava salasana (non-interlocked switching). 
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Kuva 6-53  Kytkinlaitteen ohjausnäyttö — esimerkki

Jos kytkinlaitteen ohjausta ei suoriteta puuttuvien ohjausoikeuksien tai 
lukitusehtojen vastaisen toiminnan johdosta, tulee tilanteesta ilmoitus 
näytölle. Ilmoituksessa on kerrottu miksi ohjausta ei ole hyväksytty.

• Vahvistetaan ilmoitus ENTER painikkeella. 

Luku 
DIGSI® 4  
ohjelmalla

• Avataan laite Online tilassa. 

• Kaksoisklikataan Control valikossa olevaa Breaker/Switches 
objektia. 

digsi625.gif

Kuva 6-54  DIGSI® 4 Ohjattavien kytkinlaitteiden valinta

CONTR         1/03
----  >        Open      -
---
 PS  >        OPEN    OPEN

Ohje:

Ohjaukset DIGSI® 4 ohjelmistosta edellyttää että laitteella on määritelty 
kauko-ohjaukset REMOTE voimaan. Ohjausoikeuksien tila siirretään 
DIGSI® 4 ohjelmistolle kun Control valikko avataan. 

Jos kytkinlaitteiden ohjauksissa ei lukitusehtoja oteta huomioon, ovat 
kaikki ohjaustoimenpiteet mahdollisia. Tällöin tulee syöttää lukitusehdot 
ohittava salasana (non-interlocked switching). 

Vaara!

Kytkinlaitteiden ohjausten suoritus ilman lukitusehtojen 
tarkastusta edellyttää korkeata ammattitaitoa ja kytkinkojeiston 
tarkkaa tuntemusta. Virheellinen ohjaus voi johtaa kuolemaan tai 
loukkaantumiseen ja materiaalivaurioihin.
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digsi626.gif

Kuva 6-55  DIGSI® 4 ohjaukset

Device ikkunassa esitetään kytkinlaitteiden voimassa olevat tilat. 
Oikeassa reunassa olevissa sarakkeissa ilmaistaan onko jokin 
erikoistoiminta aktiivisena kytkinlaitteelle; tilamuutosten esto (input block, 
IB), tiedonsiirron esto (transmission block, TB), estotoiminta 
(substitution, SU), kosketinvärähtelylukitus (chatter blocking, CB) tai 
onko kytkinlaitteen asentotieto päivitetty käsin. 

• Scheduled sarakkeessa valitaan haluttu kytkinlaitteen ohjaussuunta 
auki OFF tai kiinni ON. 

• Syötetään salasana (interlocked switching) ja vahvistetaan se OK 
painikkeella. 

Tämän jälkeen kytkinlaiteohjaukset voidaan suorittaa ilman salasanan 
syöttöä, kunnes Device ikkuna suljetaan tai ohjaustapaa muutetaan. 

Jos ohjauksen jälkeen tilamuutoksen takaisinkytkentätieto on 
vastaanotettu onnistuneesti, päivittyy kytkinlaitteen asentotieto Device 
ikkunassa.
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6.7.3 Asentotiedon käsin merkkaus

Jos kytkinlaitteen asentotietomerkinanto puuttuu, on ohjaustoiminta 
lukittuneena. Jos tätä kytkinlaitetta tulee kuitenkin ohjata, voidaan 
kytkinlaitteen voimassa oleva asento päivittää käsin. Käsin merkattua 
asentoa käytetään esimerkiksi lukitusehtojen tarkastuksessa. 

Käsin päivittäminen on mahdollista jos päivitysesto (input block) on 
aseteltu voimaan kytkinlaitteelle (katso kappale 6.7.4). 

Määrittely 
laitteen etu-
paneelista 

Tämä tapahtuu seuraavasti: 

• Päävalikossa MAIN MENU valitaan Control hakemisto ja siirrytään 
CONTROL alivalikkoon 

• Sieltä valitaan edelleen Breaker/Switch valikko ja siirrytään  
BREAKER SWITCH alivalikkoon. 

• Siirrytään Man. Overwrite valikkoon ja edelleen alivalikkoon MAN. 
OVERWRITE.

Näytössä on nyt kytkinlaitteet esitettynä voimassa olevilla tilatiedoilla. 

• Siirrytään nuolipainikkein sen kytkinlaitteen päälle, jonka tila halutaan 
päivittää käsin ja vahvistetaan valinta ENTER painikkeella. 

• Syötetään salasana (non-interlocked switching) ja vahvistetaan se 
ENTER painikkeella. 

Kuva 6-56  Kytkinlaitteen asennon käsin päivitys laitteen näytöllä

MAN. OVERWRITE 01/03
--------------------
BREAKER                 
>OPEN
 Disc.Swit.                    

BREAKER/SWITCH 03/04
-------------------
  Display                       
—>  1
  Control                        
–>  2
355SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Toimenpiteet käytön aikana
• Valitaan kytkinlaitteen asennoksi AUKI (OPEN) tai KIINNI (CLOSE)  
ja vahvistetaan valinta ENTER painikkeella.

Kuva 6-57  Kytkinlaitteen asennon käsivalinta laitteen näytöllä

• Vahvistetaan toiminta valitsemalla Yes  ja vahvistamalla valinta 
ENTER painikkeella.

Näyttöön tulee ilmoitus jos laitteen asentoa ei voi päivittää käsin, 
esimerkiksi jos päivitysestoa ei ole asetettu. 

• Kuitataan ilmoitus ENTER painikkeella. 

Luku 
DIGSI® 4  
ohjelmalla

Turvallisuussyistä kytkinlaitteen asennon käsin päivitys on mahdollista 
vain suoraan laitteelta, eli se ei ole mahdollista DIGSI® 4 ohjelmalla. 

6.7.4 Tilan asetus

Käyttöönoton tai koestuksen aikana on mahdollista väliaikaisesti 
katkaista kytkinlaitteen ja suojalaitteen välinen yhteys tai suojalaitteen ja 
ulkoisen ohjausjärjestelmän välinen yhteys, ilman että yhteyksiä 
katkaistaisiin fyysisesti. Esto voi olla tarpeen myös esimerkiksi jos 
kytkinlaitteen asentotieto ei välity suojalaitteelle. Tilat voidaan asettaa 
Set status toiminnalla. Tilat määritellään kytkinlaitekohtaisesti 
tunnuskirjaimin. 

T Laitteen asento määritelty käsin

I Asennon päivitysesto 

B Tiedonsiirron esto ulkoiseen ohjausjärjestelmään

C Kosketinvärähtely aktiivisena liian usein toistuvan merkinannon 
ohjaamana

O Ohjausesto, eli uloslähtevät ohjaukset on erotettu

– Laitteella ei ole mitään tilaa voimassa. 

MAN. O         01/03
------ >          Open  -
------
>52Bre         OPEN    

Ohje:

Asentotiedon päivitysesto vaikuttaa vain laitteen sisääntuloihin. 
Päivitysestoa ei tule asettaa käsin päivitettäville tilatiedoille, jotka 
muodostetaan CFC logiikalla. Näille merkinannoille päivitysesto ei johda 
tilamuutosten lukittumiseen. 
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Määrittely 
laitteen etu-
paneelista 

• Päävalikossa MAIN MENU valitaan Control hakemisto ja siirrytään 
CONTROL alivalikkoon 

• Sieltä valitaan edelleen Breaker/Switch valikko ja siirrytään  
BREAKER SWITCH alivalikkoon. 

• Siirrytään Set status valikkoon ja edelleen SET STATUS 
alivalikkoon. 

• Siirrytään sarakkeeseen I (päivitysesto) tai O (ohjausesto) ja 
vahvistetaan valinta ENTER painikkeella. 

• Syötetään salasana (non-interlocked switching) ja vahvistetaan se 
ENTER painikkeella. 

Kuva 6-58  Kytkinlaitteen tilan aseteus laitteen näytöllä

• Valitaan haluttu tila ja vahvistetaan se ENTER painikkeella.

• Vahvistetaan toiminta valitsemalla Yes  ja vahvistamalla valinta 
ENTER painikkeella.

Yllä olevassa esimerkissä katkaisijan Q0 asento on määritelty käsin T ja 
päivitysesto I on aktiivisena, eli merkinantotulot on erotettu kojeistosta. 
Lisäksi ohjausesto O on aktiivisena, jolloin ohjaukset kojeistoon on 
estetty. Erottimelle Q1 ja maadoituserottimelle Q8 ei ole määritelty tiloja.

Luku 
DIGSI® 4  
ohjelmalla

Turvallisuussyistä tilamuutokset ovat mahdollista vain suoraan 
laitteelta, mutta ei DIGSI® 4 ohjelmalla. 

1.  2.  3.  4.  5.  

BREAKER/SWITCH 04/04
--------------------
  Display                       
—>  1
  Control                        
–>  2

SET STATUS     02/03
--------------------
52Breaker T I - - O
Disc.Swit.->- - - -
GndSwit.   - - - - -

Ohje:

Toisessa sarakkeessa on päivityseston I valinta ja viidennessä 
sarakkeessa ohjauseston A valinta. Sarakkeet 1, 3 ja 4 ilmaisevat vain 
aktiivisena olevaa tilaa ja niitä ei voi muuttaa.
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6.7.5 Lukitukset

Kytkinlaitteille, kuten katkaisijat, erottimet ja maadoituserottimet, voidaan 
määritellä lukitusehdot. Lukitusehtojen tilat voidaan lukea laitteelta, 
mutta niitä ei voi muuttaa. 

Määritelty lukitus on ilmaistu kunkin kytkinlaitteen kohdalla. 

• L Ohjausoikeuksien tarkastus

• S Kytkinlaite liittyy aseman lukitusehtoihin (paikallisesti aktivoitu 
ohjaus välitetään ulkoiseen ohjausjärjestelmään tarkastusta 
varten)

• Z Kentän lukitusehtojen tarkastus

• P Kytkinlaitteen asennon tarkastus (haluttu tila = voimassa oleva tila)

• B Lukittu suojaustoiminnan ollessa havahtuneena

• – Ei lukituksia. 

Määrittely 
laitteen etu-
paneelista 

Tämä tapahtuu seuraavasti:

• Päävalikossa MAIN MENU valitaan Control hakemisto ja siirrytään 
CONTROL alivalikkoon 

• Siirrytään Interlock valikkoon ja edelleen INTERLOCK alivalikkoon. 

Kuva 6-59  Laitteen voimassa olevat lukitusehtotarkastukset, esimerkki

INTERLOCK   01/03
--------------------
>52Breaker       L – Z P B
>52Breaker        L – Z 

CONTROL       03/05
--------------------
>Tagging               –
>  2

1. 2. 3. 4.5.  Column

 52Breaker           L –
Z P B
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Kytkinlaitteiden ohjaukset
Luku 
DIGSI® 4  
ohjelmalla

Tämä tapahtuu seuraavasti:

• Avataan laite Online tilassa. 

• Kaksoisklikataan Settings hakemistoa ja kaksoisklikataan edelleen 
Masking I/O objektia. 

• Valitaan halutun kytkinlaitteen ominaisuudet valitsemalla valikosta 
Object properties. 

Kytkinlaitteen ohjaukseen liittyvät lukitukset valitaan valintaruuduin. 

Muutos ei edellytä salasanan syöttämistä.

6.7.6 Merkkaukset 

Suojattavan kytkinkojeiston poikkeavien tilojen esitystä varten on 
mahdollista asettaa sisäinen merkki, esimerkiksi maadoitettu. Nämä 
merkkaukset voidaan ottaa huomioon lukitusehdoissa. Merkkaukset 
(taggings) määritellään kuten kytkinlaitteet. 

Määrittely 
laitteen etu-
paneelista 

• Päävalikossa MAIN MENU valitaan Control hakemisto ja siirrytään 
CONTROL alivalikkoon 

• Siirrytään Tagging valikkoon ja edelleen TAGGING alivalikkoon. 

• Valitaan Display tai Set. 

Kuva 6-60  Merkkausten näyttö

Luku 
DIGSI® 4  
ohjelmalla

Turvallisuussyistä merkkaukset ovat mahdollista vain suoraan 
laitteelta, mutta ei DIGSI® 4 ohjelmalla. 

TAGGING        01/02
---------------------
Display      –>    1
Set            –>    2

CONTROL       02/03
---------------------
Breaker/Switch      –>  1
Tagging                –>  2
Interlock                –
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6.7.7 Ohjausoikeudet

Ohjausoikeuksin määritellään mistä ohjaus voidaan aktivoida, 
esimerkiksi kauko-ohjauksena REMOTE ulkoisesta 
ohjausjärjestelmästä, DIGSI® 4 ohjelmalla tai paikallisesti LOCAL 
laitteen ohjauspaneelista. 

Määrittely 
laitteen etu-
paneelista 

Laitteilla, jotka on varustettu graafisella ohjausnäytöllä, ohjausoikeudet 
määritellään ylemmällä avainkytkimellä. 

Kun avainkytkin on vaaka-asennossa (Local), on paikallisohjaustila 
aktiivisena. Avainkytkimen ollessa pystyasennossa (Remote) on 
ohjausoikeustila aktiivisena. 

Laitteilla, jotka on varustettu 4-rivisellä näytöllä, ohjausoikeudet 
määritellään seuraavasti:

• Päävalikossa MAIN MENU valitaan Control hakemisto ja siirrytään 
CONTROL alivalikkoon 

• Valitaan Control Auth. valikko ja siirrytään edelleen CONTROL 
AUTH. alivalikkoon. 

• Syötetään salasana (non-interlocked switching) ja vahvistetaan se 
ENTER painikkeella. 

• Valitaan Remote tai LOCAL ja vahvistetaan valinta ENTER 
painikkeella. 

• Näyttöön aktivoitunut ilmoitus vahvistetaan ENTER painikkeella.

Kuva 6-61  Ohjausoikeuksien määrittely näytöllä (esimerkkinä ohjaustila, joka ei tarkasta lukitusehtoja)

CONTROL       04/05
--------------------
>Interlock         –>  3
>Control Auth. –>  4 CONTROL AUTH.

--------------------
 Switch Auth.  > Local

CONTRO         
------ >           Remote    
-----
 Switc              Local    

ENTER
PW Unlock Control
     =-------

ENTER
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Kytkinlaitteiden ohjaukset
Luku 
DIGSI® 4  
ohjelmalla

Turvallisuussyistä ohjausoikeudet voidaan määritellä vain paikallisesti 
laitteen etupaneelista, mutta ei DIGSI® 4 ohjelmalla. 

Kun halutaan ohjata DIGSI® 4 ohjelmalla

Määritellään ohjausoikeudet kauko-ohjauksille (REMOTE) tai

Määritellään että tälle ohjaukselle ohjausoikeuksia ei tarkasteta 
kauko-ohjauksilla. 

Ohjausoikeuksia ei välitetä DIGSI® 4 ohjelmalle kun  Control toiminta 
aktivoidaan. 

6.7.8 Ohjaustila

Jos ohjaukset halutaan suorittaa ilman lukitusehtojen tarkastusta, 
esimerkiksi käyttöönoton yhteydessä, voidaan ohjaustila muuttaa käytön 
aikana. 

Määrittely 
laitteen etu-
paneelista 

Laitteilla, jotka on varustettu graafisella ohjausnäytöllä, ohjaustila 
määritellään alemmalla avainkytkimellä. Kun avainkytkin on 
vaakatasossa (Interlocking OFF), suoritetaan ohjaukset ilman 
lukitusehtojen tarkastusta. Avainkytkimen ollessa pystyasennossa 
lukitusehdot tarkastetaan normaalisti. 

Laitteilla, jotka on varustettu 4-rivisellä näytöllä ilman avainkytkimiä, 
ohjaustila määritellään seuraavasti: 

• Päävalikossa MAIN MENU valitaan Control hakemisto ja siirrytään 
CONTROL alivalikkoon 

• Sieltä valitaan edelleen Switch mode valikko ja siirrytään  SWITCH 
MODE alivalikkoon. Voimassa oleva tila esitetään näytöllä.

• Syötetään salasana (non-interlocked switching) ja vahvistetaan se 
ENTER painikkeella. 

• Valitaan INTERLOCKED tai NON-INTERLOCKED ohjaustila ja 
vahvistetaan valinta ENTER painikkeella. 

• Vahvistetaan haluttu valinta ENTER painikkeella. 

Vaara!

Kytkinlaitteiden ohjausten suoritus ilman lukitusehtojen 
tarkastusta edellyttää korkeata ammattitaitoa ja kytkinkojeiston 
tarkkaa tuntemusta. Virheellinen ohjaus voi johtaa kuolemaan tai 
loukkaantumiseen ja materiaalivaurioihin.
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Kuva 6-62  Ohjaustilan valinta laitteen näytöllä

Luku 
DIGSI® 4  
ohjelmalla

• Avataan laite Online tilassa. 

• Kaksoisklikataan Control valikossa olevaa Breaker/Switches 
objektia. 

• Aktivoidaan Non-interlocked switching valintaruutu ja vahvistetaan 
valinta OK painikkeella, jos ohjaukset halutaan suorittaa ilman 
lukitusehtojen tarkastuksia. 

• Aktivoidaan Interlocked switching vaihtoehto ja vahvistetaan valinta 
OK painikkeella, jos ohjaukset halutaan suorittaa lukitusehdot 
tarkastaen. 

• Syötetään salasana (non-interlocked switching) ja vahvistetaan se 
OK painikkeella. 

Kytkinlaitteiden ohjaukset on mahdollista tämän jälkeen suorittaa ilman 
salasanan syöttöä, kunnes Devices ikkuna suljetaan tai ohjaustilaa 
muutetaan. 

CONTROL       05/05
--------------------
>Control Auth.               
–>  4

ENTER
PW Unlock Control
     =-------

SWITCH MODE
--------------------
 SwMod Local   >NO

SW 
--->   INTERLOCKED   ---
 IN  NON-INTERLOCKED
                  

ENTER
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6.7.9 Ohjausten merkinannot

Ohjaustapahtuman kulkua kuvataan merkinannoin.  Taulukossa 6-3 on 
esitetty mahdolliset merkinannot selityksineen. 

Taul. 6-3 Mahdolliset ohjaustoimenpiteiden merkinannot

Merkinantoteksti Merkitys
System Error Keskeytys järjestelmävirheestä

Man. Overwrite OK Käsin päivitys suoritettu

Man. Overwrite Fail Käsin päivitystä ei ole voitu suorittaa

Control Abort OK Ohjauksen keskeytys onnistui

Control Abort Fail Toiminta ei ole keskeytettävissä, koska ohjaus ei ole käynnissä tai se on käynnissä 
toiseen suuntaan tai keskeytystä ei ole määritelty käyttöön

Control Executed Ohjaus suoritettiin ja päätettiin onnistuneesti

Control Failed Estetty, koska ohjausten lukumäärä tai ohjauslähde ei ole sallittu

Interlocked Estetty, koska liikennöintiväylä on estetty tai ohjattava kohde on lukittu 
suojaustoiminnan havahtumasta

Switchgr. Interlocked Estetty, koska kenttätason lukitusehdot estävät suorituksen

Switch in Position Estetty, koska ohjattava kytkilaite on jo toivotussa asennossa

Setting Error Estetty, koska toiminnassa on parametrointivirhe, kuten esim. tuntematon 
ohjaustyyppi

Not Authorized PAIKALLIS - ohjaus on estetty, koska ohjauspaikka on KAUKO - tilassa

Control Expired Estetty, koska ohjauskäsky on liian vanha (aikavalvonta)

No Control Device Informaatio-osoitetta ei ole määritelty ohjausulostuloksi

Config. Error Estetty, koska kytkinlaitteelle ei ole määritelty binääristä ulostuloa tai määritelty 
binäärinen ulostulo ei laitteella käytettävissä

Control Blocked Estetty, koska ohjausesto on päällä

System Overload? Estetty, koska ohjattava binäärinen tulo on jo aktiivisena (esim. yhteinen 
paluupotentiaalikosketin ohjattuna toiselta ohjaukselta)

SW: 1 to n error? Estetty, koska toinen binäärinen ulostulo on aktivoituna

System Overload? Käytettävissä ei ole enää vapaita aikaviivepiirejä

Upper Sett. Limit Muuntajan käämikytkimen ohjaus on saavuttanut ylimmän asennon

Lower Sett. Limit Muuntajan käämikytkimen ohjaus on saavuttanut alimman asennon

Executing Control Uusi ohjaus on estetty, koska ohjaus on jo käynnissä

Command Timeout Takaisinkytkentämerkinanto puuttuu

BinaryInp. Ignored Päivysesto aktiivisena

Chatter active Kosketinvärähtelyn esto aktiivisena

Setting active Estetty, koska parametrien lataus käynnissä

Status Change OK Ohjaus suoritettu onnistuneesti

Status Change Fail Ohjausta ei ole voitu suorittaa

Change OK Merkkaus suoritettu onnistuneesti

Change Failed Merkkausta ei ole voitu suorittaa

Checking Interlock Ohjaus on lähetty keskusyksikölle lukitusehtojen tarkastusta varten
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Settings  are OK Asetteluiden vaihto on onnistunut

Time Limit Expired Asetteluiden vaihto on keskeytetty, koska aika on kulunut umpeen

Terminated-Pickup Asetteluiden muutos on estetty, koska suojaustoiminta on havahtuneena

Restore Parameters Parametrien päivitys keskeytetty suojaustoiminnan havahtumasta ja vanhat 
asettelut otetaan jälleen käyttöön.

Please Wait... Toiminta on käynnissä ja kestää vielä hetken

Checking Settings Muutetut asetukset tarkastetaan ennen hyväksyntää

Swgr. Feedback OK Takaisinkytkentämerkinanto: toivottu tila on saavutettu

Swgr. Feedback Fail Takaisinkytkentämerkinanto: toivottua tilaa ei ole saavutettu

Change Rejected Asetteluiden muutos on keskeytetty (esim. aika on kulunut umpeen tai 
parametroinnin aikana suoja on havahtunut)

Control OK Ohjauksen positiivinen kuittaus

Value Incorrect Ohjauksessa itsevalvonnan havaitsema häiriö

Taul. 6-3 Mahdolliset ohjaustoimenpiteiden merkinannot

Merkinantoteksti Merkitys
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Kommunikaatio 7
Tässä kappaleessa on kuvattu kommunikaatioyhteyksien ominaisuudet 
ja kuinka liikennöintiyhteys määritellään SIPROTEC® laitteiden, 
DIGSI® 4 ohjelman ja ulkoisten ohjausjärjestelmien välille.
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7.2  Yhteyden muodostus Plug and Play-menetelmällä  370

7.3  Yhteyden muodostaminen  372
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7.5  Yhteyden muodostus IEC 60870-5 väylällä  376
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Kommunikaatio
7.1 Yleistä

DIGSI® 4 ohjelma voidaan liittää SIPROTEC 4 laitteeseen käyttäen eri 
tyyppisiä liikennöintiyhteyksiä.

Kommunikaatio suoralla yhteydellä,

Kommunikaatio modeemiyhteydellä käyttäen lisäohjelmistoa DIGSI 4 
Remote,

PROFIBUS FMS verkon kautta hyödyntäen PROFIBUS FMS 
toiminnallisuutta. Jos laite liitetään SICAM ohjausjärjestelmään, 
tarvitaan parametroinnissa myös STEP 7 ohjelmistoa DIGSI® 4 
ohjelmiston lisäksi.

SIPROTEC® laitteet järjestelmäversiosta 4.2 lähtien voidaan liittää 
ulkoiseen ohjausjärjestelmään myös PROFIBUS DP, DNP 3.0 ja 
MODBUS protokollin. 

Lisäksi DIGSI® 4 ohjelmistolla voidaan määritellä määrätyille laitteille 
myös suora laitteiden välinen kommunikointi. 
Lisätietoja toiminnoista on esitetty SIPROTEC 4 laitteiden 
käyttöohjeissa.

Osoitteet Kommunikaatioyhteyksissä DIGSI® 4 ja SIPROTEC® laiteiden välillä, 
kuten myös muilla kommunikaatioyhteyksillä, tulee laiteosoitteet 
määritellä. Riippuen osoitteen tyypistä määritellään osoite käyttäjän tai 
DIGSI® 4 ohjelman toimesta. 
Kuvassa 7-1 on esimerkkikonfiguraatio. Kuvassa on esitetty mitä eri 
liikennöintiosoitteita kommunikaatio edellyttää.
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Yleistä
Kuva 7-1 Esimerkkikonfiguraatio

Huoltoväylä Käyttöväylä

PROFIBUS 
järjestelmä- 

väylä

IEC 
järjestelm- 

väylä

SIPROTEC-VD osoite

SIPROTEC-T103-VD 
osoite

Vaihtoeh-
toinen

SI
PR

O
TE

C
 4

 la
ite

DIGSI 4 PC

COM väylä

Tähti-
jakaja

DIGSI 4 PC

COM väylä

Linkkiosoite

Linkkiosoite

LSA
tai

SICAM SAS

IEC väylä

IEC osoite

PROFIBUS 
osoite 

(SIPROTEC 4 
laite)

DIGSI 4 PC

PROFIBUS 
väylä

SICAM SAS

PROFIBUS 
väylä

PROFIBUS 
osoite (DIGSI 4)

PROFIBUS 
osoite (MCP)

DIGSI4-VD osoite DIGSI4-VD osoite

DIGSI4-VD osoite

PROXY-VD 
osoitteet1 ... n
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VD osoitteet Yksilöllinen VD osoite (Virtual Device address) on määritelty jokaiselle 
aseman komponentille. Komponentteja tässä yhteydessä voivat olla 
laitteet (esim. SIPROTEC 4 laite), laitteen moduli tai ohjelmisto (esim. 
DIGSI® 4). VD osoitteet poikkeavat toisistaan riippuen komponentin 
tyypistä:

DIGSI4 VD osoitteet
Osoitetta käytetään DIGSI® 4 ohjelman yksilölliseen tunnistukseen 
(eli tietokoneet joissa DIGSI® 4 ohjelmaa käytetään) aseman sisällä. 
Esiasetellut osoitteet voidaan yleensä jättää käyttöön sellaisenaan. 
Sitä tulee muuttaa vain jos on mahdollista käyttää kahta 
samanaikaista liikennöintiväylää SIPROTEC 4 laitteelle. Tällöin 
toinen tai molemmat DIGSI4 VD osoitteet tulee muuttaa. Tällöin 
osoite muutetaan valitsemalla DIGSI device configuration, ja 
avaamalla edelleen Interfaces objekti, jossa VD addresses sivulla 
voidaan DIGSI VD address muuttaa. 

SIPROTEC VD osoite
Osoitetta käytetään SIPROTEC 4 laitteen yksilölliseen tunnistukseen 
aseman sisällä. Se määritellään DIGSI® 4 ohjelmassa ja sitä ei voi 
muuttaa. DIGSI® 4 ohjelmassa määrittely on nimetty 
yksinkertaisuuden vuoksi vain VD osoitteeksi.

SIPROTEC-T103 VD osoite
Osoitetta käytetään SIPROTEC 4 laitteen yksilölliseen määrittelyyn 
IEC 60870-5 liikennöintijärjestelmässä. Se määritellään DIGSI® 4 
ohjelmassa ja sitä ei voi muuttaa.

SICAM-Proxy VD osoite
Osoitetta käytetään SIPROTEC 4 laitteen yksilölliseen määrittelyyn 
SICAM SAS järjestelmässä. Se määritellään DIGSI® 4 ohjelmassa ja 
sitä ei voi muuttaa. SICAM-Proxy-VD osoite otetaan huomioon saman 
projektin kaikilla SIPROTEC 4 laitteilla, jotka on liitetty SICAM SAS 
järjestelmään.

DIGSI4 VD osoite pois lukien, joka tulee mahdollisesti muuttaa käyttäjän 
toimesta, VD osoitteita ei yleensä tarvitse käyttäjän toimesta määritellä. 
Ne on esitetty lähinnä testaus- ja diagnoositarkoituksia varten.

IEC osoite Tämän osoitteen määrittely on tarpeen jos SIPROTEC 4 laite tulee 
liikennöimään IEC 60870-5 järjestelmässä. IEC liikennöinnissä tulee 
jokaisella SIPROTEC 4 laitteella on yksilöllinen IEC osoite. Yhdellä IEC 
väylällä on käytettävissä enintään 254 osoitetta. IEC väylä ja sen osoite 
määritellään SIPROTEC 4 laitteelle DIGSI® 4 ohjelmalla.

Huomio:

Ongelmia väylien priorisoinneissa voi esiintyä, eli väylä voi vaikuttaa 
samanaikaisesti käytössä olevan toisen väylän ominaisuuksiin 
(muutokset baudinopeuteen, parametrien siirtoon).
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PROFIBUS FMS 
osoite

Tämän osoitteen määrittely on tarpeen jos SIPROTEC 4 laite tulee 
liikennöimään PROFIBUS FMS järjestelmäväylässä. Yksilöllinen 
PROFIBUS FMS osoite tulee määritellä jokaiselle SIPROTEC 4 
laitteelle, jotka tulevat liikennöimään samassa PROFIBUS FMS 
verkossa. Käytettävissä on 254 PROFIBUS FMS osoitetta yhtä 
PROFIBUS FMS verkkoa kohden. SIPROTEC 4 laitteen PROFIBUS 
FMS osoite ja PROFIBUS liikennöintiväylän ominaisuudet määritellään 
DIGSI® 4 ohjelmalla.

IEC linkkiosoite Tämä osoite on tarpeen, jos liikennöintiväylä määritellään SIPROTEC 4 
laitteen etu- tai taka liikennöintiväylään. Jos käytössä on suora 
tietokoneen ja SIPROTEC 4 laitteen välinen yhteys (point-to-point), 
käytetään yleensä osoitetta 1. Jos liikennöinnissä käytetään tähtijakajaa, 
tulee jokaisella SIPROTEC 4 laitteella olla yksilöllinen IEC-linkkiosoite. 
Osoite voidaan määritellä alueella 1 ... 254.

Toimintatilat SIPROTEC 4 laitteen tietoja voidaan käsitellä DIGSI® 4 ohjelmalla joko 
off-line tai on-line tiloissa. 

Laitteelle ei ole minkäänlaista yhteyttä Offline käyttötilassa. 

Online tilassa laitteelle on yhteys. 
Tässä toimintatilassa

Voidaan siirtää asetteluarvoja tietokoneelta SIPROTEC 4 laitteelle,

Voidaan siirtää asetteluparametrejä SIPROTEC 4 laitteelta 
tietokoneen väliaikaiseen muistiin ja tallentaa ne edelleen 
tietokoneen pysyvään muistiin (katso kappale 4.4),

Voidaan siirtää merkinannot, mittausarvot ja häiriötallenteet 
SIPROTEC 4 laitteelta tietokoneen väliaikaiseen muistiin ja sieltä 
edelleen pysyvään muistiin (katso kappale 4.4),

Voidaan käynnistää testaustoimintoja,

Voidaan ohjata kytkinlaitteita ja asetella sisäisiä merkinantoja,

Voidaan aktivoida SIPROTEC 4 laitteen uudelleen käynnistys,

Voidaan asetella SIPROTEC 4 laitteen päivämäärä ja kellonaika.

Käytettävissä ovat myös samat editointimahdollisuudet kuin Offline 
tilassakin, mutta tallennettuja mittausarvoja, tapahtumia ja 
häiriötallenteita ei voi käsitellä.
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7.2 Yhteyden muodostus Plug and Play-menetelmällä

Plug & Play-menetelmää käytetään suoran yhteyden muodostukseen 
SIPROTEC 4 laitteelle tietokoneella, jossa ei ole käytettävissä laitteen 
parametrejä. Toimintaa varten tietokoneessa tulee olla käytettävissä vain 
DIGSI® 4 projekti. 

Tämä tapahtuu seuraavasti:

• Muodostetaan suora yhteys SIPROTEC 4 laitteelle IEC 60870-5 
protokollalla. Yhteys voidaan muodostaa tietokoneen vapaan COM 
sarjaliikennöintiväylän ja laitteen käyttö- tai huoltoväylien välille.

• Klikataan DIGSI® 4 projektissa oikealla hiiripainikkeella folder 
hakemistoa ja avataan Plug & Play ikkuna valitsemalla Device -> 
Create device via Plug & Play. 

DIGSMAN065-a

Kuva 7-2 Plug & Play

• Valitaan laitteen tyyppi ja hyväksytään se OK painikkeella. Tällöin 
aukeaa Plug & Play valintaikkuna.

DIGSMAN065

Kuva 7-3 Plug & Play

• PC interface kentässä valitaan alasvetovalikosta tietokoneen 
sarjaliikenneportti jolla yhteys halutaan muodostaa.

• Frame kentässä valitaan alasvetovalikosta käytössä oleva 
tiedonsiirtoformaatti.

• Painetaan OK painiketta.
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DIGSI® 4 ohjelma määrittelee laitteen tyypin, lukee parametrit 
SIPROTEC 4 laitteelta ja päivittää valitun laitetyypin tehdasasettelut 
varsinaisilla asetteluilla. Toiminta muodostaa laitteesta SIPROTEC 4 
variant objektin.

Ohje:

Jotta Plug and Play- yhteys olisi mahdollinen, tulee tietokoneelle olla 
asennettuna vastaavan laitteen ajuri tehdasasetuksineen. Jos 
tietokoneella ei ole vastaavaa laiteajuria, seuraa tapahtumasta 
virheilmoitus näytölle. Yhteyden muodostus on täten peruttu. 
Asennetaan tietokoneelle puuttuva laiteajuri käyttäen DIGSI 4 
asennustoimintaa ja uusitaan yhteyden muodostus.

Ohje:

Kaikki laitteen tiedot eivät ole käytettävissä Plug & Play-menetelmällä 
luetulta laitteelta (esimerkiksi käyttäjän määrittelemien merkinantojen 
pidemmät tekstit eivät siirry).
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7.3 Yhteyden muodostaminen

Jos halutaan muodostaa yhteys SIPROTEC 4 laitteelle jonka 
parametritiedosto on jo tietokoneella, toimitaan seuraavasti:

• DIGSI® 4 ohjelman projektinäytössä valitaan haluttu SIPROTEC 4 
laite ja avataan Open Device ikkuna valitsemalla valikosta Open 
Object toiminta.

DIGSIKOM082

Kuva 7-4 Laitteen avaaminen

• Valitaan suora yhteys Direct, 
jos yhteys muodostetaan tietokoneen sarjaliikenneväylällä, 
määritellään tietokoneen liikennöintiväylä PC interface kentässä ja 
laitteen väylä Device interface valintakentän alasvetovalikosta.

• Valitaan Modem connection, jos yhteys laitteeseen muodostetaan 
modeemiväylän ja laitteen takana olevan huoltoväylän kautta.

• Valitaan PROFIBUS FMS, jos yhteys muodostetaan PROFIBUS 
FMS verkon kautta.

• Valitaan Ethernet, jos yhteys muodostetaan Ethernet verkon kautta.

• Painetaan OK painiketta.

Yhteyden 
muodostaminen

Yhteys SIPROTEC 4 laitteelle muodostuu. Yhteyden muodostuksen 
aikana näytöllä esitetään ilmoituksia toiminnan edistymisestä. Jos 
yhteyttä ei voi muodostaa, ilmaisee DIGSI® 4 ohjelma tapahtumasta.
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DIGSIGB017

Kuva 7-5 Ilmoitus yhteyden muodostumisen epäonnistumisesta

• Tarkastetaan että fyysinen yhteys tietokoneen ja SIPROTEC 4 
laitteen välillä on kunnossa. Poistetaan ongelma ja painetaan Repeat 
painiketta. 

• Painetaan Initialize painiketta, jos SIPROTEC 4 laitteella ei ole 
voimassa olevaa parametritiedostoa. Tämän jälkeen uusitaan 
yhteydenmuodostus.

Parametriarvojen 
lukeminen

Kun yhteys on muodostettu verrataan tietokoneella ja SIPROTEC 4 
laitteella olevia parametriarvoja toisiinsa. Jos poikkeamia esiintyy, tulee 
näyttöön ilmoitus.

DIGSIGB018

Kuva 7-6 Poikkeavat asettelut laitteella ja tietokoneella

• Valitaan jompi kumpi vaihtoehdoista ja hyväksytään valinta OK 
painikkeella. 

Kumpikaan valinnoista ei vaikuta tietokoneelle tallennetuihin tietoihin.
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7.4 SIPROTEC 4 laitteen initialisointi

Jotta SIPROTEC 4 laitteen kanssa voitaisiin työskennellä Online tilassa, 
tulee se ensin initialisoida kerran. 

Initialisoinnin yhteydessä SIPROTEC 4 laitteelle lähetetään kaikki 
asettelut. Initialisoitaessa laitteelle välitetään asettelutiedostosta myös 
VD osoite, jota käytetään laitteen yksilölliseen tunnistukseen projektin 
sisällä. VD osoite muodostetaan automaattisesti DIGSI® 4 ohjelmassa, 
kun SIPROTEC 4 laite luodaan. 

Tämä tapahtuu seuraavasti:

• Valmistellaan parametritiedosto SIPROTEC laitteelle Offline 
tilassa.

• Initialisoinnissa käytetään suoraa yhteyttä tietokoneen ja laitteen 
välillä. Yhteys voidaan muodostaa tietokoneen vapaan COM 
sarjaliikennöintiväylän ja laitteen käyttö- tai huoltoväylien välille.

• Painetaan halutun SIPROTEC 4 laitetiedoston päällä oikeata 
hiiripainiketta ja avataan Initialize Device ikkuna valitsemalla 
Initialize Device toiminta.

DIGSMAN064

Kuva 7-7 Laitteen initialisointi
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Liikennöinti-
parametrien 
asettelu

Asetellaan liikennöintiparametrit. 

• PC interface kentässä valitaan alasvetovalikosta tietokoneen 
sarjaliikenneportti jolla yhteys halutaan muodostaa.

• Frame kentässä valitaan alasvetovalikosta käytössä oleva 
tiedonsiirtoformaatti.

• Vahvistetaan valinnat OK painikkeella, jolloin initialisointi käynnistyy.

Initialisoinnissa suoritetaan seuraavat vaiheet:

− Muodostetaan yhteys laitteelle.

− Tiedot siirretään laitteelle. 

− Suoritetaan laitteen täydellinen uudelleen käynnistys. 

− Yhteys laitteelle katkaistaan automaattisesti kun tehtävä on 
suoritettu.
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7.5 Yhteyden muodostus IEC 60870-5 väylällä

Toimitaan seuraavasti jos tietokoneen ja laitteen välille halutaan 
muodostaa yhteys sarjaliikenneväylällä:

• Kytketään fyysinen yhteys.

• Asetellaan liikennöintiparametrit.

• Muodostetaan yhteys tarvittaessa Plug & Play-menetelmällä.

• Suljetaan yhteys käsin.

Muodostettaessa yhteys IEC 60870-5 liikennöinnillä, liitetään 
yhdistyskaapeli tietokoneen ja laitteen välille. Yhteyden muodostuksessa 
voidaan käyttää esim. 7XV5100-4 kaapelia. Kaapelin kytkentä on esitetty 
Liitteessä A.4. 

• Liitetään kaapelin toinen pää yhteyden muodostuksessa käytettyyn 
sarjaliikenneväylään tietokoneella ja toinen pää laitteen 
käyttösarjaliikenneväylään.

7.5.1 Kommunikointiparametrien asettelu

DIGSI® 4 ohjelmassa on esiaseteltu kommunikointiparametrit, joita 
voidaan käyttää normaalitilanteissa. 

Jos asetteluita tulee muuttaa:

Muutetaan tarvittavat liikennöintiparametrit offline tilassa ja 
initialisoidaan SIPROTEC 4 laite uusin asetteluin.   

Muodostetaan ensin yhteys SIPROTEC 4 laitteelle ja muutetaan 
tarvittavat kommunikaatioparametrit Online tilassa. Tämän jälkeen 
siirretään uudet asettelut SIPROTEC 4 laitteelle.

Toimitaan seuraavasti: 

• Avataan DIGSI® 4 ja kaksoisklikataan Interfaces objektia 
tietoikkunassa. Tällöin näyttöön aukeaa Interface Settings ikkuna. 

• Valitaan Serial port on PC sivu.
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DIGSIKOM060.GIF

Kuva 7-8 Liikennöintiasetukset, Serial port on PC sivulla

• Frame, Baud rate and Address kentässä valitaan joko Apply from 
"Operator Interface" tab tai Apply from "Service Interface" tab, 
riippuen siitä mihin liikennöintiväylään tietokone on liitetty laitteella. 
Valinta takaa että tietokoneella ja SIPROTEC 4 laitteella on käytössä 
samat asettelut.

Address (device operator interface), Frame (pariteetti) ja Baud rate 
asettelut otetaan  Operator interface tai Service interface sivuilta, 
riippuen kumpi on valittu käyttöön. Näitä asetteluita ei tässä yhteydessä 
voi muuttaa.

COM port asettelu otetaan Open device ikkunasta. Tätä asettelua ei 
tässä yhteydessä voi muuttaa.
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PC- ja 
huoltoväylä

Käyttö- (operator interface) ja huoltoväylien (service interface) 
liikennöintiasettelut ovat samoja.

• Valitaan Operator Interface sivu.

DIGSIKOM062

Kuva 7-9 Käyttösarjaliikennöintiväylän liikennöintiasetukset

• Syötetään IEC linkkiosoite IEC-Link Address kentässä. Jos 
liikennöintiyhteys on muodostettu suoraan laitteen ja tietokoneen 
välille, käytetään asetteluarvoa 1. Jos käytetään jakajaa, tulee 
jokaiselle SIPROTEC 4 laitteelle määritellä yksilöllinen IEC 
linkkiosoite. Osoite voidaan määritellä alueella 1 ... 254.

• Määritellään liikennöinnin pariteetti Frame kentässä.

• Määritellään liikennöintinopeus Baud rate kentässä. 
Tätä asettelua käytetään normaaliyhteydellä. Tätä asettelua 
käytetään initialisoitaessa SIPROTEC 4 laitetta tai luettaessa tietoja 
laitteelta Plug & Play-menetelmällä. Jos yhteyden muodostus ei 
onnistu tällä yhteydellä, yritetään uudelleen alemmalla 
baudinopeudella. Tämä toistetaan kunnes yhteys onnistuu tai 
esivalittu liikennöintinopeus astuu voimaan.

• Syötetään suurin katkosaika Max. message gap kenttään. Asettelu 
kerrotaan 100 ms ajalla, tulon määrittäessä suurimman sallitun välin 
kahden tavun siirtojen välillä. Asettelulla on merkitystä vain 
kommunikoitaessa modeemilla.
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Valo pois Light OFF on määritelty tehdasasetuksena valokuituyhteyden 
lepotilaksi.

• Valitaan valo päällä Light ON toiminta, jos lepotila on toisen ylemmän 
tason ohjausjärjestelmässä. 

7.5.2 Suoran yhteyden muodostus DIGSI 4 ohjelman ja laitteen välillä

Suora yhteys voidaan muodostaa laitteen ja tietokoneen välille

Plug & Play-menetelmällä

Avaamalla laite Direct Online tilaan.

Toiminnan kuvaus, katso kappale 7.2 ja kappale 7.3.
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7.5.3 Suoran yhteyden sulkeminen

Suora yhteys voidaan sulkea eri menetelmin.

SIPROTEC 4 
laitteen sulkeminen

• Suljetaan avattu laite valitsemalla File → Close. 

Suora yhteys laitteelle sulkeutuu automaattisesti. Jos muutettuja 
asetteluita ei ole vielä tallennettu, tulee siitä näyttöön ilmoitus.

DIGSIGB057

Kuva 7-10 Ilmoitus tallentamattomista asetteluista

• Valitaan Yes, jos muutetut asettelut halutaan tallentaa ennen 
yhteyden sulkemista. 

• Valitaan No, jos muutettuja asetteluita ei haluta tallentaa. 

• Valitaan Cancel jolla voidaan perua koko sulkemistapahtuma. 
Yhteyttä ei suljeta eikä parametrejä tallenneta.

Parametroinnin 
päättäminen

• Suljetaan parametroitava laite valitsemalla File → Close. 

Suora yhteys laitteelle sulkeutuu automaattisesti. Kaikki auki olevat 
laitteet sulkeutuvat tai näyttöön tulee ilmoitus jokaiselta laitteelta, jolla on 
vielä tallentamattomia asettelumuutoksia.
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7.6 Kauko-ohjaukset

7.6.1 Johdanto

Miehittämättömillä ja kauempana sijaitsevilla asemilla on 
käytännöllistä välittää SIPROTEC laitteiden kautta kauko-
ohjaukset valvomosta tai DIGSI 4 ohjelmasta. DIGSI 4 ohjelma 
mahdollistaa myös häiriötietojen ja -tallenteiden kaukoluvun 
nopeaa häiriöanalyysia varten. On mahdollista liittää laitteet 
useammalla eri tavalla kommunikaatioverkkoon, jossa voi olla eri 
tyyppisiä suojalaitteita. 

Valvomolla tarkoitetaan järjestelmää, jossa kenttälaitteet on 
kiinteästi kytketty kaukokäyttöjärjestelmään. Tietokoneella 
käyttäjä voi ottaa yhteyden laitteisiin poistumatta valvomosta.

DIGSI 4 Remote ohjelmalla eri ihmiset voivat ottaa yhteyttä 
valvomon ulkopuolelta eri paikoissa sijaitseviin asemiin. Yhteys 
voidaan muodostaa joko puhelinverkon, yhtiön sisäisen verkon, 
kiinteiden modeemiyhteyksien tai soittomodeemiyhteyksien 
kautta. 

7.6.2 Kauko-ohjaus

Kauko-ohjaukset edellyttävät että kaikki ohjattavat laitteet on 
varustettu soveltuvalla sarjaliikenneväylällä. Käyttöön määritellyllä 
protokollalla varmistetaan että kaikki laitteet puhuvat samaa kieltä, 
jolloin laitteet on erotettu toisistaan yksilöllisin osoitenumeroin. 
Laitteet voidaan liittää ulkoiseen ohjausjärjestelmään ja siitä 
edelleen kaukokäyttöön, joko suorin tietoliikenneyhteyksin tai 
tietoväylään liitettynä. Riippuen topologiasta ja 
varmuusvaatimuksista, käytetään joko RS485 väylää, Ethernet 
väylää tai valokuituyhteyksiä. 

7.6.3 Kauko-ohjaukset DIGSI 4 ohjelmalla

Nykyään yleensä kaikki asemat ovat kauko-ohjattuja ja usein 
kauko-ohjaukset välitetään toimilaitteelle kenttälaitteiden kautta. 
Usein on tarpeen myös järjestää etähuoltoyhteys kauempana 
sijaitseville asemille. Tällöin käytetään usein 
puhelinmodeemiyhteyksiä.

Käytettävien modeemien valinta riippuu tiedonsiirtoyhteyksien ja 
liitettävien suojalaitteiden ominaisuuksista. Laitteet, joilla on paljon 
tietoa, (esim. SIPROTEC 4 laitteet) tulee liittää nopeilla 
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modeemeilla (esim. ISDN tai analoginen 56k). 

Nopeiden modeemien käyttö heikoilla tietoliikenneyhteyksillä ei 
kuitenkaan tuo mitään hyötyä. On suositeltavaa käyttää saman 
tyyppisiä modeemeja tiedonsiirtoyhteyden molemmissa päissä. 

Ethernet (intranet tai internet) yleistyy nopeasti ja se mahdollistaa 
nopean tiedonsiirtoyhteyden. Käytettävissä tätä tarkoitusta varten 
on "Ethernet modeemeja" tai "sarjaliikennehubeja" 
tiedonsiirtoyhteyden muodostamiseksi.

7.6.4 Analogiamodeemit

Analogiamodeemeja voidaan käyttää maailmanlaajuisesti kaiken 
tyyppisissä analogisissa verkoissa. 

Modeemisana muodostuu englannin kielisistä sanoista modulate 
ja demodulate. Digitaalinen signaali moduloidaan kantoaaltoon ja 
toisessa päässä eriytetään kantoaallosta takaisin digitaaliseen 
muotoon. Yhden merkin siirto vastapäähän kestää noin 60-80 ms 
ja aika on vakio. Yhden tavun (8N1=10 bittiä) 9600 baudin (bittiä/
s) nopeudella kestää noin 1 ms, eli tiedonsiirron kokonaisnopeus 
ei kaksinkertaistu kaksinkertaistamalla baudinopeus. Tästä johtuu 
suhteellisen pitkä tiedonsiirtoaika SIPROTEC 4 laitteiden tietoja 
siirrettäessä, jolloin siirtoaikaa lisäävät useat lyhyet 
lähetyssanomat ja niiden kuittaukset vasta-asemalta.

7.6.5 ISDN modeemit (terminaaliadapteri/ohjain)

"ISDN modeemeja" voidaan käyttää vain digitaalisessa 
kommunikaatioverkoissa, kuten Euro-ISDN.

Oikeastaan modeemi-sanan käyttö tässä yhteydessä ei ole oikein, 
koska varsinaista modulaatiota ei suoriteta. Tästä syystä näitä 
laitteita kutsutaankin terminaaliadaptereiksi tai ohjaimiksi. 
Tiedonsiirtoyhteys on nopeampi kuin analogiamodeemeilla, koska 
modulaatiota ei suoriteta. Yhden merkin tiedonsiirto vasta-
asemalle kestää noin 10 ms ja tämä aika on vakio. 64 kbaudin 
yhteydellä SIPROTEC 4 laitteet voivat käyttää luotettavasti 57.6 
kbaudin nopeutta.
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7.6.6 Ethernet modeemit

Ethernet on tullut tunnetuksi nopeasti laajenneen internetin kautta 
ja on ollut käytössä yrityksissä jo pidemmän aikaa. Jopa pienet 
yhtiöt käyttävät yhä laajemmin paikallisia verkkoyhteyksiä 
hyödyntäen luotettavia VPN yhteyksiä (Virtual Private Network). 
Tehokkaat palomuurit takaavat luotettavan yhteyden internettiin 
salasanoin ja monipuolisin salauksin varmennettuna. 

7.6.7 SIPROTEC 3 laitteet

SIPROTEC 3 laitteet käyttävät enintään 19.2kb 
liikennöintinopeutta ja niiden yhteydessä on suositeltavaa käyttää 
28.8 kb modeemeja. 
DIGSI 3 ohjelmiston tukemat modeemit (MT2834 ja LOGEM 928 
tai LGH28.8D) käyttävät 8E1 tiedonsiirtoformaattia ja takaavat 
luotettavan, nopean ja käyttäjäystävällisen yhteyden V3 suojille. 

Kun DIGSI 3 projekti liitetään DIGSI 4 projektiin, tulee tarvittava 
modeemiajuri asentaa ja modeemiasetukset sovittaa uuden 
tilanteen mukaiseksi. 

7.6.8 SIPROTEC 4 laitteet

SIPROTEC 4 laitteiden ja DIGSI 4 ohjelmiston myötä 
tiedonsiirtonopeus kasvoi 115 kb saakka ja siirrettävän tiedon 
määrä kasvoi oleellisesti. Nopeampi liikennöintiyhteys voidaan 
muodostaa analogiamodeemein, esim. MT5600 (7XV5800-
3xA00), ISDN modeemein LOGES 64k (7XV5810), uusilla 
Ethernet modeemeilla tai sarjaliikennehubeilla. SIPROTEC 4 
laitteiden kanssa liikennöinti on käyttäjäystävällisintä jos 
käytetään digitaalisia ISDN tai Ethernet modeemeja. 

7.6.9 SIPROTEC 3 ja SIPROTEC 4 laitteet

Jos SIPROTEC 3 laitteilla varustettu asema laajennetaan 
SIPROTEC 4 laittein ja käytössä on jo 28.8 kbaudin modeemit, 
tulee SIPROTEC 4 laitteilla asetella käyttöön samat 
liikennöintiparametrit (esim. 9600 8E1).  Nopeimmat 
modeemitkaan eivät voi kasvattaa suurinta tiedonsiirtonopeutta 
19200 baudia (SIPROTEC 3), koska kaikkien laitteiden tulee olla 
aseteltuna samaan baudinopeuteen.
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Tällöin voidaan toki SIPROTEC 4 laitteille järjestää nopeampi 
tietoliikenneyhteys liittämällä ne yhteen aktiivisella 
minitähtijakajalla (7XV5550-0xA00) ja nopeammalla modeemilla, 
sekä käyttämällä DIGSI 4 ohjelmistoa. Tällöin DIGSI 4 projektiin 
tuodaan kaikki liitettävät laitteet ja aktiivinen minitähtijakaja 
(kanavakytkin, channel switch). Tarvittaessa asennetaan uudet 
modeemiajurit ja määritellään tarvittavat modeemiasettelut (katso 
7XV5550 laitteen käyttöohje). 

Vaihtoehtoisesti käyttöön voidaan ottaa myös eri tyyppisiä 
Ethernet modeemeja tai sarjaliikennehubeja. 

DIGSI 4 ohjelmisto liikennöi nopeimmalla sallitulla 
baudinopeudella (esim. 57 kbaudia, 8N1); ja käytössä oleva 
modeemi sähköaseman päässä välittää liikenteen puskuroimatta 
suojalaitteille käyttäen niille määriteltyä baudinopeutta ja 
dataformaattia (esim. 9600 baudia 8E1).  

7.6.10 V1/2 laitteet

V 1/2 laitteet voidaan liittää myös DIGSI 4 projektiin tai luoda ne 
siellä. 

Koska näitä suojalaitteita ei voi varustaa yksilöllisin osoittein, tulee 
jokaiselta laitteelta käyttösarjaliikenneportista tuoda 
valokuitukaapeli laitteeseen liitetyltä muuntimelta aktiiviseen 
minitähtijakajaan (channel switch). 

Myös tässä yhteydessä voidaan käyttää useampia Ethernet 
modeemeja tai sarjaliikennehubeja (7XV5655). 

Jokaiselle suojalaitteelle tulee olla erillinen modeemi tai hubi. 
Releen käyttösarjaliikenneväylä voidaan liittää suoraan modeemin 
tai hubin RS232 sarjaliikenneväylään. 

7.6.11 Dataformaatti ja luotettava tiedonsiirto

Analogiamodeemi MT5600 ja kaupalliset internetmodeemit eivät 
enää tue käyttämäämme dataformaattia 8E1, tai niillä on teknisiä 
vaikeuksia käyttää sitä. 

Tämä sama pätee myös useammille ohjelmistotuotteille ja 
käyttöjärjestelmille, kuten esim. Windows. 

Dataformaatti 8N1 (8 databittiä, ei pariteettia, 1 stop bitti) on 
muodostunut standardiksi. 

Puuttuva pariteettibitti (virheen tunnistusbitti) on korvattu uusilla 
viantunnistus ja eliminointimenetelmillä tiedonsiirrossa käytetyissä 
modeemeissa. 
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Tätä kehitystä seuraten SIPROTEC 4 laitteet ja DIGSI 4 ohjelmisto 
on päivitetty tähän tiedonsiirtoformaattiin ja tarjoaa täten jopa 
paremman virheen tunnistusmenetelmän kuin 
tarkastussummalaskenta (CRC32) mahdollistaa. 

Uusissa projekteissa suosittelelemme käytettäväksi standardiksi 
muodostunutta 8N1 formaattia ja suurinta tiedonsiirtonopeutta 
57.6 kbaudia.

7.6.12 Hyväksyntä

Analogiamodeemit ovat laajalti käytössä ympäri maailman. Niiden 
käyttö julkisissa kommunikaatioverkoissa voi edellyttää kuitenkin 
maakohtaisen hyväksynnän. Useat modeemit on tuotekehitetty ja 
ne ovat soveltuvia käytettäväksi eri tyyppisissä 
tietoliikenneverkoissa, mutta siitä huolimatta maakohtainen 
hyväksyntä voi olla vaadittu. Laitteita tilattaessa tulee ottaa 
huomioon mahdolliset hyväksymisvaatimukset. Yksityiset verkot, 
esim. yrityksen sisäinen kommunikaativerkko, ei yleensä edellytä 
erillistä hyväksyntää.

Digitaaliset modeemit tai verkkoadapterit on suunniteltu 
käytettäväksi rajoitetusti kansallisesti tai kansainvälisesti (esim. 
Eurooppa) ja voivat täten toimia vain näillä alueilla. Myös tässä 
tapauksessa on mahdollista että laitteiden käyttö edellyttää 
alueellista hyväksyntää.

7.6.13 Laitteiden valinta

Kuten aiemmissa kappaleissa on kuvattu, on mahdollista toteuttaa 
tarvittava tietoliikenneyhteys useammalla tavalla, ottaen 
huomioon tiedonsiirtoverkon rakenne, haluttu tiedonsiirtonopeus 
ja luotettavuus näkökohdat. 

Modeemeilla on järjestelmässä keskeinen merkitys 
toiminnallisuuden ja liikennöintiominaisuuksiensa määrääminä, 
esim. käytettäessä modeemeja katkoksesta helposti häiriintyvien 
V3 laitteiden kanssa.

Olemme tarkastaneet yleisimmät sovellusvaihtoehdot ja 
testanneet ne suosittelemillamme komponenteilla, joita ovat 
DIGSI ohjelmistot, modeemit, tähtijakajat ja muut mahdolliset 
käytettävät konvertterit. 

Suositellut komponentit eri käyttötarkoituksiin on luettavissa 
"SIPROTEC Download Area" internetsivulta, jossa on myös 
yksityiskohtaiset sovellutusesimerkit (joitakin esimerkkejä on 
esitetty kappaleessa 7.6.15). 
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Määriteltyjen tietojen avulla helpotetaan oikeiden komponenttien 
valintaa, järjestelmän asettelua lyhyessä ajassa ja luotettavaa 
käyttöönottoa. 

www.siprotec.de → Applications → Remote Control 
Seuraavassa kappaleessa on esitetty tärkeitä kriteerejä 
valinnoille.

7.6.14 Valintakriteerit

Kauko-ohjaus vai 
huoltoyhteys?

Jos järjestelmä on liitetty kaukokäyttöön kaukovalvontamielessä, 
on tarpeen myös arvioida mahdollisen huoltoväyläyhteyden 
toteutus nyt tai tulevaisuudessa. Kauko-ohjaukset 
miehittämättömillä asemilla on vain ensiaskel 
käyttäjäystävälliseen toimintaan.

Optinen tähtiverkko 
vai sähköinen 
RS485 väylä?

Optinen tähtiverkko on luotettavin mahdollinen tiedonsiirtotapa 
kenttälaitteille sähköasemalla. Tätä suositellaan käytettäväksi jos 
käytettävyys on tärkeää suurimman mahdollisen luotettavuuden 
saavuttamiseksi tai jos kenttälaitteet on sijoitettu erilleen toisistaan 
pidemmin siirtoetäisyyksin tai esim. ne sijaitsevat eri 
rakennuksissa. 

RS485 väylää käytetään yleisesti samassa rakennuksessa tai 
huoneessa sijaitsevien laitteiden yhteenliittämiseksi, jolloin laitteet 
voivat olla sijoitettuna eri kaapeihin. Asemamodeemiin liityttäessä 
on erittäin suositeltavaa suorittaa liityntä optisesti erotettuna. 
Kaikki laitteet eivät ole varustettu RS485 väylin (katso Varusteet).

Ovatko 
suojalaitteet 
varustettavissa 
osoittein?

Kaikki SIPROTEC 3 ja SIPROTEC 4 laitteet voidaan varustaa 
yksilöllisin osoittein ja täten liikennöidä modulaarisen 7XV5300 
tähtijakajan, 7XV5450 minitähtijakajan tai RS485 väylien kautta. 

V1 tai V2 suojalaitteet eivät ole varustettavissa osoittein ja niiden 
liittäminen kaukokommunikaatioon tulee toteuttaa 7XV5550 
aktiivisella minitähtijakajalla tai Ethernet modeemeilla/7XV5655 
hubeilla.

Tärkeää:

Kaikki laitteet eivät ole varustettu valokuituväylin, mutta tarvittavat 
muuntimet ovat käytettävissä (katso varusteet).
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Sallivatko 
suojalaitteet 
liikennöinti-
katkoksia?

Jos kaikki laitteet sallivat liikennöintikatkoksia, esim. kaikki 
SIPROTEC 4 laitteet tai 7SA511/7SA513 versiosta V3.2x lähtien, 
niiden yhteydessä voidaan käyttää lähes mitä tahansa 
tähtijakajaan tai  RS485 väylään liitettyä modeemia (katso alla 
oleva ohje).

Jos muita laitteita on liitetty järjestelmään, suosittelemme 
käytettäväksi modeemeja 7XV5800/7XV5810.

Mitkä modeemit 
ovat suositeltuja?

Jos järjestelmässä on vain SIPROTEC 4 laitteita, suosittelemme 
analogisten 56k, ISDN tai Ethernet modeemien käyttöä riippuen 
käytettävissä olevasta puhelinverkosta. Kommunikaatioverkon 
tulee tukea nopeata tiedonsiirtoa.

Jos järjestelmään on liitetty SIPROTEC 3 laitteita, joilla suurin 
siirtonopeus on 19.2 kb tai kommunikaatioverkon laatu on heikko, 
on myös mahdollista käyttää "hitaita" 28.8 kb analogiamodeemeja. 

Suosittelemme käytettäväksi valmistamiamme komponentteja ja 
varsinkin modeemeja jotka olemme testanneet ja tiedämme niiden 
heikkoudet. Jos ongelmia kuitenkin esiintyy, voitte ottaa yhteyttä 
tekniseen tukeemme apua saadaksenne (katso alla oleva ohje). 

Mistä on 
mahdollista saada 
tukea?

Internetissä "SIPROTEC Download Area" sivulla on 
käyttöesimerkkejä (määrätyt esimerkit on esitetty kappaleessa 
7.6.15).

Esimerkkien avulla on helppo valita oikeat komponentit, asentaa 
laitteet vaivattomasti ja ottaa ne käyttöön luotettavasti. 

www.siprotec.de → Applications → Remote Control 

Mistä lisäapua PTD EA Services Puhelin +49 (0) 180 524 7000 
Sähköposti: Services@ptd.siemens.de 

7.6.15 Käyttöesimerkkejä

Kuvissa 7-11 ... 7-13 on esitetty valittuja käyttöesimerkkejä:

Viimeinen ohje:

Tekninen tukemme (Services) voi auttaa ainoastaan 7KV5800 ja 
7XV5810 modeemien käytössä, koska olemme testanneet ja 
suositelleet niiden käyttöä, eikä ole mahdollista antaa ohjeita eri 
valmistajien laitteille kaikkiin niihin liittyviin asetteluihin tai 
toiminnallisuuksiin.
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APPL_A_DIG4_SIP3-4_Ethernet-Modem_en_1.pdf

Kuva 7-11 SIPROTEC 3 ja 4 laitteiden etäyhteys Ethernet modeemilla
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APPL_E_DIG4_SIP4_LWL_KE64K_KE64k_1.pdf

Kuva 7-12 SIPROTEC 4 laitteiden etäyhteys ISDN-modeemilla 64k ja minitähtijakajalla
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APPL_A_DIG4_SIP4_RS485_KE64k_KE64k_oH_en.pdf

Kuva 7-13 SIPROTEC 4 laitteiden etäyhteys ISDN-modeemilla 64k ja RS485 väylällä
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PROFIBUS FMS
7.7 PROFIBUS FMS

Vaihtoehdot Seuraavat vaihtoehdot tulee ottaa huomioon:

PROFIBUS FMS ja SIMATIC NET ohjelmisto 05/2000 + SP2; katso 
kappale 7.7.1

PROFIBUS FMS ja SIMATIC NET ohjelmisto 11/2002 + SP1; katso 
kappale 7.7.2

SIMATIC NET NCM PC version määritely; katso kappale 7.7.3

7.7.1 PROFIBUS FMS ja SIMATIC NET ohjelmisto 05/2000 + SP2

Toteutus Kommunikaatioyhteys tietokoneen ja laitteen välille PROFIBUS FMS 
yhteydellä voidaan toteuttaa seuraavasti:

• Asennetaan laitteet

• Asennetaan ohjelmisto CP 5613 kortille

• Luodaan uusi master-järjestelmä

• Luodaan SIPROTEC 4 FMS Slave master-järjestelmään

• Tallennetaan asettelut

• Viedään ulos NCM tietokanta

• Asetellaan ohjelmointilaitteen tai PC-väylän ominaisuudet

• Valmistellaan käyttö ilman SICAM asemaa

• Valmistellaan käyttö SICAM aseman kanssa

• Tarkastetaan ja tarvittaessa muutetaan muuttujien osoitteet ja 
pituudet

• Muodostetaan PROFIBUS FMS yhteys

• Suljetaan PROFIBUS FMS yhteys

7.7.1.1 Laitteiden asennus

PROFIBUS FMS liikennöintiyhteyden muodostamiseksi tulee 
tietokoneelle asentaa CP 5613 kommunikaatioprosessorimoduli. 
Lisätietoja modulin asentamisesta, sekä PROFIBUS FMS verkon 
fyysisestä toteutustavasta on annettu CP 5613 
kommunikaatioprosessorimodulin käyttöohjeessa.
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7.7.1.2 PROFIBUS FMS ajurin ja COM PROFIBUS ohjelman asennus

Asennetaan ajuri CP 5613 kommunikaatioprosessorille ja  COM 
PROFIBUS ohjelma PROFIBUS  FMS yhteyden määrittelemiseksi. 

Toimitaan seuraavasti: 

• Sijoitetaan SIMATIC NET Software (05/2000 + SP2) CD tietokoneen 
CD-ROM asemaan ja käynnistetään setup.exe tiedosto. 

• Valitaan Install SIMATIC NET Software ja seurataan 
asennusohjelman ohjeita.

• Valitaan PB FMS-5613 V2.1 vaihtoehto SIMATIC NET Setup: 
ikkunassa Components kentässä ja painetaan Next painiketta. 

DIGSIKOM074a.gif

Kuva 7-14 SIMATIC NET Setup:,  asennettavien komponenttien valintaikkuna

• Onnistuneen asennuksen jälkeen käynnistetään käyttöjärjestelmä 
uudelleen. 

Ohje:

Jos kommunikaatioprosessoria CP 5613 halutaan käyttää yhdessä 
SIMATIC NET Software (05/2000 + SP2) kanssa, tulee hotfix asentaa 
levykkeeltä. Tällöin tarvittaessa tulee ottaa yhteyttä A&D osaston 
tekniseen tukeen.
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Ajureiden asennus SIMATIC NET ohjelmiston asennuksen yhteydessä CP 5613 
kommunikaatioprosessorin ajurit kopioidaan tietokoneen kovalevylle. 
Ajuri asennetaan järjestelmään, jotta CP 5613 
kommunikaatioprosessorimoduli olisi käytettävissä.

• Valitaan Windows käynnistysvalikosta Settings → Control Panel. 
Kaksoisklikataan Control Panel ikkunassa PG/PC interface ikonia. 

Näyttöön aukeaa Setting the PG/PC Interface ikkuna.

DIGSIKOM014a.gif

Kuva 7-15 PG/PC väylän asettelut

• Painetaan Select painiketta. 

Install / Remove Interfaces ikkuna aukeaa näytölle.
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DIGISKOM075a.gif

Kuva 7-16 Väylien asentaminen ja poistaminen

• Valitaan CP5613/CP5614 Select valintakentästä ja painetaan Install 
painiketta. 

• Seuraavassa ikkunassa valitaan asennettavan 
kommunikaatioprosessorin tyyppi. 

• Painetaan OK painiketta.

Ajurit on nyt asennettu. Windowsin määrittelemät resurssit esitetään 
näytössä kun asennus on päättynyt onnistuneesti. 

• Painetaan Close painiketta Install / Remove Interfaces ikkunassa. 

Näyttöön aukeaa ikkuna jossa kysytään halutaanko uudet määrittelyt 
aktivoida käyttöön käynnistämällä käyttöjärjestelmä uudelleen. Jos muita 
asetteluita halutaan vielä suorittaa, ei ole syytä suorittaa 
käyttöjärjestelmän uudelleen käynnistystä vielä. 

• Yllä mainitusta syystä painetaan Cancel painiketta. 

• Painetaan OK painiketta Setting the PG/PC interface ikkunassa. 
Tällöin ikkuna sulkeutuu.
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7.7.1.3 Uuden master-järjestelmän luonti

CP 5613 kommunikaatioprosessorimodulin ominaisuudet määritellään 
COM PROFIBUS ohjelmalla. Lisätietoja toiminnasta on esitetty COM 
PROFIBUS käyttöohjeessa. SIMATIC NET Software (05/2000 + SP2) 
CD:llä on COM PROFIBUS V5.0 ohjelma. Windows 2000 
käyttöjärjestelmä edellyttää kuitenkin version V5.1 käyttöä. Tällöin tulee 
ottaa yhteyttä A&D osaston tekniseen tukeen.

DIGSI® 4 ohjelmisto toimii PROFIBUS FMS verkossa masterina. Kun 
DIGSI® 4 ohjelma liitetään PROFIBUS FMS verkkoon CP 5613 
kommunikaatioprosessorimodulilla, tulee ensin luoda uusi master-
järjestelmä. 

Toimitaan seuraavasti: 

• Käynnistetään COM PROFIBUS ohjelma. 

• Valitaan ja siirretään (Drag & drop) FMS masteri CP5613/CP5614 
valintalistalta työskentelyalueelle (katso kuva 7-17 ).

• Valitaan valikosta Object properties... toiminta:

DIGSIKOM001a.gif

Kuva 7-17 Uusi master-järjestelmä

Väyläosoitteen ja 
asemanimen 
määrittely

• Valitaan PROFIBUS osoite ja aseman nimi FMS master parameters 
ikkunassa. Käyttöön tulee valita ainoastaan parillisia osoitteita (tässä 
tapauksessa "2").
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DIGSIKOM001b.gif

Kuva 7-18 FMS master parametrit

• Asettelut hyväksytään OK painikkeella.
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7.7.1.4 SIPROTEC 4 FMS orjan (Slave) liittäminen master-järjestelmään

SIPROTEC 4 laitteet, jotka kommunikoivat DIGSI® 4 ohjelman kanssa 
PROFIBUS FMS verkossa, ovat orjia (slave). Tästä syystä kaikki 
SIPROTEC 4 FMS laitteet tulee liittää master-järjestelmään. 

Toimitaan seuraavasti: 

• Kaksoisklikataan SIPROTEC 4 laitetta valintaluettelossa sen 
siirtämiseksi työskentelyalueelle. Valitaan symboli jonka tyyppi 
vastaa käyttöön tulevaa yhteystapaa.

DIGSIKOM004a.gif

Kuva 7-19 SIPROTEC 4 laite liitettynä orjaksi

• Valitaan Object properties... valikosta.

DIGSIKOM001b.gif

Kuva 7-20 FMS aseman parametrit
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• Valitaan PROFIBUS osoite ja aseman nimi FMS station parameters 
ikkunassa. Käyttöön tulee valita ainoastaan parillisia osoitteita (tässä 
tapauksessa "4").

• Asettelut hyväksytään OK painikkeella.

Yhteyden 
muodostaminen

• Valitaan CP5613/CP5614 symboli työskentelyalueelta.

• Valitaan Object properties... valikosta.

• Valitaan Connections FMS master parameters ikkunassa. 

Edit FMS Connections ikkuna avautuu näytölle. 

DIGSIKOM010a.gif

Kuva 7-21 FMS yhteyden määrittely

• Painetaan New painiketta. 

Ohje:

Määritelty PROFIBUS osoite tulee kirjoittaa ylös. Vastaava osoite tulee 
määritellä kommunikaatioparametrinä DIGSI® 4 ohjelmassa (katso 
kappale 7.7.1.8 ja kappale 7.7.1.9).
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DIGSIKOM010b.gif

Kuva 7-22 FMS partneriaseman valinta

• Valitaan luotu FMS partneriasema.

• Hyväksytään asettelyt käyttöön OK painikkeella. Määrittelyikkuna 
sulkeutuu.

 

• Luodaan kaikille laitteille SIPROTEC 4 FMS slave objekti 
PROFIBUS FMS verkossa liikennöintiä varten.

Ohje:

Suoritetut määrittelyt tulee kirjoittaa ylös. Ne tulee asetella DIGSI® 4 
ohjelmassa kommunikaatioparametrejä määriteltäessä (katso kappale 
7.7.1.8 ja kappale 7.7.1.9).
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7.7.1.5 Asetteluiden tallentaminen

Master-järjestelmän asettelut tulee tallentaa.

Toimitaan seuraavasti: 

• Valitaan File → Save As, jolloin näyttöön aukeaa Save As ikkuna.

DIGSIKOM012a.gif

Kuva 7-23 Asetteluiden tallennus

• Määritellään tiedostolle nimi varustettuna PB5 päätteellä File name 
kentässä. Valitaan asema jolla tiedosto halutaan tallentaa ja 
vahvistetaan valinnat  OK painikkeella. 

Asettelut on nyt tallennettu.
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7.7.1.6 NCM tietokannan vienti

Määriteltyjen asetteluiden tulee olla käytettävissä NCM tietokantana, 
jotta CP 5613 kommunikaatioprosessori voisi käsitellä niitä. Tästä syystä 
NCM tietokanta tulee viedä erilliseen tiedostoon. 

Toimitaan seuraavasti: 

• Valitaan File → Export → NCM File, jolloin Save As ikkuna aukeaa 
näytölle.

DIGSIKOM013

Kuva 7-24 NCM tietokannan tallennus

• Syötetään nimi varustettuna ldb päätteellä File name kentässä. 
Nimen määrittelyssä tulee ottaa huomioon DOS rajoitukset. Valitaan 
asema jolla tiedosto halutaan tallentaa ja vahvistetaan valinnat  Save 
painikkeella. 

Asettelut on nyt tallennettu NCM tietokantaan.
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7.7.1.7 PG/PC väylän asettelut

Siirretään master-järjestelmän määrittelyt CP 5613 
kommunikaatioprosessorin NCM tietokantaan.

Toimitaan seuraavasti: 

• Valitaan Windows käynnistysvalikosta Settings → Control Panel. 
Kaksoisklikataan Control Panel ikkunassa PG/PC interface ikonia. 

Näyttöön aukeaa Setting the PG/PC Interface ikkuna.

DIGSIKOM014b.gif

Kuva 7-25 PG/PC väylän asettelut

• Valitaan CP5613_CP5614(COM PROFIBUS) vaihtoehto Interface 
parameter set used kentässä, jolloin siitä tulee aktiivinen PROFIBUS 
FMS väylä. 

• Valitaan CP_L2_1 alasvetovalikosta Access point of application 
kentässä.
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Ominaisuudet • Painetaan Properties painiketta. 

Näyttöön aukeaa Properties - CP5613_5614(PROFIBUS) ikkuna. 

• Avataan FMS/DP Protocol sivu.

DIGSIKOM015a.gif

Kuva 7-26 Ominaisuudet - CP5613_5614(PROFIBUS), 
FMS/DP-Protocol sivu

FMS:n aktivointi • Aktivoidaan Activate FMS valintaruutu. Activate DP valintaruutu ei 
saa olla valittuna.

• FMS/DP Database kentässä syötetään NCM tiedoston nimi ja 
tallennuspolku kokonaisuudessaan tai haetaan tiedosto hakemistosta 
Browse-toiminnalla. 
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Uudelleen asettelu 
ja käynnistys

• Avataan Mode sivu ja klikataan Restart painiketta. Tämä kuittaa 
PC:n ja käynnistää sen uudelleen. 

Toiminnan vaiheet esitetään ikkunassa olevassa kentässä.

DIGSIKOM018a.gif

Kuva 7-27 Ominaisuudet ikkuna, Mode sivu

• Painetaan OK painiketta. Painetaan myös OK painiketta Setting the 
PG/PC interface ikkunassa.
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7.7.1.8 Käytön valmistelu ilman SICAM ohjausjärjestelmää

Seuraavassa on kuvattu kuinka PROFIBUS FMS verkon 
kommunikaatioparametrit tulee määritellä, kun kommunikoidaan vain 
DIGSI® 4 ohjelmiston ja SIPROTEC 4 laitteiden kanssa: 

• Avataan DIGSI® 4 projekti. 

• Valitaan SIPROTEC 4 laite ja avataan oikealla hiiripainikkeella 
avautuvasta valikosta Object properties toiminta. 

• Avataan FMS / IEC setting sivu Properties - SIPROTEC 4 device 
ikkunassa.

DIGSIKOM058a.gif

Kuva 7-28 Ominaisuudet - SIPROTEC 4 device, FMS / IEC setting sivu

• Asetellaan PROFIBUS FMS address ja Communication reference 
CR kuten ne tuli määriteltyä master-järjestelmän luonnin yhteydessä 
(katso kappale 7.7.1.4).

VFD nimi DIGSI® 4 ohjelmistoa varten luodaan automaattisesti VFD 
name kenttään. Sitä ei saa muuttaa. 

Käytetty liikennöintiprosessori on valittu PG/PC interface määrittelyiden 
yhteydessä (katso kappale 7.7.1.7).

• Valitut määrittelyt hyväksytään OK painikkeella. 
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7.7.1.9 Käytön valmistelu SICAM ohjausjärjestelmän kanssa

Jos SIPROTEC laitteet tullaan liittämään SICAM ohjausjärjestelmään, 
tulee DIGSI® 4 ohjelmiston lisäksi tietokoneelle olla asennettuna 
täydellinen STEP 7 ohjelmisto. Lisätietoja toiminnoista on esitetty 
SICAM SAS ja STEP 7 käyttöohjeissa. 

Toimitaan seuraavasti: 

• Käynnistetään SIMATIC Manager ohjelma ja avataan kyseessä oleva 
projekti. 

• Valitaan View → Component view projektin komponettinäkymän 
aktivoimiseksi.

• Valitaan SIPROTEC 4 laite ja oikealla hiiripainikkeella avautuneesta 
valikosta valitaan Object properties toiminta, jolloin Properties - 
SIPROTEC 4 device ikkuna aukeaa näytölle. Avataan PROFIBUS 
FMS Connections sivu.

DIGSIKOM019a

Kuva 7-29 Ominaisuudet - SIPROTEC 4 device, PROFIBUS FMS connections 
sivu

Liitynnän 
lisääminen

• Valitaan New ja avataan Parameters sivu Properties - PROFIBUS 
interface ikkunassa. Näytössä esitetään kaikki käytössä olevat 
PROFIBUS FMS aliverkot nimineen ja liikennöintinopeuksineen.
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DIGSIKOM020a

Kuva 7-30 Ominaisuudet - PROFIBUS interface, Parameters sivu

Aliverkon valinta • Valitaan aliverkko, johon SIPROTEC 4 laite halutaan liittää. 

• Tarkastetaan verkon profiili. Tämä voidaan tehdä painamalla 
Properties painiketta ja valitsemalla avautuvasta Properties - 
PROFIBUS ikkunasta Network Settings sivu, jossa Universal (DP/
FMS) tulee olla valittuna Profile kentässä.

DIGSIKOM021a

Kuva 7-31 PROFIBUS ominaisuudet, Network Settings sivu

• Painetaan OK painiketta.
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• Määritellään PROFIBUS FMS osoite, joka aseteltiin aiemmin master-
järjestelmän luonnin yhteydessä Properties - PROFIBUS Node  
ikkunan Address kenttään.

• Valitut määrittelyt hyväksytään OK painikkeella. 

• Painetaan OK painiketta Properties - SIPROTEC 4 device ikkunan 
FMS / IEC setting sivulla määriteltyjen yhteyksien hyväksymiseksi.

PG/PC objektin 
lisääminen

Seuraavaksi lisätään PG/PC objekti projektiin DIGSI® 4 toimintojen 
liittämiseksi projektin rakenteeseen. 

Toimitaan seuraavasti: 

• Avataan projekti ja valitaan Insert → Station → 
7 PG/PC. 

• Määritellään nimi DIGSI PC luodulle objektille ja avataan Object 
Properties jolloin näyttöön aukeaa Properties - PG/PC ikkuna. 

• Avataan Interfaces sivu.

DIGSIKOM024a

Kuva 7-32 Ominaisuudet - PG/PC, Interfaces sivu

• Painetaan New painiketta. 

Näyttöön aukeaa New Interface - Select Type ikkuna. 
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DIGSIKOM027a

Kuva 7-33 Uusi liikennöintiväylä - tyypin valinta

• Valitaan PROFIBUS ja hyväksytään valinta OK painikkeella. 

Näyttöön aukeaa Properties - PROFIBUS Node ikkuna.

• Avataan Settings sivu. Tällä sivulla on esitetty kaikki käytettävissä 
olevat PROFIBUS FMS aliverkot nimineen ja 
liikennöintinopeuksineen.

• Valitaan aliverkko, johon DIGSI® 4 tietokone halutaan liittää. 

• Tarkastetaan liikennöintiprofiili Properties - PROFIBUS ikkunan 
Network Settings sivulta. Valittuna tulee olla Universal DP/FMS 
vaihtoehto. 

• Painetaan OK painiketta. 

• Määritellään PROFIBUS FMS osoite, joka aseteltiin aiemmin master-
järjestelmän luonnin yhteydessä Properties - PROFIBUS Node 
ikkunan Address kenttään.

• Valitut määrittelyt hyväksytään OK painikkeella. 

• Painetaan OK painiketta Properties - SIPROTEC 4 device ikkunan 
FMS / IEC setting sivulla määriteltyjen asetteluiden hyväksymiseksi.

• Avataan Properties - PG/PC ikkunan Assignment sivu.
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DIGSIKOM026a

Kuva 7-34 Ominaisuudet - PG/PC, Assignment sivu

• Valitaan PROFIBUS interface(1) vaihtoehto Configured Interfaces 
kentässä ja CP5613_5614(PROFIBUS) vaihtoehto Interface 
Parameter Assignments in the PG/PC kentässä. 

• Painetaan Assign painiketta ja tämän jälkeen OK painiketta.
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Verkon rakenteen 
esitys

Aktivoidaan verkon graafinen rakennekuva määrittelyiden 
tarkastamiseksi. 

• Kaksoisklikataan PROFIBUS objektia. 
 

DIGSIKOM028

Kuva 7-35 Esimerkkinä SICAM ohjausjärjestelmällä ja DIGSI tietokoneella varustetun verkon rakenne

Master-
järjestelmän 
päivitys

• Laajennetaan master-järjestelmää SICAM ohjausjärjestelmällä. 
Tällöin käynnistetään COM PROFIBUS ohjelma ja avataan tiedosto 
(.PB5), joka luotiin master-järjestelmän määrittelyiden yhteydessä.

• Valitaan CP 5613 objekti vasemmalla hiiripainikkeella. Näyttöön 
aukeaa FMS Station Parameters ikkuna. 

• Valitaan valikosta Object properties... toiminta.

DIGSIKOM001b.gif

Kuva 7-36 FMS aseman parametrit

• Syötetään PROFIBUS FMS osoite ja hyväksytään valinta OK 
painikkeella. 
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Master-
järjestelmän 
tallennus ja vienti

• Tallennetaan master-järjestelmä samalla nimellä samaan paikkaan 
kuin alkuperäinen tiedostokin ja viedään NCM tietokanta erilliseen 
tiedostoon. 

7.7.1.10 Muuttujaosoitteiden ja pituuksien tarkastus ja muuttaminen

Muuttujat Variable 1 ja Variable 2 sisältävät tietoa joka on tarpeen 
tietojen siirtämiseksi PROFIBUS FMS verkossa. Master Ready 
muuttujaa, jolla on esimääritelty arvo, käytetään kun PROFIBUS FMS 
väylä tiedonsiirtoa varten on valmiina.

Nämä muuttujat voidaan tarkastaa seuraavasti:

• Avataan laite ja kaksoisklikataan Interfaces objektia. 

• Valitaan Interface Settings ikkunassa PROFIBUS FMS on the PC 
sivu.

DIGSIKOM064a

Kuva 7-37 Väylän asettelut, PROFIBUS FMS on the PC sivu

Ohje:

Yleensä muuttujia ei tarvitse muuttaa. Length määrittelyn tulee vastata 
laitteen ominaisuuksia.
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Arvot Write index kentässä ovat muuttujien Variable 1, Variable 2 ja 
Master ready osoitteita. 

Arvot Read index kentässä ovat muuttujien Variable 1 ja Variable 2 
osoitteita. 

Asettelut Length kentässä määrittelevät muuttujien Variable 1 ja 
Variable 2 pituudet. Niiden tulee olla samoja kuin PROFIBUS FMS 
on the device sivun asettelut. 

Laitteen väylän 
parametrit

• Avataan PROFIBUS FMS on the device sivu.

DIGSIKOM061

Kuva 7-38 Väyläasettelut, PROFIBUS FMS on the device sivu

Asettelu Length variable 1 kentässä määrittelee muuttujan Variable 
1 pituuden. Sen tulee olla sama kuin PROFIBUS  FMS on the PC 
sivulla oleva asetus. 

Asettelu Length variable 2 kentässä määrittelee muuttujan Variable 
2 pituuden. Sen tulee olla sama kuin PROFIBUS  FMS on the PC 
sivulla oleva asetus.

Ohje:

Yleensä muuttujia ei tarvitse muuttaa. 
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7.7.1.11 PROFIBUS FMS yhteyden muodostus

PROFIBUS FMS yhteys voidaan muodostaa seuraavasti:

• DIGSI® 4 projektissa valitaan SIPROTEC 4 laite tai SIPROTEC 4 
variantti ja valitaan edelleen  Device > Open. 

digsikom049a.tif

Kuva 7-39 Laitteen avaaminen

• Valitaan PROFIBUS FMS vaihtoehto Online yhteyden 
muodostamiseksi ja hyväksytään valinta OK painikkeella.
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7.7.1.12 PROFIBUS FMS yhteyden sulkeminen

Aktiivinen PROFIBUS FMS yhteys voidaan sulkea käsin tai aikaohjatusti. 

SIPROTEC 4 
laitteen sulkeminen

• Valitaan File → Close SIPROTEC laitteen sulkemiseksi. PROFIBUS 
FMS yhteys sulkeutuu automaattisesti. 

• Vastataan näyttöön tulleeseen kysymykseen halutulla tavalla.

Jos useampia laiteikkunoita on auki, kohdistuvat toimenpiteet aktiiviseen 
ikkunaan. 

Laitteen 
parametroinnin 
päättäminen

• Suljetaan DIGSI® 4 laite-editori valitsemalla File → Exit. Tällöin 
sulkeutuvat kaikki laiteikkunat ja mahdollisesti aktiivisena olevat 
PROFIBUS FMS yhteydet. Vastataan kunkin laitteen sulkeutuessa 
näyttöön tuleviin kysymyksiin. 
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7.7.2 PROFIBUS FMS V6.1 ja SIMATIC NET ohjelma 11/2002 + SP1

Toteutus Kommunikaatioyhteys tietokoneen ja laitteen välille PROFIBUS FMS 
yhteydellä voidaan toteuttaa seuraavasti:

• Asennetaan laitteet

• Asennetaan ohjelmisto (SIMATIC NET ohjelma 11/2002 tai 07/2001, 
STEP 7 (täydellinen versio), DIGSI).

• Määritellään PC asema.

• Luodaan projekti.

• Luodaan SIPROTEC laite.

• Määritellään PROFIBUS verkko.

• Ladataan määrittelytiedot CP5613 modulille.

• Muodostetaan yhteys PROFIBUS FMS verkon kautta.

• Suljetaan PROFIBUS FMS yhteys.

• Analysoidaan yhteyden muodostuksessa mahdollisesti esiintulleet 
ongelmat.

7.7.2.1 Laitteiden asennus

PROFIBUS FMS liikennöintiyhteyden muodostamiseksi tulee 
tietokoneelle asentaa CP 5613 kommunikaatioprosessorimoduli. 
Lisätietoja modulin asentamisesta, sekä PROFIBUS FMS verkon 
fyysisestä toteutustavasta on annettu CP 5613 
kommunikaatioprosessorimodulin käyttöohjeessa.

Huomio:

Aiemmilla SIMATIC NET ohjelmistoversioilla tehdyt määrittelyt eivät ole 
yhteensopivia.

Ohje:

Asennus CD:llä on seuraavat versiot

• V6.1 CD 11/2002 + SP1 (Windows XP ja Windows 2000)

• V6.0 CD 07/2001 + SP5 + HF2 (ei voida käyttää DIGSI 4.50 kanssa).
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7.7.2.2 SIMATIC NET V6.1, STEP 7 (täydellinen versio) ja DIGSI ohjelmien asennus

Asennetaan ohjelmistot. Lisätietoja asennuksesta on esitetty kunkin 
ohjelmiston käyttöohjeissa ja kappale 7.7.1.2. 

Seuraavat ohjeet tulee ottaa huomioon:

Ohje:

• STEP 7 ohjelmaan tulee asentaa myös NCM komponentit 
PROFIBUS väylää varten.

• SIMATIC NET V6.1 ohjelmistosta tulee asentaa vain SIMATIC NET 
PC software.

• DIGSI ohjelman voi asentaa ennen SIMATIC NET V6.1 ohjelmaa.

Huomio:

SICAM käyttäjille: DIGSI ja Recpro ohjelman samanaikainen käyttö 
yhdellä tietokoneella on mahdollista, mutta tällöin DIGSI yhteys tulee 
parametroida käsin.
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7.7.2.3 PC aseman määrittely

PC asema määritellään seuraavasti: 

• Valitaan SIMATIC NET → Settings → Set PC Station. Näyttöön 
aukeaa Configuration Console ikkuna.

• Valitaan hakemistopuusta CP5613/CP5614 moduli ja avataan 
General sivu.

DIGSIKOM138.tif

Kuva 7-40 PC aseman määrittely

• Valitaan Configured Mode vaihtoehto Mode of the module 
kentässä.

• Hyväksytään määrittelyt Apply painikkeella.
418 SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


PROFIBUS FMS
• Käynnistetään Station Configuration Editor toiminta. CP5613 
kommunikaatioprosessorimoduli on jo lisättynä taulukkoon.

DIGSIKOM139.gif

Kuva 7-41 Aseman määrittelyeditori

• Painetaan Station Name... painiketta aseman nimen 
määrittelemiseksi:

DIGSIKOM140.gif

Kuva 7-42 Aseman nimen määrittely

• Määritelty nimi tallennetaan OK painikkeella.
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• Painetaan Add... painiketta Station Configuration Editor ikkunassa 
DIGSI ohjelman määrittelemiseksi.

DIGSIKOM141.tif

Kuva 7-43 Komponentin lisääminen

• Hyväksytään määrittely OK painikkeella ja poistutaan myös Station 
Configuration Editor ikkunasta OK painikkeella.
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7.7.2.4 Projektin luominen

Projekti luodaan SIMATIC Manager ohjelmassa seuraavasti:

• Käynnistetään SIMATIC Manager ohjelma.

• Valitaan File → New ja annetaan projektille nimi.

PC aseman 
liittäminen

• Valitaan toiminta Insert → Station → SIMATIC PC Station PC 
aseman lisäämiseksi projektiin.

• Oikealla hiiripainikkeella avautuvasta valikosta valitaan Object 
properties toiminta ja annetaan PC asemalle sama nimi kuin Station 
Configuration Editor ohjelmassakin.

DIGSIKOM142.gif

Kuva 7-44 Ominaisuudet - SIMATIC PC Station

• Suljetaan Properties - SIMATIC PC Station määrittelyikkuna OK 
painikkeella.

• Avataan PC asema kaksoisklikkaamalla objektia.

• Avataan konfiguraatiotoiminta Configuration kaksoisklikkaamalla 
objektia.
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Kommuni-
kaatiopro-
sessorin 
lisääminen

• Lisätään CP kortti valitse ja siirrä (Drag & Drop) menetelmällä PC 
aseman Hardware Catalog ikkunassa.

DIGSIKOM061

Kuva 7-45 SIMATIC Manager, HW Config - SIMATIC_PC_Station

• Valitaan CP5613 modulin Object properties ja määritellään  
PROFIBUS liitynnän tyypiksi General sivulla.
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DIGSIKOM144.gif

Kuva 7-46 Ominaisuudet - CP 5613

• Painetaan Properties painiketta.

• Määritellään aliverkko ja modulin osoite Properties - PROFIBUS 
interface CP5613 ikkunassa.

DIGSIKOM145.gif

Kuva 7-47 Ominaisuudet - PROFIBUS interface CP5613

• Painetaan Properties painiketta.
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• Määritellään tiedonsiirtonopeus ja profiili Properties - PROFIBUS 
ikkunassa Network Settings sivulla.

DIGSIKOM146.gif

Kuva 7-48 Ominaisuudet - PROFIBUS, Network Settings sivu

• Suljetaan Properties - PROFIBUS ikkuna OK painikkeella.

• Suljetaan Properties - PROFIBUS interface CP5613 ikkuna OK 
painikkeella.

• Avataan Operating Mode sivu Properties - CP5613 ikkunassa.
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DIGSIKOM147.tif

Kuva 7-49 Ominaisuudet - CP5613, Operating Mode sivu

• Avataan Options sivu Properties - CP5613 ikkunassa.

DIGSIKOM147_2.tif

Kuva 7-50 Ominaisuudet - CP5613, Options sivu

• Valitaan Time-of-Day Synchronization kentässä  Master 
vaihtoehto, jos halutaan käyttää tietokoneen aikaa PROFIBUS 
verkkoon liitetyillä laitteilla. Suljetaan ikkuna OK painikkeella.
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Sovelluksen 
lisääminen

• Käyttäjäsovellus (user application) lisätään valitse ja siirrä 
(Drag & Drop) menetelmällä PC aseman Hardware Catalog 
ikkunassa.

DIGSIKOM148.gif

Kuva 7-51 SIMATIC Manager, HW Config - SIMATIC_PC_Station: Käyttäjäsovelluksen lisääminen

 

• Valitaan sovelluksen valikosta Object properties toiminta ja valitaan 
edelleen Edit VFDs, joka sijaitsee FMS sivulla.

• Painetaan New painiketta uuden VFD (Virtual Field Device) objektin 
lisäämiseksi.

Ohje:

Sovelluksen nimen tulee olla sama kuin se on määritelty Station 
Configuration Editor ohjelmassa. Nimi on sama jos tiedot tuodaan XDB 
formaatissa ohjelmaan.

Ohje:

Määritellään CP5613 modulin nimi valitsemalla Object 
properties → Operating Mode.
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DIGSIKOM149.gif

Kuva 7-52 VFD objektin editointi

DIGSIKOM149_2.tif

Kuva 7-53 DIGSI 4 määrittely

Ohje:

DIGSI 4.5 versiosta lähtien VFD osoite on määritelty 
Options → Configure DIGSI 4, PROFIBUS FMS sivulla (katso kuva 7-
53). Sama nimi esiintyy eri paikoissa ja sen tulee olla sama kuin 
kuva 7-52 on määritelty.
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• Suljetaan Edit VFD määrittelyikkuna OK painikkeella.

• Suljetaan Object properties ikkuna OK painikkeella.

• Valitaan Station → Save and Convert määrittelyiden 
tallentamiseksi.

• Suljetaan hardware configuration ohjelma.

Varmistus että 
sovellusnimi on 
identtinen

• Valitaan Configuration sivu PC aseman Object properties 
ikkunasta.

DIGSIKOM149_3.tif

Kuva 7-54 Ominaisuudet - SIMATIC PC Station, Configuration sivu

• Tallennetaan konfigurointitiedosto projektin XDBs hakemistoon OK 
painikkeella.

• Avataan PC asema Station Configuration Editor ohjelmaan (katso 
kuva 7-41) ja painetaan Import XDB painiketta määrittelyiden 
suorittamiseksi.

Ohje:

XDB tiedoston tuonti muuttaa Station Configuration Editor ohjelman 
toimintatilaksi OFFLINE.
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7.7.2.5 SIPROTEC laitteiden lisääminen

SIPROTEC laitteet lisätään seuraavasti:

• Valitaan Insert New Object → SIPROTEC Device ja lisätään haluttu 
laite projektiin Drag & Drop menetelmällä laitekatalogista (device 
catalog).

• Valitaan laitteen valikosta Object properties toiminta ja painetaan 
New painiketta PROFIBUS FMS sivulla.

• Valitaan aliverkko subnet kentästä Properties - PROFIBUS 
interface  ikkunassa.
Verkon osoitteeksi määritellään seuraava mahdollinen osoite 
Address kentässä.

DIGSIKOM150.gif

Kuva 7-55 Ominaisuudet - PROFIBUS interface

• Suljetaan Properties - PROFIBUS interface ikkuna OK painikkeella.
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• Valitaan FMS / IEC setting sivu Properties ikkunassa ja määritellään 
kommunikaatioparametrit.

DIGSIKOM058a.gif

Kuva 7-56 Ominaisuudet - SIPROTEC 4 device, FMS / IEC setting sivu
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7.7.2.6 PROFIBUS verkon määrittely

PROFIBUS verkko määritellään seuraavasti:

• Valitaan Options → Configure Network. NetPro ohjelma 
käynnistyy. Ohjelmassa on määritelty PC asema ja liitetyt SIPROTEC 
laitteet.

DIGSIKOM061

Kuva 7-57 NetPro ohjelma ja liitetyt komponentit

• Valitaan SIMATIC_PC_STATION objektin Application ruutu. 
Ohjelma lisää taulukon SIPROTEC laitteiden liittämiseksi.
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DIGSIKOM152.gif

Kuva 7-58 NetPro ohjelma ja määrittelytaulukko SIPROTEC laitteille

• Klikataan oikealla hiiripainikkeella ensimmäistä tyhjää kenttää Local 
ID sarakkeessa ja valitaan Insert new connection. Tällöin näyttöön 
aukeaa Insert New Connection ikkuna.
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DIGSIKOM153.tif

Kuva 7-59 Uuden yhteyden lisääminen

• Valitaan SIPROTEC laite Connection Partner kentästä, valitaan 
FMS connection vaihtoehto Connection kentästä ja aktivoidaan 
Display properties dialog valintaruutu.

• Hyväksytään määrittelyt Apply painikkeella. Tällöin näyttöön aukeaa 
Properties - FMS Connection ikkuna.
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DIGSIKOM154.gif

Kuva 7-60 Ominaisuudet - FMS connection

• Kirjataan CREF kentässä oleva numero ylös ja valitaan 
SIPROTEC4_CR2 (LSAP24) vaihtoehto Conn. profile kentässä.

• Painetaan OK painiketta. 

• Toistetaan nämä määrittelyt kaikille PROFIBUS verkkoon liitetyille 
SIPROTEC laitteille.

Ohje:

Uudessa projektissa kommunikaatioreferenssi (CREF) alkaa aina 
arvosta "3". Tämän numeron tulee olla sama kuin SIPROTEC laitteelle 
on määritelty (katso SIPROTEC laitteen Object properties ikkunasta 
Communication parameter sivulla oleva asettelu). 
Kommunikaatioreferenssi on yksilöllinen asettelu kaikille laitteille.
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DIGSIKOM155.gif

Kuva 7-61 NetPro ohjelma määritellyin SIPROTEC laittein

• Valitaan Network → Save and Convert määrittelyiden 
tallentamiseksi.

• Valitaan Convert and check everything vaihtoehto ja painetaan  OK 
painiketta. 
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7.7.2.7 Konfigurointitietojen lataaminen

Konfigurointitiedot ladataan PLC CP5613 modulille seuraavasti:

• Käynnistetään Station Configuration Editor toiminta.

• Painetaan Change Operating Mode painiketta (aktiivisen vain  
OFFLINE tilassa) ja vastataan näyttöön tulevaan kysymykseen Yes 
painikkeella. ONLINE käyttötila aktivoituu.

DIGSIKOM155_2.tif

Kuva 7-62 Station Configuration Editor - ONLINE käyttötila

• Siirrytään NetPro sovellukseen.

• Klikataan SIMATIC PC station ikonia.

• Valitaan PLC → Download to current project → Selected 
stations.

Huomio:

Tämä toiminta edellyttää että ONLINE käyttötila on voimassa.
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• Vastataan kysymykseen Yes, jos kommunikaatioprosessorille 
halutaan ladata uudet tiedot.

DIGSIKOM156.tif

Kuva 7-63 Konfigurointitietojen latauksen yhteydessä avautuva kysymysikkuna 

• Suljetaan NetPro sovellus.

7.7.2.8 Asetteluiden tarkastus

Seuraavat asettelut tulee tarkastaa, jotta voitaisiin varmistua että ne on 
aseteltu oikein:

Laitteen ominaisuudet

− CREF numero

− VD nimi

− Käytetty prosessorimoduli (Access point)

PG/PC väylän asettelut (katso kappale 7.7.1.7)

− Sovelluksen kommunikaatioprosessori

− Käytössä olevan väylän asettelut
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DIGSIKOM157.gif

Kuva 7-64 Ominaisuudet - FMS connection
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7.7.2.9 PROFIBUS FMS yhteyden luonti

PROFIBUS FMS yhteys luodaan seuraavasti:

• DIGSI® 4 projektissa valitaan SIPROTEC 4 laite tai SIPROTEC 4 
variantti ja valitaan edelleen  Device > Open.

digsikom049a.tif

Kuva 7-65 Laitteen avaaminen

• Valitaan PROFIBUS FMS vaihtoehto Online yhteyden 
muodostamiseksi ja hyväksytään valinta OK painikkeella.
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7.7.2.10 PROFIBUS FMS yhteyden sulkeminen

Aktiivinen PROFIBUS FMS yhteys voidaan sulkea käsin tai aikaohjatusti. 

SIPROTEC 4 
laitteen sulkeminen

• Valitaan File → Close SIPROTEC laitteen sulkemiseksi. PROFIBUS 
FMS yhteys sulkeutuu automaattisesti. 

• Vastataan näyttöön tulleeseen kysymykseen halutulla tavalla.

Jos useampia laiteikkunoita on auki, kohdistuvat toimenpiteet aktiiviseen 
ikkunaan. 

Laitteen 
parametroinnin 
päättäminen

• Suljetaan DIGSI® 4 laite-editori valitsemalla File → Exit. Tällöin 
sulkeutuvat kaikki laiteikkunat ja mahdollisesti aktiivisena olevat 
PROFIBUS FMS yhteydet. Vastataan kunkin laitteen sulkeutuessa 
näyttöön tuleviin kysymyksiin. 
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7.7.2.11 Diagnoositoiminnat

Jos yhteyden muodostuksessa esiintyy ongelmia, tulee seuraavat 
kohdat tarkastaa:

Väyläliityntä CP5613 prosessorimoduliin kiinnitetty liitin tulee olla terminoituna 
samalla tavoin kuin väylän viimeisellä laitteellakin oleva liitin.

Määrittelykonsoli Lisätietoja mahdollisista virheistä on esitetty määrittelykonsolissa 
(Configuration Console):

− Väylän tiedot
Kentässä on nähtävissä onko CP5613 liitetty renkaaseen ja 
esiintyykö virheitä.

DIGSIKOM158.tif

Kuva 7-66 Määrittelykonsoli, väylän tiedot
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− Väyläoliot (Bus Node)
CP5613 modulin tulee olla aktiivisena (active); muut väyläoliot voivat 
olla määriteltynä passiivisiksi (passive).

DIGSIKOM159.gif

Kuva 7-67 Määrittelykonsoli, väyläoliot

S7ONLINE 
toiminnalla väärä 
liityntä

Jos määrittelytietoja ei voida ladata kommunikaatiprosessorille, 
tarkastetaan että S7ONLINE kentässä on valittu oikea liityntä:

DIGSIKOM160.gif

Kuva 7-68 Määrittelykonsoli, liitynnät

• Jos määrittely PC internal (local) ei ole määriteltynä, 
kaksoisklikataan objektia.

• Valitaan liitynnäksi yllä mainittu vaihtoehto Properties of S7Online 
ikkunassa ja suljetaan ikkuna OK painikkeella.
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DIGSIKOM049

Kuva 7-69 S7Online ominaisuudet
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7.7.3 SIMATIC NET NCM PC version määritely

Jos käytettävissä ei ole SIMATIC STEP 7 ohjelmiston täydellistä 
versiota, toimitaan seuraavasti:

Määrittelyn 
edellytys

• Käytettävissä tulee olla kaksi tietokonetta.

Asennus • Asennetaan vain SIMATIC NET ohjelmiston NCM komponentti 
(SIMATIC NCM PC V5.2) ensimmäiseen tietokoneeseen.

• Asennetaan DIGSI ohjelmisto ja PROFIBUS kortti ajureineen toiseen 
tietokoneeseen.

Ensimmäisen 
tietokoneen 
määrittely

Määritellään NCM ensimmäiseen tietokoneeseen, PC asema 
kommunikaatioprosessorilla ja sovellus (katso myös kappale 7.7.2):

• Valitaan SIMATIC NCM PC MANAGER käyttöjärjestelmän 
käynnistys Start valikosta.

• Valitaan Insert → Station → 1 SIMATIC PC Station työaseman 
luomiseksi.

• Avataan Configuration toiminta.

• Määritellään CP5613 kommunikaatioprosessorimoduli.

• Luodaan uusi sovellus. Määritellään nimi sovelluksen ominaisuudet 
Properties ikkunassa, jolloin tulee huomioida että VFD numeron on 
oltava "1" FMS sivulla (katso kuva 7-52).

• Määritellään sovellus CP5613 kommunikaatioprosessorimodulin 
ominaisuudet Properties ikkunassa.

• Määrittely suljetaan Save + Convert.

• Valitaan Options → Configure Network, jolloin NetPro sovellus 
avautuu.

• Määritellään XDB vientitiedoston nimi PC aseman ominaisuudet 
Properties ikkunassa (katso kuva 7-54).

• Laitteiden lisääminen:
Valitaan Other station hakemisto oikealla puolella olevasta Stations 
ikkunasta ja sijoitetaan se verkkoon Drag & Drop menetelmällä.

• Määritellään sille nimi (esim. SIPROTEC + FMS numero + 
kommunikaatioreferenssi) aseman Properties ikkunassa General 
sivulla. 

• Painetaan New painiketta Interfaces sivulla aseman Properties 

Ohje:

Määrittely on lähes sama kuin kappale 7.7.2 on esitetty, joten ohjelmiston 
yksityiskohtainen kuvaus ei ole tarpeen.
444 SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


PROFIBUS FMS
ikkunassa ja valitaan PROFIBUS yhteystyypiksi. Painetaan OK 
painiketta. 

• Valitaan aliverkko subnet kentästä Properties - PROFIBUS 
interface  ikkunassa (katso kuva 7-55) ja määritellään laiteosoite. 
Painetaan OK painiketta.

• Valitaan PC Station objektin Application alue.

• Lisätään uusi liityntä. Tällöin valitaan laite ja liitynnän tyypiksi FMS 
Connection. Hyväksytään määrittely Apply painikkeella.

• Avataan FMS Connection toiminnan ominaisuudet (properties) ja 
valitaan asema sekä liitynnän profiili (katso kuva 7-60). Painetaan OK 
painiketta.

• Toistetaan nämä määrittelyt kaikille PROFIBUS verkkoon liitettäville 
SIPROTEC laitteille.

• Valitaan Network → Save and Convert ja vahvistetaan toiminta OK 
painikkeella.

• Käynnistetään Windows Explorer sovellus ja siirrytään projektin XDB 
hakemistoon 
(esim. Programs\Siemens\ SIMATIC.NCM\S7PROJ\Project\XDBs) ja 
kopioidaan XDB tiedosto levykkeelle.

Toisen tietokoneen 
määrittely

• Luodaan DIGSI 4 projekti ja lisätään tarvittavat SIPROTEC laitteet.

• Tarkastetaan määrittelyt Options → Configure DIGSI 4 valinnalla 
auenneesta ikkunasta PROFIBUS FMS sivulta (katso kuva 7-55).

• Tarkastetaan PROFIBUS osoite ja kommunikaatioreferenssi (CR) 
laitteen ominaisuudet ikkunassa (katso kuva 7-28). 

• Tuodaan XDB toiselle tietokoneelle Station Configuration Editor 
sovelluksessa (katso sivu 428).

Yhteyden 
muodostus

• Nyt yhteys voidaan muodostaa SIPROTEC laitteille.
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7.8 Muut protokollat

SIPROTEC 4 laitteilla voidaan käyttää versiosta 4.2 lähtien myös 
seuraavia liikennöintiprotokollia

PROFIBUS DP,

DNP 3.0 ja

MODBUS.

DIGSI® 4 ohjelmassa näitä liikennöintiprotokollia kutsutaan Other 
protocols termillä. 

Toteutus Näillä protokollilla voidaan määrittelyt ja yhteyden muodostus suorittaa 
seuraavasti:

• määritellään väylä DIGSI® 4 ohjelmistossa.

• Valitaan mapping-tiedosto ja editoidaan sitä.

• Määritellään informaatiot.

• Initialisoidaan SIPROTEC 4 laite.

Ohje:

Näitä liikennöintiprotokollia voidaan käyttää vain SIPROTEC laitteen ja 
ulkoisen ohjausjärjestelmän välillä. Näillä protokollilla ei voida luoda 
yhteyttä DIGSI® 4 ohjelmiston ja SIPROTEC 4 laitteiden välille.
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7.8.1 Järjestelmäväylän määrittely DIGSI 4 ohjelmassa

Määritellään järjestelmäväylä DIGSI® 4 ohjelmistossa. 

Toimitaan seuraavasti: 

• Avataan DIGSI® 4 ohjelma ja kyseessä oleva projekti. 

• Valitaan SIPROTEC 4 laite ja valitaan Object properties toiminta 
oikealla hiiripainikkeella auenneesta valikosta. 

• Valitaan Communications Modules sivu Properties - SIPROTEC 4 
device ikkunasta.

DIGSIKOM105

Kuva 7-70 Ominaisuudet - SIPROTEC 4 device, Communications Modules 
sivu

Järjestelmäväylän 
valinta

• Valitaan Other protocols vaihtoehto alasvetovalikosta. Tämän 
valinnan jälkeen L:... painike aktivoituu. Painetaan tätä painiketta. 
Näyttöön aukeaa Extended MLFB ikkuna.

DIGSIKOM106

Kuva 7-71 MLFB lisämääritetunnus
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Protokollan valinta Valitaan haluttu liikennöintiprotokolla ja fyysinen liikennöintimenetelmä. 

• Alemmasta alasvetovalikosta valitaan haluttu protokolla. Valinnan 
tulee vastata laitteeseen asennettua väylää ja 
kommunikaatioyhteyden tyyppiä.

Ylemmässä alasvetovalikossa on valittavissa vain vaihtoehto
 Protocols. 

• Valitut määrittelyt hyväksytään OK painikkeella. 

• Painetaan OK painiketta Properties - SIPROTEC 4 device 
ikkunassa määrittelyiden hyväksymiseksi.
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7.8.2 Mapping-tiedoston valinta ja editointi

DIGSI 4 tarjoaa yhden tai useamman vakiokonfiguraation valitulle 
protokollalle. Nämä tulee sovittaa kyseessä olevaan kohteeseen. 

Jos tarjolla on useampi mapping-tiedosto, valitaan tiedosto joka vastaa 
parhaiten käyttöön tulevaa kohdetta (katso kappale Mapping-tiedoston 
valinta). Käytettävissä olevat informaatiot eri protokollille on 
dokumentoitu eri kommunikaatioprofiilien SIPROTEC 4 käyttöohjeissa.

Mapping-tiedostojen dokumentit on tallennettu DIGSI 4 CDROM levyn 
...\MANUALS\Communication hakemistoon.

Suoritetaan protokollakohtaiset asettelut (katso kappale Asetteluiden 
määrittely).

PROFIBUS DP protokollalla määritellään informaatiot väylällä (katso 
kappale 7.8.3).

Toimitaan seuraavasti: 

• Avataan SIPROTEC 4 laite ja kaksoisklikataan Interfaces objektia. 
Mapping-tiedosto voidaan valita nyt Other protocols sivulla.

DIGSIKOM107

Kuva 7-72 Väylän asettelut – muut protokollat laitteella

Mapping-tiedoston 
valinta

• Valitaan mapping-tiedoston nimi Mapping file alasvetovalikosta. 
Valinta riippuu siitä kuinka järjestelmäväylä on määritelty Extended 
MLFB ikkunassa. 

Huomio:

DIGSI® 4 versiosta 4.2 lähtien PROFIBUS DP järjestelmäväylän 
määrittelyt suoritetaan mapping-tiedostossa. Kun jokin näistä mapping-
tiedostoista valitaan, päivittyvät SIPROTEC 4 laitteen asettelut. Jos 
alunperin on valittu jokin toinen tiedosto, parametroinnin alkuperäistä 
tilaa ei voida palauttaa. 
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Asetteluiden 
määrittely

• Määrätyt paramerit tulee määritellä käsin, kuten esimerkiksi valitun 
protokollan liikennöintinopeus. Tällöin parametrien nimet 
esiasetteluineen on esitetty Changeable area ikkunassa. Muutetaan 
tarvittavat asettelut käyttökohteen tarpeiden mukaisesti. 
Lisätietoja määrittelyistä on esitetty kunkin liikennöintiprotokollan 
SIPROTEC 4 käyttöohjeessa.

Asetteluiden 
hyväksyntä

• Asettelut hyväksytään OK painikkeella. 

DIGSI® 4 muuttaa laitetiedoston asettelut valitun mapping-tiedoston 
mukaisesti.

Virheilmoitukset Jos mapping-tiedoston asettelut on määritelty sallittujen rajojen 
ulkopuolelle, seuraa siitä virheilmoitus.

DIGSIKOM108

Kuva 7-73 Virheilmoitus mapping-tiedostossa suoritetusta virheellisestä 
asettelusta

• Poistetaan virheilmoitus näytöltä OK painikkeella. 

• Avataan Properties - SIPROTEC 4 device ikkuna uudelleen ja 
korjataan tarvittavat asettelut. Jos muu ei auta, ladataan 
vakioasettelut.

Ohje:

Käytettäessä PROFIBUS DP protokollaa, tulee PROFIBUS DP osoite 
määritellä Changeable area ikkunassa. Mitään asetteluita ei saa 
muuttaa FMS/IEC setting sivulla.

Ohje:

Muutettujen parametriarvojen oikeellisuus tarkastetaan. Jos 
kommunikaatio ei toimi, tarkastetaan muutetut asettelut.
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7.8.3 Informaatioiden määrittely

Mapping-tiedoston valinta esimäärittelee järjestelmäväylässä siirrettävät 
informaatiot. 

Jos on valittu mapping-tiedosto PROFIBUS DP väylälle, määrittelyitä 
voidaan muuttaa matriisissa vastaavasti kuten kappale 5.5.8 on kuvattu. 
Mapping-tiedostossa määriteltyjä informaatioita voidaan vaihtaa toisiin, 
mutta niiden lukumäärää ei voida muuttaa. 

Määrittely suoritetaan seuraavasti:

• Avataan SIPROTEC 4 laite ja kaksoisklikataan Configuration 
objektia määrittelymatriisin avaamiseksi.

Sarakkeessa S liitetään informaatio järjestelmäväylään meneväksi 
(destination). 

Määrittelyiden 
muuttaminen

Sarakkeessa on esitetty määrittelyiden esiasetukset. 

• Klikataan informaation halutun sarakkeen solua ja valitaan valikosta 
X (liitetty) tai _ (ei liitetty). Järjestelmäväylään uuden liitetyn 
informaation ominaisuudet ikkuna aukeaa näytölle automaattisesti.
451SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Kommunikaatio
DIGSIKOM136

Kuva 7-74 Object properties ikkuna, Protocol info - Destination sivu

Ikkunassa on joko Protocol info - Destination tai Protocol info - 
Source sivu, riippuen siitä onko informaatio määritelty 
järjestelmäväylään meneväksi (destination) vai sieltä tulevaksi (source). 
Jos mittausarvo on määritelty järjestelmäväylään meneväksi, on 
käytettävissä Measured value - Destination sivu.
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DIGSIKOM137

Kuva 7-75 Ominaisuudet, Measured value - Destination sivu

Protokolla-
asetteluiden 
määrittely

Asettelut Protocol info - Destination tai Protocol info - Source sivuilla 
ovat protokollakohtaisia. 

Lisätietoja yksittäisistä parametreistä on esitetty 
protokolladokumentaatiossa, joka toimitetaan kommunikaatiomodulin 
yhteydessä.
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Mittausarvojen 
skaalaus

Mittausarvojen skaalausta voidaan muuttaa Measured value - 
Destination sivulla.

Mittausarvon skaalaus on yleensä tarpeen, jos mittausarvon resoluutiota 
tulee pienentää. Jos esimerkiksi mittausarvo on 32-bittinen ja se tulee 
pienentää 16-bittiseksi, voidaan tärkeitä informaatioita menettää. 
Ongelma voidaan välttää skaalaamalla mittausarvo uudelleen. 

• Type kentässä valitaan onko kyseessä prosentti-, ensiö- tai 
toisioarvo.

• Scaling factor kentässä määritellään mittausarvolle korjauskerroin.

• Zero offset kentässä määritellään arvo joka lisätään mittausarvoon.

Riippuen käytetystä protokollasta voi käytössä vielä olla myös muita 
asetteluparametrejä, kuten esimerkiksi lähetyskynnysarvo Threshold 
value DNP protokollalla.

Asetteluiden 
palauttaminen

Jos muutettuja asetteluita protokollalla tai mittausarvojen skaalauksia 
halutaan palauttaa, avataan halutun informaation ominaisuudet ikkuna ja 
muutetaan arvot  Protocol info - Destination tai Protocol info - Source 
ja Measured value - Destination sivuilla. 
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7.9 Liityntä Ethernet verkon kautta 

Tietokone ja SIPROTEC 4 laite voivat liikennöidä Ethernet verkon kautta.

Jotta yhteys SIPROTEC 4 laitteen ja tietokoneen välillä onnistuisi, tulee 
näissä olla yhtenevät liikennöintimäärittelyt. Määrätyt toimintaan liittyvät 
asettelut voidaan asetella DIGSI 4 Device Editor ohjelmalla. Muut 
asettelut esitetään mutta niitä ei voida muuttaa. Ne voidaan muuttaa eri 
ohjelmalla, kuten esimerkiksi DIGSI Manager sovelluksella.

Tietokoneen ja laitteen liikennöintiväylien asettelut voidaan suorittaa ja 
tarkastaa seuraavasti:

• Klikataan DIGSI laitetiedoston Interface objektia oikealla 
hiiripainikkeella. Valitaan Open object toiminta valikosta. Toiminta 
voidaan myös aktivoida kaksoisklikkaamalla Interfaces objektia. 
Molemmissa tapauksissa Interface Parameters ikkuna avautuu.

• Tarkastetaan eri sivuilla olevat asettelut ja suoritetaan tarvittavat 
korjaukset.

• DIGSI > device painikkeilla voidaan muutetut asettelut siirtää 
SIPROTEC 4 laitteelle Online tilassa.

• Painetaan Apply painiketta asetteluiden hyväksymiseksi. Painikkeen 
painamisen jälkeen valintaikkuna jää auki. Määritellyt ominaisuudet 
hyväksytään sulkemalla ikkuna OK painikkeella. Molemmissa 
tapauksissa siihen mennessä muutetut arvot tallentuvat tietokoneen 
väliaikaiseen muistiin. Niitä ei vielä ole tallennettu pysyvästi 
parametritiedostoon.

Interface Parameters ikkunassa on eri määrä sivuja 
asettelumahdollisuuksineen riippuen siitä kuinka tietokone ja SIPROTEC 
4 laite on varusteltu.
"Serial interface at the PC", "VD addresses" ja "Operator interface" sivut 
ovat aina käytettävissä.

"Ethernet at the PC" sivu

Tällä sivulla on esitetty tietokoneen Ethernet väylän määrittelyt. Nämä 
asettelut voidaan määritellä DIGSI Manager ohjelmassa, valitsemalla 
Options → Configure DIGSI 4, Ethernet sivulla.

"Ethernet at the device" sivu

Tällä sivulla on esitetty SIPROTEC 4 laitteen Ethernet väylän 
määrittelyt. Tämä sivu on käytettävissä, jos SIPROTEC 4 laite on 
varustettu Ethernet järjestelmäväylällä. Nämä asettelut voidaan 
muuttaa DIGSI Manager ohjelmassa, laitteen ominaisuudet 
ikkunassa (Object properties of the device), Communication 
Parameters sivulla.

Lisätietoja määrittelyistä on annettu DIGSI® 4 ohjelmiston Online-apua 
sivuilla.
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Kunnossapito ja 
välitön apu, testaustoiminnat 8

Tässä kappaleessa on kuvattu vaaditut tai suositellut huoltotoimenpiteet 
SIPROTEC® 4 laitteille, säännöllisesti tarkastettavat ja vaihdettavat 
komponentit, testaus-/diagnoositoiminnat ja suoritettavat 
testaustoimenpiteet laitteen vikaantuessa. Kappale on tarkoitettu 
kunnossapito-, käyttö- ja suojausasiantuntijoille. 

Sisältö 8.1  Yleistä  458

8.2  Rutiinitarkastukset  459

8.3  Pariston vaihto  461

8.4  Testaus- ja diagnoositoiminnat  469

8.5  Vianetsintä  479

8.6  Korjaukset / Huolto  482

8.7  Takaisinlähetys  487
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8.1 Yleistä 

Numeerinen suoja- ja ohjauslaite SIPROTEC® 4 ei aseta erikoisia 
vaatimuksia huollolle.  Ainut kunnossapitotoimenpide koskee pariston 
vaihtoa. Kaikki mittaus- ja signaalien käsittelypiirit on toteutettu täysin 
staattisesti.  Kaikki  sisääntulopiirit on myös toteutettu staattisesti. 
Binääriset ulostulot on varustettu suojauspiirein. 

Laite on varustettu monipuolisin itsevalvontatoiminnoin, jotka ilmaisevat 
elektroniikka ja ohjelmistohäiriöt automaattisesti. Tämä takaa laitteen 
korkean käytettävyyden. Edellisestä  johtuen voidaan suojien jaksottaista 
koestusaikaväliä pidentää. 

Elektroniikkaviat Kun elektroniikkavika tunnistetaan

Laite lukitsee itsensä automaattisesti,

Itsevalvontakosketin aukeaa ilmaisten täten laitteen häiriintyneen. 

Kun laite tunnistaa häiriön ulkoisissa liityntäpiireissä suorittaa se 
ainoastaan hälytyksen. 

Ohjelmistolliset 
viat

Jos ohjelmistollinen vika tunnistetaan

Suoritetaan prosessorin uudelleen käynnistys. 
Jos ongelma ei poistunut uudelleen käynnistyksessä, toistetaan se 
kolmeen kertaan. Jos ongelma ei poistunut, poistuu laite käytöstä 
automaattisesti. 
Laitteen lukittuminen ilmaistaan etupaneelissa olevalla punaisella 
"ERROR" ledillä.

Itsevalvontakosketin aukeaa ilmaisten täten laitteen häiriintyneen.

Häiriöiden ja vikojen ilmaisut ajallisessa järjestyksessä kirjautuvat 
käyttöpäiväkirjaan (katso kappale 6.2). 

Jos laite on liitetty ulkoiseen ohjausjärjestelmään, välitetään merkinannot 
myös järjestelmäväylän kautta kaukokäytölle, edellyttäen että ne on 
parametroitu käyttöön. 
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8.2 Rutiinitarkastukset

Laukaisuaikaominaiskäyrien tai havahtumisrajojen kausittainen koestus 
ei ole tarpeen, koska ne ovat osa ohjelmistoa, jonka toimintaa valvotaan 
jatkuvasti. 

Koestuksessa tulee tarkastaa ennen kaikkea että suojaus- ja 
ohjaustoiminnat kokonaisuudessaan ovat käyttökunnossa.  
Koestuksissa varmistetaan pääasiassa, että SIPROTEC® laitteen ja 
kojeiston väliset yhteydet ovat toimintakunnossa. 

On suositeltavaa että seuraavat koestukset suoritetaan: Jos häiriö on 
havaittu, on kappaleessa 8.5 Vianetsintä esitetty lisäohjeita toiminnan 
korjaamiseksi. 

• Varmistutaan, että vihreä „RUN“ ledi palaa ja punainen „ERROR“ ei 
pala.  

• Varmistutaan, että laitteen etulevyyn määritellyt ilmaisinledit 
vastaavat laitteen olemassa olevia tiloja. 

• Painetaan LED-kuittauspainiketta. Kaikkien muiden paitsi punaisen 
"ERROR" ledin tulee palaa. 

• Luetaan laitteen esittämät käyttömittausarvot (katso kappale 6.3) ja 
verrataan niitä todellisiin arvoihin analogiatulojen toimintojen 
tarkastamiseksi. 

• Luetaan käyttömerkinannot (katso kappale 6.2). 
Varmistutaan että siellä ei ole laitteen häiriöitä, mittaussuureiden 
valvontojen tai muita ongelmia ilmaisevia merkinantoja. 
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Suoritetaan laitteen uudelleen käynnistys täydellisen 
itsevalvontaproseduurin aktivoimiseksi. Laite ei ole käyttökunnossa 
ennen kuin uudelleen käynnistyminen on suoritettu.

• Uudelleen käynnistys voidaan suorittaa laiteen etupaneelista Device 
Reset tai DIGSI® 4 ohjelmistolla Restart toiminnoin. Tällöin tulee 
syöttää testaus- ja diagnoositoimintojen salasana (testing and 
diagnostics).

• Tarkastetaan binääriset tulot ja -lähdöt DIGSI® 4  Test toiminnalla. 
Device Inputs and Outputs ikkunassa esitetään ledien, binääristen 
tulojen ja lähtöjen voimassa olevat tilat. Näitä verrataan kojeiston 
todellisiin tiloihin. 

• Tarkastetaan ohjauspiirit. Toiminta on kuvattu kappaleessa 6.6. 

Varoitus:

Kytkinlaitteiden tilojen muuttaminen testautoiminnoin käytön aikana on 
kielletty, koska muutokset vaikuttavat välittömästi laitteen tulojen ja 
lähtöjen tiloihin ja täten myös varsinaisiin ensiötoimilaitteisiin! Toiminta 
on verrattavissa esimerkiksi ohjauksiin ilman lukitusehtojen tarkastusta!

Ohje:

Laitteen etupaneelin ja DIGSI® 4 ohjelmiston käyttö on kuvattu 
kappaleessa 2 ja kappaleessa 4.
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8.3 Pariston vaihto

8.3.1 Yleistä

Merkinannot ja häiriötallenteet on tallennettu laitteella 
paristovarmennettuun RAM-muistiin. Näiden tietojen säilyminen 
muistissa jännitekatkosten ajan edellyttää että laitteelle on asennettu 
paristo. Paristo pitää myös yllä sisäistä kelloa ja kalenteria 
apujännitekatkosten aikana. 

On suositeltavaa vaihtaa paristo, jos Fail Battery merkinanto aktivoituu 
tai viimeistään noin 10 vuoden välein. 

Suositeltavat paristot:  

Lithium paristo 3 V/1 Ah, tyyppi CR 1/2 AA, esim. VARTA, tilausnumero 
6127 101 501

Toimenpiteet pariston vaihtamiseksi ovat riippuvaisia laitteen versiosta. 
Toimenpiteet eroavat riippuen siitä, onko laite tarkoitettu uppo- vai pinta-
asennukseen ja onko se mahdollisesti varustettu erillisellä 
ohjauspaneelilla. 

8.3.2 Pariston vaihto uppoasennuskoteloon sijoitetulla laitteella

Paristo vaihdetaan seuraavasti.

Paristo sijaitsee prosessorikortin CPU etureunassa. Laitteen etupaneeli 
tulee poistaa pariston vaihtamiseksi.

• Luetaan laitteen muistissa olevat merkinannot ja mittausarvot 
DIGSI® 4 ohjelmalla. Tietojen lukua varten tulee tietokone liittää 
laitteen edessä olevaan käyttösarjaliikenneväylään. DIGSI® 4 
ohjelmalla voidaan tallentaa tiedot tietokoneen kovalevylle. 

• Varataan varaosaparisto valmiiksi. 

Ohje:

Kaikki laitteen määrittely- ja asetteluparametrit on tallennettu 
haihtumattomaan muistiin. Tietojen tallennus ei ole riippuvainen pariston 
tilasta. Tiedot eivät poistu muistista paristoa vaihdettaessa tai jos laitetta 
käytetään ilman paristoa.
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• Katkaistaan laitteen apujännite kaksinapaisesti avaamalla laitetta 
syöttävä suoja-automaatti. 

• Irroitetaan kulmissa olevat suojakannet ja avataan niiden alla olevat 
etulevyn kiinnitysruuvit. 

• Irroitetaan kotelon etulevy ja sijoitetaan se varovasti sivuun. 
Irroitetaan prosessorimodulin CPU ( ) ja etupaneelin välinen 
lattakaapeli. Käännetään liittimen ylä- ja alaosassa olevat vivut ulos, 
jolloin lattakaapelin liitin nousee ulos. 

• Paristo sijoitetaan CPU modulin (  kuvassa 8-1) edessä alhaalla 
oleviin pidikkeisiin. 

Huomio:

Paristoa ei saa oikosulkea!  

Paristoa ei saa sijoittaa laitteeseen väärinpäin!  

Paristoa ei saa ladata!  

Huomio:

Sähköstaattisten varausten siirtymistä kehosta korteilla oleville 
komponenteille, johtimille tai liityntänastoille tulee välttää koskemalla 
ensin maadoitettua metallia. Pistokeliittimiä ei saa kytkeä tai irroittaa 
jännitteisenä! 

Varoitus:

Vaikka laitteen apujännite olisikin katkaistu ja moduli vedetty ulos 
kotelosta, voi laitteella esiintyä edelleen vaarallisia jännitteitä 
(kondensaattoreihin varautuneina)! 
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Kuva 8-1 Laite edestä kuvattuna kun etulevy on irroitettu (yksinkertaistettuna ja 
pienennettynä)

• Poistetaan vanha paristo pidikkeistä nippusidettä apuna käyttäen, 
kuten kuvassa  8-1 on esitetty. 

• Poistetaan nippuside vanhasta paristosta ja sijoitetaan se uuteen 
paristoon. 

• Painetaan uusi paristo tukevasti pidikkeisiin, kuten kuvassa 8-1 on 
esitetty. 

• Sijoitetaan CPU modulin ja etupaneelin välinen lattakaapeli takaisin 
liittimiinsä. Lattakaapelin kiinnityksessä ei saa käyttää tarpeetonta 
voimaa, jotta liitinnastat eivät vääntyisi! 

• Lattakaapeliliittimien lukitukset käännetään takaisin paikoilleen.  

• Sijoitetaan etupaneeli takaisin koteloon ja kiinnitetään etupaneelin 
ruuvit. 

• Ruuvien suojakannet sijoitetaan takaisin paikoilleen. 

CPU moduli
I/O tulo/lähtömoduli2

Paikka 5 Paikka 19

G1

+ –

Paristo

Nippuside

2
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• Kytketään laitteen apujännite takaisin ja tarvittaessa siirretään 
tietokoneelle tallennetut merkinannot takaisin laitteelle, kun laite on 
uudelleen käynnistynyt. 

• Asetellaan sisäinen kello ja kalenteri, jos laitetta ei ole varustettu 
ulkoisella ajantahdistuksella, esimerkiksi järjestelmäväylän kautta. 
Lisätietoja toiminnasta on esitetty kappaleessa 4.3.7. 

Varoitus:

Käytetty paristo sisältää lithiumia.  Pariston hävityksessä tulee noudattaa 
paikallisia ohjeita! 

Paristoa ei saa sijoittaa laitteeseen väärinpäin!  

Paristoa ei saa ladata!  

Paristoa ei saa heittää tuleen!  

Räjähdysvaara!  
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8.3.3 Pariston vaihto erillisellä etupaneelilla varustetulla laitteella

Paristo vaihdetaan seuraavasti.

Paristo sijaitsee prosessorikortin CPU etureunassa. Jos paristo tulee 
vaihtaa, kotelossa olevaa paristoa ei tarvitse korvata uudella. 
Etupaneelissa on paristonpidikkeet (G2) uutta paristoa varten. 

Toimitaan seuraavasti:  

• Luetaan laitteen muistissa olevat merkinannot ja mittausarvot 
DIGSI® 4 ohjelmalla. Tietojen lukua varten tulee tietokone liittää 
laitteen edessä olevaan käyttösarjaliikenneväylään. DIGSI® 4 
ohjelmalla voidaan tallentaa tiedot tietokoneen kovalevylle. 

• Varataan varaosaparisto valmiiksi. 

• Poistetaan etupaneelin kiinnitysruuvien suojakannet.

• Avataan suojakansien alla olevat kiinnitysruuvit ja irroitetaan 
etupaneeli.

• Painetaan uusi paristo tukevasti pidikkeisiin, kuten kuvassa 8-2 on 
esitetty.

Ohje:

Kaikki laitteen määrittely- ja asetteluparametrit on tallennettu 
haihtumattomaan muistiin. Tietojen tallennus ei ole riippuvainen pariston 
tilasta. Tiedot eivät poistu muistista paristoa vaihdettaessa tai jos laitetta 
käytetään ilman paristoa.

Huomio:

Paristoa ei saa oikosulkea!  

Paristoa ei saa sijoittaa laitteeseen väärinpäin!  

Paristoa ei saa ladata!  
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Kuva 8-2 Etupaneeli takaa kuvattuna, sekä pariston sijoitus

• Sijoitetaan etupaneeli takaisin koteloon ja kiinnitetään etupaneelin 
ruuvit. 

• Ruuvien suojakannet sijoitetaan takaisin paikoilleen. 

• Kytketään laitteen apujännite takaisin ja tarvittaessa siirretään 
tietokoneelle tallennetut merkinannot takaisin laitteelle, kun laite on 
uudelleen käynnistynyt. 

• Asetellaan sisäinen kello ja kalenteri, jos laitetta ei ole varustettu 
ulkoisella ajantahdistuksella, esimerkiksi järjestelmäväylän kautta. 
Lisätietoja toiminnasta on esitetty kappaleessa 4.3.7. 

+ +

– –

G
2

Paristo

Varoitus:

Käytetty paristo sisältää lithiumia.  Pariston hävityksessä tulee noudattaa 
paikallisia ohjeita! 

Paristoa ei saa sijoittaa laitteeseen väärinpäin!  

Paristoa ei saa ladata!  

Paristoa ei saa heittää tuleen!  

Räjähdysvaara!  
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8.3.4 Pariston vaihto laitteella jota ei ole varustettu käyttöpaneelilla

Paristo sijaitsee prosessorikortin CPU etureunassa. Laite tulee irroittaa 
asennuslevystä pariston vaihtamiseksi. 

Seuraavissa kappaleissa on kuvattu kuinka paristo vaihdetaan. 

• Luetaan laitteen muistissa olevat merkinannot ja mittausarvot 
DIGSI® 4 ohjelmalla. Tietojen lukua varten tulee tietokone liittää 
laitteen edessä olevaan käyttösarjaliikenneväylään. DIGSI® 4 
ohjelmalla voidaan tallentaa tiedot tietokoneen kovalevylle. 

• Varataan varaosaparisto valmiiksi. 

Ohje:

Kaikki laitteen määrittely- ja asetteluparametrit on tallennettu 
haihtumattomaan muistiin. Tietojen tallennus ei ole riippuvainen pariston 
tilasta. Tiedot eivät poistu muistista paristoa vaihdettaessa tai jos laitetta 
käytetään ilman paristoa.

Huomio:

Paristoa ei saa oikosulkea!  

Paristoa ei saa sijoittaa laitteeseen väärinpäin!  

Paristoa ei saa ladata!  

Huomio:

Sähköstaattisten varausten siirtymistä kehosta korteilla oleville 
komponenteille, johtimille tai liityntänastoille tulee välttää koskemalla 
ensin maadoitettua metallia. Pistokeliittimiä ei saa kytkeä tai irroittaa 
jännitteisenä! 

Varoitus:

Vaikka laitteen apujännite olisikin katkaistu ja moduli vedetty ulos 
kotelosta, voi laitteella esiintyä edelleen vaarallisia jännitteitä 
(kondensaattoreihin varautuneina)! 
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• Katkaistaan laitteen apujännite kaksinapaisesti avaamalla laitetta 
syöttävä suoja-automaatti. 

• Irroitetaan kiinnitysruuvit, joilla kotelo on sijoitettu asennuslevyyn. 

• Vaihdetaan vanha paristo uuteen kuten kappaleessa 8.3.2 on 
kuvattu.   

• Kiinnitetään kotelo takaisin asennuslevyyn kiinnitysruuvein.

• Kytketään laitteen apujännite takaisin ja tarvittaessa siirretään 
tietokoneelle tallennetut merkinannot takaisin laitteelle, kun laite on 
uudelleen käynnistynyt. 

• Asetellaan sisäinen kello ja kalenteri, jos laitetta ei ole varustettu 
ulkoisella ajantahdistuksella, esimerkiksi järjestelmäväylän kautta. 
Lisätietoja toiminnasta on esitetty kappaleessa 4.3.7. 

Varoitus:

Käytetty paristo sisältää lithiumia.  Pariston hävityksessä tulee noudattaa 
paikallisia ohjeita! 

Paristoa ei saa sijoittaa laitteeseen väärinpäin!  

Paristoa ei saa ladata!  

Paristoa ei saa heittää tuleen!  

Räjähdysvaara!  
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8.4 Testaus- ja diagnoositoiminnat

Online tilassa DIGSI® 4 ohjelmalla voidaan suorittaa määrätyt testaus- 
ja diagnoositoiminnat SIPROTEC® laitteelle, kuten

Testaustilan ja tiedonsiirron eston päälle ja pois ohjaus,

Testata binääriset tulot, -ohjaukset ja ledit,

Suorittaa katkaisijan koestustoiminnat,

Käynnistää häiriöntallennus käsin,

Aktivoida järjestelmäväylään menevät merkinannot käsin,

Esittää järjestelmän kuormitustilanne.

Vaara!

Testaustoimintojen käsittely käytön aikana tulee suorittaa suurta 
varovaisuutta noudattaen ja suojattavan järjestelmän ominaisuudet 
tuntien. 
Toimintojen huolimaton käyttö voi johtaa kuolemaan, vakavaan 
loukkaantumiseen ja laitteiden vaurioitumiseen.
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Testaustoiminnat voidaan aktivoida menu-valikosta. 

• Avataan laite online tilassa (katso kappale 4.3.4).

• Klikataan DIGSI® 4 navigointi-ikkunassa olevaa Test hakemistoa. 
Hakemistossa olevat objektit esitetään tieto ikkunassa.

Hardware Test (laitteen tulot ja lähdöt)
Toiminnalla voidaan testata SIPROTEC® laitteen ledit, binääriset 
lähdöt ja tulot.

Test Event for System Port
Toiminnalla voidaan aktivoida järjestelmäväylään menevät 
merkinannot.

Start Oscillographic Fault Recording
Toiminnalla voidaan aktivoida häiriöntallennus testaustarkoituksessa 
käsin.

Circuit Breaker Test Function
Toiminnalla voidaan suorittaa katkaisijan ohjauskokeet (laukaisu tai 
jälleenkytkentä).

Riippuen laitteen tyypistä kaikki testaustoiminnat eivät ole välttämättä 
käytettävissä. Testaustoiminnat on suojattu salasanoin. 
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8.4.1 Testaustilan päälle ja pois ohjaus

Jos testaustila on ohjattu päälle, välitetään SIPROTEC 4 laitteen 
aktivoimat merkinannot erillisellä testausbitillä ilmaistuna ulkoiseen 
ohjausjärjestelmään. Testausbitillä voidaan erottaa ulkoisessa 
ohjausjärjestelmässä onko kyseessä todellinen vai testauksen 
yhteydessä aktivoitu merkinanto. Testausbitillä voidaan estää myös 
merkinannon kirjautuminen valvomossa käyttöpäiväkirjaan.

Toimitaan seuraavasti: 

• Valitaan Device → Test Mode. 
Jos testaustila on päällä, otetaan se pois päältä vastaavalla tavalla. 
Aktivoitu testaustoiminta on ilmaistu valintamerkillä valikkotoiminnan 
edessä.

• Toiminnan aktivointi edellyttää testaus- ja diagnoositoimintojen 
salasanan syöttämisen. 

Kun testaustila ohjataan päälle tai pois, ilmaistaan se tilapalkin 
vasemmassa reunassa merkinannolla. Palkki kuvaa myös toiminnan 
edistymistä.

8.4.2 Tiedonsiirron eston päälle ja pois ohjaus

Jos tiedonsiirron esto on päällä, eivät merkinannot siirry SIPROTEC® 4 
laitteen järjestelmäväylää pitkin ulkoiseen ohjausjärjestelmään. 
Tiedonsiirron esto voidaan ohjata päälle tai pois riippuen sen voimassa 
olevasta tilasta. 

Toimitaan seuraavasti: 

• Valitaan Device → Block Data Transmission.
Jos tiedonsiirron esto on päällä, otetaan se pois päältä vastaavalla 
tavalla. Päällä oleva tiedonsiirron esto on ilmaistu valintamerkillä 
valikkotoiminnan edessä.

• Toiminnan aktivointi edellyttää testaus- ja diagnoositoimintojen 
salasanan syöttämisen. 

Kun tiedonsiirron esto ohjataan päälle tai pois, ilmaistaan se tilapalkin 
vasemmassa reunassa merkinannolla. Palkki kuvaa myös toiminnan 
edistymistä.
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8.4.3 Laitteen tulojen ja lähtöjen koestus (Hardware Test)

Toiminnalla voidaan testata binääristen tulojen, lähtöjen ja ledien 
toiminnat SIPROTEC® laitteella. Kun tämä testaustoiminta on 
käynnistetty, asettuu testaustila automaattisesti käyttöön ja kaikki 
merkinannot varustetaan testibitillä.

Toimitaan seuraavasti: 

• Valitaan Hardware Test ja avataan Hardware Test ikkuna oikealla 
hiiripainikkeella avautuneesta valikosta Open Object toiminnalla.

DIGISGB007

Kuva 8-3 Hardware test, ledien ja binääristen lähtöjen tilat

Ikkunassa näyttö on jaettu pystysuunnassa kolmeen ryhmään:

BI binääriset tulot, 

BO binääriset lähdöt ja 

LED ledit. 

• Kaksoisklikkaamalla ryhmän nimeä voidaan haluttu ryhmä joko 
piilottaa tai avata näyttöön.

No. sarakkeessa on esitetty binääristen tulojen, lähtöjen ja ledien 
lukumäärä. Numerot on esitetty BI, BO tai LED päättein.

Actual sarakkeessa on esitetty kunkin hardware-komponentin tila. Tila 
on esitetty graafisin symbolein, eli sammuneena tai palavana ledinä tai 
sulkeutuneena tai avautuneena koskettimena. 
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DIGISGB010

Kuva 8-4 Binääristen tulojen voimassa olevat tilat

Nominal sarakkeessa on esitetty komponentin tila, johon se on 
testaustarkoituksessa ohjattavissa. Koska komponenteilla on vain kaksi 
tilaa, esitetään aina voimassa olevan tilan vastakkainen tila. 

Allocated sarakkeessa on esitetty informaatiot, jotka on liitetty 
komponenteille. 

• Nominal sarakkeessa olevaa painiketta painamalla voidaan 
komponentin tila muuttaa vastakkaiseksi.

• Toiminnan aktivointi edellyttää testaus- ja diagnoositoimintojen 
salasanan syöttämisen. 

Kun salasana on syötetty onnistuneesti, on tilojen muuttaminen 
mahdollista. Tiloja voidaan muuttaa ilman salasanan uudelleen syöttöä 
kunnes Hardware Test  ikkuna suljetaan.

Kun Test device inputs and outputs ikkuna on auki, esitetään 
binääristen tulojen, lähtöjen ja ledien todelliset tilat näytöllä. Näyttö 
voidaan päivittää eri menetelmin.

Jos objektin tilan muuttaminen vastakkaiseksi onnistui, päivittyy 
komponentin tila näytölle automaattisesti. 

• Update painikkeella voidaan päivittää kaikkien komponenttien tilat 
käsin.

• Aktivoimalla Update Cyclically valintaruutu päivittyvät kaikkien 
komponettien tilat jaksottaisesti.

Vaara!

Toimintatilojen muuttaminen vaikuttaa
SIPROTEC® laitteen tuloihin tai lähtöihin myös todellisuudessa!
Tällöin esimerkiksi ohjauskoskettimiin liitetyt katkaisijat tai 
erottimet ohjautuvat. 
Jos tämä halutaan estää, tulee ohjausesto määritellä käyttöön 
SIPROTEC® laitteelle (katso kappale 6.7.4). 

Tulee myös huomioida että binäärisen tulon aktivointi 
testaustarkoituksessa ei välttämättä vaikuta laitteen toimintoihin, 
kuten todellinen tila.

Kun laitteen tulojen ja lähtöjen testaustoiminnasta poistutaan, 
suorittaa laite uudelleen käynnistyksen. Tämä toiminta poistaa 
tallentuneet häiriötallenteet, verkkohäiriötapahtumat, jne. laitteen 
muistista.
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• Testaustoiminta voidaan päättää painamalla Close painiketta.

Tällöin Test device inputs and outputs ikkuna sulkeutuu. Laitteen 
suoritettua uudelleen käynnistyksen kuvaavat komponentit siihen 
liitettyjen toimilaitteiden voimassa olevia tiloja.
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8.4.4 Katkaisijan koestustoiminnan suoritus

Katkaisijan koestustoiminnalla voidaan suorittaa

Vain laukaisu tai

Laukaisu ja jälleenkytkentä 

Toimitaan seuraavasti: 

• Valitaan Circuit Breaker Test ja avataan Test Circuit Breaker 
ikkuna oikealla hiiripainikkeella avautuneesta valikosta Open Object 
toiminnalla. 
Taustalle avatuu samanaikaisesti spontaani päiväkirja ikkuna 
Spontaneous Indications. Tässä päiväkirjassa esitetään katkaisijan 
koestustoiminnan tapahtumat.

DIGISGB115

Kuva 8-5 Katkaisijan koestus

Ikkunassa voidaan valita joko yksi- tai kolmivaiheinen koestus. 

• Valitaan haluttu koestus.
Painetaan Start painiketta.

Vaara!

Onnistunut koestusjakso voi johtaa katkaisijan 
kiinniohjautumiseen, jos järjestelmä on varustettu ulkoisella 
jälleenkytkentäautomatiikalla!
475SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Kunnossapito ja välitön apu, testaustoiminnat
• Toiminnan aktivointi edellyttää testaus- ja diagnoositoimintojen 
salasanan syöttämisen. 

Kun salasana on syötetty onnistuneesti, voidaan koestustoiminta 
aktivoida. Koestustoimintoja voidaan aktivoida ilman salasanan 
uudelleen syöttöä, kunnes  Test circuit-breaker ikkuna suljetaan.

Koestuksen tilat esitetään spontaanissa päiväkirjassa Spontaneous 
Log.

• Painetaan Circuit breaker test ikkunassa Close painiketta, jolloin 
toiminta päättyy.

8.4.5 Häiriötallennuksen käynnistys käsin

Koestustarkoituksessa voidaan häiriöntallennin käynnistää käsin 
DIGSI® 4 ohjelmassa.

Toimitaan seuraavasti: 

• Valitaan Test Fault Record objekti ja avataan Test Fault Record 
ikkuna oikealla hiiripainikkeella avautuneesta valikosta Open Object 
toiminnalla.

Häiriötallennus on käynnistetty ja tallennuksen pituus määräytyy erillisen 
asettelun mukaisesti. Tallennuksen aikana vastaava merkinanto on 
näkyvillä tilapalkin vasemmassa reunassa. Palkki kuvaa myös toiminnan 
edistymistä.

Häiriöntallennuksen asetteluiden määrittely on esitetty kappaleessa 
5.17.

DIGSI® 4 ohjelmiston mukana toimitetaan ComtradeViewer ohjelma. 
Sillä voidaan esittää häiriötallenteeseen kirjautuneet tiedot graafisesti. 
Optiona hankittavalla SIGRA 4 ohjelmalla voidaan esittää häiriötallenne 
huomattavasti monipuolisemmin ja se sisältää myös lisätoimintoja 
häiriön analysointia varten. 

• Kaksoisklikataan haluttua häiriötallennetta tallenteen avaamiseksi. 
Tällöin tallenne aukeaa ComtradeViewer ohjelmaan. Jos 
tietokoneelle on asennettu SIGRA 4 ohjelma, avataan häiriötallenne 
siihen.
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8.4.6 Merkinantojen koestus

DIGSI® 4 ohjelmalla voidaan järjestelmäväylään menevät merkinannot 
aktivoida käsin. Koestuksen aikana järjestelmäväylään välitetyt 
merkinannot varustetaan testibitillä.

Toimitaan seuraavasti: 

• Valitaan Test Indication for Interface objekti ja avataan  Test 
System Interface ikkuna oikealla hiiripainikkeella avautuneesta 
valikosta Open Object toiminnalla.

DIGISGB118.tif

Kuva 8-6 Järjestelmäväylän koestus

Indication sarakkeessa on esitetty merkinannon näyttöteksti. Mitä 
merkinantoja näytön taulukossa esitetään, on riippuvainen SIPROTEC® 
laitteen tyypistä.
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Koestettavan merkinannon tila voidaan valita SETPOINT status 
sarakkeesta. Riippuen informaation tyypistä, valinta suoritetaan 
alasvetovalikosta, valintaruuduista tai määrittelemällä arvo 
syöttökenttään. 

• Klikataan SETPOINT status kenttää ja valitaan merkinannolle haluttu 
tila, esimerkiksi pois päältä Off.

• Painetaan Action sarakkeessa Send painiketta informaation 
aktivoimiseksi. Informaatio välitetään järjestelmäväylään.

• Toiminnan aktivointi edellyttää testaus- ja diagnoositoimintojen 
salasanan syöttämisen. 

Kun salasana on syötetty onnistuneesti, voidaan merkinantoja aktivoida 
salasanaa uudelleen syöttämättä Salasana on voimassa kunnes Test 
system interface ikkuna suljetaan.

• Close painikkeella voidaan testaustoiminta päättää.

8.4.7 Järjestelmän kuormituksen esitys

Diagnoositarkoituksessa on mahdollista lukea järjestelmän 
kuormitustilanne. Tämä tieto ei ole oleellinen normaalissa 
käyttötilanteessa. 

Toimitaan seuraavasti: 

• Valitaan Device → Resource Meter jolloin Resource Meter ikkuna 
avautuu näyttöön.

DIGISGB013

Kuva 8-7 Järjestelmän kuormitustila

Järjestelmän kuormitus esitetään staattisesti. Tämä tarkoittaa että 
järjestelmän kuormitus kuvaa hetkeä jolloin näyttö avattiin. Jos 
järjestelmän kuormitus muuttuu ikkunan ollessa avoimena, ei näyttö 
päivity automaattisesti. 

• Update painikkeella voidaan näyttö päivittää käsin.

• Ikkuna suljetaan Close painikkeella.
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8.5 Vianetsintä

Jos laite ilmaisee vikaantuneensa, suositellaan seuraavia toimenpiteitä:

Jos mikään laitteen ledeistä ei pala tulee tarkastaa: 

• Onko modulit sijoitettu kunnolla koteloon ja onko etupaneeli lukittuna? 

• Onko lattakaapelien pistokkeet kunnolla paikoillaan ja lukitusvivuin 
varmistettu? 

• Onko apujännitteen suuruus riittävä ja onko se kytketty 
napaisuudeltaan oikein laitteen liittimille (lisätietoja liitynnöistä on 
esitetty laitteiden käyttöohjeiden liityntäkaavioissa)? 

• Onko laitteen apujännitteen syöttöpiireissä oleva sulake ehjä (katso 
kuva 8-11)? Tarvittaessa sulake vaihdetaan (katso kappale 8.6.2). 

Jos punainen "ERROR" ledi palaa ja vihreä "RUN" ledi on pimeänä, 
suoritetaan laitteen uudelleen käynnistys (katso kappale 8.2).
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Jos laitteen näytöllä on MONITOR tila ilmaistuna, tulee laite initialisoida 
DIGSI® 4 ohjelmalla. 

Kuva 8-8 Monitor tila laitteen näytöllä

digsi630.gif

Kuva 8-9 Laitteen initialisointi DIGSI 4 ohjelmalla, esimerkki

Tietoja toiminnan toteutuksesta DIGSI® 4 ohjelmalla on esitetty 
kappaleessa 4.3.6.

• Syötetään asetteluiden muutoksessa vaadittu salasana (parameter 
set). 
Laitteen näyttö vaihtuu initialisoinnin aktivoituessa. 
Onnistuneen initialisoinnin jälkeen osoittavat ilmaisinledit voimassa 
olevia tiloja ja perusnäyttö aktivoituu. Laitekohtaiset asettelut 
aktivoituvat käyttöön edellyttäen että ne olivat tallennettuina 
tietokoneen parametrointitiedostoon. Laite on nyt käyttökunnossa. 

MONITOR         01/05
---------------------
Equipment data  –>                
1
User interface    –>                 
2
System I-face    –>                 
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Tuki 
ongelmatilanteissa

Jos aiemmin kuvatut toimenpiteet eivät poistaneet ongelmaa, ottakaa 
yhteyttä tekniseen tukeen. 

Tällöin on hyvä etsiä alla luetellut tiedot valmiiksi:  

Laitteen MLFB numero kokonaisuudessaan, 

Laitteen tehdasnumero,

Käytössä oleva ohjelmistoversio (firmware),

Käytössä oleva järjestelmän käynnistysversio (boot system). 

Tiedot voidaan lukea laitteen etupaneelista tai  DIGSI® 4 ohjelmalla.

MLFB ja valmistusnumero voidaan lukea myös laitteen koteloon 
liimatusta tarrasta. 

Käyttöpaneeli • Jos laite on käyttökunnossa, valitaan
MAIN MENU →  Parameters →  Setup / Extras →  MLFB / 
Version. 

tai

DIGSI® 4 • Offline tilassa valitaan File →  Properties ja avataan Device sivu.

digsi631.gif

Kuva 8-10 Ominaisuudet DIGSI 4 ohjelmassa, esimerkki
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8.6 Korjaukset / Huolto

8.6.1 Ohjelmistolliset toimenpiteet

Käytön aikaisia ohjelmistollisia toimenpiteitä ovat

Prosessorijärjestelmän initialisointi, kuten kappaleessa 4.3.6 on 
esitetty tai

Asetteluparametrien muuttaminen, jos esimerkiksi jonkin 
valvontatoiminnan herkkyyttä halutaan pienentää valvonnan 
aktivoituessa turhaan käytön aikana. 

Jos nämä toimenpiteet eivät poista ongelmaa, ei muita toimenpiteitä 
suositella tehtäväksi käytön aikana. 
Laite tulee tarvittaessa vaihtaa toimivaan. 

8.6.2 Hardware toimenpiteet 

Laitteen käsittely- tai korjaustoimenpiteet tulee rajoittaa toimenpiteisiin, 
jotka ovat todella tarpeen. Näitä on lähinnä apujännitteen syöttöpiirissä 
olevan sulakkeen vaihto. 

Yksittäiset vikaantuneet modulit voidaan vaihtaa vain koulutetun 
henkilökunnan toimesta, kun niiden vaihto on todella tarpeen! 

Missään tapauksissa ei modulien piirilevyillä saa suorittaa 
juotostoimenpiteitä! 
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Laitteen  
purkaminen

Laite tulee purkaa, jos moduleita halutaan käsitellä. Tämä suoritetaan 
seuraavasti: 

• Valmistellaan työskentelyalusta: Työssä tarvitaan seuraavia 
työkaluja ja tarvikkeita: 
- Sähköstaattisesti herkkien komponenttien käsittelyssä käytettävä 
maadoitettu alusta (ESD), 
- Ruuvitaltta jonka leveys on 5 ... 6 mm, 
- Ruuvitaltta kokoa 1,
- 4.5 mm kiintoavain. 

• Katkaistaan laitteen apujännite kaksinapaisesti avaamalla laitetta 
syöttävä suoja-automaatti. 

Huomio:

Sähköstaattisten varausten siirtymistä kehosta korteilla oleville 
komponenteille, johtimille tai liityntänastoille tulee välttää koskemalla 
ensin maadoitettua metallia. 
Pistokeliittimiä ei saa kytkeä tai irroittaa jännitteisenä! 

Varoitus:

Vaikka laitteen apujännite olisikin katkaistu ja moduli vedetty ulos 
kotelosta, voi laitteella esiintyä edelleen vaarallisia jännitteitä 
(kondensaattoreihin varautuneina)! 
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• Irroitetaan laitteen takana mahdollisesti olevat liikennöintiväylien 
liittimet. 
Jos laitteelle on liitettynä valokuituja, tulee ne irroittaa ja suojata 
likaantumiselta (ei koske pinta-asenteisia laitteita). 

• Avataan laitteen takana olevan "A" väylän D-sub liittimien 
kiinnitysruuvit (ei koske pinta-asenteisia laitteita). 

• Jos laite on varustettu "A" väylän lisäksi muilla liikennöintiväylillä, 
tulee niiden kiinnitysruuvit irroittaa vastaavasti (ei koske pinta-
asenteisia laitteita). 

• Irroitetaan kulmissa olevat suojakannet ja avataan niiden alla olevat 
etulevyn kiinnitysruuvit. 

• Irroitetaan kotelon etulevy ja sijoitetaan se varovasti sivuun. 
Laitteilla, jotka on varustettu erillisellä ohjauspaneelilla, voidaan 
etupaneeli poistaa välittömästi kun ruuvit on avattu. 

• Laitteen etulevyn ja CPU prosessorikortin välinen lattakaapeli 
poistetaan pistokeliittimiistä.  Lattakaapeliliitin irroitetaan avaamalla 
sen molemmilla puolilla olevat lukitukset. Tätä toimenpidettä ei 
välttämättä tarvitse suorittaa laitteilla, jotka on varustettu erillisellä 
ohjauspaneelilla. 
Tällöin näillä laitteilla tulee irroittaa 7-napaiseen X16 väylään liitetty D-
naarasliitin ja lattakaapelin liitin, joka on liitetty 68-napaiseen CPU 
modulilta tulevaan liittimeen laitteen takana. 

• CPU prosessorikortin ja tulo-/lähtömodulien välinen lattakaapeli 
poistetaan.

• Irroitetaan modulit kotelosta ja sijoitetaan ne valmistellulle 
työskentelyalustalle (ESD). 
Tulee huomioida että pinta-asennuskotelossa tarvitaan määrätty 
voima jotta CPU kortti saadaan vedettyä ulos liittimistään. 

Varoitus:

Lasersäde! Sädettä ei saa katsoa paljain silmin, eikä millään optisella 
laitteella.

Laser-luokka 3A normin  EN 60825-1 mukaisesti.
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Sulakkeen 
vaihtaminen 

Sulakkeen sijainti riippuu SIPROTEC 4 laitteen tyypistä. Joillakin laitteilla 
se on sijoitettu CPU modulille, jossa apujännitteen syöttöpiirit sijaitsevat. 
Esimerkissä on kuvattu sulakkeen vaihto tämän tyyppisellä laitteella.

Toimitaan seuraavasti: 

• Otetaan 5 x 20 mm vaihtosulake esiin. Varmistutaan sulakkeen 
oikeista nimellisarvoista, nopeusluokasta (T) ja oikeista merkinnöistä. 
Nämä tiedot on painettu moduliin (katso kuva 8-11). 
Sulakkeen tyyppi riippuu käytetystä apujännitteestä. Esimerkiksi 
"T4H250V" normin IEC 60127-2 mukaisesti on tarkoitettu 
käytettäväksi apujännitteella 24 ... 48 V (katso taulukko 8-1). 

• Poistetaan viallinen sulake pidikkeestään (kuva 8-11). 

Kuva 8-11 CPU modulin apusähkön syöttöpiireissä oleva sulake 

• Sijoitetaan uusi sulake paikoilleen. 

• Kortit sijoitetaan varovasti takaisin kehikkoon. 
Modulin sijoituspaikka kotelossa on esitettu kappaleessa Asennus ja 
käyttöönotto. 

Taul. 8-1 Laitteen apujännitteistä riippuva sulakkeen tyyppi

SIPROTEC∗∗∗ versiot Nimellisapujännitteet Sulake

–2∗∗∗∗–∗∗∗∗ 24 V ... 48 V T4H250V

–4∗∗∗∗–∗∗∗∗ 60 V ... 125 V T2H250V

–5∗∗∗∗–∗∗∗∗ 110 V ... 250 V, 115 V AC T2H250V

F1

230 VAC

1

T2H250V
B15-

60-250 VDC/115 VACT2H250V
B12-

24-48 VDC
T4H250V

B11-

2
3
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Laitteen 
kokoaminen

Laite kootaan seuraavasti: 

• Liitetään lattakaapeli CPU modulin ja I/O tulo-/lähtömodulien välille.

• Sijoitetaan CPU modulin ja etupaneelin välinen lattakaapeli takaisin 
liittimiinsä. 
Laitteilla joilla on erillinen ohjauspaneeli kiinnitetään kaapeli, joka 
tulee laitteen takana olevalta 68-napaiselta liittimeltä 
prosessorimodulin liittimelle. Liitetään 7-napainen liitin (X16) D-sub 
liittimeen. Kummin päin ne sijoitetaan paikoilleen ei ole oleellista, sillä 
ne ovat suojattu väärin päin kytkentää vastaan.

• Sijoitetaan etupaneeli takaisin koteloon ja kiinnitetään etupaneelin 
ruuvit. 

• Ruuvien suojakannet sijoitetaan takaisin paikoilleen. 

• Kiinnitetään takana olevien liikennöintiväylien kiinnitysruuvit 
paikoilleen. 

• Liitetään kaikki väyläkaapelit takaisin paikoilleen laitteen takana 
oleviin moduleihin. 

• Liitetään mahdolliset valokuidut takaisin. 
FC liittimillä tulee huomioida että liittimen ohjauskara sijoittuu oikein 
vastakappaleeseen liitinruuvia kiristettäessä. Liitinruuvin saa kiristää 
ainoastaan sormivoimin.

Seuraavat kolme vaihetta tulee suorittaa laitteilla, jotka on sijoitettu pinta-
asennuskoteloon. 

• Kytketään laitteen apujännite takaisin. 

Jos vihreä ledi „RUN“ ei vieläkään syty, on  sisäisessä 
virransyöttömodulissa häiriö tai oikosulku. Tässä tapauksessa laite tulee 
lähettää tehtaalle korjattavaksi (katso kappale 8.7). 

Huomio:

Laitteen kokoamisessa tulee noudattaa suurta varovaisuutta ja 
tarpeetonta voimaa ei saa käyttää, jotta liittimien pinnit eivät vääntyisi! 
Tulee varmistua että lukitusvivut ovat lukittuneina luotettavasti.

Varoitus:

Lasersäde! Sädettä ei saa katsoa paljain silmin, eikä millään optisella 
laitteella.

Laser-luokka 3A normin  EN 60825-1 mukaisesti.
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8.7 Takaisinlähetys 

Siemens suosittelee, että viallisille laitteille tai moduleille ei suoriteta 
muita korjaustoimenpiteitä. Moduleilla on käytetty elektronisia 
komponentteja, joita tulee käsitellä sähköstaattisesti herkille 
komponenteille määritellyin menetelmin (ESD = Electrostatic Sensitive 
Devices). On tärkeää huomioida, että suojalla on käytetty 
erityisvalmistustekniikoita, monikerroskortteja ja muita herkkiä osia 
joiden suojalakkausta ei saa vahingoittaa. 

Jos ongelmaa ei saatu korjattua kappaleissa 8.5 ja 8.6 esitetyin 
menetelmin, suosittelemme että laite kokonaisuudessaan, etupaneeli 
mukaan lukien, lähetetään tehtaalle.  

• Tällöin on suositeltavaa että käytetään alkuperäistä 
kuljetuspakkausta.  
Jos kuljetuksessa käytetään muuta pakkausta, tulee sen täyttää 
seuraavat normit IEC 60255-21-1 luokka 2 ja IEC 60255-21-2 
luokka 1.

• Ennen laitteen lähetystä, tulee laitteelta lukea ja tallentaa kaikki 
asettelut, toiminnat ja määrittelyt, edellyttäen että kommunikointi 
laitteen kanssa on mahdollista. 

• Kaikki piirikorteilla olevien asettelusiltojen muutokset tulee kirjata 
ylös. 

• Laitteen mukana tulee toimittaa kuvaus ongelmasta ja yhteyshenkilö 
johon voidaan ottaa yhteyttä suoraan korjauspalvelustamme 
mahdollisten kysymysten selvittämiseksi.

Ohje:

Kun laite on tullut takaisin tehtaalta korjattuna, on korteilla olevat 
asettelusillat aseteltu vastaamaan alkuperäistä MLFB numeron 
määritystä. Tehtaalta toimitettaessa kaikki suojan määrittelyt ja 
asetteluparametrit on palautettu tehdasasetuksiin. 
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Liite A
Liitteessä on esitetty yleisiä ohjeita DIGSI 4 ohjelmalle, informaatioiden 
määrittelymahdollisuuksia ja yksityiskohtaisia tietoja modeemiliityntöjen 
määrittelyille. 

Sisältö A.1  DIGSI 4 ohjelman käyttö  490

A.2  Informaatioiden määrittely - yleistä  495

A.3  Sovellusmodeemilla toteutettu kaukoyhteys - esimerkki  502

A.4  Liityntäkaapeleiden kytkennät  505

A.5  Yleisiä ohjeita modeemeille  506
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A.1 DIGSI 4 ohjelman käyttö

DIGSI® 4 ohjelmistossa käytetään Windows käyttöjärjestelmän tyypillisiä 
toimintoja. Tästä johtuen ohjelmiston käytön omaksuminen on helppoa. 

Määrittelyitä ja käyttöä helpottaa se, että käyttäjälle esitetään vain ne 
asetteluparametrit ja ominaisuudet jotka laitteessa on käytössä. 

Määrätyt toiminnat voidaan kutsua vaihtoehtoisesti joko oikealla 
hiiripainikkeella avautuvasta valikosta, ikkunan yläreunassa olevista 
valikoista tai työkalurivin ikoneista. 

Apua-toiminnat Apua-toiminnat kuvaavat yksittäisten toimintojen ja parametrien 
merkitykset, toimien täten käyttäjän aputyökaluina. Apua-toiminta 
voidaan aktivoida Help ja About painikkeilla, sekä toimintakohtaisesti F1 
painikkeella.

Toiminta-
kohtainen valikko

Käytettävissä olevat toiminnat on yleensä esitetty DIGSI 4 ohjelmassa 
toimintakohtaisissa valikoissa. Niiden avulla voidaan avata hakemistoja, 
käynnistää sovelluksia, valita objektin ominaisuudet, linkittää 
informaatioita, jne.

Toimitaan seuraavasti: 

• Siirretään hiiren osoitin käsiteltävän objektin päälle.

• Painetaan oikeata hiiripainiketta. Toimintakohtainen valikko aukeaa 
näyttöön.

• Toiminta aukeaa valitsemalla haluttu vaihtoehto.

kontextme.gif

Kuva A-1 Esimerkki toimintakohtaisesta valikosta

Ohje:

On suositeltavaa aktivoida toiminnat nimenomaan toimintakohtaisesta 
valikosta.
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DIGSI 4 ohjelman käyttö
Työkaluvalikko Toiminnat voidaan DIGSI 4 ohjelmassa aktivoida myös työkaluvalikosta. 
Käytettävissä olevat toiminnat riippuvat DIGSI 4 komponentista ja 
käytössä olevasta toimintatilasta.

Ikonit Ikoneilla voidaan aktivoida toiminnat nopeasti ja käyttäjäystävällisesti. 
Ikonin merkitys esitetään tekstillä kun hiiren osoitin viedään ikonin päälle.

Tilapalkki Tilapalkin vasemmassa reunassa esitetään ohjetekstejä kyseessä 
olevasta toiminnasta ja hiiren sijainnista riippuen. Kyseisellä alueella 
ilmaistaan myös eri toimintojen suoritusvaiheet. Tällöin palkin koko on 
riippuvainen toiminnan suoritusvaiheesta. Tämän alueen oikealla 
puolella esitetään muita tietoja tekstilyhentein tai ikonein. 

Laitteen tyyppi ja versio
Laitteen tyyppi (eimerkiksi 7SJ610) ja laiteversio (eimerkiksi V 4.0) 
esitetään näytöllä.

Toiminnan tila
Näytöllä esitetään voimassa oleva toiminnan tila OFFLINE tai 
ONLINE tekstein.

Sarjaliikenneväylän asettelut
Käytössä olevan sarjaliikenneväylän asettelut esitetään näytöllä, 
kuten fyysinen portti (esim. COM1), tiedonsiirtonopeus (esim. 34000 
kb) ja formaatti (esim. 8E1).

Testaustila
Kahdella ikonilla ilmaistaan onko testaustila päällä vai pois päältä.

Päivitysesto
Kahdella ikonilla ilmaistaan onko päivitysesto päällä vai pois päältä.

Tiedonsiirron esto
Kahdella ikonilla ilmaistaan onko tiedonsiirron esto päällä vai pois 
päältä.

Useita eri spontaaneja merkinantoja
Useampia spontaaneja merkinantoja esitetään numeerisin arvoin.

Näppäimistön asettelut
Oikeassa reunassa esitetään voimassa olevat näytön asettelut. CL 
ilmaisee että shift-painike on lukittuna. NUM tarkoittaa että 
näppäimistön numeerinen osa on aktiivisena. OVR ilmaisee että 
päällekirjoitustila on aktiivisena.
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Hakemistojen 
avaaminen ja 
sulkeminen

Hakemistot voidaan avata joko navigointi- tai tieto ikkunasta. Toimitaan 
seuraavasti: 

• Kaksoisklikataan navigaatioikkunassa hakemistoikonia. Tällöin 
aukeaa hakemiston hierarkinen puu navigointi-ikkunassa ja sisältö 
esitetään tieto ikkunassa. 

• Kaksoisklikataan hakemistosymbolia tieto ikkunassa hakemiston 
avaamiseksi.

Drag-and-drop
toiminta

Drag-and-drop (valitse ja siirrä) toiminnalla voidaan käsitellä objekteja 
nopeasti ja luotettavasti.

Drag-and-drop menetelmällä voidaan

Kopioida tietoja (esimerkiksi katalogeista)

Siirtää tietoja (esimerkiksi luotaessa kojeiston topologiaa)

Toimitaan seuraavasti: 

• Valitaan objekti.

• Sijoitetaan hiiren osoitin valitun objektin päälle.

• Painetaan hiiren vasen painike alas ja pidetään alas painettuna.

• Siirretään hiiren osoitin haluttuun kohtaan näytöllä ja vapautetaan 
hiiren painike. 

Kohdeikkunassa kopioitu tai siirretty tieto sijoitetaan osoitettuun kohtaan. 
Sovelluskohtainen oikeellisuustarkastus suoritetaan tarvittaessa.

Kopiotoiminnat Kopiotoimintoja voidaan käyttää konfiguroinnin ja parametroinnin 
yhteydessä.

Määritetään malli laiteparametroinnille ja kopioidaan se valikon Copy 
toiminnalla.

Kopioitu malliparametrointi hyväksytään kokonaisuudessaan ja 
sovitetaan projektiin, jolloin esimerkiksi VD osoite määritellään 
uudelleen. 
492 SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


DIGSI 4 ohjelman käyttö
Sivu (Tab) Määrittelyikkunat on jaettu aiheittain aihekohtaisiin alueisiin 
havainnollisuuden saavuttamiseksi. Näitä aihekenttiä kutsutaan sivuiksi 
(tabs).

• Valittu sivu voidaan aktivoida klikkaamalla sitä hiirellä 
asetteluikkunassa.

Vyöhyke (Section) Sivu on jaettu vyöhykkeisiin. Niiden avulla voidaan määrittelyitä jakaa 
ryhmiin kehyksin erotettuna.

Valintaruudut 
(Check Boxes)

Valintaruuduilla voidaan aktivoida toiminta tai poistaa jonkin toiminnan 
aktivointi. Valintaruudut on esitetty näytöllä ruutuina, joihin voidaan 
aktivoida valintamerkki.

• Klikataan tyhjää ruutua sen aktivoimiseksi.

• Klikataan valintamerkillä varustettua ruutua toiminnan 
määrittelemiseksi pois käytöstä.

Valintakentät Vakioparametriasetteluita voidaan laajentaa tai supistaa lisätoiminnoin. 
Toimintakohtaiset syöttökentät (valintakentät) aktivoidaan tai aktivointi 
poistetaan valintaruutujen ohjaamina.

Ohjauspainikkeet Ohjauspainikkeilla aktivoidaan erillinen määrittelyikkuna tai toiminta. 
Ohjauspainikkeissa on kuvaava teksti tai symboli ja ne voidaan aktivoida 
hiirellä klikkaamalla. Kun toiminta on suoritettu, aktivoituu 
automaattisesti seuraava määrittelyikkuna.

• Aktivoidaan toiminta klikkaamalla painiketta (esimerkiksi, DIGSI > 
Device). 
Seuraava toiminta aktivoituu.

Alasveto-
valikot

Alasvetovalikot on linkitetty syöttökenttiin, joihin voidaan määritellä vain 
arvoja. Toimitaan seuraavasti: 

• Klikataan hiirellä valintaruutua. 
Alasvetovalikko aukeaa.

• Valitaan haluttu vaihtoehto. Valittu vaihtoehto on esitetty 
syöttökentässä.

Yhdistetty
alasvetovalikko

Yhdistetty alsvetovalikko on yhdistelmä yksinkertaisesta syöttökentästä 
ja alasvetovalikosta. Tiedot voidaan joko syöttää siihen käsin tai valita 
alasvetovalikosta. 
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Liite
Säätöruutu Säätöruuduissa voidaan syöttää joko arvo suoraan tai kasvattaa tai 
pienentää arvoa ennalta määräytyin askelin:

• Painetaan nuoli ylös painiketta arvon kasvattamiseksi.

• Painetaan nuoli alas painiketta arvon pienentämiseksi.

Valintaruutu Valintaruuduilla voidaan suorittaa määrittelyitä taulukoiden yksittäisissä 
kentissä. Toimitaan seuraavasti: 

• Siirretään hiiren osoitin taulukon haluttuun kenttään.

• Painetaan oikeata hiiripainiketta. Näyttöön aukeaa toimintakohtainen 
valikko.

• Valitaan haluttu vaihtoehto klikkaamalla sitä.

Katalogit Laitekatalogissa (device catalog) on SIPROTEC laitteet, jotka on 
asennettu ohjelmiston asennuksen yhteydessä tai jälkikäteen lisättynä.
Kun laite liitetään projektiin drag-and-drop menetelmällä, liitetään laitteen 
asettelut projektin tietokantaan.

Report ikkunassa esitetään eri tyyppisten tapahtumien kulkua kuvaavat 
tilamerkinannot. Merkinannot on jaettu erillisille sivuille informaation 
luonteesta riippuen:

DIGSIMAN017

Kuva A-2 Raportti-ikkuna, esimerkki

Ohje:

Report ikkuna on riippumaton sovellus. Kun ikkuna avataan, painike 
lisätään Windowsin tilapalkkiin. Painiketta painamalla ikkuna saadaan 
näkyviin päällimmäiseksi. Jos ikkuna on suljettu käsin, aukeaa se 
automaattisesti jos siihen kuuluva merkinanto aktivoituu. Ikkunaa ei 
voida avata esimerkiksi valikko-ohjauksella.
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A.2 Informaatioiden määrittely - yleistä

A.2.1 Merkinannot 
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Binääriset tulot + + + - - - - - - + + - - - -

Funktiopainike - - - - - - + + - - - - - - -

IRC (Inter Relay Communikation) - + + - + - - + + + + - + + +

CFC + + + + + + + + + - - - - - -
Järjestelmäväylä
IEC 60870-5-103 - - - +/R +/R - + + + - - - - - -

Järjestelmäväylä IEC 61850 1) +/R +/R 1) +/R -/R 1) +/R +/R -/R 1) 1) +/R +/R -/R

Järjestelmäväylä
Profibus FMS - - - +/R +/R - + + + - - - - - -

Muu järjestelmäväylä - - - +/R +/R - + + + - - - - - -

K
oh
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 (D
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Binääriset koskettimet + + - + + + + + - - - + + - -

LED + + - + + + + + - - - + + - -

Käyttöpäiväkirja + + + + + + + + + + + + + + +

Herkkä maasulkupäiväkirja + + - + + + + + - - - - - - -

Häiriöpäiväkirja + + - + + + + + - - - - - - -

Hälytyspäiväkirja - + - - - - - + - - - - + - -

Järjestelmäväylä
IEC 60870-5-103

+ + + + + + + + + - - + + + -

Järjestelmäväylä IEC 61850 1) +/R +/R 1) +/R +/R 1) +/R +/R -/R 1) 1) +/R +/R -/R

Laajennettu väylä (IEC 61850)

Järjestelmäväylä
Profibus FMS

+ + + + + + + + + + + + + + +

Muu järjestelmäväylä + + + + + + + + + - - + + + -

CFC + + + + + + + + + - - + + + -

IRC (Inter Relay Communikation) - + + - + - - + + + + - + + +

Ohjausnäyttö + + + + + + + + + - + + + + -

Perusnäyttö + + + + + + + + + - + + + + -

Ohjausvalikko - + + - - - + + + + + - + + +
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Esitetään häiriötallenteessa + + - + + - + + - - - - - - -

Suodatusaika + + + - - - - - - + + - - - -

Aikaleima ennen suodatusta + + + - - - - - - + + - - - -

Suodatusajan uudellen 
käynnistys

+ + + - - - - - - + + - - - -

Välitilan esitysesto - - + - - - - - - - - - - - -

Käämikytkimen koodaus - - - - - - - - - - + - - - -

Käämikytkimen portaiden 
lukumäärä

- - - - - - - - - - + - - - -

Käämikytkimen liikuntakosketin - - - - - - - - - - + - - - -

Käämikytkimen bittien lukumäärä - - - - - - - - - - + - - - -

Käämikytkimen näytön offset - - - - - - - - - - + - - - -

Käämikytkimen askelväli - - - - - - - - - - + - - - -

Perusasettelun palautus - - - - - - + + + - - + + + +

Perusasettelun uudelleen 
palautus

- - - - - - + + + - - + + + +

Funktiotyyppi
(IEC 60870-5-103)

+ + + + + + + + + - - + + + -

Informaationumero 
(IEC 60870-5-103)

+ + + + + + + + + - - + + + -

Informaation tyyppi (IEC 60870-
5-103)

+ + + + + + + + + - - + + + -

Vain esitys = "R"
Parametroitavissa = "+"
Ei parametroitavissa = "-"
Parametroitavissa käyttäjäobjekteilla, vain esitys L0 objekteilla = "+/R", "-/R"
1) Mahdollista liittää informaatio menemään järjestelmäväylään tai sekä tulemaan että menemään 
järjestelmäväylään, jolloin informaatiota ei voida määritellä pelkästään tulevaksi järjestelmäväylästä. 
Parametroitavissa käyttäjäobjekteilla, vain esitys L0 objekteilla.
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A.2.2 Ohjaukset
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CFC + + + + + +

IRC (Inter Relay Communikation) - - - - - -

Järjestelmäväylä IEC 60870-5-103 + - + + + +

Järjestelmäväylä IEC 61850

Järjestelmäväylä Profibus FMS + + + + + +

Muu järjestelmäväylä + - + + + +
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Binääriset koskettimet + + + + - -

Yhteinen ohjauskosketin + + + + - -

Signaalikosketin + + + + - -

Käyttöpäiväkirja + + - - + -

Järjestelmäväylä IEC 60870-5-103 - - - - - -

Järjestelmäväylä IEC 61850

Laajennettu väylä (IEC 61850)

Järjestelmäväylä Profibus FMS - - - - - -

Muu järjestelmäväylä - - - - - -

CFC + + + + + +

IRC (Inter Relay Communikation) - - - - - -

Ohjausnäyttö + + + + + +

Perusnäyttö + + + + + +

Ohjausvalikko + + + + + +
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Kiinnisuunnan vapautus (osittain lukittu) + + + + + +

Aukisuunnan vapautus (osittain lukittu) + + + + + +

Kiinnisuunnan vapautus + + + + + +

Aukisuunnan vapautus + + + + + +

Lukitustunniste (8) + + + + + +

Toiminnan tila + + + + - -

Ohjausaika + + + + - -

Aikaviive + + - - - -

Valvonta-aika - - + + - -

Takaisinkytkennän valvonta-aika - - + + - +

Funktiotyyppi (IEC 60870-5-103) + + + + + +

Informaationumero (IEC 60870-5-103) + + + + + +

Vain esitys = "R"
Parametroitavissa = "+"
Ei parametroitavissa = "-"
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A.2.3 Mittausarvot
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Analoginen jännitepiiri - - - - - +

Analoginen virtapiiri - - - - - +

CFC + + - - + -

IRC (Inter Relay Communikation) + + + - + -

Järjestelmäväylä IEC 60870-5-103 - - - - - -

Järjestelmäväylä IEC 61850 X -/R X -/R X X X -

Järjestelmäväylä Profibus FMS + + - - - -

Muu järjestelmäväylä + + - - - -
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Mittausarvoikkuna R R - - + -

Järjestelmäväylä IEC 60870-5-103 R R R R R -

Järjestelmäväylä IEC 61850 X +/R X +/R X X X -

Laajennettu väylä (IEC 61850) -

Järjestelmäväylä Profibus FMS + + + + + -

Muu järjestelmäväylä + + + + + -

CFC + + + - - -

IRC (Inter Relay Communikation) + + + - + -

Ohjausnäyttö - - + + + -

Perusnäyttö - - + + + -

O
m

in
ai

su
ud

et

Perusasettelun palautus + + - - - -

Perusasettelun uudelleen palautus + + - - - -

Kerroin + R + - + -

Desimaalilukumäärä + R + - + -

Suure + R + - + -

Min. asetteluarvo + R - - - -

Max. asetteluarvo + R - - - -

Vain esitys = "R"
Parametroitavissa = "+"
Ei parametroitavissa = "-"
X: Liitettävissä järjestelmäväylään joko kohteeksi tai lähteeksi, määrittely kohteeksi ja 
lähteeksi ei ole mahdollista. Parametroitavissa käyttäjäobjekteilla, vain esitys L0 
objekteilla.
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Liite
A.2.4 Laskurimittausarvot

PM
V

M
VM

V

Ex
M

V

Lä
hd

e 
(S

ou
rc

e)
Binääriset tulot + - -

IRC (Inter Relay Communikation) - - +

CFC - - +

Referenssimittausarvo - R/+ -

Järjestelmäväylä IEC 60870-5-103 - - -

Järjestelmäväylä IEC 61850 X X -/R

Järjestelmäväylä Profibus FMS - - -

Muu järjestelmäväylä - - -

K
oh

de
 (D

es
tin

at
io

n)

Laskurimittausarvoikkuna + + -

Järjestelmäväylä IEC 60870-5-103 + + +

Järjestelmäväylä IEC 61850 X X +/R

Laajennettu väylä (IEC 61850)

Järjestelmäväylä Profibus FMS + + +

Muu järjestelmäväylä + + +

IRC (Inter Relay Communikation) - - +

CFC + + +

Ohjausnäyttö + + +

Perusnäyttö + + +
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Informaatioiden määrittely - yleistä
O
m

in
ai

su
ud

et

Lähetystyyppi + + -

Tehon suunta R + -

Kerroin + - -

Desimaalilukumäärä + - -

Suure + - -

Pulssityyppi + - -

Ulkoinen häiriösisääntulo + - -

Perusasettelun palautus - - +

Perusasettelun uudelleen palautus - - +

Funktiotyyppi (IEC608070-5-103) + + +

Informaationumero (IEC608070-5-103) + + +

Vain esitys = "R"
Parametroitavissa = "+"
Ei parametroitavissa = "-"
Parametroitavissa käyttäjäobjekteilla, vain esitys L0 objekteilla 
= "+/R", "-/R"
X: Liitettävissä järjestelmäväylään joko kohteeksi tai lähteeksi, 
määrittely kohteeksi ja lähteeksi ei ole mahdollista. 
Parametroitavissa käyttäjäobjekteilla, vain esitys L0 
objekteilla.
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Liite
A.3 Sovellusmodeemilla toteutettu kaukoyhteys - esimerkki

Liikennöitäessä SIPROTEC laitteiden kanssa modeemein toteutetulla 
etäyhteydellä, tulee määrätyt asiat ottaa huomioon. Seuraavissa 
kappaleissa on kuvattu yksityiskohtaisesti etäyhteyden toteutus MT2834 
soittomodeemilla.

Projektin rakenne Kaikkien käytettyjen modeemien puhelinnumerot tallennetaan suoraan 
projektissa olevaan puhelinluetteloon (Phone Book).

Kaikkien projektissa käytettyjen modeemien asettelut tallennetaan myös 
suoraan projektiin (Modems).

DIGSIKOM901.gif

Kuva A-3 Modeemit ja puhelinluettelo projektissa

Modeemiyhteys (modem connection) määrittelee yhteydenotossa 
käytetyt modeemit ja se on luotavissa vain yhteen hakemistoon, 
esimerkiksi sähköasema "North".

Jos projektissa on useampia sähköasemahakemistoja, voidaan 
modeemiyhteys luoda sen hakemistoon käyttäen Modems 
hakemistossa määriteltyjä modeemeja.
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Sovellusmodeemilla toteutettu kaukoyhteys - esimerkki
Sähköasemahakemisto (esimerkiksi sähköasema "North") voi sisältää 
useampia johtolähtöhakemistoja (esimerkiksi lähtö 1, jne.), joissa 
suojalaitteet sijaitsevat.

DIGSIKOM902.gif

Kuva A-4 Lähtöhakemistoin varustettu projektirakenne

Jos asemalla olevien SIPROTEC 1/2/3 laitteiden kanssa liikennöidään 
myös kanavakytkimen (aktiivinen minitähtijakaja) kanssa, tulee se myös 
lisätä (kuten modeemiliityntä) projektiin. DIGSI 4 projektin rakenne kuvaa 
täten hakemistorakenteensa mukaisesti sähköaseman rakennetta.

Ohje:

Jos sähköasemat (esimerkiksi sähköasema "North") on luotu omaksi 
projektikseen, voidaan Phone Book ja Modems hakemistot luoda 
jokaiseen projektiin erikseen. 

Ohje:

Jos liikennöidään V2 laitteiden kanssa kanavakytkimen kautta, voidaan 
tietokoneessa käyttää vain sarjaliikenneväyliä COM1 - COM4.
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Liite
Soittotapahtuma • Avataan haluttu suojalaite kaksoisklikkaamalla sitä ja valitaan Online, 
yhteyden muodostustavaksi Modem.

DIGSI 4 ohjelma hakee suojalaitteen ylemmiltä tasoilta modeemiyhteyttä 
(modem connection), jolla se tulee yhteyden muodostamaan.

Yhteys muodostetaan modeemilla määritellyin asetteluin.

Toimistomodeemi
 (Local Modem):

Jos modeemityypit ja -asettelut ovat samoja kaikissa pisteissä, voidaan 
samaa toimistomodeemia ja puhelinnumeroa käyttää kaikkiin 
modeemiyhteyksiin. 

Jos toimistomodeemi tulee initialisoida poikkeavin asetteluin, koska 
sähköasemilla olevilla modeemeilla (remote modem) on toisistaan 
poikkeavat tiedonsiirtoformaattiasettelut, tulee useampia 
toimistomodeemeja määritellä käyttöön erillisin modeemiyhteyksin 
(Modem Connection).

Sähkäaseman 
modeemi (Remote 
Modem):

Erillinen modeemi tulee määritellä projektiin Modems objektissa 
jokaiselle sähköasemalle, joilla on toisistaan poikkeava puhelinnumero ja 
muut mahdolliset asettelut.

Jos modeemityypit ja -asettelut ovat samoja kaikilla sähköasemilla, 
voidaan samoja modeemeja käyttää samoin asetuksin ja toisistaan 
poikkeavin puhelinnumeroin eri modeemiyhteyksien luomiseen. 

Jos sähköasemilla modeemityypit poikkeavat toisistaan, tulee modeemit 
asetella niitä vastaavasti.

Ohje:

Modeemiyhteyksien asettelua helpottaa oleellisesti jos kaikkialla 
käytetään saman tyyppisiä modeemeja.
504 SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Liityntäkaapeleiden kytkennät
A.4 Liityntäkaapeleiden kytkennät

Kuvassa A-5 on esitetty modeemin ja SIPROTEC 4 laitteen huoltoväylän 
yhdistävän liityntäkaapelin kytkentä. Tätä kaapelia ei voi tilata 
Siemensiltä, koska sitä yleensä käytetään vain testaustarkoituksiin. On 
erityisen suositeltua käyttää modeemien ja suojalaitteiden välillä optista 
erotusta mahdollisten ylijännitteiden estämiseksi.

DIGSIKOM100

Kuva A-5 Modeemin ja SIPROTEC 4 laitteen välisen kaapelin kytkentä

Kuvassa A-6 on esitetty 7XV5100-4 kaapelin kytkentä. Sitä voidaan 
käyttää tietokoneen ja laitteen edessä olevan käyttö- tai kotelon takana 
olevan huoltosarjaliikenneväylän välisessä  RS232 liikennöinnissä.

DIGSIKOM101

Kuva A-6 Modeemin ja SIPROTEC 4 laitteen välisen 7XV5100-4 kaapelin 
kytkentä

2 3TxD
3 2RxD
7 5GND
Kotelo

4
5
6

20

Kotelo

7
8

Modeemi
25-napainen liitin

SIPROTEC 4 laite
9-napainen liitin

Pituus enintään 10m

2 3RxD

3 2TxD
5 5GND

4
6
7
8

7
8

PC
9-napainen liitin

SIPROTEC 4 laite
9-napainen liitin

Pituus 3 m
keltainen

valkoinen
vihreä
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A.5 Yleisiä ohjeita modeemeille

Tietokoneen ja suojalaitteen välisen modeemiyhteyden käyttöönotossa 
voi esiintyä ongelmia. Tästä johtuen seuraavat ohjeet tulee ottaa 
huomioon.

Pariteettibitti DIGSI® 4 ohjelma kommunikoi SIPROTEC 4 laitteiden kanssa 
IEC 60870-5-2 protokollalla. Protokollassa on verkko- ja 
tiedonsiirtokerrokset. Tiedonsiirtokerros on suojattu CRC-
varmennuksella, joka takaa korkeamman tiedonsiirtovarmuuden kuin 
IEC 60870-5-103 protokolla. Tämän liikennöintitavan etuna 
modeemiyhteydellä on, että pariteettibittiä ei käytetä.

Virheen korjaus ja 
tietojen pakkaus

Modeemitiedonsiirrossa käytetään nykyään yleisesti tiedon pakkausta ja 
virheen korjausta. Molemmat menetelmät aiheuttavat katkoksia 
tiedonsiirtoon, joita IEC 60870-5-103 protokolla ei salli. IEC 60870-5-103 
laitteiden ensimmäinen sukupolvi ei hyväksy tiedonsiirtokatkoksia, joten 
näiden laitteiden yhteydessä tulee tietojen pakkaus ja virheiden 
korjaustoiminnat ottaa pois käytöstä. Uudemmilla laitesukupolvilla ja 
kaikilla SIPROTEC 4 laitteilla suurin sallittu tiedonsiirtokatkos on 
aseteltavissa. Näillä laitteilla voidaan ja on myös suositeltavaa käyttää 
virheen korjaus- ja tiedon pakkaustoimintoja.

Kättelytapa
(Flow Control)

Koska useammilla suojalaitteilla (poikkeukset esitetty myöhemmissä 
kappaleissa) ei voida käyttää kättelysignaaleja, tulee modeemin pystyä 
vastaanottamaan vähintään 256 tavua. Tämä vastaa pisintä sallittua 
tiedonsiirtotelegrammia. Joillakin modeemeilla puskurin koko on 
sovitettu tietopakettien sisäiseen telegrammikokoon. Täten pituus riippuu 
tiedonsiirtoyhteyden laadusta. Tästä syystä tämä toiminta tulee 
määritellä pois käytöstä. SIPROTEC 4 laitteiden huoltoväylällä voidaan 
kättelysignaalit määritellä asettelusilloin. Tällöin SIPROTEC 4 laitteilla 
voidaan käyttää kättelysignaaleja liitettäessä modeemi suoraan 
huoltoväylään.
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Yleisiä ohjeita modeemeille
Muita
asetteluohjeita

Seuraavat asetteluohjeet pätevät vain jos SIPROTEC 4 laitteet on 
liiteetty modeemiin. Jos modeemiin on liitetty useamman laitesukypolven 
laitteita, tulee DIGSI V3.3 käyttöohjeessa, kappaleessa A.8.4 ja A.8.5 
esitetyt ohjeet ottaa huomioon.

Puhelinyhteyden tiedonsiirtonopeutta ei tule rajoittaa, jotta modeemit 
voivat valita itsenäisesti suurimman mahdollisen tiedonsiirtonopeuden. 
Tietojen pakkaus ja virheiden korjaustoiminnat tulee sallia. Mahdollinen 
pariteettibitti tulee määritellä pois käytöstä.

Jos sähköaseman modeemi edellyttää DTR signaalin yhteyden 
ohjaukseen, tulee se määritellä pysyvästi käyttöön, jos mahdollista, 
modeemin DIP-kytkimin. Muussa tapauksessa signaali tulee määritellä 
pois käytöstä käskymerkkijonolla (esimerkiksi käyttämällä komentoa 
AT&D0).

Seuraavat kohdat tulee ottaa huomioon tietokonetta ja SIPROTEC 4 
laitteita aseteltaessa:

WINDOWS käyttöjärjestelmässä modeemiajurille määritelty suurin 
sallittu tiedonsiirtonopeus 

SIPROTEC 4 laitteen liikennöintiväylän liikennöintinopeus 

SIPROTEC 4 laitteen liikennöintiväylän suurin sallittu 
tiedonsiirtokatkos 

SIPROTEC 4 laitteen ja modeemiajurin tiedonsiirtoformaatti 

Ohje:

Kun kommunikaatioyhteys ei ole aktiivisena ja suurin sallittu 
tiedonsiirtokatkos on aseteltu ≥ 2.1 s, lähettävät SIPROTEC 4 laitteet 
jaksottaisesti  ATE0Q1<CR> komentojonon, jotta modeemi voisi 
synkronoida liikennöintinopeutensa. Tästä syystä sähköaseman 
modeemilla ei liikennöintinopeutta tarvitse asetella kiinteästi, koska se 
voi tunnistaa käytetyn nopeuden automaattisesti sarjaliikenneväylästä.

Kuitenkin joillakin modeemeilla ei voida hyödyntää tätä komentojonoa. 
Jos jotkin modeemit vastaanottavat tämän komentojonon yhteyden 
ollessa aktiivisen, katkeaa yhteys välittömästi jolloin yhteyden 
muodostus ei ole mahdollista.
Tästä syystä näillä laitteilla tulee tiedonsiirtonopeus määritellä kiinteästi 
ja kaikutoiminta määritellä pois käytöstä E0 komentojonolla.

Ohje:

Lisäasetteluohjeita ja toteutusesimerkkejä löytyy internetistä http://
www.siprotec.de. Esimerkit on sijoitettu Download Area linkin takaa 
aktivoitavissa olevalta Applications → Remote Control sivulta.
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Liite B
Yleistä Tässä kappleessa on esitetty määrättyjä yksityiskohtia merkinantojen ja 

ohjausten määrittelystä.

Sisältö B.1  Merkinannot  510

B.2  Ohjaukset  511
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B.1 Merkinannot

Merkinantoja ovat laitetiedot tapahtumista ja tiloista, jotka voidaan 
välittää eteenpäin binäärisiin koskettimiin, esimerkiksi tapahtumat 
prosessorin uudelleen käynnistyksestä (tapahtuma) tai häiriö laitteen 
toiminnoissa (tila). Näitä kutsutaan ulostulomerkinannoiksi output 
indications. Merkinantoja ovat myös suojattavasta kojeistosta 
vastaanotetut tilat ja tapahtumat, kuten esimerkiksi katkaisijan 
laukeaminen tai katkaisijan asento. Näitä kutsutaan tulomerkinannoiksi 
input indications. 

Lisäksi merkinannot voidaan erotella tyypin perusteella. Alla on kuvattu 
määrätyt merkinantotyypit kaaviollisesti. Kaksinapaisessa 
merkinannossa käytetään kahta binääristä tuloa. Niillä on yleensä 
vastakkaiset tilat, joita laite myös valvoo. 

Kuva B-1 Ulostulomerkinanto (OUT)

Kuva B-2 Tulomerkinannot SI

Kuva B-3 Tulomerkinanto DP

Tapahtuma

L+

(Sisäinen looginen 
informaatio)

Merkinanto koskettimelta

(Kojeisto)

(SIPROTEC laite)

L+
L–

esim. katkaisija

Yksinapainen

Binäärinen
tulo

(SIPROTEC laite)

(Kojeisto)

L+

L–

esim. erotin
M

Kaksinapainen merkinanto

Binäärinen
tulo

Binäärinen
tulo

(Kojeisto)

(SIPROTEC laite)
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Ohjaukset
B.2 Ohjaukset

Ohjaukset ovat lähtömerkinantoja, jotka on määritelty koskettimille 
suojattavaan kojeistoon välitettäviksi. 

Kullekin kytkinlaitteelle määritellään ohjataanko sitä 1, 11/2, 2, ... 
koskettimella, yksi- vai kaksinapaisesti, varustettuna 
takaisinkytkennän valvonnalla tai ilman. Ohjaustapahtumaan liittyvien 
informaatioiden lukumäärä ja tyyppi määräytyy ohjaustyypin 
mukaisesti. 

Tulee huomioida että SIPROTEC® laitteen binäärisillä tuloilla ja 
lähdöillä on määrätyt ominaisuudet. Seuraavat kohdat tulee ottaa 
huomioon: 

− Kytkinlaitteiden asentojen määrittelyssä ja ohjausten toteutuksessa 
tulee käyttöön olla määriteltyinä peräkkäiset binääriset tulot ja 
ohjauskoskettimet.

− SIPROTEC® laitteiden binääristen tulojen ja lähtöjen yhteiset 
paluupotentiaalit tulee ottaa huomioon piirikaavioita 
suunniteltaessa. 

Kun ohjaustyyppi on valittu, varaa DIGSI® 4 ohjelma tarvittavan määrän 
laitteen binäärisistä koskettimista. Toimintaan varataan 
numerojärjestyksessä peräkkäiset koskettimet. Tämä tulee ottaa 
huomioon binäärisiä koskettimia määriteltäessä ohjauksia varten. 

Kaksoisohjauksissa DIGSI® 4 ohjelmassa valitaan 
numerojärjestyksessä ensimmäinen kosketin. Muut tarvittavat 
koskettimet varataan automaattisesti DIGSI® 4 ohjelman toimesta.  
Takaisinkytkennän valvonnalla varustetuissa ohjauksissa muodostaa 
DIGSI® 4 ohjelma automaattisesti kytkinlaitteen asennon 
valvontamerkinannon määrittelymatriisissa. 
Tällöin on erittäin tärkeää huomioida: AUKI asento tulee olla aina 
ennen KIINNI asentoa. 

Seuraavissa kuvissa on esimerkkejä ohjausten ajallisesta kulusta, 
ohjauspiireistä sekä eri ohjaustyyppien käyttämistä koskettimista.  
Kuvissa käytetään seuraavia lyhenteitä: 

− CON Kiinnikosketin

− COFF Aukikosketin

− CCC Yhteinen kosketin

− CCCC Yleinen yhteinen kosketin

− L+; L– Ohjausjännite
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Kuva B-4  1-koskettiminen yksinapainen ohjaus 

Kuva B-5  1-koskettiminen kaksinapainen ohjaus 

Kuva B-6  1 1/2-koskettiminen kaksinapainen ohjaus 

O
N

X

        Ohjaus

CON

t
ON Ohjain 

 

CON
L+

L–Koskettimien
1

määrittely:

         Kiinniohjaus
ON

CON

  COFF

          Aukiohjaus
OFF

t

ON OFFOhjain 
 

CON COFF
L+

L–

Koskettimien

O
N

X

1

O
FF

X

2

määrittely:

         Kiinniohjaus
ON

CON

COFF

           Aukiohjaus
OFF

CCC

t

ON OFFOhjain 
 

CON COFF
L+

L–

CCC

Koskettimien

O
N

X

1

 O
FF

X

2 3

X

  C
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. 
 C
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t.

määrittely:
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Ohjaukset
Kuvassa B-7 on käytetty yleistä yhteistä kosketinta useamman 
kytkinlaitteen ohjauskoskettimien kanssa. Turvallisuussyistä useamman 
kytkinlaitteen yhtäaikainen ohjaus on estetty lukituksin. 

Kytkinlaitteita ohjattaessa yleinen yhteinen kosketin ohjautuu 
automaattisesti, kun jotain kytkinlaitetta ohjataan eli sitä ei tarvitse 
konfiguroida erikseen. Ohjaus on 1-koskettiminen. 

Kuva B-7  1-koskettiminen kaksinapainen ohjaus varustettuna yleisellä yhteisellä koskettimella

Kuva B-8  2-koskettiminen kaksinapainen ohjaus (4 koskettiminen toiminta)

           Kiinniohjaus
ON

CON

COFF

Aukiohjaus
OFF

CCCC

t

ON OFFOhjain 
1

Ohjain
2...n

CON COFF
L+

L–

CCCC

Koskettimien 

O
N

X

1

O
FF

X

2

X

C
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tr.
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m
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n
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määrittely:

          Kiinniohjaus
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CON1

CON2

           Aukiohjaus
OFF

COFF1

t

ON OFFOhjain 
 

CON1 COFF1
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L–

CON2
COFF2

COFF2

Koskettimien 

O
N
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X
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O
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1

X
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O
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2

X

O
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2

X
määrittely:
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Kuva B-9  1-koskettiminen AUKI ja 2-koskettiminen KIINNI ohjaus (3 koskettiminen toiminta) 

Kuvassa B-10 on esitetty kuinka suoran moottoriohjaintoiminnan piirit 
voidaan kytkeä: 

− Vastapäivään kiinniohjaus

− Myötäpäivään aukiohjaus

− Seis lepotila

Nämä tehoreleet, joissa on kaksi sulkeutuvaa kosketinta, ovat 
keskenään lukitut jolloin vain yksi rele voi olla aktiivisena kerrallaan. 

Seuraavat kohdat tulee ottaa huomioon jos tehoreleillä ohjataan 
moottoriohjattua kolmiasentoerotinta: Samoja lähtöreleitä ohjataan 
kahdesta eri ohjauksesta eli erottimen ja maadoituserottimen ohjausten 
yhteydessä. Koska kaksi pääteasentoa tulee saavuttaa yhteisessä auki-
tilassa, eli ohjainmoottorin pyöriessä eri suuntiin, tulee kaksi ohjausta 
määritellä käänteisiksi. Tässä käyttötarkoituksessa voidaan käyttää 
ohjaustyyppejä BR_D2 ja BR_D2N. 

2-koskettiminen piiri yhdellä ohjauskanavalla yksin koskettimin 
varustetuilla kahdella releellä on mahdollista vain rajoituksin. Tällöin 
toiminnassa tulee käyttää moottoriohjauksiin suunniteltuja tehoreleitä 
(kuvat B-11 ja B-12). Huomiotava sisäisen yhteisen koskettimen käyttö. 
Lisätietoja toimintojen toteutuksista on esitetty laitteiden käyttöohjeissa.

Kuva B-10  Moottoriohjaimen piirit (vasta-/myötäpäivään), kahdella 2-koskettimisella tehoreleellä

           Kiinniohjaus
ON

CON1

CON2

            Aukiohjaus
OFF

COFF
t

ON OFFOhjain 
 

CON1 COFF
L+

L–

CON2

Koskettimien 

O
N

1

X

1

O
FF

X

2 3

X
O

N
2

määrittely:

          Kiinniohjaus
ON

CON

          Aukiohjaus
OFF

t

CON1 CON2

L+

L–

COFF1

COFF

COFF2

 
Moottori

Koskettimien 

O
N

X

6

O
FF

X

7

määrittely:
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Ohjaukset
Kuva B-11Esimerkki tehokoskettimin BO6 ... BO9 varustetun laitteen 
liityntäkaavioista, jonka piirit vastaavat kuvassa B-12 esitettyä 
toteutustapaa 

Kuva B-12  2-koskettiminen toiminta, yksi ohjauskanava kahdella ohjausreleellä (määriteltynä 
"kaksinapainen ohjaus, 1-kosketin"), esimerkki

J2
(BO6) J3

J4

C17

C18
BO7

BO8

(BO9)

J1

OFF

ON

L+L–SIPROTEC

   Kiinniohjaus
ON

CON

   Aukiohjaus
OFF

COFF

t

CON1 COFF1CON2 COFF2

ON OFF
Ohjain

Toimintaan määriteltyjä koskettimia ei saa käyttää muihin tarkoituksiin!

Koskettimien 

O
N

6

O
FF

X

7 8 9

X– –

L+

L–

määrittely:
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Kirjallisuus

/1/ SIPROTEC DIGSI 4, Start Up
E50417-G1176-C152

/2/ DIGSI CFC, Manual
E50417-H1176-C098

/3/ SIPROTEC SIGRA 4, Manual
E50417-H1176-C070
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Battery (Paristo) Puskuriparistolla varmennetaan määrätyt tiedot, sisäinen kellonaika ja 
kalenteri apusähkönkatkoksilta. 

Bay controllers 
(Kenttäyksiköt)

Kenttäyksiköt ovat ohjauksissa ja valvonnoissa käytettyjä laitteita, joissa 
ei ole suojaustoimintoja.

Bit pattern 
indication 
(Bittimalli 
merkinanto)

Bittimalli merkinannot sisältävät toiminnan, jossa useampaan 
binääriseen tuloon rinnakkain tuodut tiedot yhdistetään ja niistä 
muodostetaan yksi informaatio. Bittimallien pituus on määriteltävissä 1, 
2, 3 tai 4 tavua.

BP_xx → Bittimalli merkinanto (x bitin bittijono), 
x määrittelee pituuden bitteinä (8, 16, 24 tai 32 bittiä).

C_xx Ohjaukset ilman takaisinkytkentävalvontaa

CF_xx Ohjaukset varustettuna takaisinkytkennän valvonnalla

CFC Continuous Function Chart. CFC on graafinen editori, jossa käyttäjä voi 
luoda loogisia toiminnallisuuksia valmiiksi määritellyillä toimintalohkoilla.

CFC blocks 
(CFC lohkot)

Lohkot ovat esiohjelmoituja toimintakokonaisuuksia, joista käyttäjä voi 
muodostaa eri tyyppisiä toiminnallisuuksia. 

Chatter 
suppression 
(Kosketinväräh-
telyn esto)

Nopeasti tilaansa muuttava sisääntulo (esimerkiksi lähettävän laitteen 
kosketinhäiriö) lukitaan määrätyksi ajaksi, jolloin se ei ota vastaan 
tilamuutoksia. Toiminnalla estetään järjestelmän ylikuormittuminen 
ongelmatilanteissa.

Cleaning up 
(Puhdistus)

Objektien toistuva lisääminen ja poistaminen varaa muistialuetta, joka ei 
ole enää käytössä. Projektin puhdistuksella voidaan tämä muistialue 
palauttaa käyttöön. Tällöin puhdistus kuitenkin määrittelee VD osoitteet 
uudelleen. Tämän seurauksena kaikki SIPROTEC 4 laitteet tulee 
initialisoida uudelleen.
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Combination 
devices 
(Yhdistelmälaitteet)

Yhdistelmälaitteet ovat kenttälaitteita, jotka on varustettu 
suojaustoiminnoin ja graafisin ohjausnäytöin.

Combination matrix 
(Liityntämatriisi)

Enintään 16 yhteensopivaa SIPROTEC 4 laitetta voi kommunikoida 
keskenään suoraan laitteiden välisin liitynnöin (IRC, Inter Relay 
Communication). Siirrettävät tiedot määritellään liityntämatriisissä.

Communication 
branch 
(Kommunikaatio-
haara)

Kommunikaatiohaara muodostuu 1 ... n laitteista, jotka kommunikoivat 
samassa väylässä.

Communication 
reference CR 
(Kommunikaatio-
referenssi)

Kommunikaatioreferenssi määrittelee yksikön tyypin ja version 
PROFIBUS FMS kommunikaatiossa.

Component view 
(Komponentti-
näyttö)

Topologianäytön lisäksi SIMATIC Manager mahdollistaa ns. 
komponenttinäytön käytön. Komponettinäytössä ei esitetä projektin 
hierarkista rakennetta. Sen avulla voidaan esittää SIPROTEC 4 
laitteiden rakenne projektissa.

COMTRADE Common Format for Transient Data Exchange, josta on tullut 
yleisimmin käytetty häiriötallenteiden formaatti. 

Container 
(Hakemisto)

Tällä termillä määritellään yleisesti objektit jotka sisältävät muita 
objekteja. Yleensä tästä objektista käytetään nimitystä hakemisto.

Control display 
(Ohjausnäyttö)

Suurella graafisella näytöllä varustetuilla laitteilla control-painikkeella 
aktivoituva näyttö on nimetty ohjausnäytöksi. Sen avulla näytössä 
ohjattavaksi määriteltyjä kykinlaitteita voidaan ohjata ja kytkinlaitteiden 
asennot voidaan esittää. Sen avulla voidaan ohjata laitteeseen liitettyjä 
kytkinlaitteita. Ohjausnäytön kuva ja toiminnallisuus määritellään 
konfiguroinnin yhteydessä.

Data panel 
(Tieto ikkuna)

Projektin oikeanpuoleista ikkunaa kutsutaan tieto ikkunaksi, jossa 
esitetään navigointi-ikkunassa valitun objektin sisältö, esimerkiksi 
merkinannot, mittausarvot, jne. Ikkunassa esitetään varsinaiset objektit, 
joilla esimerkiksi laitteen konfiguroinnit voidaan suorittaa.

DCF77 Saksan valtion ylläpitämä erittäin tarkka virallinen aika, jota ylläpitää 
"Physikalisch-Technischen-Bundesanstalt PTB" virasto 
Braunschweigissa. Atomikellolla muodostettu aika lähetään 
aikasignaalina pitkillä radioaalloilla antennin sijaitessa Mainflingenissä 
Frankfurt/Mainin lähellä. Aikasignaali voidaan vastaanottaa luotettavasti 
noin 1500 km säteellä Frankfurt/Mainista mitattuna.
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Device container 
(Laitehakemisto)

Komponenttinäytöllä kaikki SIPROTEC 4 laitteet on sijoitettu 
laitehakemistoon. Tämä on DIGSI 4 Manager ohjelman erikoisobjekti. 
Koska DIGSI 4 Manager ohjelmassa ei ole erillistä komponenttinäyttöä, 
on tämä objekti nähtävissä ainoastaan STEP 7 ohjelmassa.

Double command 
(Kaksoisohjaus)

Kaksinapainen ohjaus on ohjaustapa, jolla voidaan esittää neljä erillistä 
tilaa kahdella koskettimella: 2 määriteltyä (esimerkiksi KIINNI/AUKI) ja 
kaksi määrittelemätöntä tilaa (esimerkiksi väli- ja virhetilat).

Double point 
indication 
(Kaksinapainen 
merkinanto)

Kaksinapainen merkinanto on merkinantotyyppi, jolla voidaan ilmaista 
neljä tilaa kahdella tulolla: 2 määriteltyä (esimerkiksi KIINNI/AUKI) ja 
kaksi määrittelemätöntä tilaa (esimerkiksi väli- ja virhetilat).

DP → Kaksinapainen merkinanto 

DP_I → Kaksinapainen merkinanto varustettuna välitilalla 00

Drag-and-drop 
(Valitse ja siirrä)

Toiminta jota käytetään graafisessa käyttäjäliittymässä kopiointiin, 
siirtoon ja toimintojen yhdistyksiin. Objekti valitaan hiirellä, siirretään 
hiiripainike alas painettuna halutulle alueelle ja sijoitetaan haluttuun 
kohtaan hiiripainike vapauttaen.

Earth (Maa) Johtava maa on määritelmä sähköisestä potentiaalista, joka voidaan 
määritellä nollaksi jokaisessa pisteessään.

Maaelektrodin lähettyvillä voi potentiaali poiketa nollasta. 
Maadoitusominaisuudet määritellään projekteissa erillisellä 
maadoitussuunnitelmalla.

Earthing 
(Maadoitus)

Maadoituksella tarkoitetaan että laitteen johtava osa on yhdistetty 
maapotentiaaliin.

Earthing 
(Maadoitus)

Maadoitus on yleistermi eri tyyppisten järjestelmien ja laitteiden 
liittämiseksi maapotentiaaliin.

Electromagnetic 
compatibility 
(Sähkömag-
neettinen 
yhteensopivuus)

Sähkömagneettisella yhteensopivuudella (EMC) tarkoitetaan 
elektronisen laitteen kykyä toimia häiriöttömästi eri tyyppisissä 
ympäristöissä aiheuttamatta myöskään häiriöitä muille laitteille.

EMC → Sähkömagneettinen yhteensopivuus

ESD protection 
(ESD suojaus)

ESD suojauksella tarkoitetaan yleisesti sähköstaattisten herkkien 
laitteiden käsittelyssä käytettäviä menetelmiä.
521SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Sanasto
ExBPxx Ulkoinen bittimalli merkinanto ETHERNET yhteydellä.

ExC Ulkoinen ohjaus ilman takaisinkytkentää ETHERNET yhteydellä. 
 

ExCF Ulkoinen ohjaus varustettuna takaisinkytkennällä ETHERNET 
yhteydellä. 

ExDP Ulkoinen kaksinapainen merkinanto ETHERNET yhteydellä.

ExDP_I Ulkoinen kaksinapainen merkinanto ETHERNET yhteydellä varustettuna 
välitilalla 00.

ExMV Ulkoinen mittauslaskuriarvo ETHERNET yhteydellä.

ExSI Ulkoinen yksinapainen merkinanto ETHERNET yhteydellä.

ExSI_F Ulkoinen yksinapainen hipaisumerkinanto ETHERNET yhteydellä. 

Field devices 
(Kenttälaitteet)

Yleistermi laitteille, jotka on sijoitettu sähköaseman kennotasolle: 
suojalaitteet, yhdistetyt suoja ja ohjauslaitteet ja erilliset ohjauslaitteet.

Floating (Kelluva 
potentiaali)

Esimerkiksi galvaaninen johdin, jolla ei ole sähköistä yhteyttä 
maapotentiaaliin.

FMS
Communication 
branch (FMS 
Kommunikaatio-
haara)

FMS kommunikaatiohaarassa (FMS = Fieldbus Message Specification) 
PROFIBUS FMS verkkoon liitetyt laitteet liikennöivät keskenään 
PROFIBUS FMS protokollalla.

Folder (Hakemisto) Tällä objektityypillä voidaan luoda projektiin hierarkinen rakenne.

General 
interrogation (GI) 
(Yleiskysely)

Järjestelmän käynnistyessä päivitetään yleiskyselyn ohjaamana kaikkien 
järjestelmän informaatioiden tilat. Nämä päivitetyt tilat välitetään 
mahdollisesti käytössä olevaan ulkoiseen ohjausjärjestelmään. 
Voimassa olevat informaatioiden tilat voidaan myös päivittää 
mahdollisten tiedonsiirtokatkosten jälkeen yleiskyselyohjauksen 
aktivoimana.
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GPS Atomikelloin varustetut satelliitit jotka kiertävät maapalloa noin 20 000 
kilometrin etäisyydellä kaksi kertaa vuorokaudessa maapallon ympäri.
GPS vastaanotin määrittelee sijaintinsa näiden signaalien avulla. 
Sijaintitietonsa perusteella GPS vastaanotin voi korjata yleisen GPS ajan 
vastaamaan paikallista aikaa.

Hierarchy level 
(Hierarkinen taso)

Hierarkisin tasoin objektit voidaan jakaa hakemistoihin siten, että ne 
kuvaavat havainnollisesti kyseessä olevan järjestelmän eri tasoja.

HV field description 
(Suurjännitekentän 
kuvaus)

Suurjännitekentän kuvaustiedosto sisältää yksityiskohdat kentästä 
ModPara-projektille. Kunkin kentän ajankohtaiset tiedot tallentuvat 
tiedostoon. Tämän tyyppisessä projektissa näillä tiedostoilla pidetään 
yllä laitteiston tiedot kootusti.

HV project 
description (HV 
projektikuvaus)

Yksittäisten kenttien konfigurointi- ja parametrointitiedot tallentuvat 
kenttäkuvaustiedostoon ja ne tallennetaan edelleen HV projekti 
kuvaustiedostoon, josta tiedot ModPara projektiin voidaan siirtää. Tiedot 
on jaettu eri tiedostoihin. Yksi tiedostoista sisältää yksityiskohdat 
projektin perusrakenteesta. Siinä on myös tiedot esimerkiksi kaikista 
projektiin liittyvistä kentistä. Tätä tiedostoa kutsutaan 
suurjänniteprojektin kuvaustiedostoksi.

ID Sisäinen kaksinapainen merkinanto

ID_S Sisäinen kaksinapainen merkinanto varustettuna välitilalla 00

IEC International Electrotechnical Commission

IEC address 
(IEC osoite)

IEC liikennöinnissä tulee jokaisella SIPROTEC 4 laitteella olla 
yksilöllinen IEC osoite. Yhdessä IEC väylässä voi olla enintään 254  
osoitetta.

IEC
Communication 
branch (IEC 
Kommunikaatio-
haara)

IEC kommunikaatiohaaralla tarkoitetaan väylää, jossa laitteet 
kommunikoivat keskenään IEC870-5-2 protokollalla.

Initialization string 
(Aktivointi-
merkkijono)

Aktivointimerkkijono sisältää modeemikohtaisia ohjauskomentoja. Ne 
lähetetään modeemille modeemiyhteyttä luotaessa. Näillä ohjauksilla 
voidaan esimerkiksi määritellä määrättyjä asetteluita käyttöön 
modeemilla.
523SIPROTEC 4 Järjestelmäkäyttöohje
E50417-H1173-C151-A1

http://siemens-russia.com/


Sanasto
IRC combination 
(IRC yhdistelmä)

Laitteiden välistä kommunikaatiota (IRC = Inter Relay Communication) 
käytetään SIPROTEC 4 laitteiden välisissä liikennöinneissä informaation 
välitykseen. Laitteiden välinen suora kommunikointi määritellään IRC 
combination  objektissa. Objektissa määritellään kaikki laitteiden 
välisissä liikennöinneissä tarvittavat kommunikaatioparametrit ja laitteet 
jotka liikennöinnin piiriin kuuluvat. Laitteiden välillä välitettävien 
informaatioiden lukumäärät ja ominaisuudet ovat tallennettuina myös 
tähän objektiin. 

IRIG-B Aikasignaaliformaatti, jota ylläpitää Inter-Range Instrumentation Group

IS Sisäinen yksinapainen merkinanto

IS_F Sisäinen yksinapainen hipaisumerkinanto

ISO 9001 ISO 9000 sisältää standardit, jotka määrittelevät menetelmät kuinka 
tuotteen ja palvelun laatu voidaan taata aina tuotekehityksestä 
lopulliseen käyttöönottoon saakka.

Link address 
(Linkkiosoite)

Linkkiosoitteella määritellään V3/V2-laitteiden osoitteet 

List view 
(Luettelonäyttö)

Projektin oikean puoleisessa ikkunassa luettelomuodossa esitetyt 
objektien nimet tai ikonit. Näyttötyypin nimi tulee siinä esitettyjen 
informaatioiden esitystavasta.

LV Raja-arvo

LVU Käyttäjän määrittelemä raja-arvo

Master Master voi lähettää tietoa toisille yksiköille ja pyytää tietoa niiltä. 
Esimerkiksi DIGSI® 4 ohjelmisto toimii masterina.

Metered value 
(Laskuriarvo)

Laskuriarvolla voidaan laskea jonkin informaation tilamuutoksia (laskea 
pulsseja) määrätyllä aikavälillä, esimerkiksi summausarvoja. 
Sähköyhtiöissä sähköenergian määrää mitataan yleensä laskuriarvoin 
(energian osto, myynti ja siirto).

MLFB number 
(MLFB numero)

MLFB on lyhenne termistä Maschinenlesbare Fabrikatebezeichnung. 
Tämä on käytännössä laitteen tilausnumero. SIPROTEC 4 laitteiden 
tyyppi ja toiminnallisuus määritellään tällä numerosarjalla. 

Modem connection 
(Modeemiliityntä)

Modeemiyhteysobjekti sisältää tiedot modeemiyhteyden molemmissa 
päissä olevista modeemeista.
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Modem profile 
(Modeemiprofiili)

Modeemiprofiili sisältää tiedon profiilin nimestä, modeemiajurista ja 
mahdollisesti aktivointimerkkijonon ja puhelinnumeron. Yhdelle fyysiselle 
modeemille voidaan luoda useampia modeemiprofiileja. Tällöin 
linkitetään eri käynnistysmerkkijonoja tai puhelinnumeroita 
modeemiajurille, jotka tallennetaan eri nimillä.

Modems 
(Modeemit)

Modeemit objektiin on tallennettu projektissa käytettyjen modeemien 
ominaisuudet.

MV Mittausarvo

MVMV Laskuriarvo joka on muunnettu mittausarvoksi

MVT Mittausarvo aikaleimalla

MVU Käyttäjän määrittelemä mittausarvo

Navigation panel 
(Navigointi-ikkuna)

Projektin vasemman puoleinen ikkuna, jossa esitetään kaikkien 
projektissa olevien objektien nimet hakemistopuu muodossa.

Object (Objekti) DIGSI 4 ohjelmassa kaikkia projektirakenteessa olevia elementtejä 
kutsutaan objekteiksi.

Object properties 
(Objektin 
ominaisuudet)

Jokaisella objektilla on ominaisuuksia. Ne voivat olla yleisiä 
ominaisuuksia, jotka ovat yhteisiä useammalle objektille. Objektilla voi 
olla myös määrättyjä erikoisominaisuuksia.

Offline Offline tilassa työskenneltäessä yhteyttä SIPROTEC 4 laitteeseen ei ole 
käytettävissä. Tällöin työskennellään tietokoneen muistiin tallennetuin 
tiedoin.

OI_F Hipaisulähtömerkinanto

Online Online tilassa työskenneltäessä SIPROTEC 4 laitteelle on olemassa 
fyysinen yhteys. Yhteys voi olla muodostettu paikallisesti suoralla 
sarjaliikenneyhteydellä, modeemiyhteyksien tai PROFIBUS FMS verkon 
kautta.

OUT Lähtömerkinanto 

Parameterization 
(Parametrointi)

Yleisnimitys laitteen ominaisuuksien määrittelylle. Parametrointi 
suoritetaan DIGSI® 4 ohjelmalla tai joissakin tapauksissa suoraan 
laitteen etupaneelista.
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Parameter set 
(Parametrit)

Parametreillä tarkoitetaan SIPROTEC 4  laitteen asetteluita, joilla 
toiminnat voidaan määritellä.

Phone Book 
(Puhelinluettelo)

Modeemiyhteyksien puhelinnumerot on tallennettu tähän objektiin.

PMV Pulssilaskuriarvo

PROFIBUS PROcess FIeld BUS on normin EN 50170, kappale 2, PROFIBUS, 
mukainen liikennöintimenetelmä. Siinä määritellään sarjaliikenneväylän 
toiminnallisuus, sähköiset ja mekaaniset ominaisuudet.

PROFIBUS address 
(PROFIBUS osoite)

PROFIBUS verkkoon liitetyillä SIPROTEC 4 laitteilla tulee olla 
yksilöllinen PROFIBUS osoite. Käytettävissä on 254 PROFIBUS FMS 
osoitetta yhtä PROFIBUS verkkoa kohden.

Project (Projekti) Sisällöllisesti projekti kuvaa osaa energian siirtojärjestelmästä. 
Graafisesti projekti sisältää siihen liitetyt objektit hierarkisessa 
rakenteessa esitettynä. Fyysisesti projekti sisältää hakemistoja ja niiden 
alle tallennettuja projektitietoja.

Protection devices 
(Suojalaitteet)

Laitteet, jotka on varustettu suojaustoiminnoin mutta ilman graafista 
ohjausnäyttöä.

RIO file (RIO 
tiedosto)

Relay data Interchange tiedonsiirtoformaatti, jota käytetään Omicron 
koestuslaitteissa. 

RSxxx-interface 
(RSxxx-väylä)

RS232, RS422/485 sarjaliikenneväylät

Service 
interface 
(Huoltoväylä)

Sarjaliikenneväylä laitteella DIGSI® 4 ohjelman kommunikointia varten 
(esimerkiksi modeemiyhteydellä)

SI → Yksinapainen merkinanto

SI_F → Yksinapainen hipaisumerkinanto

SICAM SAS Modulaarinen sähköaseman ohjausjärjestelmä, joka muodostuu SICAM 
SC keskusyksiköstä ja SICAM WinCC valvonta- ja ohjaustyöasemasta.

SICAM SC Ohjausjärjestelmän keskusyksikkö. SIMATIC M7 
automaatioteknologiaan perustuva modulaarinen sähköaseman 
ohjausjärjestelmä.
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SICAM WinCC SICAM WinCC työasemaohjelmistolla voidaan valvoa ja ohjata siihen 
liitettyä kojeistoa ja siinä voidaan esittää valvottava verkon osa 
graafisesti, ilmaista tapahtumia äänihälytyksin, pitää yllä käyttöpäivä- ja 
hälytyspäiväkirjaa, sekä määritellä muita käyttäjien edellyttämiä 
toimintoja.

Single command 
(Yksinapainen 
ohjaus)

Yksinapaisella ohjauksella voidaan ilmaista kahta eri tilaa (esimerkiksi 
KIINNI/AUKI) yhdellä koskettimella.

Single point 
indication 
(Yksinapainen 
merkinanto)

Yksinapaisella merkinannolla voidaan ilmaista kaksi tilaa (esimerkiksi 
KIINNI/AUKI) yhdellä tulolla.

SIPROTEC SIPROTEC on Siemensin rekisteröimä tuotemerkki suojareleille.

SIPROTEC 4 device 
(SIPROTEC 4 laite)

Tämä objektityyppi sisältää SIPROTEC 4 laitteen kaikki asetteluarvot ja 
prosessitiedot.

SIPROTEC 4 
Variants 
(SIPROTEC 4 
variantti)

Tämä objektityyppi kuvaa SIPROTEC 4 laitteen variaatiota. Objektiin 
tallennetut tiedot voivat laajuudeltaan poiketa varsinaisen laitteen 
tiedoista. Varsinaisesta laitetiedostosta muodostetussa variaatiossa VD 
osoite pysyy samana. Tästä johtuen tällä objektityypillä voidaan 
kommunikoida alkuperäisen SIPROTEC 4 laitteen kanssa suoraan. 
SIPROTEC 4 varianttia käytetään esimerkiksi projektin 
toteutusvaiheessa kun laitteen määrittelyitä suoritetaan eri tahoilla.

Slave (Orja) Orja voi välittää tietoa vain kun masteri sitä pyytää. SIPROTEC 4 laitteet 
ovat orjia.

System interface 
(Järjestelmäväylä)

Laitteen sarjaliikenneyhteys ulkoisen ohjausjärjestelmään IEC tai 
PROFIBUS protokollin.

Time stamp 
(Aikaleima)

Aikaleimalla määritellään prosessitapahtuman todellinen syntyhetki. 

Topological view 
(Topologianäyttö)

DIGSI 4 Manager ohjelmassa esitetään projektin objektit aina 
topologianäytössä. Siinä esitetään kaikki projektissa olevat objektit 
hierarkissa rakenteessa.

Transformer tap 
indication 
(Käämikytkinmen 
asentomerkinanto)

Muuntajan käämikytkimen asentomerkinanto on toiminnallisuus, jossa 
muuntajan käämikytkimen asento muodostetaan useasta rinnakkaisesta 
tiedosta.
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Sanasto
Transient 
information 
(Hipaisumerkin-
anto)

Hipaisumerkinannolla tarkoitetaan yksinapaista merkinantoa, josta 
ilmaistaan vain nouseva reuna (tullut-tila).

Tree view 
(Valikkopuunäyttö)

Projektin vasemman puoleisessa ikkunassa esitetään projektiin liitetyt 
symbolit valikkopuu muodossa. Tätä aluetta kutsutaan 
valikkopuunäytöksi. 

TxTap → Muuntajan käämikytkimen asentomerkinanto

User address 
(Käyttäjäosoite)

Käyttäjäosoite sisältää aseman nimen, kansallisen 
puhelinnumerokoodin, aluevalinta numerokoodin ja käyttäjän 
määrittelemän puhelinnumeron.

Users (Käyttäjät) Enintään 16 yhteensopivaa SIPROTEC 4 laitetta eli käyttäjää voi 
kommunikoida keskenään suoraan laitteiden välisin liitynnöin (IRC, Inter 
Relay Communication). Yksittäisiä laitteita kutsutaan tässä yhteydessä 
käyttäjiksi.

Value indication 
(Arvomerkinanto)

Arvomerkinantoja ovat yksinapaiset merkinannot, jotka sisältävät 
numeerisen lisämuuttujan (esimerkiksi: "vikapaikan etäisyys": Jolla 
voidaan välittää vikapaikan etäisyyden numeerinen arvo ulkoiseen 
ohjausjärjestelmään).

VD VD (Virtual Device) sisältää kaikki kommunikaatio-objektit, niiden 
ominaisuudet ja tilat. VD voi olla fyysinen laite, laitteen moduli tai 
ohjelmistomoduli.

VD address (VD 
osoite)

DIGSI 4 Manager muodostaa VD osoitteen automaattisesti. Se voi 
esiintyä vain kerran projektin sisällä ja määrittelee täten yksilöllisesti 
SIPROTEC 4 laitteen. DIGSI 4 Manager ohjelman määrittelemä VD 
osoite tulee siirtää SIPROTEC 4 laitteelle, jotta DIGSI 4 Device 
Configuration ohjelmisto voisi kommunikoida laitteen kanssa.

VFD VFD (Virtual Field Device) sisältää kaikki tiedot kommunikaatio-
objekteista, sekä niiden ominaisuudet ja tilat kommunikaatiossa 
käytetyllä laitteella.
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A
Absolute time 219
Advanced 289
Ajantahdistus 5
Alasveto-

valikot 493
Aliverkko 407, 409
Allocation 157
Analog inputs 176
Analog output 54
Analogiamodeemit 382
Analogue input 171
Apua-toiminnat 8, 490
Archive

Across diskettes 94
Create new 97
Selecting 97

Archive directories 95
Archive program

Configuring 93
Selecting 92, 93

Archiving 96
Archiving automatically 97
Archiving options 94
ASCII/ELCAD 142
Asentotiedon käsin merkkaus 355
Asetteluohjeita 506
Asetteluryhmä 158
Asetteluryhmät 11
Assigning text

User Text 249
Avainkytkimet 21

B
Baudinopeus 377, 378
Bay controllers (Kenttäyksiköt) 519
Binäärinenulostulo 178
Binääriset tulot 174
Binary input 165, 171
Binary output 172
Binary outputs for switching devices 180

Blocking by protection 211
Buffer 172, 186

C
CFC 10, 16, 157, 171, 172, 192

Inserting a CFC chart 226
Characteristic

Changing 293
Characteristics 291
Chatter check time 222
Chatter checks 221
Chatter idle time 222
Chatter test time 221
Check time 222
Circuit breaker test function 345
Cleaning up 109
Cleaning up (Puhdistus) 526
Close 111
Column 84
COM PROFIBUS 392
COM väylä 377
Combination devices (Yhdistelmälait-
teet) 520
Combination matrix (Liityntämatriisi)
520
Common contact 179
Communication branch (Kommunikaa-
tiohaara) 528
Communication Modules 161
Communication reference CR (Kommu-
nikaatioreferenssi) 520
Communications modules 161
Comparison 121
Component view 99
Connections for low-level signal convert-
er 56
Connectors 44
Control 172, 188, 351

Switching authority at local control
212

Switching authority at remote control
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212
Switching direction 212

Control display 157, 172, 185, 227
Drawn and configured 260
Specifying an empty control display

229
Control of switchgear 349
Controlling device functions 332
Conversion factor 208
Copy 165, 318

Area symbol 269
CP 5412 (A2) 391, 416
Creating

Device circuit breaker 271
New device 271, 272

Creating a Device 271
Creating a new symbol 263
Creating an empty symbol 264
Cubicle installation 24
Current connections 39
Current input 171

D
Date 108
DCF77 5
Decimal places 209
Declaration of Conformity i
Default display 157, 172, 185, 232

Delete 228
Displaying in normal size 256
Drawn and configured 232
Opening 233
Printing out 257
Saving 258
Saving an empty default display 229
Specifying an empty default display

228
With positioned devices 241
With positioned symbols 250

Default display with topology 236
Delay 213

Delete 319
All 240
All symbol 269
Area symbol 268
Line symbols 239
Points in the symbol editor 267
Points symbol 268
Positioned device 247
Positioned symbol 252
Positioned text 253
Range 240
Standard default display 228
Symbol 270

Deleting a standard default display 228
Deleting all 240
Deleting all symbol 269
Deleting the indication memory 313
Destination 172
Detached operator control panel 33
Device 158, 285
Device catalog 147
Device container (Laitehakemisto) 522
Device data

Exporting device data 135
Importing device data 137
Installing device updates 144

Device designation 272
Device font

Displaying 230
Device matrix

Colouring 173
Horizontal structure 170
Reduction of the display scope 194
Vertical structure 172

Device texts 151
Device type

Updating device types 146
Device variant 112
Device width 272
Devices

Assigning a state symbol 274
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Creating a circuit breaker 271
Creating anew 271, 272
Deleting a positioned device 247
Highlighting 255
Linking to information 244
Making operator-controllable 261
Moving a positioned device 246
Moving while inserting 243
Open object 274
Positioned in default display 241
Positioning 242
Relinking 246
Specifying a device designation 272
Specifying properties 274
Specifying the device width 272
Specifying the first operator-control-

lable 262
Specifying the type 272

DIGSI 4 Remote 366
DIGSI key 133
DIGSI operating tree 106
DIGSI4 VD osoitteet 368
Dimension 208
Display

Status bar 227
Toolbars 227
Tooltips 227

Display offset 205
Display text 171
Displaying the switch position 351
Displaying toolbars 227
Displaying Tooltips 227
DNP 3.0 366, 446
DNP 3.00 3, 6
DNP3.0 277
Double activation blockage 212
Drag-and-drop 492
Drawing

Circle symbol 267
Drawing a symbol freehand 267
Drawing mode symbol 267

Ellipse symbol 267
Filling a surface symbol 267
Horizontal line 238
Intersections 239
Line symbol 267
Rectangle symbol 267
Tools symbol 266
Vertical lines 236

Drawing a circle 267
Drawing an ellipse 267
Drawing freehand 267
Drawing horizontal lines 238
Drawing intersections 239
Drawing mode

Drawing symbol 267
Drawing vertical lines 236
Drawn and configured

Control display 260
Default display 232

DU type 183, 216

E
Earth fault indications 309
Editing

Header 234
ELCAD 142
Empty default display

Saving 229
Specifying 228

Encoding 205
Energialaskureiden 326
Energy flow direction 208
Energy meter 321, 323
Establishing a connection 105
Ethernet 3, 6
Ethernet liityntä IEC 61850 mukaisesti 3,
6
Ethernet modeemit 383
Exporting 135, 140, 141, 287

Configurations and protection param-
eters 142
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Fault record data 141
Setting protection functions 140
System interface 143

Extraction tool 47

F
Fault event buffer 110
Fault indications 305
Fault recording 158, 285
Fault recording data 328
Fault records 204
Fault value recordings 15
Feedback monitoring 213
Field devices (Kenttälaitteet) 522
Filling a surface 267
Filter criteria 194
Filter time 204
Filtering 85
First startup 203
FMS Kommunikaatiohaara 522
FMS Slave 397
Folder (Hakemisto) 523
Front panel fixture 22
Function key 171
Function type 183, 216
Functional scope 162, 223
Functions 166, 286

Selecting functions 167, 286
Funktiopainike 177

G
General interrogation 311
Group

Deleting a group 201
Inserting a group 199
Renaming a group 200

Group Switchover of the Function Pa-
rameters 339

H
Häiriön tallennus 15

Hakemisto 75, 492, 519
Header

Editing 234
Text input box 235

Hiding
Grid 254

Hiding the grid 254
Highlighting

Devices 255
Huoltoväylä 7, 9, 13, 526
HV field description (Suurjännitekentän
kuvaus) 523
HV project description (HV projekti ku-
vaus) 523

I
Idle time 222
IEC 3, 6, 277
IEC 60 870–5–103 6, 277
IEC 60870–5–103 3, 6, 277
IEC 61850 3, 6
IEC 61850 (Ethernet) 277
IEC Kommunikaatiohaara 523
IEC linkkiosoite 369, 378
IEC osoite 368, 377, 523
Ikonit 491
Ilmaisinelementit 21
Importing 137
Indications

Initiator category 303
Transmission cause 302

Info 179
Information 171

Deleting information 201
Inserting an information item 198
Linking to a User Text 248
Linking to device 244
Properties 202
Relinking with device 246
Renaming information 200

Information catalog 198
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Information Number 183
Information number 216
Initialisointi 374
Initialization string (Aktivointimerkkijo-
no) 523
Initializing 105
Initiator category 303
Input and display mode 289
Installing updates 144
Instanceable functions 10
Instrumentation and control system 2
Inter Relay Communication 171, 172
Interfaces 158, 277
Intermediate position 205
IRC combination (IRC yhdistelmä) 524
IRIG B 5, 335
ISDN modeemi 382

J
Järjestelmän kuormitus 478
Järjestelmän kuvaus 1
Järjestelmäväylä 13, 447, 527

K
Kaapeleiden kytkennät 505
Katalogit 494
Kauko-ohjaukset 381
Käyttöliittymä 8, 490
Käyttöohje

Alasvetovalikot 493
Drag-and-drop 492
Ohjauspainikkeet 493
Sivu (Tab) 493
Valintakentät 493
Valintaruudut (Check Boxes) 493
Valintaruutu 494
Vyöhyle (Section) 493
Yhdistetty alasvetovalikko 493

Käyttöönotto 8
Käyttösarjaliikenneväylä 22
Käyttöväylä 9

Key function 22
Keyboard shortcuts 227
Koestushäiriötallenne 476
Kojeiston tiedot (Power System Data) 11
Kommunikaatio 3

Communication reference CR (Kom-
munikaatio-
referenssi) 520

Huoltoväylä 526
IEC osoite 523
Järjestelmäväylä 527
Modem connection (Modeemiliityn-

tä) 524
Modems (Modeemit) 525
Phone Book (Puhelinluettelo) 526
Plug & Play 370
SIPROTEC 4 laitteen initialisointi

374
Työskentely online tilassa 369
User address (Käyttäjäosoite) 528

Kommunikaatioreferenssi CR 405
Komponettinäyttö 520
Konfigurointi 10
Kopiotoiminnat 492
Korjaukset / Huolto 482
Kotelo 24, 28
Kuittaus 404
Kunnossapitotoimenpiteet 461
Kytkentäsillat 41

L
Laitekonfiguraatio 372
Laitetiedot

SIPROTEC 4 laitteen konfigurointi
369

Laitetyyppi 491
Laitteen purkaminen 483
Laitteen tulot ja lähdöt 472
Language 158
Latched 178, 180
LED 172, 180
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LEDs 8, 317
Library

Printing out 264
Selecting 263
Selecting a device 272
Zooming the display 237

Liityntäkaapeli 505
Liityntöjen toteutus 46, 48, 51
Limit measured value

Configering 224
Configuring 224

Line
Deleting all 240
Deleting an area 240
Deleting line symbols 239
Drawing horizontal lines 238
Drawing intersections 239
Drawing symbol 267
Drawing vertical lines 236
Line symbols 237

Line symbols
Delete 239

Link address (Linkkiosoite) 524
Linking

Device to information 244
Linking a User Text 248
Relinking devices 246

List view (Luettelonäyttö) 524
Logging 16
Logic functions 225
Long text 171, 199
Low-level plug connectors 56
Lukitukset 16, 358

M
Määrittelymatriisi 8
Managing 90
Mapping-tiedosto 449
Master-järjestelmä 395, 397, 411, 412
Maximum value 321
Mean values 321

Measured value 197
Measured value window 187

Measured value processing 223
Measured values

Parameterizing 224
Measured values - user-defined 321
Measuring transducer 157, 285

Inserting into functional scope 223
Measuring transducer blocks 223
Menu

Toimintakohtainen valikko 490
valikko 490

Merkinannot 14, 196, 510
Merkinantojen koestus 477
Merkkaukset 359
Metered values 197

Metered value window 187
Restoring metered values 219

Minimum value 321
Mittausarvojen skaalaus 454
Mittausarvot 14
Mittaustekniikat 2
MLFB 481
MLFB extension 161
MLFB lisämäärittely 447
MLFB Number 160
MLFB numero 524
MODBUS 366, 446
MODBUS ASCII/RTU 3, 6, 277
Modem connection (Modeemiliityntä)
524
Modem profile (Modeemiprofiili) 525
Modems (Modeemit) 525
Modulin parametrit 409
Monitor operation 480
Move 318

Area symbol 269
Positioned device 246
Positioned symbol 252
Positioned text 253

Muuttujaosoitteet 412
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Muuttujapituudet 412

N
Näppäimistön asettelut 491
Näyttö

Komponetti-
näyttö 520

Topologianäyttö 527
NCM tietokanta 401
Nomal size 256
Number 171
Number of bits 205
Number of chatter checks 221
Number of taps 205

O
Object

Open device 274
Object list 152, 153
Object names 150
Object properties 79, 99
Object types 75

Device container 99
SIPROTEC 4 device 159

Objects 74
Copying 80
Deleting 80
Inserting 78
Opening 78
Opening objects 78

Objektin ominaisuudet 525
Objektit 525
Objektityypit

Device container (Laitehakemisto)
522

Folder (Hakemisto) 523
Modem connection (Modeemiliityn-

tä) 524
Modems (Modeemit) 525
Phone Book (Puhelinluettelo) 526
Projekti 526

SIPROTEC 4 variantti 527
Offline 103, 528
Ohjaukset 16, 196
Ohjausnäyttö 520
Ohjausoikeudet 360
Ohjauspaneeli 7, 13
Ohjausten merkinannot 363
Ohjaustila 361
Ohjaustoiminnat 13
Online 103, 369, 525
Opening 104

Default display 233
Header for editing 234

Opening a dynamic editor 274
Operating mode 103, 213

Changing the operating mode 109
Operating system 65
Operational indications 303
Operational measured value 321

Inserting 224
Optical fibers 48, 49
Optional products 66, 67
Options for fault location 306
Ordering code 59
Output 213

P
Packing 58
Päivitysesto 491
Panel surface mounting 28
Parameter 288

Parameter number 288
Parameter set 157

Parameter set 227
Parameter set (Parametrit) 526
Parameterization (Parametrointi) 525
Parameterizing 107
Pariston vaihto 461
Password 212

Activating the password 131
Deactivating a password 131
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Password prompt 133
Resetting all passwords 132

Passwords 128
PC väylä 370, 375
Percentages 321
Persistent output 213
PG/PC väylä 402
Phone Book (Puhelinluettelo) 526
Plug-in terminals 44
Points

Deleting a symbol 268
Positioned device

Delete 247
Move 246

Positioned symbol
Delete 252
Move 252

Positioned text
Delete 253
Move 253

Positioning
Devices 242
Symbol 251
Text 253
User Text 247

Power system data 285
Primary parameter 289
Primary values 321
Printing

Default display 257
Library 264
Print selection 154
Printing an object list 152

Process data
Deleting process data 319
Selecting process data off-line 301

PROFIBUS 3, 6, 100, 277, 526, 528
PROFIBUS address (PROFIBUS os-

oite) 526
PROFIBUS address 369
PROFIBUS DP 3, 6, 277, 366, 446

PROFIBUS FMS 3, 6, 277, 366
PROFIBUS FMS ajuri 392
PROFIBUS FMS osoite 408, 409
Project

Closing 83
Storage location 87

Projects
Archiving projects 96
Closing projects 82
Creating projects 77
Managing projects 90
Opening projects 82
Reorganizing projects 89
Retrieving projects 98
Structuring projects 74

Projektit 526
Properties 168, 202
Protection devices (Suojalaitteet) 526
Protocol IEC 60870-5-103 165
Pulse output 213
Pulse type 207

R
Radio clock 278
Range

Copy 269
Delete 240, 268
Move 269

Raportti 494
Reading and setting the date 333
Reading and setting the time 333
Reading out

Counters and memories 315
Measured values 323
Metered values 323
Operational indications 63
Operational measured values 63
Type designation 62

Rectangle
Drawing symbol 267

Relative time base 219
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Release object 211, 212
Reorganizing 89
Representation

Default display in normal size 256
Zoom in 233
Zoom out 233

Reset 133, 166, 286
Counters and memories 316
Metered values 326
Minimum and Maximum Values: 326

Reset key 133
Restart 107, 203
Restore type 208
Resume 107
Retrieving 98

Options 98
Retrigger filter 204
RIO Export 140

S
Säätöruutu 494
Sähköiset tarkastukset 60
Salasanamäärittelyt 12, 128
Salasanat 8, 12, 16
Sample display 206
Sarjaliikenneväylät 6
Saving

Default display 258
Empty default display 229
Symbol 270

Saving the indication memory 313
Scope of information 196
Screw-type terminals 37
Seal-in time 213
Secondary parameter 289
Secondary values 321
Selecting a device library 272
Selecting a symbol library 263
Selecting all in the Display Editor 240
Selection

All in the Display Editor 240

Library 263
Symbol library 263

Sensitive ground-fault measured value
321
Setting

Counters and memories 316
Limit values 324

Setting parameters 9
Setting value 277, 281, 287
Settings group 164

Changing over the settings groups
164

Copying a settings group 165
Displaying settings group 164
Resetting a settings group 166

Short Text 199
Short text 199
Short view 195
SICAM asema 405, 406
SICAM plusTOOLS

Basic hardware 65
SICAM-Proxy VD osoite 368
Signal relay 179
SIGRA 4 15
SIMATIC Manager

Tieto ikkunan avaaminen 492
Tieto ikkunan sulkeminen 492

SIPROTEC 527
SIPROTEC 4 device

Close a SIPROTEC 4 device 111
Opening the SIPROTEC 4 device 104

SIPROTEC 4 laite 527
SIPROTEC 4 variantti 527
SIPROTEC VD osoite 368
SIPROTEC-T103 VD osoite 368
Slave (Orja) 528
Source 171
Specifying

Device designation 272
Device properties 274
Device width 272
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Empty control display 229
Empty default display 228
Symbol designation 264
Symbol height 264
Symbol width 264
Type of device 272

Specifying an empty control display 229
Specifying device object properties 274
Specifying the brush size 266
Specifying the device properties 274
Specifying the line width 266
Spontaanit merkinannot 491
Spontaneous displays 305
Spontaneous indications 312
Standard view 195
State change 221
Status bar 227
STEP 7 100
Sulake 485
Sulakkeen vaihtaminen 485
Suojakannet 42
Suojan kokoaminen 486
Suurin katkosaika 378
Symbol

Copying an area 269
Creating a new one 263
Creating an empty 264
Delete 270
Deleting a positioned symbol 252
Deleting all 269
Deleting an area 268
Deleting points 267, 268
Drawing a circle 267
Drawing a line 267
Drawing a rectangle 267
Drawing an ellipse 267
Drawing freehand 267
Drawing mode 267
Filling a surface 267
Line symbol 237
Moving a positioned symbol 252

Moving an area 269
Positioning 251
Saving 270
Specifying the symbol designation

264
Specifying the symbol height 264
Specifying the symbol width 264
Tools drawing 266

Symbol designation 264
Symbol height 264
Symbol width 264
Symbols

Positioned in the default display 250
Synchronism 157, 285
System interface 171, 172, 181, 182, 278
System interlocking 211
System management 99, 161
System overview 71
System time 108

T
Table parameter 287, 290
Taggings 17
Takaisinlähetys 487
Terminaaliadapteri 382
Test mode 342
Testaustila 491
Testibitti 477
Testitila 471
Text

Deleting a positioned text 253
Moving a positioned text 253
Positioning 253

Text and decimal parameters 286
Text input box

Header 235
Thermal measured values 321
Tiedonsiirron esto 491
Tiedonsiirronesto 471
Tiedonsiirtoformaatti 370, 375, 377, 378
Tila 16
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Tilan asetus 356
Tilapalkki 491
Tilaustiedot 490, 510
Time 108
Time format 285
Time interval 219
Time period 279
Time synchronization 158, 278
Toiminnallisuus 10, 157
Toiminnan tila 491
Toimintakohtainen valikko 490
Toimintatilat 369, 372
Tools

Drawing symbol 266
Topologianäyttö 527
Topological view 99
Topology

Default display 236
Transferring displays to the device 227
Transferring parameters 227
Transformer data 11
Transmission blocking 342
Transmission causes 302
Työkalu 490
Type 171

U
Unlatched 178, 180
Unpacking 58
Update 16
Updating 146
Uppoasennus 24
User address (Käyttäjäosoite) 528
User interface 20
User Text

Assigning text 249
Linking 248
Positioning 247

Users (Käyttäjät) 528
Uudelleen käynnistys 404

V
Valikko 490
Valintaruutu 494
Value 288
Varastointi 69
Variant 112
Väyläosoite 395
Väylät

Väyläasetukset 491
VD 528
VD address 
(VD osoite) 528
VD osoite 367
Verkon rakenne 411
Version number 147
Versions 145
Vertical filtering 195
VFD 528
Vianetsintä 479
View

Filtering 85
Voltage input 171

W
Wire-bound serial interfaces 52

Y
Yhdistetty

alasvetovalikko 493
Yleiset kojeistotiedot 2 11

Z
Zone controlled 211
Zone diagram 294

Hiding and displaying zones 295
Increasing and reducing the zone dia-

gram 295
Zoom in

Representation 233
Zoom out

Representation 233
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Vastaanottaja

Siemens AG

PTD EA D SC 22

P.O. Box 4806

D-90026 Nürnberg

Lähettäjä:

Nimi: ..........................................................................................................

Tehtävä: ..........................................................................................................

Yritys: ..........................................................................................................

Osasto: ..........................................................................................................

Katuosoite: ..........................................................................................................

Kaupunki: ..........................................................................................................

Puhelinnumero: ..........................................................................................................

Telefaksi: ..........................................................................................................

Toimiala:

Muu ...................................................................................

Metsäteollisuus
Kaivostoiminta
Kemianteollisuus
Energian tuotanto
Energian siirto ja jakelu
Kunnallistekniikka

LVIS
Koneenrakennus
Öljyteollisuus
Laivanrakennus
Ympäristöteknologia
Liikennetekniikka
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Palaute

Palautteenne auttaa meitä parantamaan dokumentin käyttökelpoisuutta. Olkaa hyvä ja 
täyttäkää kysely ja lähettäkää se postitse tai telefaksilla (faksinumero ++49 - 911 / 
4338518) Siemensille.

Käyttöohjeen nimi: SIPROTEC Järjestelmäkäyttöohje

Tilausnumero: E50417-H1173-C151-A1

Olkaa hyvä ja antakaa henkilökohtainen mielipiteenne seuraaviin käyttöohjetta 

koskeviin kysymyksiin. Arvosanat 1 = hyvä ... 5 = huono.

1. Täyttääkö dokumentin sisältö vaatimuksenne? ................

2. Onko tarvittava tieto helposti löydettävissä? ................

3. Ovatko tekstit helppotajuisia? ................

4. Täyttävätkö tekniset yksityiskohdat vaatimuksenne? ................

5. Kuinka arvioitte kuvien ja kaavioiden laadun? ................

Jos teillä on määrätty ratkaisematon ongelma, kuvatkaa se alla yksityiskohtaisesti:

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................

..........................................................................................................................................
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